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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support
2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:
1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and 

it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 

times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Safety Notices
Refer to the “Important Regulatory and Safety Notices” document that accompanied your product.

Statement of Compliance
This product has been determined to be compliant with the applicable standards, regulations, and directives for the countries where 
the product is marketed.

Compliance documentation, such as certification or Declaration of Compliance for the product is available upon request by 
contacting techsupport@rossvideo.com. Please include the product; model number identifiers and serial number and country that 
compliance information is needed in request.

EMC Notices
United States of America - FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a 
Commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 



accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own 
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Canada

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appariel numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

European Union

This equipment is in compliance with the essential requirements and other relevant provisions established under regulation (EC) No 
765/2008 and Decision No 768/2008/EC referred to as the “New Legislative Framework”.

Australia/New Zealand

This equipment is in compliance with the provisions established under the Radiocommunications Act 1992 and 
Radiocommunications Labelling (Electromagnetic Compatibility) Notice 2008.

Korea

This equipment is in compliance with the provisions established under the Radio Waves Act.

Class A equipment (Broadcasting and communications service for business use).

This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be aware of this fact. This device is 
intended for use in areas outside home.

International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and found to comply with the limits for 
a Class A Digital device.

Warranty and Repair Policy
The Ultrix systems are backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable 
out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement 

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could void the 
user’s authority to operate this equipment.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may 
cause radio interference.

Notice — This is a Class A product. In domestic environments, this product may cause radio interference, in which 
case the user may have to take adequate measures.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the 
user’s authority to operate this equipment.
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parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are 
the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized 
modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of 
profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration 
of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural 
resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the 
materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste 
administration. You can also contact Ross Video for more information on the environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your area. These systems will reuse or 
recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com

E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com
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Introduction
This guide covers the configuration and operation of the Ultrix router. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” provides general information to keep in mind before configuring your Ultrix.
• “Basic Configuration” provides instructions for configuring the Ultrix network settings, and displaying the 

Ultrix nodes in DashBoard.
• “Software License Keys” provides instructions for enabling licensed features of your Ultrix router.

Hardware Configuration
• “Configuring the Ports” provides instructions on how to manage your hardware matrices, configure an AUX 

port, and assign an UltriScape (Multiviewer) head to a physical output.
• “UHD Gearbox Configuration” provides instructions on how to set up your Gearbox groups. 
• “UltriScape Setup” provides instructions on how to configure the hardware for UltriScape.
• “ULTRIX-IP-IO Setup” outlines how to configure receivers and senders for the Ultrix router to be used in 

video and audio streaming when at least one ULTRIX-IP-IO blade is installed in a slot of an Ultrix router chassis.
• “ULTRIX-SFP-IO Setup” outlines how to utilize the ports for the Ultrix router when an ULTRIX-SFP-IO blade 

is installed in a slot of an Ultrix router chassis.

Routing Configuration and Operation
• “Device Communication Setup” provides instructions for using Ultrix to establish connection points to Ross 

NK Series devices, Ross Ethernet devices, and third-party devices in your routing system.
• “Database Configuration” provides instructions on how to define destinations, sources, and levels for your 

router.
• “UltriScape Configuration” provides information on using layout templates, editing layouts, adding objects to 

a layout, and publishing a finished layout.
• “Managing the UltriScape Heads” provides instructions on how to, load and assign a layout to an UltriScape 

head, and assign router input signals to PiPs in a layout.
• “Tallies” provides instructions on how to enable TSL UMD messages in the active database, assign Tally IDs to 

your sources and destinations, and how to manage tally objects in your UltriScape heads.
• “Configuring an Audio Matrix” provides instructions on how to enable Sample Rate Conversion (SRC) of the 

embedded audio, audio fading, configuring how the audio is embedded in the outputs, mapping audio channels, 
and configuring MADI signals.

• “Using Remote Control Panels” provides information on operating the Ultrix router with Ross remote control 
panels (RCP).

• “Using Categories” describes how to assign each destination, source, and level to a specific category in the 
router database. 

• “Soft Panels in DashBoard”describes the Matrix, MultiBus, and Category panels in DashBoard, and provides 
instructions on how to use the soft panels to perform crosspoint switches.

• “Using Salvos” describes how to create and recall a salvo using the options in DashBoard.
• “Operation with Ross Devices” provides general information for operating the Ultrix router in a routing system 

that also includes Ross NK Series devices.
• “External Control” lists the third-party protocol commands the Ultrix router supports.
• “ULTRIX-UCCI Redundancy” outlines the ULTRIX-UCCI Control redundancy feature for the ULTRIX-FR5.
• “Managing your Ultrix Settings” outlines how to import and export archived files (*.ufs) of your Ultrix router 

settings to another Ultrix router.
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• “Monitoring the Hardware” outlines how to monitor the router hardware via the DashBoard status fields.
• “Monitoring the Communications” summarizes how to verify communications on an Ethernet port, an 

Ultricore connection, and the overall communication status of the Ultrix router.
• “Monitoring the Signals” outlines how to monitor the reference signal, the inputs and outputs signals via the 

options in the Frame Configuration interface of DashBoard.
• “Software Upgrades” provides instructions on how to upgrade the Ultrix router through DashBoard.
• “DashBoard Interface Overview” summarizes the functions, menus, and parameters of the Ultrix tabs and 

windows in DashBoard.
• “Glossary” provides a definitions of commonly used terms and conventions for this guide.

If you have questions pertaining to the operation of Ultrix, contact us at the numbers listed in the section 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Save As dialog, click OK.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Hardware Overview” in the Ultrix Installation Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 An error message displays when an object overlaps a tile or when one tile overlaps another in the workspace.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest 
telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service 
and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), 
technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical 
support phone line is available. If the technical support person who is on call does not answer this line immediately, 
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a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to 
react to any problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
Implement your routing system plan and then use the Ultrix user interfaces in DashBoard to configure the router. 

Configuration Overview
The generalized work-flow of configuring your Ultrix router is:

1. Implement your routing system plan.

2. Configure the network settings for the Ultrix router.

3. Ensure that DashBoard discovers the Ultrix router on your network.

4. Define the database for the router using the options in the Ultrix interfaces in DashBoard.

5. Set up control panels.

Implementing Your System Plan
An effective routing system takes careful planning. You may use multiple router levels across several input and 
output devices.

 Ultrix supports a maximum of 25 DashBoard clients with 50 other TCP/IP connections (remote control panels, 
third-party control systems, etc.).

Establish Communications
Ultrix supports the Walkabout system for initial configuration of its IP settings. Once you establish communications 
over Ethernet between the Ultrix router and DashBoard, you can proceed to use the interfaces in DashBoard that 
enable Ultrix to communicate with the other devices in your routing system.

Define the Database for the Router
The Database interface in DashBoard for an Ultrix enables you to create system input and output lists, assign those 
signals to system sources and destinations, define multiple levels and matrices. You may wish to use the following 
process when defining the database for your router.

 Ultrix supports a maximum of 64 levels, with a maximum matrix of 4096 sources and 4096 destinations.

Figure 2.1  Process for Configuring an Ultrix Router

 Ultrix does not support Unicode characters.

Re-naming the Ultrix Router via the Front Panel
If you installed multiple Ultrix routers in your system, each router must have a unique name assigned to it via its 
front panel menu system. This ensures that the router is easily identifiable in the Walkabout interface and uniquely 
identifies its inputs and outputs in the DashBoard database interfaces.
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Navigating the Front Panel Menu System
The LCD Display on the Ultrix front panel reports the chassis IP Address, the unique name of the router, and 
reports when an error or warning condition is occurring on the router. Next to the LCD Display is a five-direction 
round finger joystick that is used to access and navigate the Ultrix messages and menus on the LCD Display.

For More Information on...
• using the joystick to navigate the front panel menu system, refer to the Ultrix Installation Guide.

Re-naming the Ultrix Router
Throughout the DashBoard interface, actual sockets (inputs and outputs) of a router (or matrix) are referred to by 
hierarchical dotted notation: Frame.Slot.Port.Type.Channel where Frame identifies the physical router chassis 
housing the matrix/matrices. By default, each Ultrix router ships with the name “Ultrix” automatically set. By 
re-naming each Ultrix router, you are providing a unique identifier for the sockets within the router system.

To re-name an Ultrix router via the front panel

1. Navigate to the Frame Name menu via the front panel as follows:

The current name for the router is displayed in the bottom line of the Frame Name: field. The first character 
position in the field will alternate flash with an underscore character. This provides visual feedback to the 
current cursor position.

2. Use the joystick to assign a new name to the router.

• Pressing the joystick LEFT/RIGHT positions the cursor.
• Pressing UP/DOWN selects a character.

3. Press the joystick IN to apply the new name.

4. Ensure the cursor is positioned at the front of the name.

5. Press the joystick LEFT to navigate back up the menu tree.

1 2 3 4Network
>System

1 2 3 4Frame Name
 System  Name

1 2 3 4Frame Name:
 Ultrix

1 2 3 4>Config
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Basic Configuration
The DashBoard client software allows configuration and monitoring of the Ultrix router, and provides access to 
other devices in your routing system. This chapter provides general information for enabling the Ultrix router to 
connect to your facility network, and configuring the router to establish communications with other devices in your 
routing system.

Launching DashBoard
DashBoard must be run on a computer that has a physical wired Ethernet connection. Wireless connections do not 
allow device discovery.

For More Information on...
• downloading and installing the DashBoard client software, refer to the DashBoard User Manual.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.0 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.

Using Walkabout to Assign the Initial IP Address to the Ultrix Router
Once the Ultrix router is physically installed and cabled to your facility network, you will need to assign it an initial 
static IP Address to enable DashBoard to locate it on your network. Establishing an initial IP Address enables 
DashBoard to communicate with the router and update the Basic Tree View with the Ultrix nodes.

To assign the initial static IP address for the Ultrix router

1. Launch DashBoard.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout interface is 
current.

4. In the Walkabout table, find the entry for the Ultrix you want to configure.

 After you edit a cell in the Walkabout table, it is recommended to wait approximately 1 minute, then click 
Refresh to apply the new settings.

5. Use the Name field to assign a unique identifier to the Ultrix router. This will be the name displayed in the Tree 
View of DashBoard.

6. Use the Address field to specify the IP Address supplied by your IT Department for this device.

 The ULTRIX-FR5 requires two IP addresses.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP Address for connection outside of the local area network (LAN).

9. Click Reboot in the row of the Walkabout table for the Ultrix router.

Adding the Ultrix Router to the Tree View in DashBoard
Once you have assigned the Ultrix router a static IP Address, you can then manually add it to the Tree View in 
DashBoard. Manually adding the Ultrix router displays its node in the Tree View, granting you access to the 
interfaces described in the chapter “DashBoard Interface Overview” on page 315.
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To manually add the Ultrix router to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Select Equipment or Service Type to Add dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Select the JSON radio button as the Protocol.

6. Enter the IP Address for the router in the IP Address field that you assigned in the section “To assign the 
initial static IP address for the Ultrix router” on page 23.

7. Perform one of the following steps:

• In the text fields provided, enter the display name for the Ultrix router, and port of the panel you wish to add.
• Click Detect Frame Information to automatically retrieve the connection details.

8. Click Finish. 

The Ultrix router displays in the Tree View. 
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Accessing the Ultrix Interfaces in DashBoard
The interfaces are accessed by expanding the Ultrix node in the DashBoard Tree View and selecting the appropriate 
sub-node. Several of the interfaces are organized in a table layout with a toolbar on the bottom, and a toolbar on the 
left side of the tab.

To access the Database interfaces in DashBoard

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

Each sub-node is an Ultrix interface.

3. Select a sub-node for the interface you want to access. For example, expand the Ultrix node to display a list of 
options for the Ultrix router.

4. If required, expand the sub-node to access the function of the interface. For example, expand the Database node 
to list the options available for configuring a database for the Ultrix router.
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5. Double-click a sub-node to display its tab in the right-side of the DashBoard window. For example, 
double-click the Destinations node to display the Destinations interface.

 The selected interface may be blank or missing some data if the database is new and is not configured yet.

To access the Device Configuration interfaces in DashBoard

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Devices node.

4. Expand the Controllers + Matrices node.

5. Double-click the Ultrix node to open the Device Configuration interface.
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6. Click a button in the center toolbar to display the interface in the DashBoard window. In the previous example, 
the Frame Configuration button is selected.

Updating the Network Settings for the Ultrix Router
Once you establish initial communications with the Ultrix router, and it displays in the DashBoard Tree View, you 
may wish to review or change the IP Address and other settings according to your facility network requirements.

 This section is not applicable if your router is already set to the correct IP Address.

To update the network settings for the Ultrix router

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Devices node.

4. Expand the Controllers + Matrices node.

5. Double-click the Ultrix node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

6. Click Communication Settings.

7. Locate the Ethernet Configuration area.

The Ethernet Configuration area reports the status of the active ENET port on the Ultrix rear panel, and the 
network settings for the router.

8. Use the IP Address field to specify the new static IP Address for the Ultrix router.

9. Use the Subnet Mask field to specify the subnet mask for your network.
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10. Use the Default Gateway field to specify the gateway for communications outside of the local area network 
(LAN).

11. Click Apply.

12. Reboot the router:

a. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

b. Click Reboot. This button is located at the bottom of the window.

Re-naming the Ultrix Router in the DashBoard Tree View
Each Ultrix router can be given a unique name that is used on internal menus and as the identifier in the tree views 
of DashBoard. 

 Changing the router name after database configuration takes time to propagate through the system, and for 
DashBoard to reconnect, resuming stable system operation. Sufficient time must be allowed when making this 
change before attempting to use the system. This time will vary depending on features, matrix size, and 
configuration. In the case of the ULTRIX-FR1(-NS) and ULTRIX-FR2(-NS), the worst case will be 3-4 minutes. 
In the case of the ULTRIX-FR5, the worst case is 10 minutes. The router name is typically assigned during initial 
commission and very rarely ever changed again.

To re-name the Ultrix router in DashBoard

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Use the Device Name field to specify the new name for the Ultrix router.

4. Press Enter to apply the new name.

 It may take several seconds or more for the Ultrix node name to update in the Tree View of DashBoard.

Specifying a Default Reference Format
If you did not connect a reference source signal to the REF port on the Ultrix rear panel, you can still configure a 
Default Reference format using the options in the Frame Configuration interface. Note that this Default Reference 
setting only applies to start-up with no reference source connected.

Keep the following in mind:

• If you connect a valid reference source to the REF port, it will take precedence over the Default Reference 
setting.

• If the connected reference source becomes unavailable, the Ultrix router will use the last known good reference 
format until a re-boot or power cycle occurs (at which time the Default Reference setting will be applied). 

• If the Ultrix router does not have a valid reference signal connected to it, UltriScape still needs a reference to 
output correctly. Specifying the Default Reference Format provides an internal reference signal of either NTSC 
or PAL rates to allow UltriScape to still output with no system reference signal connected.

To specify the default reference format for the Ultrix router

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.
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4. Click Sync.

The Sync area displays in the Frame Configuration interface.

5. Use the Default Reference menu to specify the reference format for the Ultrix router. The default is NTSC. 

Specifying the Time Source
The Ultrix router requires an external time source in order to accurately report the time-of-day. The options in the 
Frame Configuration interface enable the selection of time/date source via an NTP Server in your facility, or you 
can set the device time to match the computer which is running the current DashBoard client.

Using an NTP Server as the Time Source
 Before proceeding, contact your IT Department to learn the IP address(es) of the NTP server(s) in your facility. 

To specify an NTP Server as the time source for the Ultrix router

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Locate the NTP Servers table on the Frame Configuration interface. 

5. If you are using one NTP server, enter the IP address in the Address field of the Server 1 row.

6. If using a backup NTP server:

a. Enter the IP address of the first NTP server in the Address field of the Server 1 row.

b. Enter the IP address of the backup NTP server in the Address field of the Server 2 row.

7. Select the NTP Enabled box.

8. Verify that the Status field(s) in the NTP Servers table report a valid connection to the listed IP address(es). 
You may need to refresh the interface as follows:

a. Close the Device Configuration interface.

b. Re-open the Device Configuration interface by repeating steps 1 to 3 to update the Status field(s).

Using the DashBoard Client Computer as the Time Source
This section outlines how to set the Ultrix to the local time without using an NTP Server. Instead, you will set the 
time to the values reported by the DashBoard client computer you are using.

 The time the Ultrix reports is not linked to this computer. It is a once off setting of the time to match the computer 
time when the Set to PC Time button is selected on the Ultrix interface. If the DashBoard client computer time 
changes, you will need to update the time reported on the router by repeating the procedure below.

To specify the DashBoard client computer as the time source for the Ultrix router

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.
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3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Locate the NTP Servers table on the Frame Configuration interface. 

5. Click Set to PC Time. This button is located above the NTP Servers table.

Configuring Access for DashBoard Clients
You can specify which DashBoard clients on your network can access and connect to your Ultrix. By default, the 
Permitted Clients list is blank, allowing all DashBoard clients on your network to connect to your Ultrix.

 Ross Video strongly encourages use of static IP addresses throughout systems using its equipment. A network 
device which acquires its address through DHCP is not guaranteed to always be assigned to the same IP address. 
In this case, use of DHCP could result in DashBoard client PCs being denied access to the Ultrix system.

To enable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. Locate the Permitted Clients area of the Network tab.

4. Click Add in the Permitted Clients area.

The Add Address dialog opens.

5. Use the IP Address field to specify the IP Address of the DashBoard client you wish to grant access to your 
Ultrix.

 IPV6 addresses and computer names are not currently supported for this list.

6. Click Apply.

The Add Address dialog closes.

The Dashboards list in the Permitted Clients area updates to display the specified IP Address.

7. Repeat steps 4 to 6 for each DashBoard client you want to allow access.

 Ensure that the IP Address for your DashBoard client machine is also added.
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8. Click Apply in the Permitted Clients area to apply the changes.

In the following example, four DashBoard clients were added to the Permitted Clients area.

To disable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. From the Dashboards list, select the IP Address for the DashBoard client you want to disable access for.

 Do not delete the IP Address for your DashBoard client machine.

4. Click Delete in the Permitted Clients area of the Network tab.

5. Click Apply in the Permitted Clients area to apply the change.
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Software License Keys
The Ultrix routers have software options that license functions and features. This chapter outlines the available 
software licensed features, and how to install a software key for a licensed feature. 

Before You Begin
When installing a software license key on the Ultrix router:

• You must have the DashBoard client installed and communicating with the Ultrix router that you wish to install 
the key for.

• Ensure that you are using DashBoard version 9.0 or higher. This information is available by selecting Help > 
About DashBoard from the DashBoard main toolbar.

License Keys Overview
Table 4.1 provides a brief summary on the types of licensed features available for the Ultrix router.

 The per slot UltriMix license comes standard with every Ultrix router.

Table 4.1  List of Ultrix Licensed Features

License Description
ULTRIMIX-MXR A license that enables the configuration and use of audio mixer soft panels.

UltriScape Each license enables one Multiviewer Head (output) per slot.
Each slot supports up to three Multiviewer Heads.

UltriSpeed A license that enables the use of UHD 12Gbps SDI signaling on all slots of 
the Ultrix router.
The 12Gbps SDI signaling through an SFP module installed in an AUX port 
is also supported. You must order the SFP module separately.
This license is required if you wish to configure a UHD Gearbox.

UltriSRC A per input license enabling Sample Rate Conversion (SRC) on MADI 
audio inputs. This allows MADI inputs that are not synchronized to the 
frame reference.

UltriSync A per input 3G frame sync license enabling alignment to router sync.

Ultrisync-UHD A per input frame sync license to support UHD video rates. Each slot 
supports up to 3 Ultrisync-UHD ports.
Requires software version 4.2.0 or higher and is applicable only to the 
ULTRIX-HDBNC-IO and ULTRIX-SFP-IO blades.

Ultricore-EMBER+ A license that enables the use of the EMBER+ protocol for video and audio 
streaming via an ULTRIX-IP-IO blade.

Ultricore-NVISION A license that enables the use of the NVISION protocol on all slots of the 
Ultrix router.

Ultricore-SNMP A license that enables basic SNMP monitoring on Ultrix routers. 
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Installing a License Key
Ross Video uses license keys to control user access to specific Ultrix features. You can obtain a key for an Ultrix 
licensed feature from Ross Video Technical Support.

To install an Ultrix license key

1. Launch the DashBoard client. 

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Devices node.

5. Expand the Controllers + Matrices node.

6. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

7. Click Port Licenses.

8. Make a note of the character string in the Request Code field for the feature you wish to enable.

9. Contact Ross Video Technical Support using the information found in the section “Contacting Technical 
Support” on page 18.

a. When you speak to your Technical Support representative, tell them your name, your facility name, and the 
Request Code from the Licenses table.

b. You will be given a License Key that must be entered in the applicable field in the Licenses table.

10. Enter the provided License Key in the applicable License Key field in the Licenses table.

 You can also right-click on the row for the License Key you are installing, and copy the Request Code to or paste 
the License Key from the Microsoft® Windows® clipboard.

11. Click Apply in the row for the License Key you entered in step 10.

12. Verify that the Count field is updated to report each installed License Key.

To activate an UltriScape license for a specific slot/head

1. Install the license key as outlined in the procedure “To install an Ultrix license key” on page 34.

2. Click Port Licenses.

The Port Licenses interface displays.

3. Select the UltriScape tab.

Each row in the tab represents a slot and UltriScape head in the Ultrix router (with slot 1 as the topmost slot in 
the router). The Port column in the tab represents the output for the head. The Format column represents the 
video format assigned to that head.

4. In the Port column, select the cell for the UltriScape head you want to enable.
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A drop-down menu displays that lists the available ports.

5. Select Enable to apply the UltriScape license to that UltriScape head.

Removing a License Key
When you want to move an Ultrix licensed feature from one slot to another in the same router, you must first disable 
the Ultrix feature on the current Ultrix router. 

 Removing a License Key also removes user access to all of the Ultrix features associated with that License Key.

To remove a Ultrix license key

1. Launch the DashBoard client. 

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Devices node.

5. Expand the Controllers + Matrices node.

6. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

7. Click Port Licenses.

8. Scroll to the second table in the Licenses area.

Each row in the table represents a slot in the Ultrix router. Each column represents a type of licensed feature.

9. Click in the cell for the slot and licensed feature you want to remove. 

A drop-down menu displays.

10. Select Disable to remove the license for the selected slot.

If you wish to apply the same License Feature to another slot, follow the steps outlined in the procedure “Installing 
a License Key” on page 34.

Locking Access to the Licenses
The Ultrix includes a password-protected feature that prevents unauthorized changes to license keys. When the Port 
License tab is locked, users require a password to access/edit the license key information. This feature is disabled 
by default (the Port License tab is editable).

Figure 4.1  Port License Tab — Port License Access is Locked

Enabling the Port License Lock
To lock the tab, you must enable the Password Protected settings in the System Status > Setup tab.
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To enable the lock on the Port License tab

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. In the Password Protected Settings area, select the Protect all Licensed features with a password box.

4. Click Apply at the bottom of the Setup tab.

Changing the Password
It is recommended to change the password from the default value that is assigned at the factory.

 A password must be at least 8 characters long.

To change the password

1. Click Change Password.

The Enable Password Protection dialog opens.

2. If you are changing the password from the default value:

a. In the Password field, type r0ssUltrix.

b. Click Apply.

The Change Password dialog opens.

3. If you are changing the password from a value other than the default:

a. In the Password field, type the character string for the current password.

b. Click Apply.

The Change Password dialog opens.

4. Use the Password field to type the current password.

5. Use the New Password field to type the character string for the new password.

6. Use the Confirm Password field to type the same character string you entered in step 5.

7. Click Apply.

The Change Password dialog closes and the Port License tab is now locked.
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Unlocking the Port Licenses via Password
A user can unlock the Port License tab by clicking the Unlock button and entering a password.

To unlock the Port Licenses tab via password

1. Launch the DashBoard client. 

2. Locate the Ultrix node in the Tree View.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Devices node.

5. Expand the Controllers + Matrices node.

6. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

7. Click Port Licenses.

8. Click Unlock... .

The Protected Access dialog opens.

9. In the Password field, type the password as defined in step 5 of the procedure “To enable the lock on the Port 
License tab” on page 36.

10. Click Apply.

The Protected Access dialog closes and the Port License tab is now editable.

 To re-lock the Port License tab, click Lock.
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Configuring the Ports
Ultrix is capable of switching video signals1 from 270Mbps to 12Gbps2. This format flexibility permits SD, HD, 
3G and UHD video signals to be used seamlessly in the same system. 

Ultrix also comes complete with an audio matrix side-chain to enable multiplexing, de-multiplexing, channel 
swapping and processing of the SDI embedded audio.

For More Information on...
• configuring the UHD Gearbox, refer to the chapter “UHD Gearbox Configuration” on page 61.
• configuring the ULTRIX-IP-IO ports, refer to the chapter “ULTRIX-IP-IO Setup” on page 71.
• configuring the ULTRIX-SFP-IO ports, refer to the chapter “ULTRIX-SFP-IO Setup” on page 91.
• the audio features of the Ultrix router, refer to the chapter “Configuring an Audio Matrix” on page 47.

Physical Port Configuration Overview
Table 5.1 summarizes the configuration options for the physical input and output ports of the Ultrix router.

1. SMPTE standard rates.
2. Requires the UltriSpeed license.

Table 5.1  Available Port Configurations

Port Option Notes
Inputs

2-SI Group Enables 2SI quad input (four 3Gbps streams).
Refer to the section “Configuring the Ultrix Router for Multiplexing 
Quad Input Signals” on page 63 for details.

Audio sub-channel processing You can apply a gain (+/- 20db), invert channels, and/or sum channels as 
required. 
Refer to the section “Applying Proc Amps to the Embedded Audio 
Input” on page 51 for details.

FrameSync Delay Specify a frame buffer size.
Refer to the section “UltriSync Configuration” on page 42 for details.

Outputs

Clean Switch enable Per output enable/disable of Clean Switch.
Refer to the section “UltriClean Configuration” on page 43 for details.

Clean Switch mode Selectable Clean Switch clock source.
Refer to the section “UltriClean Configuration” on page 43 for details.

Clean Switch Delay Specify a Clean Switch buffer size.
Refer to the section “UltriClean Configuration” on page 43 for details.

Audio sub-channel processing Apply a gain (+/- 20db), invert channels, sum channels, and/or insert 
tones as required.
Refer to the section “Applying Proc Amps to the Embedded Audio 
Input” on page 51 for details.
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Configuring a Reference Trigger for the Ultrix Router
If multiple reference formats will be fed into the Ultrix router, you can configure a reference trigger with a custom 
switching point. This is useful when you will be manually changing the reference signal format that is fed into the 
REF port on the Ultrix rear panel.

 A variety of switching points across the routing switchers may be required to deal with the range of digital video 
formats that are available. 

For More Information on...
• cabling the reference source for your router, refer to the Ultrix Installation Guide.
• monitoring the reference status, refer to the section “Monitoring the Reference Signal” on page 309.

To configure the reference trigger for the router

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Sync.

The Frame Configuration interface updates to display the Sync area for the router.

5. Locate the Triggers table in the Sync area.

 Only the REF A port is implemented at this time.

The Detected field indicates the format of the reference signal connected to the REF A port on the router.

6. Use the SDI Video Format field to select the switch timing that will be used by the router when switching 
inputs/outputs.

7. If you selected Custom in step 6, use the Custom field to specify the time (number of microseconds) from the 
start of the custom switching line to the actual switching event. The maximum value is 65,535ms.

8. Repeat steps 6 and 7 to configure additional triggers as required.

Configuring an SFP Port
The various modules available for Ultrix provide SFP+ slots for expansion of the base module I/O blade. Refer to 
the Ultrix SFP Modules Guide for a list of available SFP modules from Ross Video.

Keep the following in mind:

• The Flex slot in the ULTRIX-FR5 does not support any I/O in the AUX ports.
• The ULTRIX-SFP-IO blade only supports MADI in the AUX A and AUX B ports.
• The ULTRIX-IP-IO blade only supports Ultriscape outputs (SDI video) in the AUX 1 and AUX 2 ports.
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Before You Begin
You will also need to install an:

• UltriSpeed license for each slot that includes an SFP-HDB-IN-12G and/or SFP-HDB-OUT-12G.
• UltriScape license for each AUX port that will be used to provide an UltriScape head output.
• UltriSRC license for each AUX port configured for asynchronous MADI input.

Specifying the SFP Type
Once the SFP module is installed in a port, you must specify the port type. Select SDI Video for video SFP types, or 
MADI for audio SFP types. MADI audio SFP types allow you to specify the channel quantity (either 56 or 64) as 
per your facilities' standard.

The SFP Configuration interface is organized into two sections: AUX Settings, and SFP Settings. The AUX 
Settings lists all the AUX port settings for all blades in the Ultrix chassis. The SFP Settings list all the 
ULTRIX-SFP-IO blade port settings.

To specify the SFP type

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click SFP Configuration.

The SFP Settings table displays all SFP ports in two groupings; AUX ports from all Ultrix I/O blades, and the 
SFP ports from any installed ULTRIX-SFP-IO blades.

5. From the Slots table, select the router slot for the port you want to configure.

The tab updates to display a list of available ports based on the slot(s) selected.

6. Locate the row for the port you want to configure.

7. In the SFP column select either SDI Video or MADI as appropriate for the fitted port.

8. Click Apply to save your changes. 
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UltriSync Configuration
UltriSync allows the re-timing of asynchronous or time offset input signals to the frame reference. UltriSync is a 
per input feature and requires a license for each input that will be used by the UltriSync. There are two licenses:

• The UltriSync license allow for SDI data rates up to 3Gbps (1080p). This license was available in software 
versions 4.1.0 or lower.

• The UltriSync-UHD license (available as of software version 4.2.0 onward) allows the Frame Sync to operate at 
up to 12Gbps (2160p) data rates. This license is available on 3 inputs per ULTRIX-HDBNC-IO or 
ULTRIX-SFP-IO blade only (AUX B or Input 1, Input 5 or Input 6, Input 11 or Input 12).

Before You Begin
Ensure to:

• Monitor the video input signals via the Timing Lines and Timing Pixels fields in the Port Configuration > 
Input Summary interface. These fields report the amount of detected timing offset (in lines and pixels 
respectively) between the incoming signal and the frame reference signal. The timing fields are updated every 15 
seconds. This information is useful in deciding where to install an UltriSync license as follows:
› If there is an input that is out of time with regards to the frame reference, then it would beneficial to 

synchronize it with the frame reference.
› If the timing is +/- half-line, then UltriClean can accommodate the synchronization. The amount of pixels per 

line depends on the video standard being used. For example, 1080p is actually 1920x1080 pixels (nominally) 
so 1920 pixels makes one line.

• Install one (or more) UltriSync licenses. Refer to the section “Installing a License Key” on page 34.
• Verify that the video source signals are the same format as the frame reference.

Configuring UltriSync for an Input Port
UltriSync allows configuration of the frame buffer size between 1 frame and 2 frames. Data is clocked out of the 
buffer using the frame reference, thus timing arbitrarily timed input signals to a common clock. The size of the 
buffer can determine its resilience to incoming signal disturbances.

To assign an UltriSync license to an input port

1. Install the license key as outlined in the procedure “Installing a License Key” on page 34.

2. Click Port License.

The Port License interface displays.

3. Select the UltriSync tab.

Each row in the tab represents a port on the Ultrix router with each column a type of UltriSync license.
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4. Select the box in the applicable License column for the port you want to enable an UltriSync license for.

To configure the UltriSync settings for an input port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Port Configuration.

The Port Configuration interface opens.

5. Click an Inputs banner (bar underneath BNC images) in the router rear panel map, located at the top of the 
Port Configuration interface.

The Port Configuration interface updates to the Input Summary table and all Inputs display with a light-blue 
background.

6. In the Physical Address column, locate the row for the input port you wish to configure.

7. In the FrameSync Delay column, select the buffer size for the required port. Choose from the following:

• 1 frame — ensures a short delay (up to 1 frame) in router throughput, but is susceptible to incoming stream 
disturbances like a non-clean upstream switch.

• 2 frames — delays the signal between 1 and 2 frames depending on signal to reference timing offset. If an 
incoming signal is corrupted at a line or single frame rate, then a 2 frame buffer can repeat the last known 
good frame for the corrupted frame thus ensuring a clean output.

  If there is a 1 or 2 frame timing difference between the audio and video, try setting the FrameSync Delay to 1 
frame to minimize the difference.

UltriClean Configuration
UltriClean allows users to enable a Clean Switch mode and apply a line buffer (delay) on a per output basis. 
Incoming video is buffered based on the timing of the input, and is then output based on the timing of the Ultrix 
system reference (including any offsets added in the Triggers setup). Users can then switch between inputs that are 
not perfectly co-timed without perceiving any glitches of the incoming data. Video source timing must remain 
within the buffer to properly switch between sources (buffer depth is user-configurable).

Before You Begin
Ensure that:

• All video sources must be the same video format, locked to the same reference, and vertically timed to within the 
selected Clean Switch window.

• Reference triggers are correctly configured. The trigger format for the selected trigger must match the input 
video format or an equivalent custom trigger set up to comply with RP-168 Switch point. Refer to the section 
“Configuring a Reference Trigger for the Ultrix Router” on page 40 for details on setting up a reference 
trigger.

Notes on Timing

It possible that you may find a discrepancy on an output from Ultrix when trying to set the horizontal time to zero 
with respect to the reference. 

This is because there is a certain amount of latency through the Ultrix router even with Clean Switch disabled for 
the port. Due to our industry leading internal processing engine which supplies advanced features, a certain amount 
(though minimal) of delay should be expected. This should not pose a problem for most digital downstream 
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equipment. If you do encounter a problem, we recommend using an external line sync device (such as our 
SFS-8622 openGear card) to zero time the Ultrix router output.

While it may be technically possible to zero time (horizontally) the output of the Ultrix router, it is not 
recommended for the following reasons:

• While you can zero time the output if you disable Clean Switch for that output, there will still be a large timing 
window that you have to exceed in order to get the output timing to re-sync. This is due to the line sync is always 
enabled even though it is put into a very low line length mode (resulting in a small the timing window). As a 
result, every timing adjustment applied to the input is ignored on the output until the window is exceeded. Once 
it is exceeded, the output timing jumps. You will need to adjust the timing incrementally until the timing is set to 
zero. This is further complicated during a power cycle where the timing may not be exactly zero as the window 
may have moved slightly on re-boot.

• The frame syncs output timing is hard coded to match the timing of a synchronous input that is zero timed at the 
input to the router.

It is recommended that all synchronous inputs to the router be zero timed to the inputs of the router instead of trying 
to zero time the router outputs.

Configuring Clean Switch Mode for an Output Port
The Clean Switch mode uses the input signal timing to decide when a frame of active picture begins. 

To configure the Clean Switch mode for an output port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Port Configuration.

The Port Configuration interface opens.

5. Click an Outputs banner in the router rear panel map, located at the top of the Port Configuration interface.

The Port Configuration interface updates to the Output Summary table.

6. In the Physical Address column, locate the row for the output port you wish to configure.

7. To enable Clean Switch mode for an output, click the Clean Switch box for the output you want to configure. 
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8. Use the Clean Switch Mode menu to specify timing source. Choose from the following:

• Reference — The Clean Switch is based on the reference signal available on the REF port of the router.
• Input — The Clean Switch is based on the input signal available on the specified port of the router.

To configure the Clean Switch timing window

1. Navigate to the Port Configuration interface as outlined in the procedure “To configure the Clean Switch 
mode for an output port” on page 44.

2. In the Physical Address column, locate the row for the output port you wish to apply a delay to.

3. Click in the Clean Switch Delay cell for the output you want to configure. 

A drop-down menu displays.

4. Use the drop-down menu to specify the buffer size to apply.

 This will effectively delay the signal up to the amount specified minus signal-to-reference offset for a maximum 
delay of the chosen setting.

 Select Full Line to add one full line of delay to the output. This will align the output horizontally with the 
reference but with one full line delayed vertically (two lines when using 3G Level B). This option is useful if you 
want a horizontally timed output.

UltriSRC Configuration
The UltriSRC license is a per port license enabling Sample Rate Conversion for MADI audio inputs. The sample 
rate conversion will re-sample incoming MADI up to 48kHz. This allows MADI sources that are not reference 
locked to the Ultrix.

To assign an UltriSRC license to an input port

1. Install the license key as outlined in the procedure “Installing a License Key” on page 34.

2. Click Port Licenses.

The Port Licenses interface displays.

3. Select the UltriSRC tab.

Each row in the tab represents a physical AUX SFP port on the Ultrix. Each column in the second table 
represents a type of licensed feature and indicates whether it is enabled for that input.

4. Select the box in the License column for the physical port you want to enable an UltriSRC license for.

Loss of Input Signal Behavior
You can specify what the output signal is in the event of a loss of video input.

 Ultrix uses the last known and valid video format detected on the output.
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This feature is similar to a “squelch” control. High-speed digital devices will try to lock to any signal. If there is no 
direct input, they will try to equalize noise (to a point), possibly resulting in down-stream equipment having issues 
with a non-valid SDI stream. If there is a router input that is either not terminated, or the upstream device outputs a 
non-valid signal, then the input may be forced to SDI black.

To specify what to output when a loss of input signal occurs

1. Navigate to the Port Configuration interface as outlined in the procedure “To configure the Clean Switch 
mode for an output port” on page 44.

2. In the Physical Address column, locate the row for the output port you wish to configure.

3. Click in the Loss Signal cell for the output you want to configure. Choose from the following:

• None — The router ignores the loss of input signal.
• Black — If the input signal is absent, the output is set to black.
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Configuring an Audio Matrix
The UltriMix sub-system provides advanced audio integration, including the ability to embed and de-embed audio 
on all of the inputs and outputs of the router. Users also have complete flexibility to process, swap, sum, mute, or 
route any discrete or embedded audio input to any output. UltriMix is perfect for applications where audio is 
constantly changing, and it can be added as needed without throwing away any initial investment in the system.

The Ultrix routers include the following features:

• 16 AES audio channels coming from each input SDI video stream
• Asynchronous processing of all audio channels
• Support for MADI on the AUX ports when a SFP-MADI-COAX, SFP-MADI-850MM, or SFP-MADI-1300MM 

is installed
• Audio channel status Dolby® bit capture and overwrite capabilities

Audio Routing Overview
The Ultrix router handles high-bandwidth, broadcast-quality, digital video and audio signals, and embedded audio 
signals. The Ultrix router can perform signal processing functions like audio shuffling and insert into and extra 
from MADI streams.

Each SDI I/O allows for up to 1 stream of 16 channels of 48kHz sampled, 24bit audio, for a total of 16 channels. If 
there are audio channels that are received at a higher rate than 48kHz, the number of channels is limited. 

Before You Begin
Keep the following in mind when using the UltriMix feature:

• By default, all embedded audio is de-multiplexed at each input and passed through processing (proc-amps) and 
the audio matrix. 

• Each input has an Audio Bypass configuration option. When Audio Bypass is enabled for an input, the audio will 
follow the SDI regardless of any individual audio channel routing or configuration on the output. The individual 
channels of a input in Bypass mode are still de-multiplexed and available for audio routing via the audio matrix.

• Re-mapping of all audio channels from source to destination with transitions is available 
• Audio processing controls are available for each audio channel (gain, sum, invert, tone insert)
• Audio summing of any two adjacent channel pairs is available (1 + 2, 3 + 4, 5 + 6, etc.)

General Configuration Workflow
You may wish to use the following process when defining the database for your audio workflow.

Figure 6.1  Process for Configuring the Audio Channels

For More Information on...
• enabling the UltriMix license for a slot, refer to the section “Installing a License Key” on page 34.

Enable UltriMix Define Audio
Routing Levels

Assign Audio
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Sources

Assign Audio
Ports to Logical

Destinations
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Audio Matrix Routing and Processing
Table 6.1 summarizes the audio mapping options when using SDI embedded audio or MADI signals.

Table Legend

Notes on Using the Audio Bypass
• Selecting Audio Bypass in the Device Configuration interface forces the embedded audio of the input SDI 

stream to bypass the audio routing section and be routed with the SDI to a Destination for all embedded audio 
channels. 

• Selecting Audio Bypass in the Device Configuration interface for MADI inputs or outputs results in a non-valid 
situation where MADI channels cannot be routed.

Defining the Database Audio Levels
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio level). Refer to the 
section “Defining the Levels in a Database” on page 110 for instructions on how to define a level in your 
database. For each audio level, you will assign a port channel.

Table 6.1  Audio Mapping Options

Source Destination

ResultAudio 
Mapping

Input Proc 
Amp 
Available

Audio 
Mapping

Output Proc 
Amp 
Available

EMB


EMB


Switches based on logical configuration (with full breakaway 
support)

EMB, PT


EMB


Switches logical configuration (but passes through each channel 
defined as pass-through from the SDI input content)

EMB, DS X EMB X Switches logical configuration (but mutes for each channel that has 
“disconnect” defined)

EMB  MADI  Follows breakaway operation based on logical mapping

EMB, PT


MADI X Switches logical configuration (but passes through each channel 
defined as pass-through from the SDI input content)

EMB, DS X MADI X Switches logical configuration (but mutes for each channel that has 
“disconnect” defined) 

MADI


MADI


Switches based on logical configuration (with full breakaway 
support)

MADI, PT  MADI X Not Valid

MADI, DS X MADI X Switches logical configuration (but mutes for each channel that has 
“disconnect” defined)

 Feature is enabled/available or SDI embedded audio is mapped to audio levels.

X Feature is not enabled/available or no audio levels are mapped

EMB Source or destination is mapped for SDI embedded audio channels

MADI Source or destination is mapped for MADI audio channels

PT ‘passthrough[1].audio’ is defined for some or all source levels

DS ‘disconnect[1].audio’ is defined for some or all source levels
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 If an audio level is not defined for a given input or output channel of the port, then the output will remain at its 
default selection (slot1.in[1].audio.chxx). For example, if OUT 3 is selected to IN 10 but only channels 1 
- 4 are defined in the logical map, then OUT 3 will have channels of IN 1 audio mapped to channels 5 - 16. 

In Figure 6.2, Levels 2-6 are defined for audio channels.

Figure 6.2  Example of Defined Audio Levels in a Database

MADI Overview
Multi-channel Audio Digital Interface (MADI) is the industry standard for the transmission of up to 64 audio 
channels on a single cable. The Ultrix router supports the following SFP module options that provide the ability to 
route discrete MADI:

• SFP-MADI-COAX — the AUX port can receive and transmit MADI signals of 125Mbps over 75 coaxial 
cables via HD-BNC connectors.

• SFP-MADI-850MM, SFP-MADI-1300MM — the AUX port can receive and transmit MADI optical signals as 
defined in SMPTE 297-2006.

Figure 6.3  Example of Ultrix Audio Interconnect using Two SFP-MADI-COAX Options

For More Information on...
• the specifications for your SFP module, refer to the Ultrix SFP Modules Guide.

Before You Begin
Ensure an SFP Module that supports MADI is physically installed in an AUX port of the Ultrix router.

 Downstream equipment of the Ultrix MADI output may report signal on all channels due to Ultrix setting status 
bits. This is to ensure maximum equipment compatibility.

ULTRIX-FR1
32x32 3G/HD/SD SDI Router

ENET 2

ENET 1

1 4 A B

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16AUX A

AUX B

OUT IN

Ultrix-HDBNC-IO

REF

!

AUX A

MADI Bi-Directional Breakout
64x64 AES/ANLG Audio

COM2

PushPush Push PushPushPushPushPush

MADI Bi-Directional Console/Mix Processor Connection
64x64

MIDI

TO HOST

SERIALUSB
PushPush Push



50 • Configuring an Audio Matrix Ultrix User Guide (v18.0)

Configuring an AUX Port for MADI
Each SFP Module that supports MADI includes an IN (Rx) connector and an OUT (Tx) connector. 

 External MADI devices must be timed to the Ultrix reference signal unless an UltriSRC license is enabled for a 
given SFP port.

For More Information on...
• on the input and output connections for your module, refer to the Ultrix SFP Modules Guide.

MADI Inputs

A MADI input source is identified in the routing system using the nomenclature Frame.Slot.Port.Type.Channel. 
For example, ultrix.slot4.AUXA-in1.madi.ch5 where AUXA represents the physical AUX port the SFP 
module is installed, and ch5 represents Channel 5 in the MADI signal.

You must define the MADI input channels in the database for your Ultrix router to be able to route the individual 
MADI channels.

MADI Outputs

A MADI output source is identified in the routing system using the nomenclature Frame.Slot.Port.Type.Channel. 
For example, ultrix.slot4.AUXB-out1.madi.ch64 where AUXB represents the physical AUX port the SFP 
module is installed in, and ch64 represents Channel 64 in the MADI signal.

You must define the MADI output channels in the database for your Ultrix router to be able to route the individual 
MADI channels.

Mapping the Audio Channels
You can configure audio channels from DashBoard. Note that source and destination logical mapping is required to 
complete the setup of the Ultrix embedded audio routing.

To map the audio destinations

1. Double-click the Destinations node located under the Database node.

 As the audio map for Ultrix may be very large, an Advanced Fill tool is available to automatically generate a map 
for the audio levels. Refer to the section “Using the Advanced Fill Tool” on page 118 for more information on 
using this tool.

2. In the table of the Destinations tab, select the first row in the series for the audio level you defined in the 
section “Defining the Database Audio Levels” on page 48.

3. Press and hold Shift.

4. Click the last row in the series to select a range of cells within the Level column.

5. Select a range of audio outputs as outlined in the section “To map a physical output to a destination” on 
page 113.

6. Click Assign.

7. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To map the audio sources

1. Double-click the Sources node located under the Database node.

2. In the table of the Sources tab, select the first row in the series for the audio level you defined in the section 
“Defining the Database Audio Levels” on page 48.

3. Press and hold Shift.

4. Click the last row in the series to select a range of cells within the Level column.
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5. Select a range of inputs as outlined in the section “To map an input to a source” on page 117.

6. Click Assign.

7. Click Apply at the bottom of the Sources tab to apply the changes to the database.

Specifying the Audio Transition Mode
You can specify an audio transition mode for each audio channel output. 

To set the audio transition mode for an audio channel

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Click Port Configuration.

The Port Configuration interface displays.

5. From the Ultrix rear panel map, select the icon for the output source you wish to set the transition mode for.

The icon in the map is lit blue.

6. Click audio.

The Port Configuration interface updates to display the audio options for the selected output.

7. Use the Transition menu to set the audio transition mode for the audio channel. Choose from the following:

• Cut — The audio input channel is immediately switched to its selected output. A transition to or from 
Dolby® will always be a Cut transition regardless of what the Transition setting is set to.

• V Fade — The original audio input channel fades down to silence followed by the new input channel fades 
up from silence to unity gain level.

• X Fade — The original audio input channel fades down to silence as the new input fades up from silence, 
and both will be mixed.

• Cut Fade — The original audio input channel cuts to silence and the new input fades up from silence to 
unity gain level.

• Fade Cut — The original audio channel fades down to silence and the new input is cut in at unity gain level.
• Quiet Cut — The original audio channel performs a V Fade transition with a 5ms duration.

8. Use the Duration slider to specify the length of the audio fade, in milliseconds, between audio transitions.

Applying Proc Amps to the Embedded Audio Input
Ultrix includes Processing Amplifiers (Proc Amps) for the audio inputs. For each audio channel of an input signal, 
you can set the Bypass Mode, invert selected channels, and sum two adjacent audio channels or apply audio delay. 
The Proc Amp settings are applied before going through the audio matrix.

To set up processing of the embedded audio input

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Click Port Configuration.

The Port Configuration interface displays.
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5. From the Ultrix rear panel map, select the icon for the audio input you wish to process.

The icon in the map is lit.

6. Click Audio.

The Port Configuration interface updates to display the audio options for the selected input.

7. Select the Audio Bypass box to a prevent breakaway switching of untimed sources. The router will alarm 
when the audio signal becomes asynchronous to the reference signal provided on the REF port of the router.

 Select the Audio Bypass box if the input is asynchronous to other inputs. This will avoid any improper mapping 
of the associated audio channels onto other asynchronous outputs. 

8. To apply a gain to a channel, use the associated Gain field to select a value between -20dB and 20dB.

9. To invert a channel, select the associated Invert box. 

10. To sum two adjacent audio channels, select the Sum box for the first channel.

The Sum box for the second channel is automatically selected.

 Each selected channel will carry the average of the two input channels ((A+B)/2). When the input is summed, the 
original signals are no longer available for output.

11. Apply up to 500ms of delay per channel.

 The audio delay feature requires an UltriSync license applied to the port.

12. If required, repeat steps 5 to 11 for each audio input you want to configure.

Applying Proc Amps to the Embedded Audio Outputs
The Ultrix router includes Processing Amplifiers (Proc Amps) for the audio outputs. Proc Amp adjustments are 
applied in the following order:

1. Gain — This option provides a +/- 20dB gain range in 0.50dB increments. If you have added a gain to an input 
channel, the gain value specified for the output channel is an addition. For example, if you set the gain for an 
input to 10dB, then specify a gain of 2dB on the output, the total gain will be 12dB on the final output.

2. Invert — This option enables you to invert the polarity of the audio signal for the selected channel.

3. Sum — This option enables the selected channels to carry the average of the specified channels ((A+B)/2). 

To configure the embedded audio outputs

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.
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4. Click Port Configuration.

The Port Configuration interface displays.

5. From the Ultrix rear panel map, select the icon for the output you wish to configure.

The icon for the output in the map is lit.

6. Click audio.

The Port Configuration interface updates to display the audio options for the selected output.

7. Use the Trigger menu to specify which reference signal trigger to use. Refer to the section “Configuring a 
Reference Trigger for the Ultrix Router” on page 40 for details.

8. To apply a gain to a channel, use the associated Gain field to select a value between -20dB and 20dB.

9. To invert a channel, select the associated Invert box. 

10. To two adjacent audio channels, select the Sum box for the first channel.

The Sum box for the second channel is automatically selected.

 Each selected channel will carry the average of the two channels ((A+B)/2). When the output is summed, the 
original signals are no longer available for output.

11. To insert a test tone into a channel:

a. Use the Tone Freq menu to specify the type of test tone to embed in the output. 

a. Use the Tone Mode menu to enable test tones for that channel.

12. Repeat steps 5 to 11 for each channel you wish to configure.

Examples of Audio Configured Databases
UltriMix enables access to the 16 audio channels embedded in the SDI stream. 

Muting Embedded Channels
Once the various channels are mapped to levels, then we may treat those channels individually akin to them being 
independent physical connections to the router. For example, we may define a source to the router as:

With this mapping, we may route the embedded channels to any other audio enabled destination by selecting levels 
required prior to making our route selection.

Source SDI Level 1 Level 2 Level 3 Level 4 ...
Input1 SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 ...

... ... ... ... ... ... ...
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Consider the case where only the first audio group (Embedded channels 1, 2, 3 and 4) are needed for routing. What 
occurs to the other 12 channels of the SDI stream that are not mapped?

The remaining audio channels within the SDI stream are still there and even though they are not explicitly defined 
within the logical map. They will remain at a default routing of 1-to-1 (i.e.; input #1 embedded channel #8 will 
always be routed to output #1 embedded channel #8). It may be undesirable to have these extra embedded audio 
channels routed this way, so a 'disconnect' may be defined for the input channels not required. 

Switching Bilingual Sources
This example assumes the following setup:

• Embedded audio channels 1 and 2 are the primary channels.
• Incoming sources have English on Embedded channels 1 and 2, and French on 3 and 4.

The Sources are defined as follows:

The Destinations are defined as follows:

To route Src1 to Dest1 and swap the Primary Audio from English to French

1. Select the Destination.

2. Select the Source.

The resulting status would be:

The Destination will have the video from SDI.in[1] but embedded channels Level A1 and Level A2 will have the 
input SDI embedded channels 3 and 4 respectively which we have previously defined as being our French language 
stereo pair. Note that in this example the English language stereo pair are still available but now on the destination 
channels Level A3 and Level A4.

Source SDI Level 1 Level 2 Level 3 Level 4 Level 5 ... Level 16
Input1 SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 Disconnect ... Disconnect

...... ... ... ... ... ... ... ...

Sources SDI Level A1 Level A2 Level A3 Level A4 ...
SRC1 EN SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 SDI.in[1].ch3 SDI.in[1].ch4 ...

SRC1 FR SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 SDI.in[1].ch1 SDI.in[1].ch2 ...

Destinations SDI Level A1 Level A2 Level A3 Level A4 ...
Dest 1 SDI.out[1] SDI.out[1].ch1 SDI.out[1].ch2 SDI.out[1].ch3 SDI.out[1].ch4 ...

... ... ... ... ... ... ...

Status SDI Level A1 Level A2 Level A3 Level A4
Dest1 SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 SDI.in[1].ch1 SDI.in[1].ch2
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If pair Level A3 and Level A4 are not required to be muted, the source definitions change to contain a 'disconnect' 
in the Level A3 and Level A4 levels (and any other levels requiring muting): 

Embedded Channel Routing
Embedded audio routing encompasses the following scenarios:

• Embedded channels to embedded channels
• Embedded channels to MADI channels
• MADI channels to Embedded channels
• MADI channels to MADI channels

To accommodate these scenarios, the database source table defines many individual channels in addition to the 
standard SDI plus audio source. In the examples below, In 1 is our SDI and audio source - our normal “audio follow 
video” source. Also defined are the individual embedded audio channels that will allow routing of these to other 
audio destinations.   

 If all 16 channels of embedded audio are not required or used, then only the in-use channels need be defined. 
This can serve to reduce the source table size to just the required definitions.

The Source definitions for SDI IN 1 and its individual embedded audio channels are defined as follows:

The Destinations for SDI outputs are defined as follows:

The Source definitions for MADI inputs are defined as follows:

Sources SDI Level A1 Level A2 Level A3 Level A4 ...
SRC1 EN SDI.in[1] SDI.in[1].ch1 SDI.in[1].ch2 disconnect[1].ch1 disconnect[1].ch1 ...

SRC1 FR SDI.in[1] SDI.in[1].ch3 SDI.in[1].ch4 disconnect[1].ch1 disconnect[1].ch1 ...

Sources SDI Level A1 Level A2 ... Level A15 Level A16
In1 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

In1 ch1 audio.ch1 audio.ch1 ... audio.ch1 audio.ch1

In1 ch2 audio.ch2 audio.ch2 ... audio.ch2 audio.ch2

... ... ... ... ... ... ...

In1 ch16 audio.ch16 audio.ch16 ... audio.ch16 audio.ch16

Destination SDI Level A1 Level A2 ... Level A15 Level A16
Out1 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

Out2 sdi.ch1 audio.ch1 audio.ch2 ... audio.ch15 audio.ch16

... ... ... ... ... ... ...

Sources SDI Level A1 Level A2 ... Level A15 Level A16
MADIch1 audio.ch1 audio.ch1 ... audio.ch1 audio.ch1

MADIch2 audio.ch2 audio.ch2 ... audio.ch2 audio.ch2

... ... ... ... ... ...

MADIch63 audio.ch63 audio.ch63 ... audio.ch63 audio.ch63

MADIch64 audio.ch64 audio.ch64 ... audio.ch64 audio.ch64
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The Destinations for MADI outputs are defined as follows:

Embedded Channels to Embedded Channels
If we wish to perform the route as illustrated below (a channel swapping route) where the audio.ch3 and audio.ch4 
are to be routed to destination audio.ch1 and audio.ch2, we need to route the embedded channels individually as our 
default mapping provides no common control levels between source audio.ch3 and audio.ch4 and destination 
audio.ch1 and audio.ch2.

To route Audio Channels 3 and 4 from Src1 to SDI OUT 1 Channels 1 and 2

1. Select the Destination (Out 1).

2. Perform the first switch (Switch the SDI Level) as follows:

a. Select the SDI Level.

b. Select the Source (In 1).

c. Press TAKE to switch.

3. Perform the second switch (Source In1ch3 on Audio Level 1) as follows:

a. Select Level A1.

b. Select the Source (In1 ch3).

Destination SDI Level A1 Level A2 ... Level A15 Level A16
MADIch1 audio.ch1 ...

MADIch2 audio.ch2 ...

... ...

MADIch63 audio.ch63 ...

MADIch64 audio.ch64 ...
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c. Press TAKE to switch.

4. Perform the third switch (Source In1ch4 on Audio Level 2) as follows:

a. Select Level A2.

b. Select the Source (In1ch4).

c. Press TAKE to switch.

The Level buttons serve to indicate the Destination channels we are routing to.

Embedded Channels to MADI Channels
To route embedded channels to MADI channels, select a MADI channel destination, then select the appropriate 
source. If the current level mask or breakaway contains level A1, then level A1 does not need specific selection. As 
the destination MADIchx contains only physical port assignments in level A1, then all other levels are ignored.

The following illustrates routing source In1 embedded ch3 and ch4 to our MADI destination on ch5 and ch6 
respectively:

1. Select the Audio Level.

2. Perform the first switch (Source In1ch3 to Destination MADIch5) as follows:

a. Select the Destination (MADIch5).

b. Select the Source (In1ch3).

c. Press TAKE to switch.
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3. Perform the second switch (Source In1ch4 to MADIch6) as follows:

a. Select the Destination (MADIch6).

b. Select the Source (In1ch4).

c. Press TAKE to switch.

MADI Channels to Embedded Channels
Routing MADI input ch5 and ch6 to SDI embedded ch1 and ch2 of Out 2 is as follows:

1. Select the Destination (OUT 2).

2. Perform the first switch as follows:

a. Select Level A1.

b. Select the Source (MADIch5).

c. Press TAKE to switch.

3. Perform the second switch.
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a. Select Level A2.

b. Select the Source (MADIch6).

c. Press TAKE to switch.

MADI Channels to MADI Channels
Routing MADI inputs to MADI outputs is as follows:

1. Select the Destination.

2. Perform the first switch.

a. Select the Destination (MADIch3).

b. Select the Source (MADIch5).

c. Press TAKE to switch.

3. Perform the second switch.

a. Select the Destination (MADIch4).

b. Select the Source (MADIch5).
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c. Press TAKE to switch.
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UHD Gearbox Configuration
Ultrix provides maximum performance and quality with standard configurations supporting data rates up to 
12Gbps. In addition, you can purchase the UltriSpeed software license that enables 12Gbps performance 
throughout every signal path within the router. When combined with the inherent capabilities within the router, the 
UltriSpeed license also enables routing of the emerging single link UHD (50Hz, 60Hz) standard alongside 
Quad-link UHD signals, and seamlessly switch these signals back and forth to each other.

 The Ultrix Gearbox function handles the two sample interleave (2SI) format of quad link. Note that Square 
Division Quad Split is not implemented.

Example Setup for Multiplexing
Assign Gearbox Group 1 on the Ultrix router to be 4:1 (multiplex four 3Gbps inputs into a single 12Gbps output). 
The router OUT 1 BNC is the combined signal of IN 1-4. The OUT 2, 3, and 4 BNCs are reserved by the system.

Figure 7.1  Example of Gearbox Workflow of an Ultrix Router — Multiplexing to a 12Gbps Signal

Table 7.1  Example Mapping for Multiplexing

Name Channel 1 Channel 2 Channel 3 Channel 4
Source
QUAD IN slot2.in[1] slot2.in[2] slot2.in[3] slot2.in[4]

Destination
12G OUT slot2.out[1]

UHD Camera
3Gbps SDI Sources

PORT 1 PORT 2 PORT 3 PORT 4 PORT 5 PORT 6 PORT 7 PORT 8

PORT 9 PORT 10 PORT 11 PORT 12 PORT 13 PORT 14 PORT 15 PORT 16

PSU

ENET 2

ENET 1

1 4 A B

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

Ultrix-HDNBC-IO

REF

!

3Gbps Channel 1

12Gbps SDI

ULTRIX-FR1
32x32 SDI Router

Server
UHD Destination

3Gbps Channel 2

3Gbps Channel 3

3Gbps Channel 4



62 • UHD Gearbox Configuration Ultrix User Guide (v18.0)

Example Setup for De-multiplexing
Assign Gearbox Group 1 on the Ultrix router to be 1:4 (de-multiplex a single 12Gbps input into four 3Gbps 
outputs). The router OUT 1, 2, 3, and 4 BNCs are the split output signals.

Figure 7.2  Example of Gearbox Workflow of an Ultrix Router — De-multiplexing a 12Gbps Signal

Gearbox Overview
A Gearbox is a group of four consecutive inputs or four consecutive outputs that are automatically grouped together 
in the Ultrix database. The first port of the Gearbox group is used for routing and UltriScape, while the remaining 
three ports in the group are reserved but not used (they are not listed in the Third Party Matrices, Sources, and 
Destinations tabs of the database).

• When you enable a Gearbox input group, Ultrix multiplexes the signals of the four 3Gbps Level A channels 
together. 

• When you enable a Gearbox output group, Ultrix takes the signals of the four 3Gbps Level A channels together 
and provides a single 12Gbps signal to an output.

The most common application of a Gearbox is when there are quad channels coming in and out of the Ultrix router. 
The first channel is used as the port for those I/O to define single level of logical I/O while only the audio on the 
first channel is available.

For More Information on...
• cabling for a Gearbox application, refer to the Ultrix Installation Guide.

Table 7.2  Example Mapping for De-multiplexing

Name Channel 1 Channel 2 Channel 3 Channel 4
Source
12G IN slot1.in[4]

Destination
QUAD OUT slot2.out[1] slot2.out[2] slot2.out[3] slot2.out[4]
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Signal Medic
The Signal Medic is a function that attempts to ‘repair’ the incoming Gearbox signal group if one of the four input 
stream is temporarily interrupted. The Signal Medic will replace the missing stream with an interpolated version 
derived from the other incoming signals. 

For More Information on...
• the Signal Medic options, refer to Table 30.9.

Gearbox Timing
Ultrix Gearbox requires all four of the input signals be within 350ns of each other. Cable lengths to the Gearbox 
input should be as matched as practicable.

For More Information on...
• the cable length specifications, refer to the Ultrix Installation Guide.

Configuring the Ultrix Router for Multiplexing Quad Input Signals
When I/O ports are enabled for a Gearbox, the first port of the group is the designated port for mapping (the other 
three ports of the group are reserved but not used). The Port Configuration interface indicates the groups using color 
backgrounds with each group set in a different color. (Figure 7.3)

Figure 7.3  Example of Port Configuration Interface — Gearbox Groups

Before You Begin
Ensure the following steps are completed before configuring the router to multiplex a 12Gbps signal:

1. Install the UltriSpeed software license for the Ultrix router that will multiplex the four 3Gbps into one 12Gbps 
signal.

2. Set up a connection between the external device that will provide the four 3Gbps input signals and the Ultrix 
router, ensuring the four input signals are cabled to the Ultrix rear panel as outlined in Table 7.3. 

Table 7.3  Gearbox Mapping — Default Input Groups

Group Channel 1 Channel 2 Channel 3 Channel 4
1 slot#.in[1] slot#.in[2] slot#.in[3] slot#.in[4]
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3. Set up a connection between the Ultrix router and the external device that will receive the 12Gbps signal.

4. Make a note of the physical IN BNCs on the Ultrix router that will receive the 3Gbps signals.

5. Make a note of the physical OUT BNC on the Ultrix router that will transmit the 12Gbps signal.

Assigning Physical Router Inputs to a Gearbox Group
The Gearbox inputs are automatically arranged in groups of four (e.g. slot1.in[1] to slot 1.in[4] is one group). You 
can enable up to four Gearbox groups per Ultrix slot.

To assign router inputs to a UHD Gearbox group

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Port Configuration.

The Port Configuration interface opens and displays the Input Summary table.

5. In the Physical Address column:

a. Locate the slot that the UltriSpeed license was installed for.

b. Locate the first input port in the Gearbox group you wish to configure for multiplexing four 3Gbps signals.

6. In the 2-SI Group column, click the cell for the first input port of the Gearbox group.

A drop-down menu opens.

7. Select Enable.

The new setting is applied to the selected port and the three associated ports in the same Gearbox group. Note 
that only the first input in the Gearbox group (e.g. slot1.in[1]) will display in the Matrix I/O lists in the Third 
Party Matrices and Sources tabs.

Assigning a Multiplexed 12Gbps Signal in the Database

You can assign the new 12Gbps signal in the Ultrix database much like assigning an input of any other signal type. 
However, the new 12Gbps signal is now the first input in the Gearbox group (e.g. slot1.in[1]) to a Destination in the 
database. 

The original 3Gbps signals will still display in the Matrix I/O lists in the Ultrix database and can still be managed as 
individual sources in the database. 

2 slot#.in[7] slot#.in[8] slot#.in[9] slot#.in[10]

3 slot#.in[13] slot#.in[14] slot#.in[15] slot#.in[16]

Table 7.3  Gearbox Mapping — Default Input Groups

Group Channel 1 Channel 2 Channel 3 Channel 4
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Example of a Gearbox Database for Inputs

Table 7.4 provides an example of mapping the Gearbox inputs in an Ultrix database.

For More Information on...
• managing the sources in a database, refer to the section “Defining the Sources in a Database” on page 115.

Configuring the Ultrix Router for De-multiplexing a 12Gbps Signal
The Ultrix router is capable of de-multiplexing a 12Gbps SDI sources into four separate 3Gbps SDI output signals. 

Before You Begin
Ensure the following steps are completed before configuring the router to de-multiplex a 12Gbps signal:

1. Install the UltriSpeed software license for the Ultrix router that will de-multiplex the 12Gbps signal.

2. Set up a connection between the external device that will provide the 12Gbps signal to the Ultrix router.

3. Setup a connection between the Ultrix router and the external device that will receive the four 3Gbps signals.

4. Make a note of the physical IN BNC on the Ultrix router that will receive the 12Gbps.

5. Make a note of the physical OUT BNCs on the Ultrix router that will transmit the processed 3Gbps signals.

Configuring the Ultrix Router for De-multiplexing a 12Gbps Signal
De-multiplexing an 12Gbps signal produces four 3Gbps SDI signals. These SDI signals can then be assigned to 
separate Ultrix router outputs.

To assign the de-multiplexed signals to a Gearbox group

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Port Configuration.

The Port Configuration interface opens.

5. Click an Outputs banner in the router rear panel map, located at the top of the Port Configuration interface.

The Port Configuration interface updates to the Output Summary table and all Outputs banners are lit blue.

Table 7.4  Example of Gearbox Input Database Mapping

Source Name SDI Level A1 Level A2
GearBox In 1 Slotx.in[1].sdi.ch1 Slotx.in[1].audio.ch1 Slotx.in[1].audio.ch2

GearBox In 2 Slotx.in[7].sdi.ch1 Slotx.in[7].audio.ch1 Slotx.in[7].audio.ch2

GearBox In 3 Slotx.in[13].sdi.ch1 Slotx.in[13].audio.ch1 Slotx.in[13].audio.ch2
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6. In the Physical Address column, locate the first output port in the Gearbox group you wish to configure for 
multiplexing.

7. In the 2-SI Group column, click the cell for the first output port of the Gearbox group.

A drop-down menu opens in the column.

8. Select Enable.

The new setting is applied to the selected port and the three associated ports in the same Gearbox group.

Assigning the De-multiplexed 12Gbps Signal to a Destination in the Database

You can assign the new 3Gbps signals as outputs in the Ultrix database much like assigning a destination of any 
other signal type. Refer to the section “Defining the Destinations in a Database” on page 112 for details on 
configuring destinations in your database.

You can still assign the original 12Gbps signal as a source in the Ultrix database much like assigning a source of 
any other signal type. Refer to the section “Defining the Sources in a Database” on page 115 for information on 
managing the sources in a database.

Example of a Gearbox Database for Outputs

Table 7.4 provides an example of mapping the Gearbox outputs in an Ultrix database.

Table 7.5  Example of Gearbox Output Database Mapping

Destination Name SDI Level A1 Level A2
GearBox Out 1 Slotx.out[1].sdi.ch1 Slotx.out[1].audio.ch1 Slotx.out[1].audio.ch2

GearBox Out 2 Slotx.out[7].sdi.ch1 Slotx.out[7].audio.ch1 Slotx.out[7].audio.ch2

GearBox Out 3 Slotx.out[13].sdi.ch1 Slotx.out[13].audio.ch1 Slotx.out[13].audio.ch2
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UltriScape Setup
The UltriScape licensed feature allows you to view multiple video sources from a single output on an Ultrix router. 
Any video source on the router can be assigned to any PiP on an UltriScape layout. Each layout is configured 
independently and can be applied to one or more UltriScape outputs (Heads). Each router slot supports up to three 
Heads.

Overview
UltriScape provides:

• 3 UltriScape Heads (Multiviewer outputs) per Ultrix slot
• 1080i or 1080p configurable output standard
• UltriScape Head layout switched by any router controlling device
• choose 2 system wide PiP sizes from 9 available
• head specific third PiP (large sizes)
• up to 128 system wide PiPs available
• 21 layout templates
• flexible layout editor to create custom layouts
• PiPs may follow a router input, router output, or be switched as a destination
• flexible audio metering per PiP
• dynamic or static PiP labeling
• TSL protocol controls border, indicator, and label tallies

Before You Begin
Keep the following in mind as you implement your UltriScape Heads:

• You must have assigned a router OUT BNC to each UltriScape Head that is licensed in each slot.
• Moving overlay elements on the DashBoard interfaces are in real time, and there is a rendering delay on the 

UltriScape Head output making layout changes/updates non- real time. Refer to Table 8.1 for approximate 
refresh times (once the layout is selected and applied). 

For More Information on...
• installing a license for an UltriScape Head, refer to the section “Installing a License Key” on page 34.

Workflow
Once the Ultrix router is listed in the Tree View of Dashboard, and the UltriScape licensed feature is enabled for 
each head, the UltriScape nodes are displayed in the Tree View.

The UltriScape hardware setup includes the following tasks:

Table 8.1  UltriScape — Refresh Times

Element Refresh Time
Label Change 0.5 seconds

Layout Change 1 second/layout

Audio Meters All meters update every 10 frames
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1. Install the UltriScape license keys for your router.

2. Assign each UltriScape Head to a physical output on the router.

3. Plan your layouts for each UltriScape Head. This will determine the number of PiPs and outputs you will need 
to set up in the database.

 UltriScape can have PiPs that are shared between all Head outputs (shared PiPs), or PiPs that are specific to a 
particular Head (local PiPs). The shared PiPs are particularly useful when the same source or destination is to be 
shown on one or more UltriScape outputs.

4. Assign each PiP to a Destination in the database. Refer to the section “Assigning the UltriScape 
Destinations” on page 154.

Once the hardware setup is completed, proceed to the chapter “UltriScape Configuration” on page 151 for details 
on configuring the layouts for the UltriScape Heads.

Installing an UltriScape License Key
The number of UltriScape Heads for an Ultrix router depends on the number of installed UltriScape license keys. 
An UltriScape license enables one UltriScape Head on one slot only. For example, if you wanted to enable three 
UltriScape Heads on slot 1, you would install three UltriScape licenses on slot 1.

 You must have at least one UltriScape license installed for each slot that will provide an UltriScape Head.

For More Information on...
• installing an UltriScape license key, refer to the section “Installing a License Key” on page 34.

Assigning an UltriScape Head to a Physical Router Output
Only certain physical outputs may be designated as UltriScape outputs. For example, if you installed a second 
UltriScape license for slot 2, you must assign either OUT 5 or OUT 7 as the UltriScape Head output. Table 8.2 lists 
the connections on the rear panel that are available for UltriScape Heads. 

Figure 8.1 illustrates the output connections allocated for UltriScape Heads on a router rear panel.

Figure 8.1  UltriScape Heads — Output Connections

To assign an UltriScape Head to a router output

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Click Port Licenses.

The Port Licenses interface displays.

Table 8.2  Outputs Allocated for UltriScape Heads
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5. Verify that the Port Licenses interface reports the correct number of licensed UltriScape Heads for your router.

 The Ultrix rear panel map at the top of the Port License interface will display the text “MV” set in red on each 
output socket that has the UltriScape enabled for it.

6. In the Port License interface, locate the UltriScape Head you want to assign.

The example below, there are twelve UltriScape Heads licenses enabled and one is assigned.

7. Use the Port field to select the physical OUT BNC on the Ultrix router you want to assign to the UltriScape 
Head. Choose from the following:

• Disable — Select Disable if you do not wish to assign the physical OUT BNC as the UltriScape Head 
output.

• Slot#.[#] — Specifies which physical OUT BNC on the Ultrix rear panel will be the UltriScape Head output. 
Note that the slot combinations listed depends on the slot and number of Heads enabled.

8. Use the Format field to specify the output video format for the UltriScape Head. Choose from the following:

• 1080p (3Gbps SDI)
• 1080i (1.5Gbps SDI)
• 1080i-LC (1.5Gbps SDI)

 This adds video processing for some interlace formats to ensure stability by introducing 1 frame delay.
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ULTRIX-IP-IO Setup
This chapter outlines how to configure receivers and senders for the Ultrix router to be used in video and audio 
streaming when an ULTRIX-IP-IO blade is installed in a slot of an Ultrix router chassis.

 The ULTRIX-IP-IO supports multicast IP Addresses in the range of 232.x.x.x or 239.x.x.x only.

For More Information on...
• the installation and cabling of the ULTRIX-IP-IO, refer to the Ultrix Installation Guide.

What are Receivers, Senders, and Streams?
The following terms may be used throughout this chapter:

Device

A physical, virtual, or software application that may include multiple sources, destinations, senders, or receivers.

Flow

The continuous raw media content. It can contain more than one essence (e.g. an audio flow can contain multiple 
channels, and an SDI flow may contain audio and video essences).

A flow is independent of the transport protocol. For example, 48kHz LPCM audio is a flow; AES67 is one type of 
stream which can carry the flow.

Flows cannot generally be passed around natively, and need to be encapsulated in a stream. Flows from the same 
source are considered “editorially equivalent”, but may be encoded differently. For example, a video source may be 
encoded as 4:2:2 YCbCr uncompressed, 4:4:4 RGB uncompressed, and h.265 encoded. Each of these would be a 
separate flow from a common source.

Receiver

An element within a device that receives exactly one stream, which contains one flow from a network.

Sender

An element within a device which presents exactly one flow, packaged as a stream onto a network.

Stream

One flow, encapsulated within a transport protocol. Examples include SMPTE ST 2022-6, SMPTE ST 2110-20 
Video, or SMPTE ST 2110-30 Audio (AES67).

Before You Begin
This section provides information to keep in mind before setting up Ultrix-IP streams.

 Each ULTRIX-IP-IO blade has four ENET ports with 25Gb bandwidth per port. The ports are grouped into two 
pairs where the first pair is ENET 1 and ENET 2; the second pair is ENET 3 and ENET 4.

Audio Streams
Keep the following in mind when setting up audio IP streams:

• Each ENET pair can support a maximum of 32 audio streams.
• If redundancy is enabled for an ENET pair, an additional 32 redundant streams are made available.
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• Only ENET 1 and ENET 3 support audio streams at this time.
• Each audio stream can support up to 8 audio channels. For example, a stream with 10 audio channels requires 2 

audio streams where the first stream includes channels 1-8, and the second stream includes channels 9-10.

Video Streams
Keep the following in mind when setting up video IP streams:

• When using 1080p or lower video formats, each ENET pair can support up to 8 video streams with a maximum 
of 16 streams per ULTRIX-IP-IO blade. An additional 8 redundant streams are available if the Redundant option 
is enabled for the ENET pair.

• When using UHD 6G formats (2160p 30/29.97/25Hz), each ENET pair can support up to 4 video streams with a 
maximum of 8 streams per ULTRIX-IP-IO blade. An additional 4 redundant streams are available if the 
Redundant option is enabled for the ENET pair.

• When using UHD 12G formats (2160p 60/59.94/50Hz), each ENET pair can support up to 3 video streams with 
a maximum of 6 streams per ULTRIX-IP-IO blade. If the Redundant option is enabled for the ENET pair, up to 4 
video streams (2 streams in the first port and 2 redundant streams in the second port) are available.

• When using a mix of UHD 6G and 12G formats, each ENET pair can support up to 4 video streams. For 
example, 3x12G streams and 1x6G stream.

Redundant Streams
The ULTRIX-IP-IO blade also provides protection switching as per SMPTE 2022-7. This option can be enabled for 
each pair on the blade.

Keep the following in mind when setting up redundant streams:

• You will need to assign a unique IP address to each stream (primary and secondary) in the same multicast range 
(the first octet in the addresses must match). For example, if the primary stream is set to 239.1.1.1, the secondary 
stream could be 239.2.2.2.

• ENET 2 is reserved for redundant streams when the Redundant option is enabled for that ENET pair.
• ENET 4 is reserved for redundant streams when the Redundant option is enabled for that ENET pair.
• When an ENET pair is in redundant mode:

› The stream must be added to the first port of the ENET pair (ENET 1 or ENET 3) and a duplicate (secondary) 
stream is automatically added to the second port (ENET 2 or ENET 4 respectively).

› The primary and secondary audio streams must have the same IP Address but different UDP ports.

Overview
The generalized work flow of configuring your ULTRIX-IP-IO is:

1. Download and install the latest version of the DashBoard client software.

2. Contact your IT department for the required IP addresses for your ULTRIX-IP-IO ports.

3. Cable the ULTRIX-IP-IO ports.

4. Configure the protocol settings for the ULTRIX-IP-IO.

5. Configure the Port Network settings.

6. Define the Network Stream Groups.

7. Specify the timing requirements for the ULTRIX-IP-IO.

8. Configure the sender streams for the ULTRIX-IP-IO.

9. Configure the receiver streams for the ULTRIX-IP-IO.

10. Enable and configure the redundant streams.
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11. Make your connections.

12. Continue to setup your database as outlined in “Database Configuration” on page 105.

Setups with an Ultricore BCS
An Ultricore BCS enables the video senders/receiver endpoints to be reported as available ports to the router 
database. The video senders/receivers are seen as part of a single video-IP matrix, and the audio senders/receivers 
are part of a single audio-IP matrix. Refer to the Ultricore BCS User Guide for details on setting up and configuring 
the Ultricore BCS in your routing system.

Figure 9.1  Example Setup with an Ultricore BCS Redundancy System
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Configure the Protocol Settings
The Ultrix-IP supports media distribution based on NMOS, and Ember+. This section outlines how to configure the 
Ultrix-IP for each protocol.

 Any changes made to the ULTRIX-IP-IO settings requires a frame reboot.

Configuring the NMOS Settings
This section outlines the required settings for the Ultrix to establish communications via the Network Media Open 
Specifications (NMOS).

To configure the Ultrix as a NMOS device

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click ULTRIX-IP Settings.

The Frame Configuration interface updates to display the ULTRIX-IP-IO Settings area for the router.

5. To assign a name to the Ultrix for use in the NMOS network, perform one of the following:

• Use the NMOS Device Name field to specify a unique identifier for the Ultrix in the NMOS network; or
• Click Default beside the NMOS Device Name field to use the pre-assigned name.

6. Use the SDP Port field to specify the SDP HTTP port used to GET SDPS.

7. To specify the HTTP port used by the Ultrix to browse NMOS properties, perform one of the following:

• Use the NMOS Node field to specify the port as defined by your IT Department; or
• Click Default.

Configuring the Ember+ Settings
 Ultrix implements BESS v1.1 for Ember+ support to communicate with third-party controllers.

To establish a connection between the Ember+ client and the Ultrix, you will first need to:

1. Add the Ultrix in the Ember+ client interface using the IP Address assigned to the Ultrix router.

2. Enable SDP patching with the Ember+ client to establish video and audio receivers on the Ultrix.

3. Set the TCP port to 9095, in the Ember+ client, for the Ultrix.

4. Ensure that all network streams have a consistent audio channel count.
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Establishing a Connection

Before proceeding, ensure that SDP patching is enabled with the Ember+ client to establish receivers on the Ultrix.

To establish a connection between the Ember+ client and the Ultrix

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click ULTRIX-IP Settings.

The Frame Configuration interface updates to display the ULTRIX-IP Settings area for the router.

5. Type 9095 in the Ember+ Port field.

Mapping

You will need to configure the Senders, and then use the Ember+ controller interface (e.g. Lawo VSM) to map the 
sources to the targets. Refer to the documentation that came with your Ember+ controller for details.

Configuring the Port Network
By assigning an IP Address to each port of the ULTRIX-IP-IO blade, you are able to uniquely identify it on the 
network and control it via the DashBoard interface. Each port can be configured separately for media traffic.

 All ENET ports are set to DHCP by default.

To assign the network settings for an ULTRIX-IP-IO port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click ULTRIX-IP Settings.

The Frame Configuration interface updates to display the ULTRIX-IP Settings area for the router.

5. In the Port Network table, locate the row for the port you wish to configure.

6. If you are manually configuring the Ethernet settings:

a. Click the cell in the IP Mode column and select Static.

b. Use the IP field to specify the static IP Address for the port. This is the IP Address that is used to control 
and communicate with the specified port.

c. Use the Subnet Mask field to specify the subnet mask for the port. 

d. Use the Gateway field to specify the gateway for communications outside of the local area network (LAN) 
the ULTRIX-IP-IO will use.

7. If you want the network settings for the port to be automatically obtained, and DHCP service is available on 
your control network, click the cell in the IP Mode column and select DHCP.

8. Click Apply to save the new settings.

9. Repeat this procedure for the second port you wish to configure.

10. Click Reboot to apply the new settings. This button is located at the bottom of the interface.

The Ultrix is temporarily taken off-line during the reboot.
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11. Verify the new settings reported on the Frame Configuration status fields.

Configuring the Timing Settings
The Ultrix supports the Precision Time Protocol (PTP) as defined in the IEEE 1588-2008 standard and the SMPTE 
ST-2059 specification.

 The Ultrix behaves only as a slave and cannot be used as a Boundary Clock or Grandmaster device.

Configuring the PTP Settings
You can synchronize the Ultrix to real-time clocks of other devices in the same network. You create a profile (use 
the default settings or create a custom profile) that identifies the Ultrix to the Grandmaster clock.

 There are several criteria that PTP clocks compare to determine who will be master and who will be slave (called 
the Best Master Clock Algorithm, or BMCA), and they are evaluated in order: Priority1, clock class, accuracy, 
scaled log variance, Priority2, clock ID (similar to the MAC address). Practically, Priority1 is the only setting 
configured on all clocks to control the outcome of the Grandmaster election. If Priority1s are equal, the next 
criterion is evaluated (clock class) and the criteria are evaluated in succession until a Grandmaster is determined.

To configure a PTP default profile for the Ultrix

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click ULTRIX-IP Settings.

The Frame Configuration interface updates to display the ULTRIX-IP Settings area for the router.

5. Locate the ULTRIX-IP PTP area.

 You may need to scroll down to the ULTRIX-IP PTP area.

6. Use the Profile menu to specify the standard/specification used for PTP. The default is SMPTE ST 2059-2.

 The Domain is automatically set if the Custom PTP Profile is not selected.

To create a custom PTP profile for the Ultrix

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click ULTRIX-IP Settings.

The Frame Configuration interface updates to display the ULTRIX-IP Settings area for the router.

5. Locate the ULTRIX-IP PTP area.

6. Select the Custom PTP Profile box.

7. Use the Domain menu to specify the sub-domain the PTP clock is assigned to. The default is 127.
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 There can be multiple PTP domains operating concurrently within a network. The domain is a field in all PTP 
message headers. Messaging between entities are segregated by domain (e.g. the Ultrix is an endpoint configured 
for domain 128 and ignores messages from a neighboring clock configured for domain 127).

Configuring the PTP Settings for a Specific Port
Once you create a PTP profile for the Ultrix, you may want to uniquely define the PTP settings for each 
ULTRIX-IP-IO port. 

To configure the PTP settings for a specific port

1. In the ULTRIX-IP PTP area of the Frame Configuration interface, select the Custom PTP Profile box for 
the required port.

2. Locate the Port PTP Intervals table.

3. Use the Name field to assign a unique identifier to the port.

4. Use the Sync Interval field to specify the number of seconds at which synchronization messages are sent from 
the master clock to the specified ULTRIX-IP-IO port.

5. Use the Announce Interval field to specify the rate of announce messages that the specified ULTRIX-IP-IO 
port requests from the master clock during a unicast session.

6. Use the Announce Receipt Timeout field to specify the number of seconds the specified ULTRIX-IP-IO port 
waits for an announce interval message before timing out.

7. Click Apply.

Configuring the Senders
You will need to specify the IP encapsulation properties for the active video and audio. For each input signal, you 
need to specify the IP encapsulation properties for the active video and audio. A sender stream on the 
ULTRIX-IP-IO can be configured with any multicast IP address in the range of 232.x.x.x or 239.x.x.x.

Make note of the bandwidth allocation for the ULTRIX-IP-IO port to determine the available capacity of the 
port. You can add as many streams to fill up the 25Gb bandwidth of the selected ENET port. Once that maximum 
this maximum is reached, existing streams of the selected ENET port are automatically removed before new 
streams are added.

To display the Senders table for a port in DashBoard

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Port Configuration.

The Port Configuration interface opens.

5. Locate the ULTRIX-IP-IO blade in the router rear panel map.

 You may need to scroll to the bottom of the map to display this slot.

6. Click an SFP port in the ULTRIX-IP-IO slot.

The selected port is lit blue and the Port Configuration interface updates to display the options for the port. 

7. Locate the Senders table in the Port Configuration interface.
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To add advertised sender streams

1. Click Default.

The Setup Default Senders dialog opens.

2. Use the IP Address field to specify the IP range for the sender.

In the above example, the user entered 239.14.4.1 as the starting point for the sender streams. Each subsequent 
advertised stream after this IP Address (e.g. 239.14.4.2, 239.14.4.3, 239.14.4.4 etc.) will be added to the 
Senders table.

3. Use the UDP Port field to specify the RTP port for the advertised stream.

4. Use the Video Format field to specify the video format of the signal available for the advertised stream.

5. Use the Audio Codec field to specify the audio compression format for the advertised stream.

6. Use the Audio Channels field to specify the maximum number of audio channels in each stream.

7. Click OK. 

The Setup Default Senders dialog closes and the Senders table updates to list the sender streams advertised 
using the IP Address specified in step 2.

Make a note of the automatically assigned label in the Name field for each stream. This name will be used in the 
database to represent the specific stream as an output (destination).

To manually add a sender stream

1. Click Add.

The Add Senders dialog opens.
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2. Use the IP Address field to specify the stream address for the video and/or audio signals for the sender.

3. Edit the UDP Port to specify the source port to connect to the stream. This must match the source you are 
attempting to connect to.

4. Use the Type menu to select the type of stream that will be available at the specified IP Address.

 It is recommended to not edit the UDP Port field as this field is auto-populated by the advertised stream.

5. Use the Output menu to assign the SDI input signal to the sender stream.

6. If you selected Video & Audio, or Video in step 4, use the Video Format menu to specify the video format of 
the signal available to the sender.

7. If you selected Video & Audio, or Audio in step 4:

a. Use the Audio Codec menu to specify the audio compression format for the sender.

b. Use the Audio Channels menu to specify the maximum number of audio channels in the specified stream.

8. Click OK.

The Add Senders dialog closes and the new stream is added to the Senders table.

Make a note of the automatically assigned label in the Name field for the stream. This name will be used in the 
database to represent the specific stream as an output (destination).

To edit a sender stream

1. Select the row for the sender stream you wish to edit in the Senders table.

2. Click Edit.

3. Edit the fields as required.

 The fields with yellow backgrounds are read-only and cannot be edited.

4. Click OK.

Configuring the Receivers
Each configured Receiver enables the Ultrix to advertise to the Senders (in your network) how much data it can 
receive and buffer. A receiver on the ULTRIX-IP-IO can be configured to connect to a network stream with any 
destination multicast IP address in the range of 232.x.x.x or 239.x.x.x.

To display the Receivers table for a port in DashBoard

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.



80 • ULTRIX-IP-IO Setup Ultrix User Guide (v18.0)

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Port Configuration.

The Port Configuration interface opens.

5. Locate the ULTRIX-IP-IO blade in the router rear panel map.

 You may need to scroll to the bottom of the map to display this slot.

6. Click an SFP port in the ULTRIX-IP-IO slot.

The selected port is lit blue and the Port Configuration interface updates to display the options for the port.

7. Locate the Receivers table in the Port Configuration interface.

To add a series of receivers

1. In the Receivers table, click Default. 

The Setup Default Receivers dialog opens.

2. Use the IP Address field to specify the IP range for the receiver.

In the above example, the user entered 239.19.8.1 as the starting point for the receiver streams. Each 
subsequent advertised stream after this IP Address (e.g. 239.19.8.2, 239.19.8.3, 239.19.8.4 etc.) will be added 
to the Receivers table.

3. Use the UDP Port field to specify the RTP port the receivers will use.

4. Use the Video Format field to specify the video format of the signal the receivers will output.

5. Use the Audio Codec field to specify the audio compression format for the receiver streams.

6. Use the Audio Channels field to specify the maximum number of audio channels in each stream.

7. Click OK. 

The Setup Default Receivers dialog closes and the Receivers table updates to list the receiver streams using 
the IP Address specified in step 2.

Make a note of the automatically assigned label in the Name field for each stream. This name will be used in the 
database to represent the specific stream as an input (source).
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To manually add a single receiver

1. In the Receivers table, click Add. 

The Add Receivers dialog opens.

2. Use the IP Address menu to specify the IP Address for the transport stream for the receiver.

3. Use the UDP port menu to specify the UDP port number of the transport stream for the receiver.

4. Use the Type field to specify the type of signal.

 Selecting Video+Audio automatically creates table entries for one video and multiple audio streams.

5. If you selected Video or Video+Audio in step 4, use the Video Format field to specify the video format for the 
stream.

6. If you selected Audio or Video+Audio in step 4, use the # of Audio Channels field to specify the audio 
channels in the stream.

7. Use the Transport IP field to specify the UDP IP address of the transport stream for the signal.

8. Click OK to create a new entry in the Receivers table.

The Add Receivers dialog closes and the Receivers table updates with the new receiver stream.

Make a note of the automatically assigned label in the Name field for the stream. This name will be used in the 
database to represent the specific stream as an input (source).

Enabling Redundant Mode
The ULTRIX-IP-IO enables a user to protect their streams to ensure mission critical operation. Using SMPTE ST 
2022-7, they can run the same video and audio over two separate, redundant networks in case an error occurs.

 This section is only applicable if your system requires protection switching.

Before You Begin
Ensure that:

• your source is capable of sending SMPTE ST 2022-7 streams
• the Ultrix is set up within a protection switching network

Enabling the Redundant Mode
By default, the Redundant mode is disabled. 

To enable the Redundant Mode for an ENET pair

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click ULTRIX-IP Settings.

The Frame Configuration interface updates to display the ULTRIX-IP Settings area for the router.

5. In the Port Network table, locate the ENET pair you wish to configure.

Each row in the table is an ENET port on an installed ULTRIX-IP-IO blade. In the example below, there are 
two ULTRIX-IP-IO blades (slot 5 and slot 7).
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6. Select the Redundant box for the ENET pair you wish to configure for protection switching.

7. Click Apply.

Configuring the Ultrix for Protection Switching
You will need to assign a unique IP address to each stream (primary and redundant) in the same multicast range (the 
first octet in the addresses must match) and a different UDP port. For example, if the primary stream is set to 
239.1.1.1, the redundant stream could be 239.2.2.2 but not 232.2.2.2.

 The audio streams must have the same IP address as the video streams.

To configure the Ultrix for protection switching

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Port Configuration.

The Port Configuration interface opens.

5. Select the first port of the ENET pair you enabled the Redundant mode for in the router rear panel map, located 
at the top of the Port Configuration interface.

The Port Configuration interface updates to display the Status, Senders, and Receivers tables for the port. The 
port also displays with a light-blue background.

6. Configure the primary Senders as outlined in the section “Configuring the Senders” on page 77.

7. Configure the redundant Sender stream for the ENET pair as follows:

a. In the Senders table, select the row for the first port of the ENET pair you enabled Redundant Mode for.

b. Click Edit.

The Edit Senders dialog opens.

c. Use the Secondary IP menus to specify the IP address for the secondary (redundant) stream. Ensure that it 
is the same IP Address as the primary stream.

d. Use the Secondary UDP port to specify the UDP port for the secondary (redundant) stream. Ensure that it 
is not the same value as the primary stream.

e. Click OK.

f. Verify the new Redundancy settings are reported in the Redundancy column of the Senders tab.
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8. Configure the primary Receivers as outlined in the section “Configuring the Receivers” on page 79.

9. Configure the redundant Receiver stream as follows:

a. In the Receivers table, select the row for the first port of the ENET pair you enabled Redundant Mode for.

b. Click Edit.

The Edit Receivers dialog opens.

c. Use the Secondary IP menus to specify the IP address for the secondary (redundant) stream. Ensure that it 
is the same IP Address as the primary stream.

d. Use the Secondary UDP port to specify the UDP port for the secondary (redundant) stream. Ensure that it 
is not the same value as the primary stream.

e. Click OK.

f. Verify the new Redundancy settings are reported in the Redundancy column of the Receivers tab.

Troubleshooting
Table 9.1 provides brief explanations for some common stream setup messages.

Using Senders and Receivers in the Router Database
Throughout the Dashboard interface, the senders and receiver streams (outputs and inputs respectively) of a router 
(or matrix) are referred to by hierarchical dotted notation: Slot.Port[x].Type.Channel where:

• Slot identifies which slot in the router chassis the ULTRIX-IP-IO blade is located in.
• Port[x] identifies the physical port on the ULTRIX-IP-IO blade.
• Type identifies the generic signal type (e.g. SDI, audio).
• Channel identifies the audio channel within the stream. If the stream is video, the channel number is fixed to 1.

Table 9.1  Troubleshooting the Error Messages

Error Message Cause
Cannot set default due to maximum 
allowable streams has reached

ENET pair has reached the maximum number of allowable streams

Cannot add 2160P59 video due to 
maximum allowable UHD streams 
has reached

Primary and Secondary UDP port 
cannot be the same

When in Redundant mode, the primary and secondary streams must 
have the same IP address but different UDP ports assigned.

This IP port does not have enough 
bandwidth to add 2160P29 video 
stream

The ENET port has reached the maximum 25G bandwidth.

slot#.port# is a redundant IP port. It 
is reserved for redundant senders.

The ENET pair is in Redundant mode and you cannot edit the second 
port (ENET 2 or ENET 4) of the pair.

UHD video must be assigned to 
output 1, 2, 3, 4, 9, 10, 11, or 12.

The UHD video stream (6G or 12G) format must be assigned to one 
of the inputs/outputs 1-4 or 9-12.

Address x.x.x.x:x is being used by 
slotx.out[y].#.chz

Each stream must have a unique network address
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Figure 9.2  Example of Senders in the Port Configuration Interface

These designators may be assigned more user friendly names if required by editing the Port Labels interface.

Figure 9.3  Example of Senders in the Database Interface

Integration Examples
This section describes use cases for video streams.

Using 3G HD Video
The following setups use 3G HD video or lower formats. All streams can fit within the first ENET port but there is 
a maximum of eight video streams per pair.

Redundancy Mode is Disabled

Figure 9.4 shows two ULTRIX-FR5 routers with the first router (Frame A) transmitting eight 3G HD video streams 
and the second router (Frame B) receiving eight 3G HD streams.
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Figure 9.4  Example of ULTRIX-IP-IO with 3G HD Video Streams

In this setup you would configure eight video streams with 1080p 59.94 format (including the audio streams) 
without redundancy. 

1. For Frame A you would configure eight video sender streams with 1080p 59.94 format (pairing two audio 
sender streams per video stream).

2. For Frame B you would configure eight video receiver streams with 1080p 59.94 format (pairing two audio 
receiver streams per video stream).

3. Ensure that the receiver IP address on Frame B matches the existing sender address on Frame A.

Redundancy Mode is Enabled

In this setup, there are eight video streams with 1080p 59.94 format (including the audio streams) but the 
Redundancy Mode is enabled. All streams can fit within the first ENET port but there is a limit of eight video 
streams per pair. The second ENET port is reserved for the redundant streams.

Figure 9.5 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting eight 3G HD primary video 
streams and eight 3G HD secondary streams. The second router (Frame B) receives two sets of eight 3G HD 
streams (primary and secondary).
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Figure 9.5  Example of ULTRIX-IP-IO with 3G HD Video Streams — Redundancy Mode

In this setup you would configure eight video streams with 1080p 59.94 format (including audio streams) with the 
Redundancy Mode enabled for each ENET pair in use.

1. For Frame A you would:

a. configure two sets of eight video sender streams with 1080p 59.94 format (pairing two audio sender 
streams per video stream).

b. enable Redundant Mode for the ENET pair where ENET 1 will transmit the primary streams and ENET 2 
will transmit the secondary (redundant) streams.

2. For Frame B you would:

a. configure two sets of eight video receiver streams with 1080p 59.94 format (pairing two audio sender 
streams per video stream).

b. enable Redundant Mode for the ENET pair. ENET 1 will receive the primary streams and ENET 2 will 
receive the secondary (redundant) streams.

Using UHD 12G Video Format
When using UHD 12G video formats (60/59.94/50Hz), there is a limit of two video streams per ENET port with a 
maximum of three video streams per ENET pair.
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Redundancy Mode is Disabled

Figure 9.6 shows two ULTRIX-FR5 routers with one (Frame A) transmitting three 12G UHD video streams and 
the second router (Frame B) receiving three 12G UHD streams.

Figure 9.6  Example of ULTRIX-IP-IO with 12G UHD Video Streams

In this setup you would configure three video streams with 2160p 59.94 format without redundancy. 

1. For Frame A you would configure two video sender streams with 2160p 59.94 format on ENET 1 and one 
2160p 59.94 video sender stream on ENET 2.

2. For Frame B you would configure two video receiver streams with 2160p 59.94 format on ENET 1 and one 
2160p 59.94 video receiver stream on ENET 2.

3. Ensure that the receiver IP addresses on Frame B match the existing sender addresses on Frame A.

Redundancy Mode is Enabled

In this setup, there are two video streams with 2160p 59.94 format (including the audio streams) but the 
Redundancy Mode is enabled. There is a limit of two video streams per ENET port. The second ENET port is 
reserved for the redundant streams.

Figure 9.7 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting two 12G UHD primary video 
streams and two 12G UHD secondary streams. The second router (Frame B) receives a primary set of two 12G 
UHD streams and a secondary set of two 12G UHD streams.

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
OUT IN

Ultrix-HDBNC-IO

Ultrix-HDBNC-IO

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
16OUT IN

AUX A AUX B

AUX A AUX B

AUX B

Ultrix-HDBNC-IO

16

!

!

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
OUT INUltrix-HDBNC-IO

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

AUX A AUX B

OUT INUltrix-HDBNC-IO
16

!

AUX A AUX B

!

AUX A AUX B

!

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
16OUT IN

AUX A AUX B

Ultrix-HDBNC-IO
!

1 4

ENET 1

ENET 2

FLEX
SLOT

PWR

ALARM

LOOP A
           B 

TERM

Ultrix-HDBNC-IO
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

OUT

AUX A AUX B

!
IN 16

Ultrix-IP-IO
!

PORT 1 PORT 2 AUX 2 PORT 3 PORT 4

Ultrix-IP-IO
!

PORT 1 PORT 2 AUX 2 PORT 3 PORT 4

AUX
Ultrix-UCCI

ALARM
PRIM

/SEC

STA
TUS

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
OUT IN

Ultrix-HDBNC-IO

Ultrix-HDBNC-IO

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
16OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

AUX A AUX B

AUX A AUX B

AUX A AUX B

OUT IN

Ultrix-HDBNC-IO

Ultrix-HDBNC-IO
16

16

!

!

!

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
OUT INUltrix-HDBNC-IO

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

AUX A AUX B

OUT INUltrix-HDBNC-IO
16

!

AUX A AUX B

!

AUX A AUX B

!

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
16OUT IN

AUX A AUX B

Ultrix-HDBNC-IO
!

1 4

ENET 1

ENET 2

FLEX
SLOT

PWR

ALARM

LOOP A
           B 

TERM

Ultrix-HDBNC-IO
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

OUT

AUX A AUX B

!
IN 16

Ultrix-IP-IO
!

PORT 1 PORT 2 AUX 2 PORT 3 PORT 4

AUX
Ultrix-UCCI

ALARM
PRIM

/SEC

STA
TUS

FRAME A

FRAME B

NETWORK A
2 x 12G UHD Sender Streams 1 x 12G UHD Sender Stream

2 x 12G UHD Receiver Streams 1 x 12G UHD Receiver Stream



88 • ULTRIX-IP-IO Setup Ultrix User Guide (v18.0)

Figure 9.7  Example of ULTRIX-IP-IO with 12G UHD Video Streams — Redundancy Mode

In this setup you would configure two video streams with 2160p 59.94 format with Redundancy enabled for each 
ENET pair in use.

1. For Frame A you would:

a. enable Redundant Mode for the ENET pair where ENET 1 will transmit the primary streams and ENET 2 
will transmit the secondary (redundant) streams.

b. configure two sets of two 12G UHD video sender streams with 2160p 59.94 format.

2. For Frame B you would:

a. enable Redundant Mode for the ENET pair. ENET 1 will receive the primary streams and ENET 2 will 
receive the secondary (redundant) streams.

b. configure two sets of two video receiver streams with 2160p 59.94 format.

Using Multiple Video Streams with Different Formats
In this setup, there are multiple video streams with different video formats with a total bandwidth of all streams 
totaling less than 25Gb. 

Figure 9.8 shows two ULTRIX-FR5 routers with one router (Frame A) transmitting four 3G HD video streams and 
one 12G UHD video stream on ENET 1. The second router (Frame B) receives four 3G HD streams and one 12G 
UHD video stream on ENET 1.
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Figure 9.8  Example of ULTRIX-IP-IO with Multiple Streams with Different Video Formats

In this setup you would configure a total of five video streams on each ENET port of each router. 

1. For Frame A you would configure:

a. four video sender streams with 1080p 59.94 format on ENET 1.

b. one 2160p 59.94 video sender stream on ENET 1.

2. For Frame B you would configure:

a. four video receiver streams with 1080p 59.94 format on ENET 1.

b. one 2160p 59.94 video receiver stream on ENET 1.

3. Ensure that the receiver IP addresses on Frame B match the existing sender addresses on Frame A.
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ULTRIX-SFP-IO Setup
This chapter outlines how to utilize the ports for the Ultrix router when an ULTRIX-SFP-IO blade is installed in a 
slot of an Ultrix router chassis.

For More Information on...
• the installation and cabling of the ULTRIX-SFP-IO, refer to the Ultrix Installation Guide.

Overview
The Ultrix router automatically detects when the ULTRIX-SFP-IO blade is installed. Each signal is made available 
in the Ultrix routing system much like those available via the standard IN and OUT HD BNCs for each slot. The 
signals are initially named using the standard Frame.Slot.Port.Type.Channel nomenclature where Port is reported as 
the physical AUX and/or SFP port on the Ultrix rear panel that the module is installed in. The options in the SFP 
Configuration interface for a module are the same as those for video and audio signals on the BNCs.

  MADI SFP modules are only supported in the AUXA and AUXB ports.

For More Information on...
• the supported modules for the ULTRIX-SFP-IO blade, refer to the Ultrix Installation Guide and Ultrix SFP 

Modules Guide.

Figure 10.1  Example of the SFP Configuration Interface

Before You Begin
You may also need to install an:

• UltriSpeed license if the ULTRIX-SFP-IO includes an SFP-HDB-IN-12G, SFP-FIBER-12G, and/or 
SFP-HDB-OUT-12G.

• UltriScape license for each port that will be used to provide an UltriScape head output.
• UltriSRC license for each AUX port configured for asynchronous MADI input.
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Configuring an SFP Port
Once the SFP module is installed in a port, you must specify the port type. Select SDI video for video SFP types, or 
MADI for Audio SFP types. MADI audio SFP type allow you to specify the channel quantity - either 56 or 64 as 
per your facilities' standard.

The SFP Configuration interface is organized into two sections: AUX settings, and SFP settings. The AUX Settings 
lists all the AUX port settings for all blades in the frame. The SFP Settings list all the SFP I/O port settings.

To specify the number of inputs and outputs for an SFP port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Select SFP Configuration.

5. Select the tab appropriate to the port location you wish to configure.

6. From the Slots table, select the router slot the ULTRIX-SFP-IO blade is installed in.

 Click ALL to display the available SFP/AUX ports available in the router.

The Settings table updates to display the port name, and the type of signals for each populated port.

7. Locate the row for the port you want to configure.

8. In the SFP column for the port, verify the type of signal the port will provide. 

9. If applicable, use the MADI I/O Size menu for the AUX port to specify the input and output configuration for 
the port.

MADI is only available in the AUX ports. The SFP I/O ports 1-16 does not support MADI I/O.

10. Click Apply to save your changes. 

To verify an SFP port

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.



Ultrix User Guide (v18.0) ULTRIX-SFP-IO Setup • 93

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Select Port Configuration.

5. Locate the SFP for the port you want to verify in the router rear image and click to high-light it.

6. Use the Inputs and Outputs tabs to monitor the current audio and video status.
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Device Communication Setup
A single Ultrix router can communicate with external devices such as remote control panels, Ross NK devices, and 
automation devices running third-party protocols.

Figure 11.1  Example of System Connectivity Options with an Ultrix Router

Communication between an external device and the Ultrix router is over Ethernet via an established connection 
point. A connection point defines the interface and the protocol to be used for communications. By default, Ultrix 
runs several server connections points as listed in Table 11.1 for incoming control/communications. Client 
connection points from the router to the external device is configured using the options in the Ultrix Connections 
interface of DashBoard. This step is only required if external routing systems are connected to the Ultrix router.

Device Discovery in DashBoard
When DashBoard is launched, devices such as openGear frames and Ross NK routers, are listed and made available 
in the Tree View. DashBoard uses the open SLP protocol to locate devices on the same network as the computer 
running the DashBoard client software. There are two methods for adding a device to the Tree View in DashBoard: 
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using the auto-connect feature of DashBoard or manually adding a device by specifying the IP address of the 
device. Both methods are described in more detail in the DashBoard User Manual.

 Third-party device information is not automatically retrieved. These devices must be added manually. 

Communications between Ultrix and the Devices in a Routing System
The Ultrix Connections tab enables you to use DashBoard to locate devices in your network. To enable Ultrix to 
function as the ‘master’ of the routing system, you must establish communications with the devices it is connected 
to and define how they are connected. Each external router must have a connection point defined. For those devices 
that are not directly connected to your network, such as Ross NK Series routers and remote control panels, you must 
supply their connection information (port number) in the Connections interface. Once this information is entered 
into the interface, the Ultrix can communicate directly with the device and list it as a node under the Devices 
interface.

Connecting to Ross Remote Control Panels
A single Ultrix router can communicate with external remote control panels such as the Ross RCP-NK series, 
RCP-ME, and RCP-QE. Communication with Ethernet enabled panels is direct from the panel to Ultrix. Refer to 
the panel user manual for specific configuration details.

RCP-NK Series Panels
Communication with RCP-NK series panels is via an established connection point with either an NK-IPS or 
NK-NET network bridge. Refer to the RCP-NK User Guide for details.

RCP-ME and RCP-QE Panels
The connection from the remote control panel to Ultrix is configured on the panel’s DashBoard interface.

1. Display the RCP Connection Editor in DashBoard for your remote control panel. Refer to the user guide for 
your remote control panel for details.

2. Locate the Servers to Connect table.

3. In the first row of the table, use the IP address column to specify the IP address of the Ultrix router that the 
remote control panel will communicate with.

4. Send the current configuration file to the remote control panel. Refer to the user guide for your remote control 
panel for details.

The remote control panel will connect to the Ultrix router and receive a copy of the current database labels.

Connecting to Ross NK Series Devices
Ross NK routers and remote control panels are linked via the T-Bus Control System, a multi-drop RJ-45 control 
system. These T-Bus devices can communicate over Ethernet via a Ross NK-IPS or NK-NET.

A connection point between the Ultrix router and an NK-IPS or NK-NET is defined using the auto-populated fields 
in the Connections tab of the Ultrix interface. Once a connection point is established, the Ultrix router gains control 
over those Ross NK devices connected to the NK-IPS or NK-NET.

For More Information on...
• Ultrix work-flow with Ross NK devices in a routing system, refer to the chapter “Operation with Ross Devices” 

on page 257.
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To establish communication between Ultrix and an NK-IPS or NK-NET

1. Launch the Walkabout utility in DashBoard as follows:

a. Expand the NK Utilities node in the Tree View.

b. Double-click Show Walkabout to open the Walkabout utility in the DashBoard window.

c. Verify that the NK-IPS or NK-NET is listed in the table of the Walkabout utility. Make a note of its name 
and IP Address.

 If the device you want to connect to Ultrix is not detectable in Walkabout, you can still establish communications 
with it in Ultrix using the Connections > Settings menu to manually enter/edit the device settings.

2. Display the Connections tab for Ultrix as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

3. Click Edit > Add.

The Add Connections dialog opens.

4. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select Ross NK.

b. Use the Type menu to select tcp.

c. Use the Count menu to specify the number of new connection entries to make in the Servers table.

d. Click Apply to create the new device row(s) in the Servers table and close the Add Connection dialog.

5. In the Name column, click the cell of the new row to display the drop-down menu.

6. From the drop-down menu, select the device you which to establish a connection to.

 Ross Video devices detected by Walkabout will auto-populate this menu.

7. In the Enabled column of the new row, select Enable.

8. Click the [...] button to verify the IP Address and TCP port values for the device.

9. Click Apply at the bottom of the Connections tab to save the new settings.

Defining a Database with a Ross NK Router Matrix
Once a connection point is established between Ultrix and the Ross NK router, the NK router ports are 
automatically included in the Available Ports lists of the Ultrix database. 

Defining the Levels for an NK Router

Once a connection point is established between Ultrix and the Ross NK router, you can define levels for the router 
via Ultrix and save them to the Ultrix database.

For More Information on...
• defining the levels, refer to the section “Defining the Levels in a Database” on page 110.

Defining the Sources and Destinations for an NK Router

Once a connection point is established between Ultrix and the Ross NK router, you can define a physical 
input/output socket as a source destination in a specific level within the Ultrix database. 

When creating a virtual label for a source or destination, it is recommended to use a short or abbreviated name as 
this text is used to identify the specific signal on the remote control panels which have limited display areas.
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For More Information on...
• defining the sources, refer to the section “Defining the Sources in a Database” on page 115.
• defining the destinations, refer to the section “Defining the Destinations in a Database” on page 112.

Connecting to Ultricore Central Controllers
The Ultricore Central Controller (Ultricore-CC) and the Ultricore Broadcast Central Controller (Ultricore-BCS) 
may act as a master controller for one or more Ultrix routers as well as legacy Ross NK series devices. A 
connection is made from the controlling Ultricore panel to the Ultrix router(s). The controlling Ultricore (primary) 
contains the full database configuration for the entire operation of the system.

All control devices, such as a remote control panel (RCP) or third-party controller, must be configured for and 
communicate with the master Ultricore. Any Ultrix configured as a sub-device will only accept control commands 
via the master Ultricore.

 Any Ultrix devices to be controlled by the Ultricore Central Controller must have the Remote Controller Mode 
enabled. Refer to the section “Enabling Remote Controller Mode on the Client Ultrix Routers” on page 102 
for details.

 Ultricore redundancy is only available when using Ultricore-BCS units.

For More Information on...
• configuring a connection point from an Ultricore to an Ultrix router, refer to the Ultricore User Guide or the 

Ultricore BCS User Guide.

Connecting to Third-Party Devices
Ultrix provides support for many industry standard protocols for interfacing to external devices such as control 
systems, external routing matrices, and tally systems.

 Before proceeding, ensure that your third-party device is installed and configure according to its documentation.

Connection to third-party devices may be categorized into two broad groups: controller and controllee.   

• Controllers are devices that will control the Ultrix router and connect via what may be termed an incoming 
connection.

• Controllees are devices to be controlled by Ultrix router and connect via what may be termed an outgoing 
connection.

Incoming Ethernet connections are defined within the Ultrix control system by default and need no further 
configuration. Table 11.1 lists the available protocols and ports. Serial connections must be defined before either 
incoming or outgoing connection styles may be utilized by Ultrix.

Third-part Connection via Ethernet
The Ultrix router can communicate with third-party external devices via a TCP connection. By default, Ultrix runs 
a server process for the following Ethernet protocols:

Table 11.1  Supported Protocols — Ethernet Connection

Protocol Default Port
GVG Native Series 7000 TCP: 12345

Probel SW-P-08 TCP: 8910

RossTalk TCP: 7788

TSL UMD v3.1 TCP: 5727
UPD: 4490



Ultrix User Guide (v18.0) Device Communication Setup • 99

These Ethernet servers are always running. No further configuration is required — simply configure your client 
device to match the TCP/IP address and port number of the Ultrix. 

Figure 11.2  Example of the Protocol Server Option Dialog

The available Protocol Server options depends on the type of protocol. Table 11.2 briefly summarizes the server 
configuration options for each protocol type. 

TSL UMD v4.0 TCP:5728
UDP: 4491

TSL UMD v5.0 TCP: 5729
UDP: 4492

Table 11.2  Protocol Server Options

Protocol Option Notes
GVG Native Series 7000

L4 Echo • No — the Ethernet Layer 4 acknowledge is disabled. This is the 
default.

• Yes — the Ethernet Layer 4 acknowledge is enabled.

Probel SW-P-08

Protocol Variant • Use Last Req — Ultrix will respond using protocol variant 
(extended/non-extended) as per the received request format. This 
is the default.

• Non-Extended — Ultrix will always replay using non-extended 
formatting.

• Extended — Ultrix will respond with extended formatting.

Matrix Mode • No — Ultrix will use information from the LEVEL section of the 
protocol to control Ultrix levels.

• Yes — Ultrix will use information from the MATRIX_ID section 
of the protocol to control Ultrix levels.

TSL UMD v5.0

Wrapping • No — the DLE/STX wrapping is not enabled. This is the default.
• Yes — enables the DLE/STX wrapping for TCP/IP transport 

PBC in Count • No — Packet Byte Count is not included in total byte count. This 
is the default.

• Yes — Packet Byte Count is included in total byte count.

Table 11.1  Supported Protocols — Ethernet Connection

Protocol Default Port
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To set up an outgoing connection over Ethernet between Ultrix and a third-party device

1. Expand the Database node.

2. Double-click the Connections node located under the Database node.

The Connections tab opens that lists the current database connection points.

3. Click Edit > Add.

The Add Connection dialog opens.

4. In the Add Connection dialog, perform the following:

a. From the Protocol menu in the Add Connection dialog, select the communication protocol the third-party 
uses. Refer to Table 30.12 on page 337 for a list of options.

b. From the Type menu in the Add Connection dialog, select tcp.

c. Use the Count menu to specify the number of devices you want to establish a connection point to.

d. Click Apply to create the new device row(s) in the Servers table and close the Add Connection dialog.

5. In the Name field, type a unique identifier for the third-party device. This name is used to identify the specific 
device within the Ultrix database.

6. Click the [...] button in the new row to display the Communications dialog.

7. To manually create a connection point via the TCP protocol:

a. From the Type menu in the Communications dialog, select tcp.

The table in the Communications dialog updates to display the settings for TCP communication.

b. Use the IP Address field to specify the IP Address assigned to the third-party device.

c. Use the Port field to specify the Port Number assigned to the third-party device that the Ultrix router will 
try to connect to.

d. Use the Wrapping field to specify the TSL UMD v5.0 TCP wrapping is enabled or disabled. This setting is 
ignored for other protocol types.

e. Click Apply to save your settings and close the dialog.

8. Edit the Description field to your requirements.

9. In the Enabled column of the new row of the Servers table, select Enabled.

10. Click Apply in the Connections tab to save the new settings.

Defining a Serial Connection
Ultrix may communicate directly with third-party devices using a native serial protocol. A USB-to-Serial converter 
must be used to give the Ultrix a serial communication port. Refer to Table 11.3 for information on the supported 
protocols.
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 Only USB-serial devices based on these chip-sets are supported: FTDI Chip, Belkin, Prolific PL 2303, and 
Silicon Labs CP210x.

 A serial connection point must be implemented on the Connections tab in the Ultrix database before 
communications can start. The settings may be changed from the protocol defaults to suit your requirements.

To set up a serial connection between Ultrix and a third-party device

1. Double-click the Connections node located under the Database node.

The Connections tab opens.

2. Click Edit > Add.

The Add Connections dialog opens.

3. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select the protocol standard.

b. Use the Type menu to select Serial.

c. Use the Count menu to specify the number of new connection entries to make in the Servers table.

d. Click Apply to create the new device row(s) in the Servers table.

4. In the Name field, type a unique identifier for the third-party device. This name is used to identify the device 
within the Ultrix database.

5. Click the [...] button in the new row to display the Communication dialog.

6. Use the Port field to specify the Port Number assigned to the third-party device that Ultrix will connect to.

7. From the Type menu in the Communication dialog, select RS232 or RS422.

The table in the Communication dialog updates to display the settings for serial communication.

8. Use the Type field to specify the serial transmission standard for the third-party device.

9. Use the Baud Rate field to specify the bit rate for the third-party device.

10. Use the Parity field to specify the parity.

Table 11.3  Supported Protocols — Serial Connections

Protocol
Settings

Type Baud Data Bits Parity Stop Bits
GVG Native Series 7000 RS232 or RS422 38400 8 None 1

Probel SW-P-08 RS232 or RS422 38400 8 None 1

TSL UMD v3.1 RS422 or RS485 38400 8 Even 1

TSL UMD v4.0 RS422 or RS485 38400 8 Even 1

TSL UMD v5.0 RS422 or RS485 38400 8 Even 1
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11. Click Apply to save your settings and close the Communication dialog.

12. In the new row of the Servers table, select the Enabled box.

13. Click Apply to save your settings.

The Connected field in the Connections tab reports “Connect” when the ability to communicate with the 
serial port is confirmed and enabled. The system does not poll or query the serial link to verify the validity of 
the setup.

Connecting to Other Ultrix Routers
Ultrix may act as a master controller for additional Ultrix routers. A connection is made from the controlling 
(primary) Ultrix to the sub-device (client) router(s). The primary Ultrix contains the full database configuration for 
the entire operation of the routing system.

Setup Overview
1. Set up any Ultrix licensing requirements within each Ultrix router.

2. Set up any UltriScape requirements within each Ultrix router.

3. Enable Remote Controller Mode on the client Ultrix routers.

4. Create a database within the primary Ultrix to accommodate the inputs/outputs provided by the client routers.

5. Create a connection point from the primary Ultrix to any/all clients.

6. Edit the primary database to map logical source and destinations to client inputs/outputs, and any UltriScape 
heads/PiPs.

Setup Notes

Keep the following in mind when establishing a connection point from a primary Ultrix to client Ultrix routers:

• Ensure unique device names for each Ultrix router. This allows identification of each individual router 
throughout the setup process. You can edit the name via the Ultrix front panel interface as outlined in the section 
“Re-naming the Ultrix Router via the Front Panel” on page 21.

• Client device configuration (licensing, port configuration, etc.) is achieved via its own device node within the 
DashBoard tree.

• Client UltriScape Multiviewers are configured via the UltriScape node within the DashBoard tree of the Client 
that physically hosts that Multiviewer.

• Routing commands are issued to the primary device via remote control panels, external protocols or DashBoard 
soft panels1. Any client Ultrix will ignore routing commands not originating from the primary while in this 
connected mode.

Enabling Remote Controller Mode on the Client Ultrix Routers
Before establishing a connection point between routers, each client Ultrix router must have its Remote Controller 
Mode enabled. This allows the client Ultrix router to be controlled by the primary Ultrix router in the routing 
system.

To enable the Remote Controller Mode on a client Ultrix router

1. In the Tree View, double-click the System Status node for the client Ultrix router.

The System interface displays in the DashBoard window.

2. Select the Database tab.

1. Only the soft panels defined within the database of the primary Ultrix may control the system.
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3. Select the Remote Controller Mode box.

4. Reboot the client Ultrix router to apply the new setting.

Adding an Ultrix Connection Point
Once a connection point is established between the primary Ultrix router and its clients, the physical inputs and 
outputs the clients provide will display in the Port Labels tab of the primary database. These input and outputs 
ports are now ready for renaming (if required) and mapping to logical source and destinations. 

 A connection point is created using the primary router’s interface. Do not create a connection from a client router 
to the primary router.

 UltriScape PiP and head destination mapping is required in the primary Ultrix database for each UltriScape Head 
in use. The procedure is the same as the UltriScape configuration for a stand-alone Ultrix router. 

To create a connection point between the two Ultrix routers

1. Ensure each Ultrix router is installed, configured, and listed in the Basic Tree View of your DashBoard client.

2. Expand the Database node for the primary Ultrix router.

3. Double-click the Connections node located under the Database node.

The Connections tab opens.

4. Click Edit > Add.

The Add Connection dialog opens.

5. In the Add Connection dialog, perform the following:

a. From the Protocol menu in the Add Connection dialog, select ultrix.

b. From the Type menu in the Add Connection dialog, select tcp.

c. Use the Count menu to specify the number of client Ultrix routers you want to connect.

d. Click Apply to create the new device row(s) in the Servers table.

The Add Connection dialog closes.

6. In the Name column of the Servers table, click the cell of the new row to display the drop-down menu.

7. From the drop-down menu, select the client Ultrix router you wish to establish a connection to.

8. If the client Ultrix router name is not listed in the drop-down menu:

a. Close the Connections tab.

b. Launch Walkabout to detect the on-line devices in your system.

c. Double-click the Connections node for the master Ultrix router to display the Connections tab.

d. Repeat steps 4 to 7.

9. In the Enabled column of the new row, select Enabled.
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10. Repeat steps 6 to 9 for each additional client Ultrix router.

11. Click Apply at the bottom of the Connections tab to save the new settings.

Deleting an Ultrix Connection Point
If requirements change, an Ultrix to Ultrix connection point may be deleted from the Servers table. Devices listed in 
the Clients table are automatically deleted when the connection point to Ultrix is no longer valid.

To delete a connection point between Ultrix routers

1. Expand the Database node for the primary Ultrix router.

2. Double-click the Connections node located under the Database node.

The Connections tab opens.

3. In the Servers table, select the row for the Ultrix connection point to be deleted.

4. Click Edit > Delete.

5. Power cycle the client Ultrix router.

 You must power cycle the client router to re-establish its internal database.

6. Re-configure the primary Ultrix and the client Ultrix routers as per the new requirements.
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Database Configuration
Procedures in this chapter assume that you have DashBoard launched and the Ultrix router displayed in the Tree 
View.

 Ultrix does not support Unicode characters.

How a Database Determines the Routing System
The various tables within an Ultrix router determine if a signal/route can be made from input to output.

For a given level, if there is a physical port mapped, for the same physical device, in both the Source and 
Destination tabs, and the controlling device has the level enabled, then a crosspoint switch can be issued and 
executed on the router(s). Table 12.1 outlines a database with four levels. Level 1 has mapped valid Sources and 
Destinations, and the level is enabled on the controlling device. 

Defining a Database for the Router
The Database interface in DashBoard for an Ultrix enables you to create system input and output lists, assign those 
signals to system sources and destinations, define multiple levels and matrices. You may wish to use the following 
process when defining the database for your router.

Configuration Overview
The generalized work flow of configuring a database for the Ultrix router is:

1. Create a database as outlined in the section “Creating a New Database” on page 106.

2. Establish connection points to external devices. This step is only required if external routing systems are 
connected to the Ultrix router. Refer to the chapter “Device Communication Setup” on page 95 for details.

3. Verify the available IN/OUT ports to ensure correct system connections. The default port naming convention of 
frame.slot.port.type may be overwritten (if required) at this stage.

4. Create levels as outlined in the section “Defining the Levels in a Database” on page 110.

5. Create destination labels and assign physical ports to the labels as outlined in the section “Defining the 
Destinations in a Database” on page 112.

6. Create source labels and assign physical ports to the labels as outlined in the section “Defining the Sources in 
a Database” on page 115.

7. Define a soft panel or establish a connection from a remote control panel (RCP).

Table 12.1  Example of a Multi-Level Database Setup

Level 1 Level 2 Level 3 Level 4
Is a physical source assigned?  Xa

a. An entry is not present in the corresponding Level column of the Source tab.

 

Is a physical destination assigned?   Xb

b. An entry is not present in the corresponding Level column of the Destinations tab.

X

Is the Level enabled on the Controller device?    X

Can a switch be executed? c

c. A switch will be executed.

Xd

d. A switch will not be executed. Physical ports from the same logical matrix must be entered in the same control level 
before a connection can be made.

Xd Xd
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Database File Management Overview
Each Ultrix database consists of a collection of configuration files necessary for Ultrix operation. The database 
resides within the Ultrix storage system. Multiple databases may be saved and accessed at any time, but only one 
database can be active at a time. 

Use the System Status > Database tab to create, load, and delete databases. Use the System Status > Transfer tab 
to backup and restore databases.

For More Information on...
• the System Status tabs and menus, refer to “System Status Interface” on page 317.

Database management consists of the following tasks:

Creating a New Database

A database manages the configuration file and settings for your Ultrix router. A router may use a number of 
database configurations depending on its role in the routing system. Refer to “Creating a New Database” below.

Loading an Existing Database

Use the System Status > Database tab to load a configured database to your Ultrix router. Refer to “Loading a 
Database” on page 109.

Exporting a Database

Enables you to capture a database configuration in a *.uda file that is saved to a location on your network that you 
can specify. Refer to “Exporting a Database” on page 125.

Importing a Database

Enables you to import a saved *.uda file and make it available in the System Status > Database tab. Refer to  
“Importing a Database” on page 125 for details.

Deleting an Existing Database

You can choose to permanently delete any configured database on your Ultrix router. Refer to “Deleting a 
Database” on page 125 for details.

Creating a New Database
When you define a database, the information you enter into the Levels, Sources, and Destinations fields will 
auto-populate the applicable fields in the other interfaces for that Ultrix router. You can change the labels for the 
destinations and sources at any time using the options in the Destinations and Sources interfaces. There are two 
methods for creating a new database: using the Database Builder, or using the options in the System Status > 
Database tab. Both methods are described below.

Using the Database Builder
Use the Database Builder to easily create a working database. Once you define the basic parameters of the new 
database using the settings in the Quick Start interface, you can then define the levels, destinations, and sources for 
the new database. This makes it very easy to build basic configurations as well as get a system up and running 
quickly. 

 Before proceeding, ensure that the required license keys are installed for your router(s). Refer to the chapter 
“Software License Keys” on page 33 for more information.
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To create a new database using the Database Builder

1. Display the Database nodes as outlined in the procedure “To access the Database interfaces in DashBoard” 
on page 25.

2. Double-click the Database Builder sub-node.

The Database Builder interface opens in the DashBoard window with the Quick Start page displayed.

3. Use the Provide a Name field to type a unique identifier for the database.

4. Select the box(es) from the provided list of detected routers the routers to make the database available to. 

5. If you wish to leave the remaining settings at their default values and quickly setup a database, you can click 
Finish and the database will be generated based on selected routers in step 4.

 Click Next, located at the bottom of the DashBoard window, to display the next page of options in the Database 
Builder interface.

6. If any AUX Ports are populated with SFP modules, use the Include AUX ports menu to specify how to label 
the I/O in the database.

 The default is Insert at Slot, which labels the I/O in each slot as 1-18 with the AUX Ports as 17 and 18.

7. Use the Support Video Signal and Number of Audio Channels menus to define the Levels in the database.

8. Use the Breakaway Source Support menus to implement audio shuffling. The options for SDI and MADI 
channels are as follows: 

• None — no audio-only breakaway sources are created.
• Mono — sources are created to enable individual mono audio channel routing.
• Stereo — sources are created for stereo pair audio routing (1-2, 3-4, 5-6 etc.).
• Quad — sources are created for four channel groups or quad-audio routing (1-4, 5-8, 9-12 etc.).
• Oct — sources are created for eight group audio routing (1-8, 9-16, 17-24 etc.).

 You must have SFP modules installed that support MADI to implement the MADI routing with breakaway 
support.

9. Use the Disconnect Source menu to create a disconnect source. This enables the routing silence to audio 
channels (muting).

10. Use the Passthrough Source menu to create a pass-through source definition. This enables setting an audio 
source to follow video bypassing the audio processing and other routing.
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11. If you have an UltriScape license installed, use the last set of menus to define the heads, including the number 
of Picture in Picture (PIPs) that new layouts can include. 

 You can still create and edit layouts in a database with settings that differ from these.

12. Click Finish to save the new settings and:

a. Use the Levels page to review or rename the level labels if required.

b. Use the Destinations page to review the destination label to physical port mapping. Renaming the labels is 
also possible from this page if required.

c. Use the Sources page to review the source label to physical port mapping. Renaming the labels is also 
possible from this page if required.

 Click the Rename button on a page to define multiple elements. For example, clicking Rename on the Sources 
page enables you to define a prefix (e.g. SRC) and apply from a starting point (input 4).

13. Click Finish to create the new database and apply it to the routers selected in step 4.

Using the Database Tab
You can use the Database tab in the System Status interface when only configuring a database for a single router.

For More Information on...
• assigning destinations, refer to the section “Defining the Destinations in a Database” on page 112.
• assigning sources, refer to the section “Defining the Sources in a Database” on page 115.

To create a new database using the options in the Database tab

1. In the Tree View of DashBoard, double-click the System Status node under the Ultrix node.

The System Interfaces display in the DashBoard window.

2. Select the Database tab.

3. Locate the Add Database options in the Database Management area of the tab.

4. In the Add Database Name field, type a unique identifier for the database.

When the database is currently loaded in the system (in use), the Database node displays the database name in the 
tree view under the Ultrix node.
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5. Select the Include I/O Maps box to create a database to match the quantity of BNC I/O ports available in the 
current Ultrix router.

 Each SDI IN/OUT ports will be mapped to the default labels of SRC# and DST# respectively for Level 1 only 
(SDI). The Destinations and Sources fields are ignored, but the Level field is applied.

6. Use the Levels field to specify the total number of levels available in the database for this router.

7. Use the Sources field to specify the total number of inputs available in the database for this router.

8. Use the Destination field to specify the total number of outputs in the database for this router.

9. Click Database Add to create the new database and save it to the Ultrix memory.

10. Load the database to ensure it is active before proceeding to customize.

Loading a Database
Each active database includes a unique setup saved to the Ultrix file system. You must load a database before you 
can configure the matrices, levels, sources and destinations, and soft panels for a particular setup. This also enables 
you to quickly load a saved (configured) routing setup just by recalling a different database. 

To load a saved database

1. In the Tree View, double-click the System Status node.

The System interface displays in the DashBoard window.

2. Select the Database tab.

3. From the Name menu in the Load Database area, select the database you want to load.

4. Click Load.

5. Verify the following to ensure the database was loaded:

• The Name, Levels, Sources, and Destination read-only fields in the Current Database area in the 
Database tab report the correct values.

• The Database node in the Tree View for the Ultrix router reports the correct Database name. 
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Defining the Levels in a Database
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio level). Ultrix uses 
level definitions for easy identification and control of various routing matrices or parts of the system. The levels 
defined in the Levels tab have a direct relationship with the Level entries in other database configuration tabs. 

Before You Begin
Determining the number of levels needed requires a little planning:

• Ultrix can operate with as little as one level to define control of the SDI switching matrix. Ultrix contains the 
UltriMix audio sub-system which allows independent routing of SDI embedded audio channels as well as MADI 
channels. Using a single level control, Ultrix can limit the independent selection of embedded audio and/or 
MADI streams. 

• Any Ross NK series routers or other third-party routers attached to the Ultrix system will require their own 
control levels.

 The quantity of levels determines how many independent IN/OUT ports (including embedded / MADI channels) 
may be grouped together as one source or destination selection.

Example 1

A single control level can be used when there is no requirement for independent embedded audio/MADI channel 
switching. For example: 

 If AFV (audio-follow-video) is desired on a single level database, the Audio Bypass must be enabled for each IN 
and OUT port. Alternatively, the UltriMix audio routing sub-system may be disabled on a per slot basis. Refer to 
the sections “Applying Proc Amps to the Embedded Audio Input” on page 51 and “Applying Proc Amps to 
the Embedded Audio Outputs” on page 52 respectively.

Example 2

A single Ultrix level setup with NK-A64 analog audio router attached would require the following levels: 

Example 3

A setup using SDI with 4 embedded audio levels. This can allow independent switching of 4 of the embedded SDI 
channels and grouping of 4 MADI channels.The following levels would be required:

ID Name
1 SDI

ID Name
1 SDI

2 AnAud L

3 An Aud R

ID Name
1 SDI

2 A1

3 A2

4 A3

5 A4
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To define a level in the database

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Verify the ID field to specify the priority of the level.

 The ID field is a row number automatically defined by the routing system. This ID value corresponds to level 
numbers when used in remote control panel (RCP) configurations and third-party communications.

3. To re-name a level:

a. In the Name column, type a unique identifier for the level. It is recommended to use words that describe the 
level such as 3G, Audio, etc.

b. Click Apply to update the name.

4. To select a unique color that will represent the level in the soft panels:

a. In the Color column, click the cell for the level you want to configure to display the Color Select dialog.

b. Select the hue from the provided vertical color grid in the Color Select dialog.

c. Use the Saturation options to specify the depth of the color.

d. Use the Lightness options to specify the amount of white or black mixed with the selected hue.

e. Confirm that the field beneath the color grid displays the correct color for the level.

f. Apply your changes using one of the following options:

• Click Live to preview the color scheme and apply it but not close the Color Select dialog; or
• Click OK to apply the new color to the level and close the Color Select dialog.

5. Use the Description column to enter a brief summary of the level or provide additional information about the 
level use or purpose.

 The Description column is for identification purposes only and not required for operation.

6. Click Apply to save your changes.

To create additional levels

1. Select a row in the Levels tab.

 It is recommended to insert below the last row in the table.

2. Click Edit.

 You can also copy and paste an existing level by clicking Copy, then Paste from the Edit dialog.

3. To add a single level, select Add.

4. To add multiple levels:

a. Select Add Series to display the Fill Cell Values dialog.

b. In the Prefix field, type the phrase. For example, to create levels as AUDIO 1, AUDIO 2, etc., you would 
type AUDIO into the Prefix field.

c. In the Start Value field, type the first number to be used in the series.

d. In the End Value field, type the last number to be used in the series.

e. Click Apply.
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To delete an entry from the Levels table

1. Select the row for the destination to delete in the Levels tab.

2. Click Edit > Delete.

Defining the Destinations in a Database
Ultrix uses a database to assign inputs and outputs, as well as define levels and matrices. Table 12.2 outlines the 
available outputs for mapping to the destinations in your database. 

For More Information on...
• defining a database, refer to the section “Creating a New Database” on page 106.

Specifying a Destination Label
The Destinations tab allows the definition of names (or labels) for your routing system outputs. When a database is 
initialized, default labels of Dest # are automatically filled in to the quantity specified by the database. These 
destination labels may be changed to suit your naming conventions.

To specify a label for a destination

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

Table 12.2  Mapping Outputs to Database Destinations

Default Slot Label

Physical 
or Virtual 

Port? Description
Slotx.out[y].sdi.ch1 P Digital video output slot x port y

flex.out[y].sdi.ch1 P Digital video output flex slot port y (ULTRIX-FR5 only)

Slotx.out[y].audio.chn P Digital audio channel n of output slot x port y

flex.out[y].audio.chn P Digital audio channel n of flex slot output port y (ULTRIX-FR5 only)

Slotx.head[y].sdi.ch1 V Ultriscape video output slot x head y 

Slotx.heady-pip[z].sdi.ch1 V Video destination for PiP z of slot x Ultriscape Head y

Slotx.heady-pip[z].meter.chn V Audio destination for meter n PiP z of slot x Ultriscape Head y

Slot0.mixer-in[y].audio.ch1 V Audio destination mixer input port y

Slot0.virt-out[y].sdi.ch1 V Acuity AUX BUS output port y
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2. Select the cell in the Name column of the label to alter.

3. Type the required label.

 Take care to limit the amount of characters as these labels are displayed on Remote Control Panels (RCPs) which 
have a limited display area.

4. Repeat steps 2 to 3 for each destination you want to specify a virtual label for.

5. Click Apply at the bottom of the Destinations tab to save your changes.

Mapping an Output to a Destination
The Destinations tab is organized into a table with each row representing a Destination and each column 
representing a Level. The table cells are the output ports assigned to the Destination for that level. Initially, the table 
cells are empty (e.g. the destination labels are not assigned to physical output sockets). These may be populated as 
described in “To map a physical output to a destination”, or, via the Advanced Fill tool.

The Advanced Fill tool is provided to create new destination labels that are automatically assigned to physical 
outputs depending on options set by the user. The audio routing features provided by Ultrix can result in an 
extensive source and destination definition map requiring some time to manually enter. The Advanced Fill tool will 
speed the assignment of physical ports greatly.

Various editing options are available from the editing menus, accessed via the Edit button located on the bottom 
toolbar of the tab. Refer to “Additional Dialogs, Menus, and Toolbars in the Database Interfaces” on page 355 
for details on these menus.

  If you are defining the destinations in a database for use with UltriScape, it is recommended to first define the 
destinations using the Advanced Fill tool, then re-name the UltriScape Heads as required. Otherwise there may 
be duplicate assignments of channels in the database.

For More Information on...
• the Advanced Fill tool, refer to “Using the Advanced Fill Tool” on page 118.
• assigning Tally IDs to destinations, refer to “Assigning the Tally IDs to the Destinations” on page 194.

To map a physical output to a destination

1. Double-click the Destinations node located under the Database node.

2. If desired, type a new name for the destination in the Name cell as outlined in the procedure “To specify a 
label for a destination” on page 112.
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3. In the table of the Destinations tab, locate the column for the level you wish to include in the destination 
definition.

4. To map a single output, perform one of the following:

• Select the cell of the row in the table to display a list of available outputs; or 
• Choose an output from the available Matrix Outputs list, located to the far right, and click Assign.

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to assign SDI 
embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal across many levels but the 
selection would be vertical from the available outputs. The assignment operation will take the top-most of the 
available outputs selection and assign it to the left-most of the horizontal selection etc. through the range.

5. To map a range of outputs:

a. Select the first cell in the table column.

b. Press and hold Shift.

c. Select the last cell in the table column. 

d. Select a range in the available Matrix Outputs list with same click, shift-click method.

e. Click Assign.

6. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To map a series of outputs to multiple destinations on the same level

1. In the table of the Destinations tab, select the first row in the series you want to define for the level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column.

4. Select a range of outputs as outlined in step 5 of the procedure “To map a physical output to a destination” 
on page 113.

5. Click Assign.

6. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To delete an entry from the Destination table

1. Select the row for the destination to delete in the Destinations tab.

2. Click Edit > Delete.

 Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the Destinations table. To 
re-order the Destinations ID numbers in the database, click Edit > Reset All IDs in the Destinations tab.

3. Click Apply.

Configuring the Destination Follow Feature
The Destination Follow feature enables you to route a specific destination’s source signal to another destination. 
For example, set Dest 1 to follow Dest 6 so when Dest 6 is switched to a different source, Dest 1 is also 
switched to that same source. You can set multiple destinations to follow another single destination, or each 
following their own unique destination.

Controlling a destination that has a follow directly will overwrite the current status. Any subsequent changes to the 
followed destination will again update that destination. For example, if Dest 1 follows Dest6 and a a controller 
requests a new source to Dest1, that source is routed to Dest1. If a controller then requests a new source to Dest6, 
Dest1 will then also change status to the new source.

 Destinations defined as UltriScape Heads or UltriScape PiPs are not enabled for DestFollow configuration. A 
PiP DestFollow is configured via the UltriScape interface.
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To configure the Destination Follow feature

1. Double-click the Destination Follow node located under the Database node.

The Destination Follow tab opens.

2. Locate the row for the destination to configure.

3. Use the Following menu to specify the output that the selected Destination will follow.

In the example below, the user is configuring Dest1 to follow Dest6.

 To delete a DestFollow, use the Following menu to select the required DestFollow and click Delete.

Defining the Sources in a Database
Ultrix uses a database to assign inputs, as well as define levels and matrices. Table 12.2 outlines the available 
inputs for mapping to the sources in your database. 
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Specifying a Label for a Source
The Sources tab allows the definition of labels for your routing system inputs. When a database is initialized, 
default labels of Src # are automatically filled in to the quantity specified by the database. These source labels may 
be changed to suit your naming conventions.

For More Information on...
• assigning Tally IDs to sources, refer to “Assigning the Tally IDs to the Sources” on page 193.

To specify a label for a source

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

Table 12.3  Mapping Inputs to Database Sources

Default Slot Label

Physical 
or Virtual 

Port? Description
Slotx.in[y].sdi.ch1 P Digital video input slot x port y 

flex.in[y].sdi.ch1 P Digital video output flex slot port y (ULTRIX-FR5 only)

Slotx.in[y].audio.chn P Digital audio channel n of input slot x port y 

flex.in[y].audio.chn P Digital audio channel n of flex slot input port y (ULTRIX-FR5 only)

Slot0.disconnect[1].sdi.ch1 V A ‘no signal/disconnected’ video source 

Slot0.disconnect[1].audio.ch1 V A ‘no signal/disconnected’ audio source 

Slot0.passthrough[1].audio.ch1 V Audio on this channel will follow video regardless of audio matrix 

Slot0.layout:name[n].mv.ch1 V Ultriscape Head layout file name id n – route a layout to a head to 
change Ultriscape layouts 

Slot0.mixer-out[y].audio.ch1 V Audio source for mixer output port y

Slot0.mixerd-out[y].audio.ch1 V Audio source for mixer channel strip direct output port y

Slot0.virt-in[y].sdi.ch1 V Acuity AUX BUS Input port y
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2. Select the cell in the Name column of the label to alter.

3. Type the required label.

4. Press Enter to apply the change.

 Take care to limit the amount of characters as these labels are displayed on Remote Control Panels (RCPs) which 
have a limited display area.

5. Repeat steps 2 to 4 for each source you want to specify a virtual label for.

6. Click Apply at the bottom of the Sources tab to save your changes.

Mapping an Input to a Source
The Sources tab allows the mapping of physical and virtual input ports to your routing system inputs. The tab is 
organized into a table with each row representing a Source and each column representing a Level. At the top of the 
column is the name of the Level. The table cells are the input ports assigned to the source for that level.

An Advanced Fill tool is provided to create new source labels that are automatically assigned to inputs depending 
on options set by the user. The audio routing features provided by Ultrix can result in an extensive source and 
destination definition map requiring some time to manually enter. The Advanced Fill tool will speed the 
assignment of ports greatly.

Various editing options are available from the editing menus, accessed via the Edit button located on the bottom 
toolbar of the tab. Refer to “Additional Dialogs, Menus, and Toolbars in the Database Interfaces” on page 355 
for details on these menus.

To map an input to a source

1. Double-click the Sources node located under the Database node.

2. If desired, type a new name for the source in the Name cell as outlined in “To specify a label for a source” on 
page 116.

3. In the table of the Sources tab, locate the column for the level you wish to include in the source definition.

4. To map a single input, perform one of the following:

• Select the cell of the row in the table to display a list of available input sockets.
• Choose an input from the available Matrix Inputs list and click Assign.

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to assign SDI 
embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal across many levels but the 
selection would be vertical from the available inputs. The assignment operation will take the top most of the 
available inputs selection and assign it to the left most of the horizontal selection and so on through the selection 
range.

5. To map a range of inputs:

a. Select the first cell in the table column.

b. Press Shift.

c. Select the last cell in the table column. 

d. Select a range in the available Matrix Inputs list. 

e. Click Assign.

6. Click Apply at the bottom of the Sources tab to apply the changes to the database.

To map a series of inputs to multiple sources on the same level

1. In the table of the Sources tab, select the first row in the series you want to define for the level.

2. Press and hold Shift.
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3. Click the last row in the series to select a range of cells within a Level column.

4. Select a range of inputs as outlined in step 5 of “To map an input to a source” on page 117.

5. Click Assign.

6. Click Apply at the bottom of the Sources tab to apply the changes to the database.

To delete an entry from the Sources table

1. Select the row for the destination to delete in the Sources tab.

2. Click Edit > Delete.

3. Click Apply at the bottom of the Sources tab to apply the changes to the database.

Using the Advanced Fill Tool
The Advanced Fill operation is typically a tool used to initially set up an Ultrix database. Edits and customization 
may then be performed after the Advanced Fill tool has done the bulk of the work.

The following examples are shown on a new database with only database default settings loaded.

 Take care when determining label names. While a long name may be nice and descriptive for the Source and 
Destination tabs, many control devices have limited screen space and labels may be truncated.

For More Information on...
• the settings and menus available in the Advanced Fill tool, refer to “Advanced Fill Tool” on page 357.

Create Source Labels with Assignments for SDI Video Levels
The objective of this example is to insert new labels and assignments for inputs for the entire Ultrix router on SDI 
Levels only.

To create source labels with assignments for SDI video levels

1. Define the levels as outlined in the section “Defining the Levels in a Database” on page 110.

2. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill to open the Breakaway Fill dialog.

3. If required, select Fill > Entire Device.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the prefix and the 
numerical counter.

5. From the AUX Port menu, define the AUX ports. Refer to Table 30.42 for a list of options.
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6. From the Slot menu, select the first slot in the Ultrix router. (e.g. Ultrix.slot1)

7. From the Port menu, select the first IN port of the first slot. (e.g. Ultrix.slot1.in[1])

8. From the Starting Channel menu, select the first channel of the selected port. (e.g. Ultrix.slot1.in[1].sdi.ch1)

9. In the Levels table of the dialog, select the fully qualified input name from the I/O Assignment column.

10. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with assignments.

Create Destination Labels with Assignments for SDI Video Levels
The objective of this example is to insert new labels and assignments for Ultrix outputs for the SDI only level.

To create destination labels with assignments for SDI video levels

1. Define the levels as outlined in the section “Defining the Levels in a Database” on page 110.

2. Select an entry point in the Destinations tab from where the new labels and assignments will begin.

a. Double-click the Destinations node located under the Database node.

The Destinations tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Fill dialog opens.
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3. If required, select Fill > Entire Device.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the prefix and the 
numerical counter.

5. From the AUX Port menu, define the AUX ports. Refer to Table 30.42 for a list of options.

6. From the Slot menu, select the first slot in the Ultrix router. (e.g. Ultrix.slot1)

7. From the Port menu, select the first OUT port of the first slot. (e.g. Ultrix.slot1.out[1])

8. From the Starting Channel menu, select the first channel of the selected port. (e.g. Ultrix.slot1.out[1].sdi.ch1)

9. In the Levels table of the dialog, select the fully qualified Output assignment name from the I/O Assignment 
column.

10. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with assignments.

Create Source Labels with Assignments for SDI and Embedded Audio
The objective of this example is to create source labels and assignments for the SDI video and the first four 
embedded audio channels for an entire Ultrix enabled slot. The remaining twelve audio channels are not used.

To create source labels with assignments for the SDI video and embedded audio levels

1. Ensure that you have the UltriMix licensed feature enabled for the slot. Refer to “Installing a License Key” on 
page 34 for details.

2. Define one level for SDI Video and 16 levels for the embedded audio. Refer to “Defining the Levels in a 
Database” on page 110.

3. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 
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b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

4. If required, select Fill > Entire Slot.

5. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the prefix and the 
numerical counter.

6. From the AUX Port menu, define the AUX ports. Refer to Table 30.42 for a list of options.

7. From the Slot menu, select the UltriMix enabled slot in the Ultrix router. (e.g. Ultrix.slot1)

8. From the Port menu, select the first port of the UltriMix enabled slot. (e.g. Ultrix.slot1.out[1])

9. From the Starting Channel menu, select the first channel of the selected port. (e.g. Ultrix.slot1.in[1].sdi.ch1)

10. In the Levels table of the dialog, select a range of Level rows by clicking the first row level name, then holding 
the Shift button, click the last row level name. 

 Ensure to select the SDI Video level and the first four embedded audio levels.

11. Click Assign to automatically fill the I/O Assignment column for the selected levels.

The Breakaway Fill dialog updates but does not close.

To set the unused audio channels to disconnect

1. From the Slot menu in the Breakaway Fill dialog, select Ultrix.slot0.

2. From the Port menu, select Ultrix.slot0.

3. From the Starting Channel menu, select Ultrix.slot0.disconnect[1].audio.ch1.

4. In the Levels table of the dialog, select the remaining twelve audio levels (e.g. A5-A16) from the I/O 
Assignment column.

5. Select Ultrix.slot0.disconnect[1].audio.ch1 from the I/O Assignment cell for the first selected row (e.g. A5).

The disconnect[1].audio will be applied to all the selected rows1.

1. Pass through may also be selected. Pass through has the effect of passing through any audio (silence or otherwise) on the channels A5 
to A16. Disconnect effectively mutes those channels on the output stream.
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6. Click Apply.

The dialog closes.

7. Click Apply in the Sources tab.

 The Sources tab updates with the newly created and insert labels with assignments.

Creating Labels with Assignments for SDI and Embedded Audio, with Audio 
Breakaways
The objective of this example is to create and insert a series of source labels with assignments for SDI video and 
embedded audio. Also, audio breakaway sources will be required to implement audio shuffling.

To enable the ability to shuffle audio (that is to take an audio channel and route into another stream in a different 
position within that stream), we need to define that audio channel as a source and assign it across all required levels. 
For example, we may wish to take channel 3 audio from an input SDI stream, and route (just that individual 
channel) to channel 2 of an output SDI stream. To facilitate this, the following definitions are needed; 

 If only four audio levels are defined as shown in Table 12.4, and assuming no other level definitions, the user can 
only route SDI 1 ch3 to any of the corresponding levels in the destination, i.e. cannot route SDI 1 ch3 to a 
destination stream channel 8 as Out[1].audio.ch8 is not defined in any of the destination levels.

To enact the previous example, the user selects the destination channel by selecting the appropriate level button on 
the control panel (in this case, the A2 level) before actuating the crosspoint switch (destination button SDI out1, 
then, source button SDI 1 ch1). The Advanced Fill tool can automate the creation of these audio breakaway sources 
saving a great deal of setup time.

Table 12.4  Example 1

SDI Level Level A1 Level A2 Level A3 Level A4
Source Name

SDI 1 ch3 <blank> In[1].audio.ch3 In[1].audio.ch3 In[1].audio.ch3 In[1].audio.ch3

Destination Name

SDI out1 Out[1].sdi.ch1 Out[1].audio.ch1 Out[1].audio.ch2 Out[1].audio.ch3 Out[1].audio.ch4
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To create source labels with assignments for SDI and embedded audio, with audio breakaways

1. Define one level for SDI Video and 16 levels for the embedded audio as outlined in the section “Defining the 
Levels in a Database” on page 110.

2. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

3. If required, select Fill > Entire Slot.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the prefix and the 
numerical counter.

5. From the Slot menu, select the UltriMix enabled slot in the Ultrix router. (e.g. Ultrix.slot1)

6. From the AUX Port menu, define the AUX ports. Refer to Table 30.42 for a list of options.

7. From the Port menu, select the first port of the UltriMix enabled slot. (e.g. Ultrix.slot1.out[1])

8. From the Starting Channel menu, select the first channel in the series.

9. In the Levels table of the dialog, assign physical ports to the levels. 

10. Select the BRK I/O box for the Levels assignment to be broken out to a separate label/assignment definition.

11. Select the BRK Level box for each level to be included in that label/assignment definition.

12. Click Apply.

The dialog closes.

13. Click Apply in the Sources tab.

The Sources tab updates with the newly created and insert labels with assignments, and the audio breakaways 
definitions.
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 Notice the chx automatic suffix to the label. This may be overridden by placing text in the BRK Suffix cell of the 
Breakaway Fill dialog.

Creating Categories
You can assign each destination, source, and level to a specific category in the router database. Defining multiple 
categories enable you to filter the sources, destinations, and level and organize them into logical groups. Each 
database provides up to six categories that you can define.

For More Information on...
• managing the categories for your Ultrix router, refer to the chapter “Using Categories” on page 207.

Acuity AUX Bus Mapping
When setting up the Ultrix router to support an Acuity switcher, you must also map the switcher aux buses to router 
sources and destinations so that video can be assigned to them. Aux bus routing is done virtually within the router. 
When a source is selected on an aux bus in the switcher, the switcher tells the router to connect a video source to an 
aux bus destination. The video does not pass through the switcher, only the router. An aux bus source must be 
assigned to a router destination for that video stream to be available on an output. Refer to the switcher 
documentation for details on setting up an Ultrix with an Acuity switcher.

For More Information on...
• setting up an Ultrix with an Acuity switcher, refer to the switcher documentation.

Managing your Databases
A database can be archived by saving it as a *.uda file to a specified location. This enables you to import and export 
an archived database which is useful for:

• creating a safe, off-frame copy of a default database configuration for that router
• importing a copy of a reference database that can be tailored to a specific application for that router
• restoring a known backup copy of a database to a specific router 

 This feature requires DashBoard v8.2 or higher and Ultrix software v2.0 or higher.

Overview
The following information is captured when you archive a database:

• Definitions of levels, sources, and destinations
• Salvos
• Category assignments
• Soft panels
• User assigned port labels
• Current crosspoint status
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 The following information is not captured: hardware specifics, and license settings.

Exporting a Database
You create an archive of a database (as a *.uda file) using the options in the System Status > Transfer tab.

To export a database to the archive

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Select the Ultricore Database sub-tab.

4. Locate the Export area on the tab.

5. Use the Database field to specify the database to export.

6. Click Browse... to specify the location to save the *.uda file to.

The Archive read-only field updates with the selected path and database name.

7. Click Apply.

The Downloading Archive dialog opens to report the status of the export.

Importing a Database
Once a database is imported from the archive to your system, you can select it from the list of databases to load via 
the System Status > Database tab.

 The database is not automatically loaded. Refer to “Loading a Database” on page 109 to load a database.

To import a database to an Ultrix router

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Select the Ultricore Database sub-tab.

4. Locate the Import area.

5. Select the *.uda file you wish to import as follows:

a. Click Browse... to display the Open dialog.

b. Use the Open dialog to specify the *.uda file to import.

c. Click Open to close the dialog and load the file.

6. Click Apply.

The Uploading Archive dialog opens to report the status of the transfer.

7. Verify that the imported database is now available for selection in the System Status > Database tab.

Deleting a Database
 You cannot delete the active database.

To delete a database

1. In the Tree View, double-click the System Status node.

2. Select the Database tab.
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3. From the Delete Database Name menu, select the database you want to delete.

4. Click Database Delete.
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ULTRIMIX-MXR
The ULTRIMIX-MXR licensed feature is a virtual audio mixer that can be configured up to 128×64. It can be 
partitioned into smaller mixers so you can have multiple instances within the frame. 

The ULTRIMIX-MXR has access to every input in the system, and its outputs can be routed to any output in the 
frame, providing tremendous flexibility for audio work-flows. Each input has a 4-band parametric equalizer, noise 
gate and compressor/limiter. In addition, ULTRIMIX-MXR has 128 direct outputs for simple audio processing as 
part of its standard feature set. It is controllable via a DashBoard user interface as well as application-specific 
panels for both the Ultritouch-2 and Ultritouch-4 control panels.

Key Features
• Licensed in 32×16 blocks
• Multiple licenses can be purchased to build a maximum size of 128×64
• 4 Band Parametric EQ per input
• Noise Gate per input
• Compression/Limiter per input
• DashBoard control
• Ultritouch-2 and Ultritouch-4 panel support

Flexible Mapping
Any Ultrix audio input (embedded SDI, MADI, or IP based) may be routed to any mixer input, and any mixer 
output may be routed to any audio output channel. You may route any audio signal within Ultrix via any mixer 
input. Also, the mixer outputs may be routed to any Ultrix audio destination, including back into the mixer.

Each ULTRIMIX-MXR license provides an I/O (Input/Output) block of 32 inputs by 16 outputs. A maximum of 4 
licenses provides an I/O block of 128 inputs by 64 outputs.The ULTRIMIX-MXR may be partitioned into smaller 
blocks to provide multiple small audio mixers. 

Figure 13.1 is an example of one audio mixer (one license) with 64 stereo inputs (128 channels) and 32 stereo 
outputs (64 channels). Figure 13.2 is an example of partitioning to obtain two smaller independent 
ULTRIMIX-MXR I/O blocks. Each partition is stereo 32x16.

Figure 13.1  One Audio Mixer — 64x32 Figure 13.2  Two Audio Mixers — Each 32x16
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Soft Panels
An Audio Mixer soft panel type allows for real-time adjustment of audio levels and audio processing, and provides 
a familiar interface similar to other audio consoles.

 Each channel strip is a stereo pair (i.e. two audio channels). Similarly, each output bus is a stereo pair.

By default, the Home View of an audio mixer soft panel is similar to Ross RAVE. The window is divided into 
channel strips and includes the features you enabled during the soft panel configuration. You also have the option to 
add drawers to the left and/or right margins of the soft panel window (like an Ultritouch soft panel). 

For More Information on...
• audio mixer soft panels, refer to the section “Creating Audio Mixer Soft Panels” on page 133.

Figure 13.3  Example of an Audio Mixer (Desktop) Soft Panel

Setup Overview
This chapter summarizes how to set up an audio mixer soft panel. This requires you to:

1. Install a ULTRIMIX-MXR license(s) for each audio mixer partition you require. You can install up to 4 
licenses in a single router. 

2. Specify the audio mixer I/O partitions.

3. Create sources and destinations with audio mixer I/O mappings.

4. Configure an audio mixer soft panel.

5. Load the audio mixer soft panel to your desktop or an Ultritouch panel.

The following sections outline each step.

Installing the License Key for an Audio Mixer
Install the ULTRIMIX-MXR software license for the Ultrix router as outlined in the chapter “Software License 
Keys” on page 33.
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Configure the Audio Mixer I/O Partitions
Each ULTRIMIX-MXR license provides a block of audio mixer Inputs and Outputs (I/O). The block size is 
determined by how many ULTRIMIX-MXR licenses are enabled. This I/O block may be partitioned to create 
smaller independent mixers.   

For example, an Ultrix with all four ULTRIMIX-MXR licenses enabled will yield a single audio mixer with an I/O 
matrix of 64 stereo inputs × 32 stereo outputs. The Frame Configuration interface in DashBoard enables you to 
create the following matrices based on how you want to partition the inputs and outputs:

• 1 Mixer where the mixer is a 64×32 (stereo)
• 2 Mixers where each mixer is a 32×16 (stereo)
• 4 Mixers where each mixer is a 16×8 (stereo)
• 8 Mixers where each mixer is a 8×4 (stereo)

 It is strongly recommended to configure your audio mixer partitions at the same time as configuring the other 
ports for your router. Changes to mixer partition is a major operation due to existing mixer I/O maps in sources 
and destinations are no longer valid, and mixer partition assigned to a mixer panel may no longer available.

Master and Monitor Outputs
Each partition has two defined outputs named Master and Monitor. The physical outputs the Master and Monitor 
buses are assigned to is user configurable. By default, Master is assigned to the first output bus and Monitor is 
assigned to the last output bus of the partition.

For example, an Ultrix with one ULTRIMIX-MXR license allows a single block of 32×16 audio mixer I/O. This 
equates to a possible mixer with 16 stereo inputs and 8 stereo outputs, or buses. By default, a single partition on this 
I/O block will set the Master bus to mixer I/O OUT 1 and the Monitor bus to OUT 8.

With Master set to bus OUT 1 and Monitor set to bus OUT 8, this leaves the remaining 6 outputs as Auxiliary 
(AUX) buses. 

Figure 13.4  Master and Monitor Outputs within a Partition

The Master and Monitor buses operate in conjunction as follows;

• The Monitor bus follows the Master unless a channel strip has SOLO activated.
• When no channel strip SOLO is activated, the Monitor bus has the same audio mix as the Master bus.
• When a channel strip SOLO is activated, the Monitor bus mutes other channels except for those in SOLO mode. 

The SOLO button is highlighted (this applies whether the active bus is Master or an AUX).
• Any Master channel strip with SOLO activated does NOT affect the Master bus.
• Multiple channel strip SOLOs are allowed, and they all appear in the Monitor simultaneously.
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• Selecting the SOLO Clear button will clear all currently active SOLO channel strips.

The SOLO mode on an auxiliary bus operates differently as there is no specific monitoring bus output for the 
Auxiliary buses.

• Any channel strip with SOLO activated will MUTE the other channels on that AUX bus.
• When an AUX strip SOLO is activated, the Monitor bus has the same audio mix as an AUX bus with SOLO 

activated.

Configure the Audio Mixer Partitions
The number of default partitions is determined by the license key you installed.

To configure an audio mixer partition

1. Locate the Ultrix in the Tree View of DashBoard.

2. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

3. Expand the Devices node.

4. Expand the Controllers + Matrices node.

5. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

6. Click Audio Mixer Partitions.

The Frame Configuration interface updates to display the Audio Mixer Partitions area for the router.

7. Use the Mixer Partition menu to specify the number and types of audio partitions you require.

In the example below, the user has four licenses installed but selected the option for 2 stereo partitions.

8. Click Apply.

Mapping the Sources and Destinations for the Audio Mixer
An Audio Mixer Fill Tool is provided in the Destination and Source interfaces to help quickly map the audio mixer 
I/O. The Audio Mixer Fill tool enables you to specify:

• one or more partitions to create destinations/sources based on the I/O available in those selected partition(s).
• the starting audio level for the I/O mapping for each destinations/sources.
• how many audio levels for each destinations/sources.
• a prefix for each destinations/sources and a starting number (if there are more than one destination).
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Before You Begin
When mapping your audio mixer I/O:

• Mixer Inputs (channel strips) are mapped to Router Destinations 
• Mixer Outputs (output strips) are mapped to Router Sources 

Figure 13.5  Block Diagram of Mapping Audio Mixer I/O to Router Destinations and Sources

Mapping the Router Destinations to the Audio Mixer Inputs
The Audio Mixer Fill Tool prevents a user from mapping I/Os from two different mixers into one logical matrix 
since each source/destination can have I/O mappings from only one mixer partition.

By default, the Audio Mixer Fill Tool assigns consecutive mixer inputs across the table starting at the defined 
Starting Level and continuing each level column for the channels per Destination quantity. Note the chosen 
Channels per destination setting will impact the total number of logical labels created. For example, when creating 
mixer input logical label for a 64×32 mixer, a setting of Quad will result in 32 logical destinations (mixer inputs) 
created or 32 destinations × 4 levels (Quad) with 128 mixer inputs (64 stereos channel strips).

When mapping stereo pairs, each channel strip in the soft panel Home View represents a stereo pair with the first 
strip automatically assigned to the first pair of the selected partition. For example, slot0.mixer-in[1] and 
slot.mixer-in[2] is mapped to Channel strip 1, and slot0.mixer-in[3] and slot.mixer-in[4] is mapped to channel 
strip 2 etc. This is also true for the mixer outputs. 

To map the destinations to the audio mixer

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard” on page 25.

2. Double-click the Destinations sub-node.

3. Select an entry point in the Destinations tab from where the new audio mixer assignments will begin.

4. Click Edit > Audio Mixer Fill.

The Fill Audio Mixer dialog opens.
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5. Select the Include box for each audio mixer partition you want to add router destinations for.

6. Use the Starting Level field to specify the starting audio level for the I/O mapping for each destination.

7. Use the Channels per Destination menu and field to specify how many audio levels for each destination. 

 If you selected Custom, use the provided field to specify the number of audio levels for each destination.

8. When mapping multiple destinations, specify a prefix for each destinations and a starting number as follows:

a. Select Insert New Destinations.

b. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the prefix and the 
numerical counter.

c. Use the Starting menu to select the cell of the row for the entry point. The new entries will be inserted 
below this row.

9. Click Apply.

The dialog closes and the Destinations tab updates with the newly created and insert labels with assignments.

Mapping the Router Sources to the Audio Mixer Outputs
When mapping sources, ensure to use the same mixer partition(s) that was selected in step 5 of “To map the 

destinations to the audio mixer” on page 131.

To map the inputs for an audio matrix

1. Display the Database nodes as outlined in the procedure “To access the Database interfaces in DashBoard” 
on page 25.

2. Double-click the Sources sub-node.
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3. Select an entry point in the Sources tab from where the new audio mixer assignments will begin.

4. Click Edit > Audio Mixer Fill.

The Fill Audio Mixer dialog opens.

5. Select the Include box for each audio matrix you want to add router source to.

6. Use the Starting Level field to specify the starting audio level for the I/O mapping for each source.

7. Use the Channels per Source menu and field to specify how many audio levels for each source. 

 If you selected Custom, use the provided field to specify the number of audio levels for each source.

8. When mapping multiple sources, specify a prefix for each source and a starting number as follows:

d. Select Insert New Source.

e. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the prefix and the 
numerical counter.

f. Use the Starting menu to select the cell of the row for the entry point. The new entries will be inserted 
below this row.

9. Click Apply.

The dialog closes and the Sources tab updates with the newly created and insert labels with assignments.

Creating Audio Mixer Soft Panels
Much like other types of soft panels, when you create a new audio mixer soft panel, you select from an existing soft 
panel type (templates). You then assign a Panel Name and ID to display in the tree view using the nomenclature 
“Panel Name [#]” where [#] is the Panel ID.

 If you prefer to manually perform crosspoint switching on the panel, you also have the option to add router 
destinations and sources to the audio mixer soft panel.
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To create a new audio mixer soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. Click Edit > Add.

The Add Panel dialog opens.

3. Type a unique identifier in the Name field. This will be used to identify the panel in the tree under the Soft 
Panels node.

4. Use the Style menu to specify the type of audio mixer panel to create. Choose from the following:

• Audio Mixer — Creates a soft panel suitable for a desktop monitor where multiple rows of channel strips 
are possible.

• Audio Mixer 4RU — Creates a soft panel formatted for an Ultritouch-4 panel.
• Audio Mixer 2RU — Creates a soft panel formatted for an Ultritouch-2 panel.

5. Click Apply to save your settings and close the Add Panel dialog.

The new panel name is added to the Saved Panels list and automatically selected for editing.

6. Use the Panel ID menu to determine the position of the panel in the Soft Panels tree where a value of “1” is the 
highest priority (and listed at the top).

 Ensure that the new soft panel does not use the same Panel ID as a previously saved soft panel.

7. Use the Description field to provide a textual summary of the panel. 

8. Click Apply (located at the bottom of the Panels tab).

Adding Operation Features to the Soft Panel
You can customize the soft panel to include, or not, specific operational buttons used when switching crosspoints.

To set the operation modes for your audio mixer soft panel

1. Select the Info tab.

2. Set the Take Operation to Direct.

The audio mixer soft panel does not display a Take button. A crosspoint switch occurs automatically after each 
destination/source selection is made by the user on the soft panel.

3. Click Apply.
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4. If required, add router (video) levels, destinations, and sources to your audio mixer soft panel according to the 
following sections.

Levels

For consistent crosspoint status reporting, the levels for an audio mixer soft panel should be assigned database 
audio levels only. (Figure 13.6)

Figure 13.6  Example of Router Levels for an Audio Mixer Soft Panel

Destinations

Audio mixer soft panels can be enabled to route the mixer outputs to Ultrix router destinations. The destinations 
located in the assigned list are available for selection to route mixer outputs to Ultrix destinations in the soft panel. 
In Figure 13.7, only Ultrix router destinations DST1 - DST9 will be available for this soft panel.

Figure 13.7  Example of Router Destinations for an Audio Mixer Soft Panel

If destinations are assigned to an audio mixer soft panel, you must assign a mixer destination drawer window. If no 
destinations are assigned, the audio mixer soft panel cannot route mixer outputs to Ultrix destinations. Another 
panel must perform this function.

Sources

Audio mixer soft panels can be enabled to route the Ultrix sources to mixer inputs. The sources placed in the 
assigned list are available for selection to route mixer Ultrix sources to mixer inputs in the soft panel. In Figure 
13.8, only Ultrix router sources SRC1 - SRC10 will be available for this soft panel to choose mixer inputs

Figure 13.8  Example of Router Sources for an Audio Mixer Soft Panel
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If sources are assigned to an audio mixer soft panel, you must assign a mixer sources drawer window.

If no sources are assigned, the audio mixer soft panel cannot route Ultrix sources to mixer inputs. Another panel 
must perform this function.

Audio Mixer Partitions

Select one or more audio mixer partition that this soft panel has access to. The mixer source and mixer destination 
lists provide information of the selected partition inputs and outputs as per the database definitions. (Figure 13.9)

Figure 13.9  Example of Partitions for an Audio Mixer Soft Panel

Assign an Audio Matrix to the Soft Panel
To assign an audio matrix to the soft panel

1. Select the Mixer tab.

2. From the Mixer Selection list, select the audio matrix you want to assign to the soft panel.

The Mixer Source and Mixer Destination lists update to display the available sources/destinations that have 
mixer I/O maps.

 The Mixer Source and Mixer Destination lists are read-only.

3. Click Apply to save your new soft panel.

Customizing the Soft Panel Layout
When creating an audio mixer soft panel, you also have the option to customize the different areas (windows) of the 
panel, and determine the width of each window, drawer, and their elements. A Home Page can be a collection of 
windows as defined during the soft panel configuration using the options in the Panels > Home View tab.

Table 13.1 summarizes the options for the types of windows you can assign to the Home Page of an audio mixer 
panel.



Ultrix User Guide (v18.0) ULTRIMIX-MXR • 137

Defining the Home Window Elements of a Soft Panel
The options for defining the Home Windows of a soft panel are arranged in a table format of the Home View tab. 
You can chose to use the default settings, or customize the width and number of rows/columns in each window 
independently.

 The order of the rows in the Home Windows table determine the order of the windows that display on the soft 
panel. For example, if the first row is assigned to Sources, the first window next to the main toolbar of the soft 
panel will display the Sources buttons.

To customize the layout of your audio mixer soft panel

1. To re-size the scroll bars on your soft panel:

a. Select the Info tab.

b. Use the Vertical Scrollbar Width field to determine the size of the bar that enables the user to scroll along 
the vertical axis of the soft panel.

c. Use the Horizontal Scrollbar Height field to determine the size of the bar that enables the user to scroll 
along the horizontal axis of the soft panel. 

d. Click Apply.

2. Select the Home View tab.

3. Use the Display Icons menu to specify whether buttons will display the default icons based on window type 
(Enable) or will only display the label text as determined by the database (Disable).

4. To add a window to the Home View:

Table 13.1  Home Page — Types of Windows

Window Type Description
Channel Strip Displays the controls for the inputs of the selected audio mixer

Output Strip Displays the controls for the outputs of the selected audio mixer

Mixer Destination Displays the audio mixer destination selection buttons

Monitor Displays read-only status information of the selected audio mixer

Sources Displays the router source selection buttons 



138 • ULTRIMIX-MXR Ultrix User Guide (v18.0)

a. Select a row in the Home Windows table.

b. Use the Up, Down, Top, Bottom, Sort buttons (located in the toolbar to the right of the table) to move a 
highlighted row to the desired position.

c. Click Add.

The Add Window dialog opens.

d. Use the Window menu to specify the first window to include in the soft panel. Choose from the following:

 You cannot have multiples of the same window in either Home windows or Drawer windows.

e. Click Apply.

The Add Window dialog closes and the Home Windows table updates to include the selection.

5. Repeat step 4 for each window you want to include in the soft panel.

6. Specify the order that the windows will display in the completed soft panel layout as follows:

 By default, the windows are organized in the following order (left to right): Channel Strip, and Output Strip.

a. In the Home Windows table, select the row for the window you want to move to on the soft panel layout.

b. Use the buttons in the toolbar to move the row to the desired position.

7. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel area.
• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display

8. Click Apply to save your changes.

Defining the Drawers on a Soft Panel
Soft panels to control an audio mixer can also include fly-out menus (drawers) that operate like horizontal 
drop-down menus. You can specify what menus, functions, and settings each drawer includes.

 By default the Drawer window is populated with a right-side Mixer Output window, a left-side Mixer Selection 
window, and a right-side Mixer Filters window. When multiple windows are assigned to either left or right 
drawers, the user must first select the drawer handle, then the window that is required.

Table 13.2 summarizes the options for the types of windows you can assign to the drawers of an audio mixer panel.

Table 13.3 summarizes the default sizes for the types of drawers for each type of audio mixer panel.

Table 13.2  Drawers — Types of Windows

Window Type Description
Mixer Outputs Displays the available audio mixer outputs. Select to switch the mixer 

panel current output bus.

Mixer Partition Displays the audio matrix (partition) selection buttons.

Audio Filters Displays the audio filter page for the currently selected channel strip.

Channel Balance Displays the audio channel balance slider.

Mixer Destinations Displays the router destination selection buttons in the specified drawer. 
Select to route the current mixer output to one or more Ultrix destinations.

Sources Displays the router source selection buttons in the specified drawer. Select 
to route an Ultrix source to the current mixer channel.
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To define the drawer elements of the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Home View tab.

3. Locate the Drawer Windows area of the tab.

4. Select a row in the Drawer Windows table.

 The order of the rows in the Drawer Windows table determine the order of the windows that display on the soft 
panel. For example, if the first row is assigned to Sources, the first window next to the main toolbar of the soft 
panel will display the Sources buttons.

5. Click Add.

The Add Drawer dialog opens.

6. Use the Type menu to specify the location of the drawer, in relation to the window it will be assigned to.

For example, if you select Type > Left and Window > Sources, the drawer will display on the left side of the 
Sources window.

7. Use the Window menu to specify the window to assign to the drawer to.

8. Click Apply.

The Add Window dialog closes and the Drawer Windows table updates to include the selection.

9. Repeat steps 5 to 8 for each drawer you want to include in the soft panel.

10. To customize a drawer size:

Table 13.3  Drawer Windows — Default Settings

Window Type Default Percent
Audio Mixer Desktop

Mixer Output 30

Mixer Selection 30

Mixer Filters 50

Audio Mixer 4RU

Mixer Output 30

Mixer Selection 30

Mixer Filters 100

Audio Mixer 2RU

Mixer Output 30

Mixer Selection 30

Mixer Filters 100



140 • ULTRIMIX-MXR Ultrix User Guide (v18.0)

a. Use the Width field to specify the percentage of the allocated drawer space.

b. Use the Rows field to specify the number of rows in the drawer will display.

c. Use the Columns field to specify the total number of columns in the drawer will display.

 You can also use the Drawer Width menu, located near the top of the Home View tab, to specify the width of 
the drawer handle size.

11. Repeat step 10 for each drawer of the soft panel you wish to re-size.

12. Click Apply to save your settings.

Soft Panel Features
The panel UI design are similar to Ultritouch approach where UI sections are categorized into UI windows. These 
UI windows can be placed in main display and/or drawers. 

Home View Window
By default, the channel strips are placed from left to right, and the output strips are placed at the far right.

Figure 13.10  Example of an Audio Mixer Soft Panel

1. Channel Strips

Each strip controls the input from that audio channel and are color coded for where the audio comes from. Each 
strip includes the name of the audio channel and the router source assigned to it. Clicking the router source name 
opens the router source selection drawer window if defined.

2. Noise Gate

Opens the Noise Gate page in the Audio Filters window. Refer to “Noise Gate” on page 142 for details.

3. Compressor/Limiter

Opens the Compressor/Limiter page in the Audio Filters window. Refer to “Compressor/Limiter” on page 143 
for details.

4. Equalizer

Opens the Equalizer page in the Audio Filters window. Refer to “Equalizer” on page 141 for details.



Ultrix User Guide (v18.0) ULTRIMIX-MXR • 141

5. Mute

Turn off the audio from this source. This does not change the level.

6. Audio Fader and Meter

Adjust the level of the audio from the source. 

7. Solo, Solo Clear

The solo action is dependant on the current mixer output.

› Master output — Selecting solo will route that channel to the defined Monitoring output. It does not affect the 
master output. Only those channels with solo activated will be connected to the Monitoring output.  If no 
channels have solo activated, the monitoring output follows the Master output.

› Aux outputs — Selecting solo MUTES all other inputs to the selected output bus.

Any channels with solo active will illuminate the Solo Clear button - even channels not currently visible.

Clicking Solo Clear disables any solo action for the selected output bus.

8. Output Strips

The output channel strip fader controls the over-all level for that mixer output. Use the scroll bar at the bottom or 
the mixer output drawer window to select a mixer output bus. 

9. Drawers

A navigation drawer is available on the left and right sides of the interface. Tap the drawer icon once to open a 
pane that provides access to additional menus and functions of your soft panel. Tap the drawer icon again to close 
the pane. The contents of a drawer is determined when the soft panel was configured.

10.Monitor Strip

The Master layer also has a Monitor output and level. By default, the Monitor strip reports the status of the last 
channel pair of the partition.

Audio Filters
By default, the audio filters are located in the right drawer of the soft panel. The following audio filters are available 
for each channel strip: audio equalizer, noise gate, and compressor/limiter. 

 At the top of each audio filter setting is a Clipping indicator to warn you if clipping is occurring in the Equalizer 
stage (EQ) or Compressor/Limiter stage (CL).

Equalizer
The audio equalizer (EQ) allows you to enhance the sound quality of audio sources. An independent equalizer is 
available for every audio fader in the system and allows for adjustment in four bands (low-shelf, mid-range, high 
mid-range, and high-shelf).

 You can adjust the EQ settings using the EQ graph or the specific slider control.

To configure an equalizer

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Equalizer.

In the example below, the Audio Filters window displays in the right drawer.
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3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the Low Shelf slider to adjust the gain of the low frequency band.

 You can also move the L point around on the graph to adjust the low shelf values.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Max Freq — set the maximum frequency that you want the low shelf audio band limited to (20Hz to 1kHz).

5. Use the Midrange 1 slider to adjust the gain of a midrange frequency band.

 You can also move the M1 point around on the graph to adjust the midrange 1 values. The dot below the M1 
allows you to adjust the Q ratio.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Center Freq — set the middle frequency of the audio band (20Hz to 20kHz).
• Q — set the bandwidth of the Q ratio filter (0.51 to 9.91). Note that adjusting the bandwidth also changes the 

frequency range the filter affects.

6. Use the Midrange 2 slider to adjust the gain of a midrange frequency band.

 You can also move the M2 point around on the graph to adjust the midrange 2 values. The dot below the M2 
allows you to adjust the Q ratio.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Center Freq — set the middle frequency of the audio band (20Hz to 20kHz).
• Q — set the Q ratio.

7. Use the High Shelf slider to adjust the gain of the high frequency band.

 You can also move the H point around on the graph to adjust the high shelf values.

• Gain — set the audio level of the frequency band (-20dB to 20dB).
• Min Freq — set the minimum frequency that you want the high shelf audio band limited to (20kHz to 

1kHz).

Noise Gate
A noise gate allows a signal above a certain selected threshold to pass through. Noise gates are typically used to 
reduce unwanted external sounds, and/or reduce natural channel noise.
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To configure the noise gate

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Noise Gate.

In the example below, the Noise Gate window displays in the right drawer.

3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the Threshold slider to specify the level at which the gate opens.

5. Use the Gain Reduction slider to 

6. Use the Attack slider to specify how quickly sounds louder than the threshold are affected.

7. Use the Release slider to specify how quickly sounds softer than the threshold are affected.

8. Select the Enable Clipping to 

 Click Reset Noise Gate to return all Noise Gate settings to the default values.

Compressor/Limiter
The audio compressor allows you to restrict audio levels from passing a threshold level. These are often used to 
prevent digital clipping of audio levels that are too high for output equipment. Once the threshold is reached, the 
compressor starts to reduce the gain at a specific ratio. The higher the compression ratio, the harsher the reduction 
in gain. The compression continues until the audio level falls below the threshold. You can adjust how quickly the 
compressor is applied once the threshold is surpassed as well as how long after the level drops below the threshold 
that the compressor is still applied.

 The compressor is said to be acting as a limiter when the compression ratio is set very high, or to infinity, and the 
attack time is set very low. This has the effect of causing a very abrupt flattening of the audio level once the 
threshold is reached.

To configure the Compressor/Limiter settings for the audio matrix inputs

1. Expand the applicable drawer to display the Audio Filters window.

2. Click Compressor/Limiter.

In the example below, the Compressor/Limiter window displays in the right drawer.
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3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the Threshold slider to select the level (dB) at which the compressor is applied.

5. Use the Compression slider to select the ratio for the amount of compression you want to apply. The higher the 
ratio the more compression is applied to lower the level. At infinity the audio level is limited to the threshold.

6. Use the Attack slider to select the amount of time (ms) you want to pass between the level surpassing the 
threshold and the full compression ratio being applied.

7. Use the Release slider to select the amount of time (ms) you want to pass between the level falling below the 
threshold and the compression ratio returning to 1:1 (no compression applied).

8. Use the Makeup slider to increase the gain of the audio after compression.

Adjusting the Balance an Audio Source
Adjusting the balance of an audio source adjusts the volume of the left and right stereo channel. For example, as 
you move the Balance slider to the right the volume of the right channel is increased and the volume of the left 
channel is decreased.

To adjust the balance of an audio source

1. Expand the applicable drawer to display the available window options.

2. Click Pre-Processors & Balance Control.

In the example below, the Pre-Processors & Balance Control window displays in the right drawer.
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3. Select an audio channel to modify.

In the example above, the user is modifying Channel 1.

4. Use the slider in the Balance area to adjust the volume of the left and right stereo channel.

Audio Processing Options
The audio mixer panel enables you to adjust the gain and phase invert, individually, each of the audio sources.

To configure the audio proc-amps for an audio source

1. Expand the applicable drawer to display the available window options.

2. Click Pre-Processors & Balance Control.

3. Select an audio channel to modify.

4. Use the Pre-Gain field to specify the amount of gain (dB) applied to the input channel. 

5. To invert a channel:

• Click Left Channel Phase Invert to inverts the audio signal of the left channel.
• Click Right Channel Phase Invert to inverts the audio signal of the right channel.

6. Click Input Sum to sum the left and right input channels. Both channels will carry the average ((A+B)/2) of the 
two input (Left and Right) channels. 

Loading the Audio Mixer Soft Panel
The audio mixer soft panels are only available in DashBoard. You can load a soft panel to the DashBoard window 
on your PC, or to an Ultritouch panel. Both methods are presented here.

To load an audio mixer soft panel to a desktop

1. Launch DashBoard on your PC as described in the section “Launching DashBoard” on page 23.

2. Locate the Ultrix in the Tree View of DashBoard.

3. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

4. Expand the Soft Panels node for the Ultrix. 

5. Double-click the node for the newly edited soft panel.
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The selected soft panel opens in the DashBoard window of your PC.

To load an audio mixer soft panel to an Ultritouch

1. On the Ultritouch hard panel display, tap .

The All Connections interface displays.

2. Tap the router you want to control via the Ultritouch.

3. Tap the second button.

The panel updates to display the router hierarchy much like the tree view in the router menu system.

4. Tap Soft Panels.

A list of available soft panels displays.

5. Tap the audio mixer soft panel for the Ultrix.

6. Tap Open.

The Ultritouch interface updates to display the selected soft panel.

Notes on Audio Mixing via a Soft Panel
If your audio mixer soft panel includes partitions, you can switch between matrices as follows:

1. Expand the applicable drawer to display the Mixer Selection window.

 By default, the Mixer Selection window is located in the left drawer of the soft panel.

2. Click the Partition button for the required mixer (partition).

• The channel strips and output strips are auto-populated.
• The mixer inputs are automatically routed to the mixer outputs.
• The soft panel recognizes a take transition from an external panel.

If your audio mixer soft panel includes router levels, sources, and destination, you can perform crosspoint switches 
as outlined in the“Soft Panels in DashBoard” on page 221.

Audio Mixer Operation
This section provides examples two possible audio mixer setups: a generic system and a.

Generic Setup
This example assumes the following generic setup seen in Table 13.4. Note that generic physical IO names shown 
for brevity.

Table 13.4  Example Mapping for Router Sources and Destinations

Video A1 A2
Source
SRC1 slot1.in[1].sdi slot1.in[1].audio.ch1 slot1.in[1].audio.ch2

SRC2 slot1.in[2].sdi slot1.in[2].audio.ch1 slot1.in[2].audio.ch2

SRC3 slot1.in[3].sdi slot1.in[3].audio.ch1 slot1.in[3].audio.ch2

... ... ... ...

MXR MSTR slot0.mixer-out[1] slot0.mixer-out[2]

MXR AUX1 slot0.mixer-out[3] slot0.mixer-out[4]
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To perform a simple route of audio mixer channels

1. To route a mixer output to a destination:

a. Choose a destination to receive the mix.

b. Choose a source for the destination.

2. To route a source audio to a mixer input:

a. Select the mixer input.

b. Select the required source.

With these route operations, we have routed the output of the Mixer Master bus (assuming Master is set to 
Out1 in the mixer partition settings), to our router destination DST 1, and then routed audio channels 1 and 2 
(as the mixer map is only configured for two channels in this example), of our router source SRC 3 to the mixer 
Channel strip 1.

Or, to look at it another way; audio channels 1 and 2 on router destination DST 1 are connected to the mixer 
Master bus. The Master bus has router source SRC 3 audio channels 1 and 2 via Channel strip 1.

3. To add another source to the mix:

... ... ... ...

Destination
Dest1 slot1.out[1].sdi slot1.out[1].audio.ch1 slot1.out[1].audio.ch2

Dest2 slot1.out[2].sdi slot1.out[2].audio.ch1 slot1.out[2].audio.ch2

Dest3 slot1.out[3].sdi slot1.out[3].audio.ch1 slot1.out[3].audio.ch2

... ... ... ...

MXR IN1 slot0.mixer-in[1] slot0.mixer-in[2]

MXR IN2 slot0.mixer-in[3] slot0.mixer-in[4]

... ... ... ...

Table 13.4  Example Mapping for Router Sources and Destinations

Video A1 A2



148 • ULTRIMIX-MXR Ultrix User Guide (v18.0)

a. Select another mixer input.

b. Select the source of the extra channels.

After this route, audio mixer Channel strip 2 receives the audio channels 1 and 2 of SRC 2. The MXR MSTR 
can have a mix of SRC 3 channels 1 and 2, and SRC 2 channels 1 and 2. Channel strip faders 1 and 2 control 
the mix of their respective sources. The Mixer Master fader controls the overall level of the mix.

Using Audio Mixer Direct Outputs
ULTRIMIX-MXR provides a direct channels strip output (pre-fader). This allows the use of the equalizer, 
compressor/limiter, and noise gate without requiring the effects to be routed through a mix bus.

In this example, we assume the mapping seen in Table 13.5.

With the above mapping, we can feed the output of the filters (noise gate, equalizer, compressor/limiter) to any 
destination.

Table 13.5  Example Mapping for Router Sources and Destinations

Video A1 A2
Source
SRC1 slot1.in[1].sdi slot1.in[1].audio.ch1 slot1.in[1].audio.ch2

SRC2 slot1.in[2].sdi slot1.in[2].audio.ch1 slot1.in[2].audio.ch2

SRC3 slot1.in[3].sdi slot1.in[3].audio.ch1 slot1.in[3].audio.ch2

... ... ... ...

FX1 slot0.mixerda-out[1]

a. The “d” in the mixer physical label represents Direct Out.

slot0.mixerd-out[2]

FX2 slot0.mixerd-out[3] slot0.mixerd-out[4]

... ... ... ...

Destination
Dest1 slot1.out[1].sdi slot1.out[1].audio.ch1 slot1.out[1].audio.ch2

Dest2 slot1.out[2].sdi slot1.out[2].audio.ch1 slot1.out[2].audio.ch2

Dest3 slot1.out[3].sdi slot1.out[3].audio.ch1 slot1.out[3].audio.ch2

... ... ... ...

MXR IN1 slot0.mixer-in[1] slot0.mixer-in[2]

MXR IN2 slot0.mixer-in[3] slot0.mixer-in[4]

... ... ... ...
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1. Route a channel strip direct output to a destination:

a. Select the required destination.

b. Select an output of the mixer as the source.

2. Route a source to the channel strip:

a. Select a mixer input as a destination for the source.

b. Select the required source.

With these route operations, we have routed the direct outputs of mixer Channel strip 1 to our router destination 
DST1, and then routed audio channels 1 and 2 of our router source SRC3 to the mixer Channel strip 1.

Or, to look at it another way; audio channels 1 and 2 on router destination DST1 are connected to router source 
SRC3 audio channels 1 and 2 via mixer Channel strip 1 filters (gate, compressor/limiter, and equalizer). The 
settings of the filters will effect the audio channels 1 and 2 of destination DST1.
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UltriScape Configuration
This chapter outlines how to create, edit, and manage your UltriScape layouts. 

Overview
Once you have set up the UltriScape hardware as outlined in “UltriScape Setup” on page 67:

1. Install the UltriScape license key. Refer to “Installing a License Key”.

2. Assign each UltriScape Head to an output. Refer to “Assigning an UltriScape Head to a Physical Router 
Output”.

3. Configure the UltriScape Heads and PiPs in your database. Refer to “Assigning the UltriScape Destinations”.

4. Navigate to the UltriScape Configuration interface to configure the global settings for all UltriScape Heads.

5. Create a new layout using the UltriScape Layout Editor.

6. Save the layout with a unique name.

7. Assign each required UltriScape Head to a layout. Refer to “Managing the UltriScape Heads”. 

Configuring the UltriScape Global Settings
UltriScape provides a central Configuration interface that allows you to set parameters that are common between 
PiPs, tallies, and labels. Global settings apply to all layouts with either Shared or Local PiPs.

Configuring the Local and Global PiP Settings
UltriScape supports two concurrent PiP sizes (A, B). Each PiP can be set to a specific dimension, allowing you to 
quickly set the size for the two PiPs and build layouts using the PiPs.

To set the Local PiP settings for all layouts

1. Double-click the Configuration node located under the Ultriscape node.

The Configuration interface opens.

2. Select the PiP Layout sub-tab located at the bottom of the Layout Editor Settings tab.
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3. Use the PiP Size A field to set the first of the common PiP sizes for the UltriScape layout1.

4. Use the PiP Size B field to set the second of the common PiP sizes for the UltriScape layout1.

5. Use the PiP SD Aspect Ratio options to set the aspect ratio to match the expected SD-SDI signal format (if 
applicable).

6. Use the Audio Meter options to set the audio meter green to yellow transition level.

7. Click Apply.

 Layout configurable properties are stored on the router and are accessible from any DashBoard client on the 
same network.

Configuring the Global PiP Border Settings
 You can specify the border width and placement for all layouts.

To specify the border location for the PiPs

1. Double-click the Configuration node located under the Ultriscape node.

The Configuration interface opens.

2. Select the PiP Layout sub-tab located at the bottom of the Layout Editor Settings tab.

3. Locate the PiP Video Alignment area in the PiP Layout sub-tab.

4. Use the Video options to specify where the PiP borders are drawn. Choose from the following:

• Overlap — The border displays as a layer over the video. The thicker the border width, the less of the video 
image displays within the PiP. This is the default. The Pip Border Width Override fields are now read-only.

• Frame — The border surrounds the image within the PiP. The image is scaled to fit within the PiP. This will 
override individual PiP border settings.

5. Click Apply.

To set the global PiP border widths for all layouts

1. Locate the PiP Border Width area in the PiP Layout sub-tab.

 This option is only available if the Video option was set to Frame during step 4 of the previous procedure.

2. Use the Border field to specify the border width in number of pixels.

3. Click Apply.

Configuring the Global Label Settings
You can also edit the global settings relating to the display of tally objects and the level of transparency for the label 
boxes overlaid on the PiPs. 

 Ultrix does not support Unicode characters.

To set the global label transparency setting for all layouts

1. Double-click the Configuration node located under the Ultriscape node.

2. Select the Label Settings sub-tab located at the bottom of the Layout Editor Settings tab.

1. Applying changes to PiP size settings may prevent the currently selected layout from displaying correctly.
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3. Use the Transparency slider to specify the level of transparency of the label background. 

UltriScape Layout Editor Overview
Use the UltriScape Layout Editor to manage your layouts. The workspace of the UltriScape Layout Editor provides 
a visual representation of how your PiPs will be organized in the final output. The tools and menus available enable 
you to define the number of PiPs in a layout, customize their display, and add labels, borders, and audio meters.

For More Information on...
• the menus and options in the Layout Editor, refer to the section “Layout Editor Interface” on page 363.

Figure 14.1  Example of a UltriScape Layout Editor Interface — LAYOUT-2.lay Template
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Shared and Local PiPs Overview
UltriScape provides two methods for addressing the PiP elements: Shared and Local.

What are Shared PiPs?

Shared PiPs are defined PiPs that may be displayed by any UltriScape output (head). Shared PiPs can lessen the 
quantity of definitions required when multiple UltriScape heads are required to access many of the same PiPs.

What are Local PiPs?

Local PiPs are PiPs defined for use with a particular UltriScape head. Local PiPs may only be used by the head for 
which they are defined.

Which PiP method should I choose?

Shared PiPs can be more convenient for multiple UltriScape Head systems where some or all PiPs are shown on 
more than one Multiviewer head (e.g. PiP 1 on Head 1 is the same as PiP 1 on Head 2). Changing the source for PiP 
1 requires one route or configuration change and both UltriScape Head outputs update simultaneously.

Local PiPs offer the advantage of independent control (e.g. PiP 1 on Head 1 is different to PiP 1 on Head 2). 
Changing the source for both those PiPs will require two routes or configuration changes.

Assigning the UltriScape Destinations
UltriScape Heads (Multiviewer outputs) and PiPs (Picture-in-Picture tiles) are required to be mapped in as logical 
destinations. To the router control system, they are a destination of the router and may be controlled as such from 
external controlling devices.

Ensure that for every licensed UltriScape Head:

• Each PiP of an UltriScape Head must be assigned to a destination within the router database.
• Each UltriScape Head must be assigned to a destination within the router database.

Identifying UltriScape Destinations in the Database
The UltriScape Heads and PiPs are identified much like a physical BNC using the standard nomenclature of 
Frame.Slot.Port.Type.Channel.

• UltriScape Local PiPs are identified as frame.slot n.headx-pip[y].sdi.ch1 where x represents the UltriScape 
Head ID and y represents the individual PiP. For example:

• UltriScape Shared PiPs are identified as frame.slot0.pip[y].sdi.ch1 where y represents the individual PiP 
number. For example:

• UltriScape Heads are identified as frame.slot n.head[x].sdi.ch1 where x represent the Head ID within a given 
slot (there can be up to 3). For example:



Ultrix User Guide (v18.0) UltriScape Configuration • 155

Assigning an UltriScape Destination
The assignment of UltriScape Heads and PiPs will enable the UltriScape sub-nodes in the Device Tree for further 
UltriScape configuration.

To assign an UltriScape destination in the database

1. Expand the Database node.

2. Double-click the Destinations node located under the Database node.

The Destinations tab opens. The number of rows are specified in the Destination field of the active database.

 If required, you can add Destinations to the list to accommodate the assignment of UltriScape Heads and PiPs.

3. If desired, type a new name for the destination in the Name cell as outlined in the procedure “To specify a 
label for a destination” on page 112.

4. In the table of the Destinations tab, locate the column for the level.

5. Assign an UltriScape Head to a Destination in the database as follows:

a. Click the cell of the Destination row in the table to display a list of available Destinations sockets.

b. Select the UltriScape Head you want to assign.

6. To assign a single PiP to a Destination:

a. Select the Destination to assign to the PIP.

b. Perform one of the following:

• Click the cell of the row in the table to display a list of available Destinations sockets.
• Choose a PiP from the available Matrix Outputs list and click Assign.

7. To associate a range of PiPs:

a. Select the first cell in the table column.

b. Press and hold Shift.

c. Select the last cell in the table column. 

d. Select a range of PiPs in the available Matrix Outputs list with same click, shift-click method.

e. Click Assign.

8. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

Using the Auto-Fill Function

You can also use the auto-fill function to populate the PiPs in the Destinations database.

When using the auto-fill function, we recommend naming PiPs for a particular UltriScape Head a base name that 
will distinguish them from PiPs for other UltriScape Heads. For example, using base names of S1H1P, S2H2P, and 
S3H3P for the first UltriScape Head on Slot 1, the second UltriScape Head on Slot 2, and the third head on Slot 3, 
respectively, would generate names for PiPs as follows:

S1H1P1, S1H1P2, S1H1P3, ...

S1H2P1, S1H2P2, S1H2P3, ...

S1H3P1, S1H3P2, S1H3P3, ...

In order to achieve these results the auto-generation would have to be done as three separate operations.

To use the auto-fill function to assign PiPs to destinations

1. Click Edit > Fill.

2. Set the Fill Type to Custom.
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3. Enter the desired base name in the Name field. (e.g. S4H1P)

 The starting and count fields define the trailing number for PiP identification.

4. Specify the starting and count values. (e.g. generally PiP range starts at 1)

5. Select the slot.

It should be of the form <frame name>.slot<n>.head-pip, where n is the slot of interest on the designated 
router.

6. Select the port. 

It should be of the form <frame name>.slot<n>.head<m>-pip[x], where m is the head whose PiPs are 
being assigned, and x is the PIP number. Normally x will be 1 (the first PiP on the UltriScape Head).

7. Select the starting channel. 

This should be of the form <frame name>.slot<n>.head-pip[x].sdi.ch1.

8. Specify the levels on which the PiPs for the selected UltriScape Head will be active.

9. Click Assign.

10. Click Apply.

11. Repeat the process for UltriScape Heads whose PiPs will be assigned while ensuring the correct slot, port, and 
starting channel are selected.

Creating a Layout
UltriScape layouts are created and stored within Ultrix to be assigned to a live UltriScape Head when needed. You 
create a new layout using one of the default templates or start with a blank layout then add your PiPs based on the 
selected PiP size settings. Both methods are outlined here.

By default, layouts are created using Local PiPs (for use only on a per head basis). Shared PiPs (for use with any 
UltriScape Head), require additional configuration. Refer to the section “Using Shared PiPs” on page 159 for more 
information.

Layout Templates
A layout is comprised of a series of tiles organized into a grid layout. Each tile in a layout represents a single Picture 
in Picture (PiP) element. Each tile displays a number that represents the PiP number. By default, the PiPs are 
organized with PiP1 in the top left corner of each layout. 

Creating a Layout using a Template
You can create a new layout using one of the default templates that come standard with UltriScape.

To load a layout template

1. Double-click the Layout Editor node located under the Ultriscape node.

The Layout Editor interface opens.

2. From the main toolbar, select File > Load Layout Template from Ultricore.

The Load Layout Template dialog opens.
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3. Select a template from the provided list.

4. Click OK.

The Layout Templates dialog closes and the UltriScape Layout Editor workspace now displays the selected 
template layout.

Creating a Custom Layout
Creating a custom layout clears the workspace and enables you to add your Local PiPs in a customized pattern.

To create a custom layout

1. Double-click the Layout Editor node located under the Ultriscape node.

The Layout Editor interface opens.

2. From the main toolbar, select File > New Layout.

The Create Blank Layout dialog opens.

3. Set the required dimensions for PiP sizes A, B, and C using the applicable fields in the lower toolbar of the 
Layout Editor.

In the following example, the user selected a new size for PiP C.

 It is possible to create a layout with different PiP sizing to the currently configured. The new layout will not 
output from the Ultriscape head if the PiP A or PiP B tiles do not match the values set in the Configuration > PiP 
Layout > PiP Size Selection menus. The PiP C tile size is defined by the layout it is in.
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4. Click OK.

To add a Local PiP to a layout

1. From the Objects toolbar, located on the left side of the Layout Editor, choose one of the following:

• Click PIP • A to add a PiP A tile to the layout.
• Click PIP • B to add a PiP B tile to the layout.
• Click PIP • C to add a PiP C tile to the layout. 

 You many only place one instance of a PiP C tile per layout.

2. If you wish, click Toggle Grid to display a grid background (and optionally snap to). The grid can help with the 
placement of the PiPs on your layout.

 You can change the grid dimensions by selecting Format > Grid from the main toolbar, specifying the 
horizontal (h) and vertical spacing (v), then clicking OK.

3. On the Layout Editor workspace, select the location for the Local PiP.

 For more precise positioning of PiPs on the layout, select Format > Grid > Snap To Grid.

The layout updates to display a new PiP.

In the following example, one large PiP was positioned on the right margin of the workspace and three smaller 
PiPs were positioned near the left margin.

4. Reposition the PiP by selecting and dragging with your mouse. 

• For fine, accurate movements, the keyboard arrow keys move the PiP in 2 pixel increments. 
• The top left of a PiP may be set by defining the left and top coordinates in the tool bar.   
• When PiPs overlap, a red Overlap message displays on the top right of the Layout Editor interface. 

Overlapping PiPs and/or elements will not function. The layout cannot be saved until the overlap is 
corrected.

5. Repeat for each PiP you wish to add to the layout.

 You may place multiple instances of PiP A and B tiles, but only one instance of the PiP C tile.

6. To save your layout to the system, select File > Save to Ultricore.
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Using Shared PiPs
Shared PiPs are PiPs that may be displayed on multiple UltriScape Heads. Updating the source for shared PiPs 
updates all Multiviewer layouts that contain that shared PiP definition.

For More Information on...
• the Shared PiP settings, refer to the section “Shared PiPs Tab” on page 366.

To configure a Shared PiP

1. Double-click the Layout Editor node located under the Ultriscape node.

The Layout Editor interface opens.

2. Select the Shared Pips tab.

The Shared Pips tab is organized as a table where each row represents a specific Shared PiP.

3. To configure a new Shared PiP, right-click the last row in the table and select Insert Row Below.

4. Use the Mode field to determine how sources are assigned to the PiP when in a layout regardless of the 
UltriScape Head. Choose from the following:

• Normal — The PiP monitors the Source that the Destination the PiP is assigned to is currently switched to 
(e.g. a PiP acts like a regular router destination).

• Follow — The source that the PiP displays is dependent on the source routed to the specified Destination.
• Source — The PiP displays the specified Source in the database.

5. Use the Source field to specify the resource that the Shared PiP will monitor. This applies to all layouts with 
this Shared PiP in all UltriScape Heads.

 The list of available resources depends on the database currently loaded.

6. If the Mode is set to Normal, use the Audio Mode field to configuring the audio meters for the Shared PiP in 
a layout regardless of the UltriScape Head. Choose from the following:

• Logical — the audio bars on the Shared PiP displays audio levels based on a source’s logical definition. The 
bars index from left to right (meter port channel 1 represents the leftmost audio meter bar, and meter port 
channel 16 represents rightmost possible audio meter bar).

• Physical — the audio bars on the Shared PiP represents the audio that is embedded in the SDI stream.

7. To configure the channel numbering for the audio meters in the Shared PiP:

a. Select the Audio Bars cell for the Shared PiP.

The Audio Channels dialog opens.

b. If the Audio Mode is set to Logical, select the audio levels to map to the audio meters.

 To select multiple levels/channels, press Ctrl then click the levels/channels to include.

c. If the Audio Mode is set to Physical, select the audio channels to map to the audio meters.

The Audio Bars cell updates to display the selected items, separated by commas.

8. Click Apply to save your changes.
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Adding a Shared PiP to a Layout
You can add a Shared PiP to any layout.

To add a Shared PiP to a layout

1. Create or load a layout in the UltriScape Layout Editor.

2. Right-click the PiP Number on the PiP tile you wish to convert to a Shared PiP.

The Set Shared PiP ID dialog opens. In the following example, PiP 3 was selected.

3. Use the Shared PiP ID menu to select the ID of the Shared PiP you want to add.

4. Click Set.

The Set Shared PiP dialog closes and the layout updates to display the Shared PiP ID inside the selected PiP.

5. To save your layout to the system, select File > Save to Ultricore.

Changing the Layout Background
The UltriScape Layout editor provides the option to insert a background color or background image. This will 
display in the space between PiPs.

To change the background color of a layout

1. Create a new layout as outlined in the section “Creating a Layout” on page 156 or load an existing layout as 
outlined in the section “Loading a Previously Saved Layout” on page 176.

2. From the bottom toolbar, set the Background menu to Solid Color.

3. Select the Background Color menu.

4. Select a color from the provided color grid in the dialog.

5. Click Choose to update the layout background.
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To change the background image of a layout

1. Create a new layout as outlined in the section “Creating a Layout” on page 156.

2. From the top toolbar, select File > Upload Background Image.

The Upload Background Image dialog opens.

3. Click Choose File.

The Open dialog opens.

4. Navigate to the image file you want to display, then click Open.

 Images must be 1920x1080 pixels or less.

The Open dialog closes and the Upload Background Image dialog updates with the new image.

5. Click OK to confirm the file upload to Ultrix.

6. Use the Background menu, located in the bottom toolbar, to select the image file.

The layout displays the selected image.

Editing the Border for a PiP
You can specify the border thickness for a single PiP or all the PiPs in a layout. Figure 14.2 shows a layout of four 
PiPs where PiP1 and PiP4 have a border set to 16. If the border is for a tally, as seen in PiP 4, the border color is 
always to dark blue. Refer to the section “Adding a Tally Border to a PiP” on page 197 for details.

Figure 14.2  Example of Borders

To edit the border width for a PiP

1. Create a layout in the UltriScape Layout Editor as outlined in the section “Creating a Layout” on page 156.

2. From the Objects toolbar, click SELECT.

3. Select the PiP to edit the border width for.

The PiP displays with a dotted yellow border and the Border Width field now displays under the Main toolbar. 
In the example below, PiP1 is selected.
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 Press Ctrl then click the PiP on the layout to unselect a single PiP.

4. From the top toolbar, use the Border Width field to specify the border width in number of pixels and lines.

5. Press Enter to apply the new width value.

To edit the border width for all PiPs in a layout

1. Create or load a layout in the UltriScape Layout Editor.

2. Right-click any PiP in the layout.

3. Click Select All.

The PiPs display with a dotted yellow border and the Border Width field now displays under the Main toolbar.

4. In the Border Width field, specify the border width in number of pixels and click Enter.

The border width for each PiP in the layout updates to the new size.
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Adding Objects to a Layout
Once a layout is created, you can add objects using Edit Mode. This section outlines how to add specific object 
types to a single layout.

What is a layout object?
An object is any element in a layout that is not a direct video source from the router. For example, a block of audio 
meters, or a text label. The following objects can be added to an UltriScape layout.

• UMD Labels — This object is a text area. The Under Monitor Display (UMD) or label can display static text, 
database names or text from a TSL tally manager device.

• Audio Meters — Each PiP can display up to 16 channel of audio meters. The audio meters can be positioned 
anywhere on the layout including outside of a PiP.

• Tally Borders, Labels, and Lamps — When tallies are enabled in a database, Ultrix will track the current tally 
status for all sources that have an associated Tally Display ID. When a PiP has a tally display object defined 
(such as a label, lamp, and/or border), the current source that is displayed on the PiP determines what is shown on 
the UltriScape Head display (based on the associated tally ID for that source). Refer to the chapter “Tallies” on 
page 189 for details.

• PiP Borders — You can adjust the size of each PiP border. A global setting sets the border to overlay on top of 
the video, or resize the video to fit within the border confines.

• Clocks — You can add a clock that reports the time of day, counts down from a set point, or counts up from zero.

Managing the Objects in a Layout
You can add new objects to PiPs in a layout using the options in the Objects toolbar. Simply select a PiP in the 
layout, select the tool for the object type you want to add, and draw a box to place the object on the PiP. Each object 
provides a series of menus for configuring the look and feel of the object on a PiP. You can add multiple objects to a 
single PiP, but objects cannot span multiple PiPs. 

Editing an Object

Any object in a layout can be re-sized, re-positioned, or deleted. The available configuration options for the object 
depends on its type. 

Grouping Objects in a Layout

You can select multiple PiPs in a layout by pressing Ctrl and then clicking the PiPs you want to group together. This 
enables you to quickly select and edit the properties of specific PiPs.

Cut/Paste Objects

You can select an object on a PiP, copy it, and then paste it to another location within that same PiP, to a different 
PiP in the same layout, or to a PiP in a separate layout.

Adding a UMD/Label
Labels can be added PiPs to provide source information. A PiP label (or Under Monitor Display) shows the 
database name for the currently displayed source (this will update when a different source is routed to the PiP). A 
PiP label may overlay the PiP image area, or be positioned outside the PiP if there free space available.

Additionally labels may also be configured to show static text or tally text from a tally management system.

When you place a label on a layout, the menus under the main toolbar update to include options for configuring 
your label. The top left corner of the label is defined by the Top and Left fields (in absolute pixels). The label height 
and width are defined by the corresponding fields. 
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The label type options change depending if placed on a PiP, or placed in free space:

• on a PiP — choose between PiP Source or Static Text
• in free space — choose between Static Text or the UltriScape Head identifier

To create a label using the database name as the content

1. Create or load a layout in the UltriScape Layout Editor.

2. From the Objects toolbar, click UMD.

3. Select the PiP to add the label to.

The PiP displays a new text area. It will automatically size to proportionally to the size of PiP the label was 
placed on. 

The Label Settings displays under the main toolbar.

4. Click and drag the label to a position outside of the PiP area if required.

For More Information on...
• adding a tally label, refer to the section “Adding a Tally Label to a PiP” on page 198.

To add static text to a label

1. From the Objects toolbar, click SELECT.

2. Select the label you wish to edit.

3. From the Type menu, select Static to display the text field under the main toolbar.

The text box on the PiP automatically displays “Input Text”.

4. In the text field, enter the content to display in the label for the PiP to a maximum of 121 characters. The text 
automatically re-sizes to fit inside- the text box.

5. Click Enter.

The label on the PiP automatically updates with the new text.

To re-size a label

1. From the Objects toolbar, click SELECT.

2. Select the label box you wish to re-size.

The box displays with a dotted yellow border with white nodes at the corners.
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3. Perform one of the following:

• Hover your cursor over the label box and expand its height using the provided tools; or
• Use the height menu to specify the number of pixels for the box height.

The text in the box automatically adjusts to the new box dimensions.

To re-position a label

1. From the Objects toolbar, click SELECT.

2. Select the label box you wish to move. 

The box displays with a dotted blue border with white nodes at the corners.

3. Perform one of the following:

• Hover your cursor over the label box and drag it into the new position on the PiP; or
• Use the top menu to specify the number of pixels to offset the box from the top of the PiP.
• Use the keyboard arrow keys to nudge selected objects around a PiP.

Adding a UMD Label to the Background
Layouts with blank areas, or sections where no PiP is positioned, can also display a label outside of the PiPs but still 
on the layout background. These labels can display static text or the Multiviewer Head label. By default, the width 
of the label is set to 300 pixels, and the height is set to 48 pixels.

To add a UMD label to free space

1. Create or load a layout in the UltriScape Layout Editor. Ensure the layout includes a blank area to position the 
UMD label in.

2. From the Objects toolbar, click UMD.

3. Click on the free space between PiPs to create a static text label. 

 If you wish the label to be controlled via the PiP source, click the PiP to create a label on the PiP, then select and 
drag the label to free space.

The text box on the layout automatically updates with “Unknown” and the Type menu displays.
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To create a UMD label with static text

1. Create or load a layout in the UltriScape Layout Editor.

2. Ensure the layout includes a blank area to position the UMD label in.

3. From the Objects toolbar, click UMD.

4. Draw a box for the label on the layout (but not on a PiP).

5. From the Type menu, select Static to display the text field under the main toolbar.

The text box updates to display “Input Text”.

6. In the text field, enter the content to display in the label.

7. Click Enter.

The text box on the PiP automatically updates with the new text.

To create a UMD label that displays the identifier of the UltriScape Head output

1. Create or load a layout in the UltriScape Layout Editor.

2. Ensure the layout includes a blank area to position the UMD label in.

3. From the Objects toolbar, click UMD.

4. Draw a box for the label on the layout (but not on a PiP).

5. Select Multiviewer Head Name from the Type menu.

The text box on the PiP updates to display “Unknown”.

 The label will automatically update when the layout is assigned to an UltriScape head. Refer to “Assigning a 
Layout to an UltriScape Head”.
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Adding a Block of Audio Meters
For each PiP, you have the ability to display up to 16 channels of audio in a single block of audio meters. The 
meters can be positionable individually anywhere in the layout (even outside of the PIP). The meters display the 
peak level of the waveform no matter how brief its duration. The audio meters report the audio peak level 
measurements for your audio channels. Measurement units are in decibel full scale (dBFS) where 0dBFS is the 
maximum digital value. Each audio meter displays audio level information as illustrated in Figure 14.3.

      
Figure 14.3  Illustrative Example of Audio Level Information

Audio meters may be configured in either Physical or Logical mode. Physical mode ensures the meter responds to 
audio that is associated with SDI currently feeding the PiP. Logical mode allows other audio sources to display.

To add an audio meter to a PiP

1. Create or load a layout in the UltriScape Layout Editor.

2. From the Objects toolbar, click METER.

3. Use the mouse pointer to indicate where to create the box for the audio meter on a PiP of the layout.

The box auto-populates with two static audio meters and the Audio Meter menus display under the main 
toolbar. An error message displays in the top right corner of the Layout Editor interface when a block of audio 
meters overlaps more than one PiP or another object in a layout.

 By default, the audio meters are aligned by the upper left corner of the selected PiP. Ensure that you click in a 
region that allows the meter to be positioned within the PiP to avoid the overlap.

0.00 dBFS

-10.00

-20.00 (or -18.00)

-70.00 No audio Non-PCM format Dolby format Silence
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4. To place audio meters outside a PiP:

a. Place the audio meters on a PiP.

b. Click and drag the meters to the required location on the layout.

5. Use the Number of Channels field to specify how many channels to display. 

To assign an audio channel to a meter

1. From the Objects toolbar, click SELECT.

2. Select the audio meters you want to configure.

The Audio Meter menus display under the main toolbar. The selected meters display a dotted yellow border.

3. Assign the first meter to a channel using the Meter Channels menu.

4. Click Assign Channels to update the channel assignments.

The channel assigned to the first meter determines the series of channels displayed in the meters. In the 
example below, a meter block of 8 channels was created in PiP 1.
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To re-position a block of audio meters

1. From the Objects toolbar, click SELECT.

2. Select the block of audio meters you wish to re-position.

The audio meters display with a dotted yellow border.

3. Perform one of the following:

• Click and drag the audio meters to their new position on the layout; or
• Use the keyboard arrow keys to nudge the audio meters on a PiP.

Assigning Logical Audio Meter Destinations
Audio meters may be set to Logical Mode to allow the display of audio levels of sources not associated with the 
video currently displayed on a PiP. The process is similar to defining a standard destination for the video level and 
any audio levels in the system. 

Keep the following in mind when assigning logical audio meters:

• Local PiP metering is identified by frame.slot n.head x.pip[y].meter.ch z where x represents the UltriScape 
Head number, y represents the PiP number, and z represents the audio channel number.

• Shared PiP metering is identified by the frame.slot 0.pip[y].meter.ch z where y represents the PiP number, and 
z represents the audio channel number.

To assign metering for logical operation

1. Assign a PiP to the video level.

2. Assign a PiP meter to the audio levels.

3. Refer to the section “Configuring the Audio Meter Logical Source Mode” on page 184.

Adding a Clock
When creating layouts with a clock object, you first must define the types of clock(s) available to add to a layout. 
The Clocks tab in the Layout Editor is used to define and list the available clocks. 

Defining a Clock
A clock can perform one of the following functions:

• Time-of-day — this clock is a 24 hour display of system time. You can add an offset to display time zone relative 
to the system time. By default, one clock is defined as this type.

• Count down — the clock counts down from a set point. This may be controlled via RossTalk commands or the 
clock control panel.

• Stop watch — the clock counts up from a value of 00:00:00. This may be controlled via RossTalk commands or 
the Clock Control interface.

To define a clock

1. Double-click the Layout Editor node located under the Ultriscape node.

The Layout Editor interface opens.

2. Select the Clocks tab.
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The Clocks tab is organized as a table where each row represents a specific clock that is available to add to 
your layouts.

3. Right-click the last row in the tab.

4. Select Insert Row Below.

A new blank row displays in the tab. The text “New Clock #” displays in the Name cell of the new row. In the 
example below, a new row was created for “New Clock 2”.

5. To name the clock:

a. Select the Name cell in the new row.

b. Type a unique identifier in the Name cell.

This text will be used to identify this clock object in the Layout Editor menus.

6. To assign a function to the clock:

a. Right-click the Type cell in the new row.

b. Select an option. Refer to Table 30.52 on page 367 for a list of options.

7. Use the Offset menu to specify an offset (hh:mm) relative to the system clock.

 This value is only applicable when Type is set to timeofday.

8. Use the Time Value menu to specify the timer start value (hh:mm:ss).

 This value is only applicable when Type is set to countdown.

9. Click Apply.

Adding a Clock to a Layout
A clock may be placed on a PiP or the layout background.

To add a clock to a PiP

1. Create or load a layout in the UltriScape Layout Editor.

2. From the Objects toolbar, click CLOCK.

3. Use the mouse pointer to indicate where to create the box for the clock on a PiP of the layout.

The box auto-populates with the text “Default Clock”. 
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4. From the Objects toolbar, click SELECT.

5. Select the clock box you created in step 3.

The Clock menus display under the main toolbar.

6. Use the Clock Source menu to specify the clock to use in the clock selected box.

The box auto-populates with the clock function you selected. 

 There may be only four clocks in a horizontal line across the layout. The bounding box (dotted outline) of small 
clocks increases to indicate this.

Copying Objects in a Layout
Using hot-keys, you can quickly select, and copy individual or groups of objects from one PiP to another PiP, 
multiple PiPs, or to a PiP in another layout. When you select a PiP, all of its associated objects are also selected (as 
a group) and can be move or re-sized as a group. Clicking the PiP again, or any of the objects, will then select that 
object only.



172 • UltriScape Configuration Ultrix User Guide (v18.0)

To copy a single object in a PiP

1. Create or load a layout in the UltriScape Layout Editor.

2. Configure the object of the PiP as required.

3. From the Objects toolbar, click SELECT.

4. Select the object in the PiP.

The object displays a dotted yellow border.

5. Press Ctrl + C or right-click the object and select Copy.

To copy all objects in a single PiP

1. Create or load a layout in the UltriScape Layout Editor.

2. Configure the objects of the PiP as required.

3. From the Objects toolbar, click SELECT.

4. Select the PiP with the objects you want to copy. 

The PiPs displays a dotted yellow border.

5. Press Ctrl + C or right-click the object and select Copy.

To copy a selection of objects in a single PiP

1. Create or load a layout in the UltriScape Layout Editor.

2. Configure the objects in your layout as required.

3. From the Objects toolbar, click SELECT.

4. Select the first object you want to copy. 

The object displays a dotted yellow border.

5. Press and hold Ctrl as you select additional objects to copy.

The additional selected objects now display a blue border.

6. Press Ctrl + C.

Pasting Objects in a Layout
Using hot-keys, you can quickly paste objects from one PiP to another PiP, multiple PiPs, or to a PiP in another 
layout. If you are pasting the contents of one PiP to another PiP of a different size, the objects are automatically 
re-sized to fit the new PiP. The position of the objects within the new PiP reflects the position in the original PiP.

 An object is pasted where your cursor was last positioned within the selected PiP. For example, if you selected a 
PiP by clicking in its center, the object will be pasted to the center of the new PiP.

To paste an object to a PiP in the same layout

1. Copy the object using one of the methods in the section “Copying Objects in a Layout” on page 171.

2. From the Objects toolbar, click SELECT.

3. Select the PiP to paste the object into.

The PiP displays with a dotted yellow border.

4. Press Ctrl + V.

A copy of the object is added to the selected PiP.

 If the PiP that the object is pasted into is a different size from the original PiP, an error message displays alerting 
you that the pasted object now straddles multiple PiPs.
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To paste an object to multiple PiPs in the same layout

1. Copy the object using one of the methods in the section “Copying Objects in a Layout” on page 171.

2. From the Objects toolbar, click SELECT.

3. Select the PiPs to paste the object into.

The selected PiPs display with a dotted yellow border.

4. Press Ctrl + V.

A copy of the object is added to all the selected PiPs.

To paste an object to a PiP of a different layout

1. Save the changes to the current layout if required as outlined in the section “To save a layout to the local 
DashBoard client computer” on page 175.

2. Copy the object(s) using one of the methods in the section “Copying Objects in a Layout” on page 171.

3. Load the layout you wish to paste the object(s) into as outlined in the section “To load a layout template” on 
page 156.

4. From the Objects toolbar, click SELECT.

5. Select the PiP to paste the object(s) into.

The PiP displays with a dotted yellow border.

6. Press Ctrl + V.

A copy of the object(s) is added to the selected PiP.

 If the PiP that the object is pasted into is a different size from the original PiP, an error message displays alerting 
you that the pasted object now straddles multiple PiPs.

Using PiP Templates
Once you have configured a PiP, you can save it as a PiP template to be applied to other PiPs in the same layout, or 
other active layouts. Note that a PiP template only captures the objects and their placement on the PiP and not the 
PiP Simulation Color.

To save a PiP as a new template

1. Create or load a layout in the UltriScape Layout Editor.

2. Configure the objects of the PiP as required.

3. From the Objects toolbar, click SELECT.

4. Select the PiP.

The PiP displays with a dotted yellow border.

5. From the main toolbar, click SAVE PiP.

The Save PiP Template dialog opens.
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6. In the PiP Template Name field, type a unique identifier.

7. Click OK to save the current PiP settings as a new PiP template and close the dialog.

To apply a PiP template

1. Create or load a layout in the UltriScape Layout Editor.

2. From the Objects toolbar, click SELECT.

3. Select the PiP to apply the template to.

The PiP displays with a dotted yellow border.

4. From the main toolbar, click LOAD PiP.

The Load PiP Template dialog opens.

5. Select a template from the list.

6. Click OK to apply the template to the selected PiP and close the dialog.

To delete a PiP template

1. From the main toolbar, select File > Delete PiP.

The Delete PiP Templates dialog opens.
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2. Select a template from the list.

3. Click OK to apply the template to the selected PiP and close the dialog.

Any PiPs that had the template applied are not affected, but the PiP template will no longer be made available 
for applying to future PiPs.

Saving a Layout to the Multiviewer System
Before a layout can be assigned to a UltriScape Head, you must first publish the layout and make it available to the 
Multiviewer system. Once a layout is published, it is available for use by all UltriScape Heads in your routing 
system and appears in the Activate Layout area of the UltriScape Head interface.

To save a layout to the database

1. Create or load a layout in the UltriScape Layout Editor.

2. Edit your PiPs as required.

3. Save your layout changes.

4. From the main toolbar, select File > Save to Ultricore.

The Save Layout dialog opens.

5. To overwrite a previously published layout in the Ultricore system:

a. Select a layout to overwrite from the provided list.

b. Click OK.

6. To publish the layout as a new layout in the Ultricore system:

a. Type a unique identifier for the layout in the Layout Name field.

b. Click OK.

Saving a Layout as a Local Copy
When you save a layout, it saves a local copy to the computer running your DashBoard client. To make the layout 
available to the routing system, you must publish the layout as outlined in “Saving a Layout to the Multiviewer 
System” on page 175.

To save a layout to the local DashBoard client computer

1. Create or load a layout in the UltriScape Layout Editor.

2. Edit your PiPs as required.

3. From the main toolbar, select File > Save to Local.
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The Save to Local dialog opens.

4. Type a unique identifier for the layout in the Layout Name field.

5. Click OK to save your changes.

The Save to Local dialog closes.

Loading a Previously Saved Layout
Loading a saved layout automatically clears the Layout Editor workspace. 

To load a previously saved local layout

1. From the main toolbar, select File > Load from Local.

The Open Layout dialog opens.

2. Select a layout from the provided list.

3. Click OK.

The Load Layout dialog closes and the UltriScape Layout Editor workspace updates with the selected layout.

To load a previously saved layout in Ultricore

1. From the main toolbar, select File > Load from Ultricore.

The Load Layout dialog opens.

2. Select a layout from the provided list.

3. Click OK.

The Load Layout dialog closes and the UltriScape Layout Editor workspace updates with the selected layout.

Managing your Layouts
A layout can be archived by saving it as a *.lay file to a specified location. This enables you to import and export an 
archived layout.

 This feature requires DashBoard v8.2 or higher and Ultrix software version 2.0 or higher.

Exporting a Layout
You create an archive of a layout (as a *.lay file) using the options in the System Status > Transfer tab.

 The following information is not captured: hardware specifics, and license settings.

To export an UltriScape layout

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Select the UltriScape Layout tab.

4. Locate the Export UltriScape Layout area on the tab.

5. Use the Layout field to select the layout to export.

6. Click Browse... to specify the location to save the *.lay file to.

The Save As read-only field updates with the selected path and layout name.

7. Click Export.

The Downloading Archive dialog opens to report the status of the export.
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Importing a Layout
Once a layout is imported from the archive to your system, you can select it from the list of layouts to load in the 
UltriScape > Layout Editor > Load from Local menu and the Head Selection > Activate Layout area.

To import an UltriScape layout

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Select the UltriScape Layout tab.

4. Locate the Import UltriScape Layout area.

5. Select the *.lay file you wish to import as follows:

a. Click Browse... 

The Open dialog opens.

b. Use the Open dialog to specify the *.lay file to import.

c. Click Open to close the dialog and load the file.

6. Click Import.

The Uploading Archive dialog opens to report the status of the transfer.

7. Verify that the imported layout is now available for selection in the following locations:

a. UltriScape > Layout Editor > Load from Ultricore menu

b. UltriScape > Head Selection > Activate Layout area

Deleting a Layout
 If the layout is not displayed in the Delete Layout dialog, it is currently in use by a UltriScape Head.

To delete a layout from the Ultricore system

1. From the main toolbar, select File > Delete Layout from Ultricore.

The Delete Layout dialog opens.

2. Select the layout from the provided list.

3. Click OK to delete the layout from the Ultricore system.

Clearing the Workspace
Changes and updates to layouts and PiPs only take effect if you save the new settings. You can clear the workspace 
and start over.

 Any unsaved changes to the current layout will be discarded.

To clear the workspace

• From the main toolbar, select Edit > Clear All.
The Workspace area is now blank.
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Managing the UltriScape Heads
This chapter summarizes how to load and assign a layout to an UltriScape Head, and assign router sources to PiPs 
in a layout.

For More Information on...
• assigning an UltriScape Head to a router output, refer to the section “Assigning an UltriScape Head to a 

Physical Router Output” on page 68.

Before You Begin
Keep the following in mind when configuring an UltriScape Head:

• The UltriScape Layout Editor look matches the output UltriScape Head to the pixel. The output is selectable 
between either 1080p or 1080i. Refer to the section “To assign an UltriScape Head to a router output” on 
page 68.

• The UltriScape license is on a per head basis. When not licensed, the UltriScape Layout Editor is available, but 
you cannot assign any layouts to an UltriScape Head.

• Ancillary data is stripped, except for audio; SMPTE 352 and AFD packets are re-generated and output by the 
system.

• The output aspect ratio is always 16:9
• If a PIP is set to follow a router destination, audio levels reflect any processing done (gain, shuffle etc.).
• If a PIP is set to follow a source, it reports the source audio information without any processing.
• Ultrix does not support Unicode characters.

Head Selection Interface
The Head Selection interface is organized into a series of tabs, each representing an enable Head. Each Head 
Selection tab is divided into three areas: Activate Layout (top area), Source Selection (middle area), and Settings 
(bottom area).

Figure 15.1  Example of the Head Selection Interface
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Activate Layout Area

The Activate Layout area is the top half of the interface. This area provides a visual representation of each layout 
that is enabled in your routing system. Multiple routers can load a layout at the same time. Each PiP is numbered (1, 
2, 3 etc.) to enable quick identification when assigning sources. The currently selected Layout for the UltriScape 
Head output displays a blue border, and its name is displayed in the Layout Name field. In the example above, the 
L16box_all.lay is selected. A layout will appear gray to indicate the PiP sizes within the layout do not match the 
current settings. These layouts cannot be selected for UltriScape output until the Configuration > PiP Layout > PiP 
Size Selection settings for Pip A and PiP B match those on the layout. 

Source Selection Area

You assign sources to a PiP using the list provided in the Source Selection area of the UltriScape Head interface. 
The menu for each PiP lists the input signals available via the IN sockets for the Ultrix router you are configuring 
the UltriScape Head for. The number of PiP menus depends on the number of tiles in the currently selected layout.

Head Audio Meter Settings

The Head Audio Meter Settings enable you to specify whether the audio bars on PiPs represent the audio that is 
embedded in the SDI stream (Physical mode), or if audio bars on PiPs display audio levels based on a source’s 
logical definition (Logical mode).

For More Information on...
• the Head Audio Meter Settings, refer to the section “Audio Meter Modes Setup” on page 183.

Assigning a Layout to an UltriScape Head
Each UltriScape Head in your system can use the same layout, or different layouts depending on your needs. Both 
instances share the same layout properties, but can have different sources assigned to each PiP. The list of available 
sources to assign to each PiP depends on the currently loaded database for the Ultrix router.

To assign a layout to an UltriScape Head

1. Double-click the Ultrix router in the Basic Tree View of DashBoard.

The tree for the router expands.

2. Expand the UltriScape node.

3. Double-click the Head Selection node.

The Head Selection tab displays in the right side of the DashBoard window. Each UltriScape Head displays as 
a sub-tab in this window.

4. Select a layout from the Activate Layout area of the tab.

The Head Selection tab updates to list the number of PiPs in the selected layout. In the example below, 
layout 2_4_4Box_UMD.lay is selected.

5. Click Apply at the bottom of the Head Selection tab.
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PiP Layout Mapping Overview
This section provides examples to illustrate the PiP assignment in a layout where:

• x is the slot number counted from the top of the layout starting at 1.
• n is the UltriScape Output Head number. The actual physical port this output appears on is defined by the Port 

License tab of the Ultrix Hardware Interface.

Example using the LAYOUT-01 Template
This template is a 2+8 layout with a total number of 10 PiPs available to map.

Figure 15.2  Example of the LAYOUT-01 Template

Table 15.1 outlines the destination assignment for each PiP in the LAYOUT-01 template.

Table 15.1  PiP Layout Mapping — LAYOUT-01 Template

PiP Number Destination Assignment
1 Ultrix.slotx.headn-pip[1]

2 Ultrix.slotx.headn-pip[2]

3 Ultrix.slotx.headn-pip[3]

4 Ultrix.slotx.headn-pip[4]

5 Ultrix.slotx.headn-pip[5]

6 Ultrix.slotx.headn-pip[6]

7 Ultrix.slotx.headn-pip[7]

8 Ultrix.slotx.headn-pip[8]

9 Ultrix.slotx.headn-pip[9]

10 Ultrix.slotx.headn-pip[10]
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Example using the LAYOUT-02 Template
This template is a 2x2 layout with a total number of 4 PiPs available to map. In this example, the user altered the 
template to utilize shared PiPs.

Figure 15.3  Example of the LAYOUT-02 Template

Table 15.2 outlines the destination assignment for each PiP in the LAYOUT-02 template.

Multiple Heads
If multiple heads are configured, destination assignments must be defined for all heads and PiPs.

Table 15.2  PiP Layout Mapping — LAYOUT-02 Template

PiP Number Destination Assignment
1 Ultrix.slot0.headn-pip[1]

2 Ultrix.slot0.headn-pip[2]

3 Ultrix.slot0.headn-pip[3]

4 Ultrix.slot0.headn-pip[4]

Table 15.3  PiP Layout Mapping — Multiple Heads

Name Destination Assignment
MV Head 1 Ultrix.slot1.head1.sdi.ch1

MV1 PiP1 Ultrix.slot1.head1-pip[1]

MV1 PiP 2 Ultrix.slot1.head1-pip[2]

...more MV1 PiP Assignments

MV Head 2 Ultrix.slot2.head1.sdi.ch1

MV2 PiP1 Ultrix.slot2.head1-pip[1]

MV2 PiP 2 Ultrix.slot2.head1-pip[2]

...more MV2 PiP Assignments
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Assigning a Source to a PiP
A PIP source is controlled by routing just like any destination. Each PiP can be configured as a ‘direct source’ take 
operation or a ‘destination follow’ operation (where they switch to the same input signal that a destination is 
switched to).

Each PiP in a layout is assigned a video signal from the Head Selection interface. If the input signal includes 
embedded audio, the audio is included in the UltriScape Head output.

The source selection area is for initial setting and quick visual changes. The Ultrix router can override these 
selections by directly routing to the PiP destinations. The Head control source selection area may not update to 
show current status if direct control changes have been applied.

When assigning new sources to the PiPs of an UltriScape Head, you can display sources:

• of different formats on the same head at one given time.
• with no assumed timing relationship on the same head at one given time.

To assign a source to a PiP

1. Assign a layout to the UltriScape Head as outlined in the section “To assign a layout to an UltriScape Head” 
on page 180.

 The options in the PiP Source menus depend on the sources and destinations configured in the currently loaded 
database.

2. For each PiP in the layout, select a source from its PiP Source menu. Choose from the following:

• Normal — The PiP displays the source that the Destination the PiP is assigned to is currently switched to 
(e.g. a PiP acts like a regular router destination). Refer to the section “To assign an UltriScape destination 
in the database” on page 155 for information on assigning PiPs to Destinations.This is the default setting 
for all PiPs. 

• Src # — The PiP displays the specified Source in the database.
• Follow Dest # — The source that the PiP displays is dependent on the source routed to the specified 

Destination. In the following example, PiP 5 is set to Follow Dest 10. If the user switches Dest 10 to Src 3, 
PiP 5 displays Src 3. If Dest 10 then switches to Src 30, PiP 5 will then display Src 30.

3. Click Apply at the bottom of the Head Selection tab.

Audio Meter Modes Setup
This section outlines how to set up and monitor audio meters for PiPs that are configured for Normal or Default 
Source modes. There are two source modes when configuring audio meters:

• Physical Source mode — the audio bars on PiPs represent the audio that is embedded in the SDI stream. This is 
the default mode.

• Logical Source mode — the audio bars on PiPs display audio levels based on a source’s logical definition. The 
bars index from left to right (meter port channel 1 represents the leftmost audio meter bar, and meter port channel 
16 represents rightmost possible audio meter bar).
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Overview
A PiP containing a defined audio meter object may be configured to represent the audio from a variety of sources as 
outlined in Table 15.4.

By default, UltriScape Heads will be in Physical mode, which shows the levels for the audio embedded in the SDI 
stream currently displayed on the PiP.

To enable an UltriScape Head to show display audio metering based on the logical source definition, select Logical 
from the Head Audio Meter Settings menu in the Head Selection interface.

Figure 15.4  Head Audio Meter Settings Menu

Note that when activated, the Logical Mode setting:

• is global to the UltriScape Head and it affects all PiPs defined on the Head that are not set to Dest Follow. The 
Logical mode is enabled regardless of which layout is applied to the UltriScape Head.

• causes the affected PiPs to ignore the meter channels assignment made in the active layout's PiP definition 
(which are only used for Physical mode). The same number of meter bars defined in the PiP is still displayed.

• requires that PiP meter ports be assigned in the logical database to map the meter to audio channels; otherwise no 
audio levels will be displayed for PiPs that are set to Normal or Source #.

 Audio meters on PiPs set to Dest Follow, by definition, will always show what has been embedded into the 
output SDI stream, regardless of the Head Audio Meter Setting.

Configuring the Audio Meter Logical Source Mode
In order for the PiPs to display logical source audio levels, the audio meters' ports must be assigned to logical 
destinations associated with the UltriScape PiPs.

Each available PiP SDI port in the system will now have associated with it 16 'meter' ports; one for each possible 
audio bar in a meter. These ports should be mapped to the audio levels within the database. The bars index from left 
to right (meter port channel 1 represents the leftmost audio meter bar, and meter port channel 16 represents 
rightmost possible audio meter bar). It is not required to add meter port entries to the database for bars that will not 
be shown in a PiP. Figure 15.5 provides an example where the SDI for the video source and two audio (A1 and A2 
levels) for the metering.

Figure 15.5  Example of Defining the Audio Meter Ports

There are two stages to configuring Audio Meter Logical Source mode support:

Table 15.4  Audio Meter Settings

PiP Mode
Audio Meter Mode

Physical Logical
Source Audio from the SDI source Router audio channels

Normal Audio from routed SDI source Routed audio channels

Dest Follow Audio from destination SDI Audio from destination SDI
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1. UltriScape Layout and Head Configuration

2. Logical Database Configuration

Audio Meter Behaviors

Table 15.5 summarizes the behaviors for the Audio meters in Physical vs. Logical mode under various switching 
scenarios. Note for all “Logical” switching scenarios, the assumption is that the UltriScape Layout/Head is 
configured for meters and that the appropriate meter ports have been assigned to the database as required.

Notes
• If the input port is from an UltriMix enabled slot, then the logical definition can be used to route the audio.
• To see the physical audio associated with an UltriMix input, there would need to be an additional source defined 

in the logical database that has the appropriate pass through (or audio ports) assigned (similar to defining 
“breakaway” audio sources) (or the user can set the UltriScape Head to Physical mode).

Configuration Example
Consider the following scenario: a bilingual source is defined where the English audio appears on embedded 
channels 1 and 2, and the French audio appears on embedded channels 3 and 4 and a PiP destination is defined to 
have audio metering showing 2 channels.

When the user routes source 'Src 1 EN' to the PiP, it will display the SDI from Slot1.in[1] port, and the embedded 
audio channels 1 and 2 will be mapped to the PiP meters 1 and 2.

Table 15.5  Expected Audio Meter Behavior

Audio Meter 
Source Mode Source Port Definition

Input 
License Result

Logical No Logical Audio defined No Bars active (Physical shown)

Logical No Logical Audio defined Yes No bar activity

Logical Logical Audio defined Yes Bars Active (Logical shown)

Logical Logical with pass-through port Yes Bars Active (Logical shown, Physical on pass-through)

Logical Port set to ‘Bypass’ Yes Bars Active (Physical shown)

Physical No Logical defined No Bars active (Physical shown)

Physical No Logical defined Yes Bars active (Physical shown)

Physical Logical Audio defined Yes Bars active (Physical shown)

Physical Logical with pass-through port Yes Bars active (Physical shown)

Physical Port set to ‘Bypass’ Yes Bars active (Physical shown)

Table 15.6  Example 1

SDI Level Level A1 Level A2
Source Name

Src 1 EN Slot1.in[1] Slot1.in[1].ch1 Slot1.in[1].ch2

Src 1 FR Slot1.in[1] Slot1.in[1].ch3 Slot1.in[1].ch4

Destination Name

PiP1 Head1-pip[1] pip[1].meter.ch1 pip[1].meter.ch2
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When the user routes source 'Src 1 FR' to the PiP, it will display the SDI from Slot1.in[1] port, and the embedded 
audio channels 3 and 4 will be mapped to the PiP meters 1 and 2.

UltriScape Layout and Head Configuration
When activated, the Logical Mode setting is global to the Head and affects all PiPs defined on that Head that are not 
in Dest Follow mode. The Logical Mode is enabled regardless of which layout is active on the Head. 

To enable logical source mode on a PiP of an UltriScape Head

1. Define an UltriScape layout with PiPs that include audio meters as outlined in the section “Adding a Block of 
Audio Meters” on page 167.

2. Activate the layout on the required UltriScape Head as outlined in the section “Assigning a Layout to an 
UltriScape Head” on page 180.

3. Define the sources for each PiP in the layout as outlined in the section “Assigning a Source to a PiP” on 
page 183.

4. Make a note of which PiPs in the layout display the audio meter bar(s) you wish to configured. This 
information is required when assigning meter ports in the database.

 The audio meters on PiPs set to Dest Follow mode always represent what has been embedded into the output 
SDI stream, regardless of the Head’s Audio Meter setting.

5. Select Logical from the Head Audio Meter Settings menu located at the bottom of the Head Selection tab.

 To disable the Logical Mode, select Physical from the Head Audio Meter Setting menu.

Logical Database Configuration
This section outlines the database configuration steps necessary to enable Logical Source Audio meter support on a 
UltriScape PiP and Head.

To assign PiP audio meter ports to Multiviewer PiP Destinations

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens. The Matrix Outputs list, located to the far right, displays the PiP meter ports for 
licensed UltriScape Heads, as shown below. Note that you may need to scroll through the list, or use the 
provided drop-down menu, to locate the PiP meter ports.

2. Assign the UltriScape Head to a Destination in the database as outlined in the section “Assigning an 
UltriScape Head to a Physical Router Output” on page 68.

3. Assign a PiP audio meter port to level for that Head Destination as follows:

 The database level to which the meter bar’s port is assigned determines the signal for which the bar will display 
audio meter data when switched. The bar will display the audio meter data from the audio port channel assigned 
to the corresponding level of a logical source when switched to the PIP destination.

a. Select the first cell in the first Level column of the Destination row for the Head output.

This will be the first meter bar in the PiP.



Ultrix User Guide (v18.0) Managing the UltriScape Heads • 187

a. Choose a PiP meter output from the available Matrix Outputs list. 

The meter outputs are labeled as Ultrix.slot#head#-pip[#].meter.ch#. For example, to assign the 
first bar for the second PiP of Head 3, you would select Ultrix.slot#head3-pip[2].meter.ch1.

b. Click Assign.

4. Repeat step 3 for each audio meter bar you want to assign.

5. Click Apply at the bottom of the Destinations tab to save your changes.

 It is not required to add meter port entries to the database for bars that will not be shown in a PiP.

Clock Control
The procedure for operating a clock in UltriScape is the same for either countdown or stopwatch types. There is no 
control option for time-of-day clocks.

For More Information on...
• the Clock Control interface, refer to the section “Clock Control Interface” on page 368.

To use a clock

1. Configure your clock type(s) as outlined in the section “To define a clock” on page 169.

2. Add a clock to an UltriScape layout as outlined in the section “To add a clock to a PiP” on page 170.

3. Assign the layout to an UltriScape Head as outlined in the section “Assigning a Layout to an UltriScape 
Head” on page 180.

4. Double-click the Clock Control sud-node in the UltriScape tree.

The Clock Control tab opens.

5. Select the row for the Clock ID for the stopwatch you wish to use.

6. Use the buttons in the right toolbar to control the clock. Choose from the following:

• PLAY — starts the stopwatch or countdown timer.
• RESET — stops the stopwatch or countdown timer and resets it 00:00:00.
• PAUSE — temporarily stops the stopwatch or countdown timer without resetting to start point. Click this 

button again to re-start the clock.
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Tallies
The Ultrix accepts TSL UMD tally messages, and passes tally status notifications to a configured UltriScape Head. 
Tally messages associated with a router source may also be passed to the routed destination tally status. Tally 
information may be associated with either routing system sources or destinations.

For More Information on...
• the TSL UMD protocols that Ultrix supports, refer to the chapter “External Control” on page 263.

Tally Types
Tally information may be associated with either routing system sources or destinations.

 Ultrix does not support Unicode characters.

Source Association

Tally IDs associated with routing system sources may serve two purposes:

1. Trigger any UltriScape Multiviewer to display tally status (this requires that the Ultrix router has at least one 
UltriScape Head enabled and configured).

2. Enable the tally status to be mapped to other Tally IDs based on router crosspoint status (the destination must 
have Tally ID associated and Tally Re-direct enabled).

To associate Tally IDs to sources in the database you must:

• Use the Sources tab in the Database interface to associate the Tally IDs with logical sources in the Ultrix 
database.

• Specify the UMD “Tally Level” using the Tally Status Level menu in the Levels tab.

Destination Association

A Tally ID may be associated with routing system destinations. This enables any tally status associated with router 
sources to map to a different Tally ID associated with a router destination, based on current router crosspoint status.

• Use the Destinations tab in the Database interface to associate Tally IDs with logical destinations.
• When a source is switched to a destination on the selected Tally Level, Ultrix forwards the tally status of the 

source that is active on the destination, but the outbound TSL message has its display ID re-mapped to the 
display ID that is associated with the destination (Tally Redirect is set to ON).

 Ensure the destination Tally IDs do not conflict with Tally IDs asserted by other devices.

• When the TallyID is associated with an UltriScape PiP (slotn.headx-pip[y] or slot0.pip[y]), any assertion on this 
TallyID will directly control the PiP tally visual elements and over ride any Tally associated with the PiP video 
source (Tally Redirect is set to OFF).

• For switcher support, the label of the connected source to a destination is sent as TSL tally text (TSL v3.1 only 
and when Tally Redirects is set to OFF).
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Tally ID Format
Table 16.1 summarizes the format that the TSL protocol defines Display IDs that are associated with the tally 
displays. 

Keep the following in mind when using tally display IDs:

• TSL UMD protocols v3.1 and v4.0 messages will always map to screen 0.
• When using TSL UMD v5.0, the screen ID is assumed to be 0 if no screen ID is entered.
• If the controller is configured for either v3.1 or v4.0 protocol, it is not necessary to enter a screen ID.
• If the controller is configured for v5.0, it is only necessary to specify the screen ID if the tally controller is 

configured to send messages to tally displays on ‘screens’ other than the one with the screen ID of 0.

UltriScape PiP Tally Operation Overview
Ultrix will track current tally status for all sources or destinations that have an associated TallyID configured. When 
an UltriScape PiP has tally display objects (e.g. border, label, lamp) enabled, the PiP determines what is shown on 
the display based on the configured source and destination TallyIDs and the Tally Redirect setting.

UltriScape PiPs may be configured to follow the TallyID of the currently displayed source, or, a direct Tally mode, 
over-riding any information from the currently displayed source.

The two modes are:

1. Tally Redirect — UltriScape PiPs will show tally information associated with the currently connected source, 
i.e. the tally information of the currently displayed source is redirected to the PiP.

2. Tally Direct — UltriScape PiPs will show tally information directly associated with the PiP, overriding any 
currently displayed source tally information.

 The signal must have tally data to drive the tally display objects on the PiP it is assigned to. If the signal does not 
include the applicable tally data for an object, that object does not update but still displays on the PiP.

For More Information on...
• assigning Tally IDs to sources, refer to the section “Assigning the Tally IDs to the Sources” on page 193.
• defining tally PiP objects, refer to the section “Configuring PiP Tallies in an UltriScape Head” on page 197.

Example

In this example, the following sources are configured for Tally IDs: 

Figure 16.1  Assigning Tally IDs to Src 2 and Src 3 in the Database

Table 16.1  TSL Protocol — Tally ID Format

TSL Protocol Version Tally ID Format Range
3.1 <displayID> 0 - 127

4.0 <displayID> 0 - 127

5.0 <screenID>:<displayID> 0 - 65535 : 0 - 65535

Table 16.2  Example of Sources Assigned to Tally IDs

Source Name Tally ID Tally Status
Src 2 10 off

Src 3 15 on
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Assuming the UltriScape layout has a tally border object defined for the top right hand tile (PiP 2 in Figure 16.2), 
when the PiP is displaying the source Src 2, the PiP displays the status of Tally ID 10, which in Figure 16.3 is 
off (no border displays). 

If Src 3 is routed to PiP 2, the PiP now displays the status of Tally ID 15, which in this example is on. Now the 
tally border configuration is displayed. Any changes to Tally ID 15 (from external devices) will be displayed by 
the PiP as long as Src 3 is routed to PiP 2.

Figure 16.4  Example of a 2x2 Layout with Src 3 Assigned to PiP 2 and Tally ID 15 is On

Router Tally Output Operation
Ultrix will track current Tally Status messages sent by a controller via Tally Display IDs associated with router 
sources. When a source (with a Tally ID) is routed to a destination (with a Tally ID), the router will emit Tally Status 
messages that reflect the current tally status of the Tally ID associated with the source, but that target the Display ID 
associated with the destination.

 An outgoing connection point must be defined for Ultrix to send the new status out.

Example

Consider the following source and destination configurations:

Figure 16.2  Example of Creating a 2x2 Layout with a 
Tally Border in PiP 2

Figure 16.3  Example of a 2x2 Layout with Src 2 
Assigned to PiP 2

Table 16.3  Example of Sources and Destinations Assigned to Tally IDs

Name Tally ID Tally Status
Sources

Src 1 5 T1:on

Src 2 10 T1:off

Destinations

Dest 1 33 T1:xxx
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For the above configuration settings, the following states are possible:

Router Status over TSL UMD v3.1 Operation
Ultrix can use the TSL UMD protocol version 3.1 to send the connected source database name as tally text. This 
requires you to:

1. Set up an outgoing TSL v3.1 connection.

2. Assign Tally ID numbers to the destinations you wish to track.

3. Ensure the Tally Redirect mode is set to Off.

When a configured destination changes, the name of the new source will be sent as tally text. Ultrix will resend all 
the configured destinations every 1 minute, and immediately for any source change on a configured destination.

Getting Started
Before configuring tallies in an UltriScape Head, you must first perform the following in the active database:

1. If RS-232 or RS-422 communication is required, add a serial connection point for either incoming or outgoing 
TSL protocol support.

2. Add an Ethernet connection point for outgoing TSL protocol support (if required).

3. Enable Tally ID support.

4. Assign the Tally IDs to the sources.

5. Assign the Tally IDs to the destinations.

6. Set the Tally Redirect mode.

Adding a Serial Connection Point

Connections may be created via the Edit > Add menu on the Connections tab and selecting the TSL protocol from 
the Protocol menu in the Add Connection dialog.

For More Information on...
• a serial connection point to third-party devices, refer to “Defining a Serial Connection” on page 100.

Adding an Ethernet Connection Point

An Ethernet connection point must be added for outgoing TSL protocol support only. Incoming Ethernet services 
are natively available. Refer to the chapter “External Control” on page 263 for settings.

For More Information on...
• Ethernet connection point to third-party devices, refer to “Third-part Connection via Ethernet” on page 98.

Enabling Tally ID Support in the Active Database

To enable tally ID configuration in an active database, you must select the Enable Tally box on the System Status 
> Database tab, and then define the Status Level for tally operation.

Once support is enabled, the Source and Destinations tabs display a Tally column which is used to assign Tally IDs 
to sources and/or destinations in the active database.

Table 16.4  Example of Sources and Destinations Assigned to Tally IDs

Router Status Tally Status
Src 1 > Dest 1 TallyID 33 = TallyID 5 (on)

Src 2 > Dest 1 TallyID 33 = TallyID 10 (off)
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To enable tally ID support in the active database

1. In the Tree View, double-click the System Status node.

The System interface displays in the DashBoard window.

2. Select the Database tab.

3. Verify that the active database is the one you wish to enable tally ID support for.

4. Select the Enable Tally box located in the Current Database area.

The Source and Destinations tabs automatically update to display the Tally column. The Levels tab now 
displays the Tally Status Level menu.

Defining the Status Level for Tally Operation
The Tally Status Level specifies which level in the routing system is used to determine the current source switched 
to a given logical destination. Generally this should be the main SDI Video level; which in most systems is the level 
to which the UltriScape Head PiP and/or Router Video destinations are mapped in the system database.

To define the status level for tally operation

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Use the Tally Status Level menu (located at the bottom of the Levels tab) to specify the Level in the active 
database that will determine the tally status. 

Assigning the Tally IDs to the Sources
Assigning a Tally ID to an Ultrix source enables configured UltriScape displays to show tally information.

For example, if an UltriScape Head contains a PiP configured to display tally information (as outlined in the section 
“Configuring PiP Tallies in an UltriScape Head” on page 197), and a source with an assigned Tally ID is routed 
to that PiP, that PiP will reflect the incoming messages received by Ultrix via the TSL protocol.

TallyID 41 is associated with Src 1 in the Ultrix database. 
(TSL UMD v3.1 and v4.0)

Tally Screen 5, ID 41 is associated with Src 1 in the Ultrix 
database. (TSL UMD v5.0)

Figure 16.5  Example of a Sources with Assigned Tally IDs
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 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines how you must 
enter the information into the Tally cells of the Sources tab. Refer to Table 16.1 for details.

To assign a Tally ID to a source in the database

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

2. Verify that the Tally column displays in the Sources tab. If it does not, refer to the section “Enabling Tally ID 
Support in the Active Database” on page 192.

3. Select the cell in the Tally column of the Sources tab to assign the Tally ID to.

4. Type the Tally ID you wish to assign to that source.

5. Press Enter to apply the change.

6. Repeat steps 3 to 5 for each source you wish to assign a Tally ID.

7. Click Apply at the bottom of the Sources tab to save your changes.

Assigning the Tally IDs to the Destinations
Assigning a Tally ID to an Ultrix destination enables the pass-through of source tally status to a configured 
destination in the database.

 An outgoing connection point (either ethernet server or RS232/422 port) is required for Ultrix to emit tally 
information. Refer to the section “Connecting to Third-Party Devices” on page 98 for connection details. 

 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines how you must 
enter the information into the Tally cells of the Destinations tab. Refer to Table 16.1 for details.

To assign a Tally ID to a destination in the database

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

2. Verify that the Tally column displays in the Destinations tab. If it does not, refer to the section “Enabling 
Tally ID Support in the Active Database” on page 192.

3. Select the cell in the Tally column of the Destinations tab to assign the Tally ID to.

Tally ID 51 follows the connected source associated tally. 
This requires an established outgoing connection point. 
(TSL UMD v3.1 and v4.0)

Tally Screen 4, ID 11 follows the connected source 
associate tally. This requires an established outgoing 
connection point. (TSL UMD v5.0)

The UltriScape PiP displays the tally information from 
Tally ID 11 regardless of the displayed source video.

The UltriScape PiP will display tally information from the 
connected source associated Tally ID.

The label of the source currently connected to Dst 1 will be 
sent as TSL text on Tally ID 5. (TSL UMD v3.1)

Figure 16.6  Example of Destinations with Assigned Tally IDs
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4. Type the Tally ID you wish to assign to that destination.

5. Press Enter to apply the change.

6. Select the Tally Redirect box to enable the connected source Tally ID to be directed to this destination Tally 
ID.

7. Repeat steps 3 to 6 for each destination you wish to assign a Tally ID.

8. Click Apply at the bottom of the Destinations tab to save your changes.

Assigning a Tally ID to an UltriScape PiP Destination
Assigning a TallyID to an UltriScape PiP will cause the PiP to display that TallyID information and ignore any tally 
information from the displayed source.

Figure 16.7  Example of a TallyID to an UltriScape PiP

UltriScape Tally Settings
The UltriScape Configuration interface provides options for specifying the tally colors for all UltriScape Heads, 
and setting the operation mode.

Table 16.5  Examples of TallyIDs for an UltriScape PiP

PiP Destination Configuration Example Notes
The tally will be asserted when 
the tally ID associated with 
source 'CAM 1' is asserted, ie; 
the PiPs video source TallyID is 
redirected to the PiP.

The tally will be asserted when 
Tally ID 65 is asserted as '65' is 
entered in the Tally column.

No tally information will 
display on the PiP as neither 
tally redirect is enabled, nor, a 
direct TallyID specified.
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Specifying the Global Tally Colors for the UltriScape Heads
The Tally Lamp Color enable you to specify the color of Tally 0 and Tally 1 for all the UltriScape Heads enabled in 
the active database. Note that the function of Tally 0 and Tally 1 is determined by the TSL UMD protocol version as 
outlined in the chapter “External Control” on page 263.

To specify the tally colors used in all UltriScape Heads

1. Double-click the Ultrix router in the Basic Tree View of DashBoard.

The tree for the router expands.

2. Expand the UltriScape node.

3. Double-click the Configuration node.

The Configuration - Layout Editor Settings tab displays in the right side of the DashBoard window.

4. Locate the Tally Lamp Color options.

 Changing the Global Tally Settings values on one UltriScape Head tab automatically updates all UltriScape 
Heads in the active database.

5. Use the Tally menus to specify the color used when the tally is active (on). By default, Tally 0 is set to Red and 
Tally 1 is set to Green.

The setting change is automatically applied.

Specifying the Global Tally Label Settings for the UltriScape Heads
Tally label text can be determined by the source of the tally or the labels defined in the Ultrix database. An 
UltriScape UMD label may either show database name, the associated tally text, or, it may show tally text appended 
to the database name.

 If the associated tally contains no text, the UMD label displays as a blank field.

To specify the tally label text used in all UltriScape Heads

1. Double-click the Ultrix router in the Basic Tree View of DashBoard.

The tree for the router expands.

2. Expand the UltriScape node.

3. Double-click the Configuration node.

The Configuration - Layout Editor Settings tab displays in the right side of the DashBoard window.

4. Locate the Tally Label Text Settings options.

 The tally label text setting change is automatically applied.

5. Use the Source Mode options to specify the tally label text when any UltriScape Head PiP Source is assigned 
to a Src #. Choose from the following:

• overwrite — the tally label text is entirely replaced with the text provided by the tally.
• append — the tally label text displays as src : tally where src is the name the source is assigned in the 

Ultrix database, and tally is the text provided by the tally.

6. Use the Follow Dest Mode options to specify the tally label text when any UltriScape Head PiP Source is 
assigned to a Follow Dest #:

• overwrite — the tally label text is entirely replaced with the text provided by the tally.
• append — the tally label text displays as dest : tally where dest is the name the destination is assigned 

in the Ultrix database, and tally is the text provided by the tally.



Ultrix User Guide (v18.0) Tallies • 197

Specifying the Tally Behavior
You can specify whether only the red tally or both tallies are lit when the tallies are on (tally indicator PiP objects 
only).

To specify the tally behavior in all UltriScape Heads

1. Double-click the Ultrix router in the Basic Tree View of DashBoard.

2. Expand the UltriScape node.

3. Double-click the Configuration node.

The Configuration - Layout Editor Settings tab displays in the right side of the DashBoard window.

4. Locate the Tally Behavior Settings area.

5. Choose one of the following:

• Red tally only — the red tally indicator is lit when both tallies are on. The green is unlit.
• Both tallies lit — both the red and green tally indicators are lit.

Configuring PiP Tallies in an UltriScape Head
In the UltriScape Layout Editor interface, you can select PiPs and add a border or a text box to represent the status 
of a tally in the UltriScape Head output. 

Adding a Tally Border to a PiP
A tally border is a PiP border that will change color depending on the associated Tally ID information. By default, a 
tally border is set in blue on the layout and the color cannot be edited. The default border width is fixed at 8 pixels.

To add a tally border to a PiP in a layout

1. Load the layout in the Layout Editor as outlined “Loading a Previously Saved Layout” on page 176.

2. From the Objects toolbar, click SELECT.

3. Select the tile to add a tally border to.

The tile displays with a dotted yellow border and the Border Width and Border Type menus now display 
under the Main toolbar.

4. Set the Border Type to Tally.

The tile displays with a solid blue border. In the example below, a tally border was added to PiP1.
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5. From the top toolbar, use the Border Width field to specify the border width in number of pixels and lines.

6. Press Enter to apply the new width value.

7. Save the changes to the layout as outlined in the section “To save a layout to the database” on page 175.

Adding a Tally Label to a PiP
Adding a tally label is similar to adding a static or dynamic text box to a PiP. Once a source is assigned to the tile 
(via the options in the UltriScape Head interface) its Tally ID information automatically populates the box contents.

The background color of a tally enabled UMD label will change with the tally information. A blue background on a 
tally enabled UMD label means the Ultrix does not have any tally information to display. 

To add a tally label to a PiP

1. Load the layout in the Layout Editor as outlined in “Loading a Previously Saved Layout” on page 176.

2. From the Objects toolbar, click UMD.

3. Select the PiP to add a text box.

The Label settings, including the Type menu and the Tally box, display under the main toolbar.

4. From the Type menu, select PiP Source.

5. Select the Tally box.

The box on the tile automatically updates to “PiP Source Unassigned w/ Tally”.

6. Save the changes to the layout as outlined in the section “To save a layout to the database” on page 175.

Adding Tally Lamps to a PiP
Tally lamps (or Tally Indicators) are blocks on the PiP that emulate the classic UMD tally lamp behavior. You can 
add tally lamps to any PiP in a layout. 

Once a source is assigned to the tile (via the options in the UltriScape Head interface) its Tally ID information 
automatically sets the lamp colors.

To add a tally lamp to a PiP

1. Load the layout in the Layout Editor as outlined in “Loading a Previously Saved Layout” on page 176.

2. From the Objects toolbar, click TALLY.

3. Select the PiP in the layout to add the tally lamps to.
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The PiP displays a dotted blue border with a lamp box in the bottom left and right corners. By default, the left 
lamp is Tally 0 (red) and the right lamp Tally 1 (green). In the example below, tally lamps were added to PiP2.

4. Save the changes to the layout as outlined in the section “To save a layout to the database” on page 175.

Configuring the UltriScape Head
Each PiP in a layout is assigned a video signal from the current database. If the input signal includes tally data and 
the PiP assigned to that source includes tally objects (e.g. border, label), the tally data is included in the UltriScape 
Head output.

Assigning a Source to a PiP with Tally Objects
If a layout in the UltriScape Head interface includes tally objects in the PiPs, the objects are set in blue for quick 
identification on the layout. In specific:

• Tally labels — this object displays as a text box, in the PiP, with white text on a blue background.
• Tally border — the blue border displays around the PiP.

Figure 16.8 shows two layouts with tally elements: lay9_all.lay and newone.lay.

Figure 16.8  UltriScape Interface — Example of Layouts with Tally Objects

For More Information on...
• assigning a layout to an UltriScape Head, refer to the section “Assigning a Layout to an UltriScape Head” on 

page 180.
• assigning a source to a PiP, refer to the section “Assigning a Source to a PiP” on page 183.
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Using Remote Control Panels
When the Ultrix router is configured for Ultricore mode, it responds to switch commands from Ross NK Series and 
Ross series control devices. These commands contain source, destination, and level designations. Routers 
acknowledge the switch request with the selected crosspoint switch status after the switch has occurred. The 
Remote Control Panels (RCP) may operate singularly, or in a linked mode where two or more (up to 10) panels may 
operate as a larger panel with more buttons.

Connection to Ultrix
The method of connection between Ultrix and an RCP will vary depending on the type of panel. Ethernet enabled 
devices such as the RCP-ME and RCP-QE communicate with Ultrix directly. Non-ethernet panels such as the 
RCP-NKQ, RCP-NKM and RCP-NK1 connect through an NK-NET or NK-IPS to convert the native T-Bus 
commands to ethernet.

Native ethernet panels receive their labels automatically from the Ultrix database upon panel start-up. Any 
subsequent changes to the database labels are also automatically pushed out to connected ethernet panels. The NK 
series panels do not automatically get updates from the Ultricore control system and must use a manual process via 
DashBoard. Refer to the user guide for your RCP for details.

 For optimal performance when using a Ross RCP with Ultrix, the Comms Retry factor should be set to 80ms or 
greater within the RCP configuration. Refer to the user guide for your RCP for details.

RCP-NKM Connection to a Ross NK Router and an Ultrix Router

The RCP connection as shown in Figure 17.1 requires a connection point between Ultrix and the NK-NET. Refer to 
the section “Connecting to Ross NK Series Devices” on page 96 for details.

 The NK-NET requires power from the Ross NK Router (over T-Bus).

Figure 17.1  Example of a Connection from an Ultrix Router to an NK-3G-16 and RCP-NKM

RCP-QE Connection to an Ultrix Router

RCP-QE and RCP-ME remote control panels require a a connection point between Ultrix and the panel. Refer to 
the user guide for your panel for details.
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Figure 17.2  Example of a Connection from an Ultrix to an RCP-QE

RCP-NKM with a NK-IPS and NK Router to an Ultrix Router

The RCP connection as shown in Figure 17.3 requires a connection point between Ultrix and the NK-IPS. Refer to 
the section “Connecting to Ross NK Series Devices” on page 96 for details.

Figure 17.3  Example of a Connection from an Ultrix Router to an NK-IPS and an RCP-NKM

Remote Control Panel Operation
The control panel functions detailed in this section can be programmed with the Ultricore for full functionality. The 
examples herein are generic functions applicable to all panel types.

For More Information on...
• specific applications, refer to the user documentation that accompanied your device.
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Destination Buttons
Selecting a destination changes the destination the panel controls or switches the next time a Source button is 
pressed. Destinations can be selected by pressing a preset DESTINATION button.

When a preset DESTINATION button is pressed, that button and its source status button (if a preset key exists on the 
current view or menu) will be illuminated.

 Each panel type has slightly differing method of displaying current status depending on the display type or lack 
there-of. Refer to individual RCP manuals for details.

Figure 17.4 illustrates an RCP-QE36 panel where Outpt1 is the selected destination.

Figure 17.4  Selecting a Destination Button — Outpt1 Selected

Source Buttons
Source switching is performed by pressing a preset SOURCE button. Selecting a source (when a TAKE function 
button is not assigned), results in the controller requesting the selected source to be switched by the router to the 
panel's current destination. If a TAKE function button is assigned to the current view or menu, the TAKE button will 
be illuminated. This indicates that TAKE is armed and the requested switch will be completed upon the user 
pressing the TAKE button.

Figure 17.5 illustrates a panel where Outpt1 is the destination, Input 7 is the source, and the TAKE is armed.

Figure 17.5  Selecting a Source Button — Camera 7 Selected

The flow is always destination selection followed by source selection. This switch will be executed with the current 
panel breakaway/level selections.

Level Buttons
Level buttons select individual router levels. These correspond to the levels tab of the current Ultricore database. 
Level buttons are cumulative e.g. you may activate other levels after already selecting a level button.

The following sequence of button presses would result in SRC 1 being routed to DEST 1 but only on the levels 
named SDI, SDI A1 and SDI A2. Any other levels defined in the current Ultricore database will be ignored and 
their status will remain as previously selected. If a level is selected in error, press that key again to unselect. The 
switch occurs once the Source selection is made.
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1. Select the Destination button.

2. Select the SDI Level button.

3. Select the Level SDI A1 button.

4. Select the Level SDI A2 button.

5. Select the Source button.
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Breakaway Buttons
Breakaway buttons are buttons tied to a breakaway definitions. A breakaway is a pre-set pattern of levels defined 
within the panel configuration. Breakaways can be customized from the control panel’s properties settings via the 
interface in DashBoard. Figure 17.6 is an example of configuring a breakaway for a control panel.

Figure 17.6  Example of a Breakaway Setup Interface

 The level numbers correspond to the number in the ID column of the Levels tab within the current database.

The following sequence of key presses would result in Src 3 being routed to Dest 2 but only on the levels included 
in the SDI Only breakaway pattern as defined within the RCP set-up (Level 1 in this example). The switch occurs 
once the source selection is made.

1. Select the Destination button.

2. Select the SDI Only breakaway button.

3. Select the Source button to activate the switch selection.

In the following example, the user is switching video from one source (Src 1) and embedded audio from another 
(Src 2).
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1. Select the Destination button.

2. Select the SDI breakaway button containing SDI video only level.

3. Select the Source button to activate the switch selection.

4. Select the breakaway button containing the SDI embedded Ch1 and Ch2 levels.

Once BWAY A1, A2 is pressed, BWAY SDI becomes unlit.

5. Select the Source button for the embedded audio.

Crosspoint Buttons
Crosspoint buttons perform a preset single crosspoint switch in a single button press. A crosspoint key contains a 
source (e.g. Src 1), a destination (e.g. Dest 1), and breakaway (e.g. SDI Only) within its definition. 

DEST 1 DEST 2 DEST 3

SRC 3SRC 2SRC 1

BWAY

SDI

BWAY

A1, A2

DEST 1 DEST 2 DEST 3

SRC 3SRC 2SRC 1

BWAY

A1, A2

BWAY

SDI

DEST 1 DEST 2 DEST 3

SRC 3SRC 2SRC 1
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Using Categories
Category navigation enables you to organize the resources (sources, destinations, and/or levels) in a router database 
to defined categories. There are three types of categories (each with independent interfaces):

• Group — allows a user to organize database resources into folders and sub-folders with arbitrary group names. 
Resources may be assigned to multiple groups if required.

• Cat/Index — allows a user to piece together or build up the final resource name from category names and index 
identifiers.

• Legacy — allows compatibility with earlier RCP-QE models. Note that this is not available as a soft panel.

Group Categories Overview
 Group category mode is only available when using an Ultrix router or Ultricore CC running software version 2.0 

or higher.

Group Category allows the user to organize database resources (sources, destinations, and levels) into folders and 
sub-folders with arbitrary group names. The group name is not required to match the resource names (it is similar to 
setting up file folders). This group categorization is useful when you need to group resources based on their 
operational regions, events, personnel credentials etc.

 Ultrix does not support Unicode characters.

Example of a Group Category Setup

A user wants to arrange sources and destinations based on the types of sports the network broadcasts: baseball and 
football. The resources available are: 

The resources need to be arranged into the following groups based on the sport type: 

Sources Destinations

Baseball Football
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The Group Category interface would be used to arrange the resources into group categories:

Figure 18.1  Example of Group Categories Arrangement Based on Sport Type

Once the group categories are defined, the user can perform switches, on a hard or soft panel, based on the group 
categories.

In Figure 18.2, an RCP-QE18 is used to select the source labeled as HD 3.

Figure 18.2  RCP-QE18 — Selecting HD 3 via Category Mode

In Figure 18.3, an Ultrix soft panel is used to select the destination labeled as SAT 1.

Figure 18.3  Ultrix — Selecting SAT 1 via a Soft Panel
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Configuring Group Categories
Group categories are arranged in a hierarchy and displayed in a tree view. Each group is represented as a folder or 
node, and the resources included in that group are sub-nodes. Each type of resource is represented within the 
hierarchy as follows: sources are green, destinations are blue, and levels are red. Figure 18.4 also shows two main 
groups (MV, and SDI) where the SDI group also has four sub-groups (Slot1, Slot2, Slot3, and Slot4)

Figure 18.4  Example of Group Categories Tree View

Configuring group categories requires:

1. Creating group names

2. Assigning destinations, sources, and/or levels to groups

3. Configuring a soft panel or a hard panel for use

Creating Group Names
For each database, you can create multiple category groups and add sub-groups. Once you create your groups, 
resources can be added. Note that by default, the groups are organized alphabetically in the tree view.

To create a category group

1. Double-click the Group Categories node located under the Database node.

The Group Categories tab opens.
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2. Select the Group Categories: node.

3. Click Add.

The Add Group dialog opens.

4. In the Name field, type a unique identifier for the new group.

5. Click Apply.

The Add Group dialog closes and the new group is added as a child of the selected node.

In the example below, a new sub-group “Studio 1” was created in the SDI group.

6. Click Apply in the bottom right corner to apply your changes.

To create a category sub-group

1. In the Group Categories tree, select the group icon that you wish to add a sub-group to.

2. Click Add.

The Add Group dialog opens.

3. In the Name field, type a unique identifier for the new sub-group.

4. Click Apply.

The Add Group dialog closes and the new sub-group is added to the Group Categories tree view.

In the example below, a new sub-group “Cameras” was created in the Studio 1 group.

5. Click Apply in the bottom right corner to apply your changes.

To move a group within the tree view

1. In the Group Categories tree, select the group you want to move.

The Move dialog opens. The dialog header displays the name of the selected group to move.

2. Use the tree view in the dialog to select where to move the group to.

3. Click Apply.

The Move dialog closes.

The group displays in the selected position of the tree view.

4. Click Apply in the bottom right corner to apply your changes.

Auto Generating the Groups
You can also choose to create a group based on the levels, sources, and destinations in your database or a 
combination. This requires the virtual labels for each resource to be consistent. For example, if all destinations are 
labeled as Dest x, a group will be created called “Dest” with each destination listed as a separate node.

 Auto generating a group will delete the groups currently listed in the Group Categories tree view.

To auto generate a group

1. Click Auto Generate.

The Auto Generate Groups dialog opens.
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2. Select the box to include the resources in the group.

3. Click Apply.

The Auto Generate Groups dialog closes and the Group Categories tree updates.

4. Click Apply in the bottom right corner to apply your changes.

Assigning Resources to a Group
You can assign resources (destinations, sources, levels) once a group is configured.

To assign a resource to a group

1. In the Group Categories tree, select the group you want to add a resource to.

The middle pane of the Group Categories interface updates to list the sub-groups or resources assigned to it.

In the example below the area is blank because nothing is assigned to the selected group.
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2. In the right pane, select the tab for the type of resource you wish to assign to the group.

In the example above, the Destinations tab was selected.

3. To assign a single resource, select the resource from the tab.

4. To select a series of resources:

a. In the selected tab, select the first resource in the series you want to assign.

b. Press and hold Shift.

c. Click the last row in the series.

5. Click Assign.

The Group Categories tree updates to display the selected resources in the group.

In the example below, Dest 1 to Dest 6 were assigned to the Studio 1 group.

6. Click Apply in the bottom right corner to apply your changes.

To move a resource to another group

1. In the Group Categories tree, select the resource you want to move.

2. Click Move.

The Move dialog opens.

3. Select the new location for the resource.

4. Click Apply.

The Move dialog closes.

The Group Categories tree updates to display the resource in the new location. Notice that the resource is now 
removed from the original group.

5. Click Apply in the bottom right corner to apply your changes.

To delete a resource from a group

1. In the Group Categories tree, select the specific resource you want to delete from the group.

2. Click Delete.

The Delete dialog opens.
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3. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the resource in the group. 

4. Click Apply in the bottom right corner to apply your changes.

To delete a series of resources from a group

1. In the Group Categories tree, select the specific group you want to edit.

The middle pane of the Group Categories interface updates to list the sub-groups or resources assigned to it.

2. In the middle pane, select the first resource in the series you want to delete.

3. Press and hold Shift.

4. Click the last row in the series.

5. Click Delete.

The Delete dialog opens.

6. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the resource in the group. 

7. Click Apply in the bottom right corner to apply your changes.

Managing the Groups
 You cannot rename resources using the options in the Group Categories interface.

To rename a group

1. In the Group Categories tree, select the specific group you want to rename.

2. Click Rename.

The Rename Group dialog opens.

3. Use the Name field to enter a unique identifier for the selected group.

4. Click Apply.

The Rename Group dialog closes.

The Group Categories tree updates to display the new name for the group. 

5. Click Apply in the bottom right corner to apply your changes.

To delete a group

1. In the Group Categories tree, select the group you want to delete.

2. Click Delete.

The Delete dialog opens.

3. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the group. 

4. Click Apply in the bottom right corner to apply your changes.
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Cat/Index Categories Overview
Category Index category mode (also referred to as Cat/Index mode), allows alpha-numeric extensions to labels to 
“build up” the final label selection. For example, VTR 1 - 6 may be expressed as a VTR label with numerical 
extensions 1 through 6. Similarly, alpha extensions may be used, for example, VTR A - E for VTRs A through E.

Destination and source names are split into substrings - the first substring is referred to as the category, and 
subsequent substrings as the indexes (e.g. Category VTR index 1 through 6). As source/destination names become 
more complex, an index may not be the final part of the selection name. For example, consider the source names 
CG TX 1 and CG TX 2; Cat/Index category mode may be configured so that a user selects CG, then TX, then either 
1 or 2. This may be extrapolated to cover a large range of sources and destinations.

Example of a Cat/Index Category Setup

The following resources are available: 

The possible categories and indexes would be: 

Once the Cat/Index categories are defined, the user can perform switches, on a hard or soft panel, based on the 
categories. In Figure 18.5, a RCP-QE18 is used to select the source labeled as CAM 3. Note only the sources are 
available for the second button selection. In this example, the user would need to select TAKE to make the switch.

Sources / Destination Names

Categories Indexes
CAM_a

a.The “_” characters represents a blank space. This indicates the 
category will filter resources with a space in the name (e.g. the 
CAM_ category will allow resources named CAM 1, CAM 2 but 
not CAM3).

1 5 D

SAT_ 2 A E

CG_ 3 B RX_

EDIT_ 4 C TX_

VTR
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Figure 18.5  RCP-QE18 — Selecting CAM 3 via Category Mode

In Figure 18.6, an Ultrix soft panel is used to select the destination labeled as CG RX 2.

Figure 18.6  Ultrix — Selecting CG RX 2 via a Soft Panel

Configuring a Cat/Index Category Setup
Configuring Cat/Index categories requires:

1. Assigning categories

2. Assigning indexes

3. Configuring a soft panel or a hard panel for use

Assigning Categories
You can assign each destination to a specific category or multiple categories in a database. Using multiple 
categories enable you to filter the destinations, and organize them into logical groups. By default, categories are 
organized in alphabetical order.

To auto generate categories based on a database

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.
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2. Click Generate.

The Auto-Generate dialog opens.

3. Click Yes.

The Auto-Generate dialog closes.

All previous categories are deleted from the Categories pane and new ones are listed based on the resource 
labels in your database.

4. Click Apply.

To manually create categories

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens

2. Click Add (located next to the Categories pane).

The Add Category dialog opens.

3. Use the Name field to specify a unique identifier for the new category.

 The entry must match a resource name prefix.

For example:

• “CG_” creates a category to categorize resources named CG_xxxx where xxxx is any index.
• “CG” creates a category to categorize resources named CGxxxx where xxxx is any index.
• “cg” will not categorize any resources as the category names are case sensitive.

4. Select the Insert trailing space box to represent a space character with the “_” symbol.

5. Click Apply.

The Add Category dialog closes.

The new category is listed in the Categories pane.

6. Click Apply.
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To create a category for a specific resource type

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Create for the resource type you wish to filter. 

The Create Category/Index dialog opens.

3. Use the Category Name field to specify the characters for the new index filter. 

 The entry must match a partial resource name.

4. Select the Insert trailing space box if you wish to include trailing spaces in the filter.

5. Click Apply.

The Create Category/Index dialog closes.

6. Click Apply.

Assigning Index Filters
An index for a category enables you to filter resources. As category names and indexes are entered, the Affected 
Resources pane in the interface will update to indicate which sources or destinations of a given category is 
accessible on a control panel. Select a name in the Categories pane to see which source or destinations are in that 
category and filtered by the available Indices pane. 

To assign an index filter

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Add (located next to the Indices pane).

The Add Index dialog opens.

3. Use the Name field to specify a new index filter. 

 The entry must match a partial resource name.

For example:

• “TX_” creates a sub-index of TX, meaning further entry is required on the control panel. This will filter 
resources named <category name>TX_xxxx where xxxx is any index.

• “TX 1” creates an ‘end-point’ index, meaning TX 1 is the last substring and no further entry is required on a 
control panel. This will filter resources named <category name>TX 1.

• Note that you would not create an index of “TX 1” and a sub-index of “TX_”. You must choose one or the 
other.

4. Click Apply.

The Add Index dialog closes.

The new index filter is listed in the Indices pane.

5. Click Apply.

To assign an index filter for a specific resource type

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Create for the resource type you wish to filter. 

The Create Category/Index dialog opens.

3. Use the Index Name field to specify a unique identifier for the new index filter.
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 The entry must match a partial resource name.

4. Select the Insert trailing space box if you wish to include trailing spaces in the filter.

5. Click Apply.

The Create Category/Index dialog closes.

6. Click Apply.

Legacy Categories Overview
Legacy Category mode allows some category functionality on legacy RCP-QE control panels (17 button). There is 
no soft panel for Legacy Category Mode. Legacy mode is similar in operation to Group category mode with some 
elements of the index functionality of the Cat/Index Category mode.

Keep the following in mind when using legacy category mode:

• A destination or source cannot be in more than one category
• Only numerical indexes are supported

For More Information on...
• legacy category mode, refer to the RCP-QE User Guide.

Configuring Legacy Categories
Source and destination selection may be achieved in two ways: direct selection or numerical index entry. The setup 
of the Ultricore Category tables determines the operational functionality.

For More Information on...
• Category mode for the Ultricore, refer to the Ultricore User Guide.

Category Direct Selection Mode
Figure 18.7 illustrates the Categories configured in the Ultrix database for direct selection mode.

Figure 18.7  Ultrix — Entries in the Legacy Categories Tab

Figure 18.8 illustrates direct destination entries and the resulting available destinations in the selected category.

Figure 18.8  Ultrix — Resulting Operation on a Remote Control Panel
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To set up direct selection in categories

1. Expand the Database node in the Tree View.

2. Double-click the Legacy Categories node.

3. Click Destination or Source as required.

4. Type the text for a category name in the Category 1 column for each row that is required to be in that category.

5. Copy the items in the name column to the Category 2 column.

This will result in those rows being within the category you named in column Category 1.

 You can use keyboard shortcuts such as Ctrl+C (copy) and Ctrl+V (paste) and Shift+click to select a range for 
ease of data entry.

Numerical Index Entry Mode
Figure 18.9 illustrates the Categories configured in the Ultrix database for numerical entry mode

Figure 18.9  Ultrix — Entries in the Legacy Categories Tab

Because we have set the VTRs numbered 6 through 10 in Figure 18.9, the Ultrix expects a two digit entry signified 
by the two underlines on the button next to the category name. As only numerals 1 or 0 are the only possible entries 
to make for the first digit, the Ultrix has blanked the invalid entry keys. (Figure 18.10)

To select VTR 6, press 0 then the remaining available numbers will become available, then press 6 to finish the 
selection. 

Figure 18.10  Ultrix — Resulting Operation on a Remote Control Panel

To set up numerical index selection in categories

1. Expand the Database node in the Tree View.

2. Double-click the Legacy Categories node.

3. Click Destination or Source as required.

4. Enter a category name in the Category 1 column for each row that is required to be in that category. For 
example, in Figure 18.9 the user entered “VTR”.

5. Enter a number in the Category 2 column.

This will result in those rows being within the category you named in the Category 1 column. These 
destinations are accessible via entering the numerical extension of the required destination. For example, in 
Figure 18.9 the user entered “6” for row 5.
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Creating a Soft Panel with Categories
Once you have defined your categories and tags for each level of a database, you can create a custom soft panel 
using the category settings as a basic for arranging the sources, destinations, and levels. This topic is covered in the 
section “Using Category Panels” on page 239.



Ultrix User Guide (v18.0) Soft Panels in DashBoard • 221

Soft Panels in DashBoard
A soft panel is a software implementation of a physical remote control panel (RCP). The soft panel configurations 
are part of a database so any instance of DashBoard connecting to a given Ultrix router has the defined soft panels 
available. You can customize a soft panel by defining the sources, destinations, levels, and/or salvos that will be 
available on the panel interface. The Ultricore Control Mode in the Ultrix router provides four types of soft panels 
for router control:

• Matrix — the destinations and sources are organized into a grid layout.
• MultiBus — the destinations and sources are organized into separate a rows (buses) of buttons.
• Group Category — the destinations and sources are grouped by pre-defined categories.
• Cat/Index Category — the resources are defined using a defined set of search criteria (indexes).
• Ultritouch PB — the resources are organized into a customized layout that is pre-sized for an Ultritouch hard 

panel. Refer to the Ultritouch + Ultrix User Guide for details.
• Push Button — similar layout and features of the Ultritouch PB panel but sized for use on a computer monitor.

 For information on the Audio Mixer soft panel options, refer to the chapter “ULTRIMIX-MXR” on page 127.

Before You Begin
Keep the following in mind when managing your soft panels in DashBoard:

• Soft panels require the setup of the database source/destinations/levels and port assignment to be complete.
• If the database changes (source/destination/level/salvo addition or deletion), you will need to edit the soft panel 

configuration to ensure the correct sources/destinations/levels/salvos are visible.
• Ultrix does not support Unicode characters.

For More Information on...
• databases, refer to the chapter “Database Configuration” on page 105.

Soft Panels Overview
A soft panel is created using the options in the Panels interface for your database. Soft panels are listed as sub-nodes 
under the Soft Panels node in the Tree View of DashBoard. Double-click a sub-node to display the corresponding 
soft panel in the DashBoard window. The hierarchy of the nodes in the tree is determined by their Panel ID which is 
assigned when the soft panel is created in the database. In Figure 19.1 there are seven soft panels in the tree view.

Figure 19.1  Example of a Soft Panels Tree View

A soft panel can be as simple or complex in its layout as you require. The Panels interface enables you to specify 
the number of destinations, sources, levels, and salvos displayed on your panel. You select one of six soft panel 
types and specify the elements of the soft panel including giving the panel a unique name. 
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For More Information on...
• Matrix panels, refer to the section “Using Matrix Panels” on page 230.
• Multibus panels, refer to the section “Using MultiBus Panels” on page 236.
• Category panels, refer to the section “Using Category Panels” on page 239.
• Ultritouch PB panels, refer to the Ultritouch + Ultrix User Guide.
• Push Button panels, refer to the section “Using Push Button Panels” on page 243.
• Audio Mixer panels, refer to the section “Creating Audio Mixer Soft Panels” on page 133.

Enabling Machine Control
Typically, the ports on a data router (such as the NK-M series routers) are bi-directional where there is both a 
transmit (input to output) and reciprocal receive connection that is made for each port. For example, a switch from 
port 1 to port 2 involves a forward path (from port 1 input to port 2 output) and the reciprocal connection from (port 
2 input to port 1 output).

In some cases however, there is a need to connect on the port’s input to several ports’ output (e.g. one device 
commanding many target devices) without making the reciprocal connection. This allows the commanding device 
to just broadcast commands and not receive from the many devices it communicates with. 

When configuring a soft panel, you have the option to add a Machine Control button to the panel. When selected on 
the panel, this Machine Control button sends a Take request directed to an NK-M series data router to automatically 
make the reciprocal port switch. On a video router, the connection is all one way from an input port to an output 
port (e.g. such as from IN 1 to OUT 2). 

Creating a Soft Panel
Soft panels are listed under the Soft Panels node in a hierarchy as determined by their Panel ID. When you create a 
new soft panel, you select from the existing soft panel types. You then assign a Panel Name and ID to display in the 
tree view using the nomenclature “Panel Name [#]” where [#] is the Panel ID.

 A Default Panel is available that is a MultiBus style with 1 level, 4 destinations, and 4 sources.

To create a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. Click Edit > Add.
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The Add Panel dialog opens.

3. Type a unique identifier in the Name field. This will be used to identify the panel in the tree under the Soft 
Panels node.

4. Use the Style menu to specify the type of panel to create. Choose from the following:

• Matrix — Creates a soft panel that organizes the destinations and sources in a grid layout.
• MultiBus — Creates a soft panel where destinations and sources are organized into separate buses.
• Group Category — Creates a soft panel where the hierarchy of the destinations and sources are determined 

by the values in the Group Categories tab. Refer to “Using Categories” for details.
• Cat/Index Category — Creates a soft panel where the hierarchy of the destinations and sources are 

determined by the values in the Cat/Index Categories tab. Refer to “Using Categories” for details.
• Push Button — Creates a soft panel that organizes the destinations and sources in a distinct vertical layout.
• Ultritouch PB — Creates a soft panel that is used on an Ultritouch hard panel. Refer to the Ultritouch + 

Ultrix User Guide for details.

5. Click Apply to save your settings and close the Add Panel dialog.

The new panel name is added to the Saved Panels list of the Panels tab and automatically selected in the tab 
for editing.

6. Select the Info tab.

7. Use the Panel ID menu to determine the position of the panel in the Soft Panels tree where a value of “1” is the 
highest priority (and listed at the top).

 Ensure that the new soft panel does not use the same Panel ID as a previously saved soft panel.

8. Use the Description field to provide a textual summary of the panel. 

9. Use the Protection Operation menu to provides options for preventing crosspoint switches. Choose from the 
following:

• Enable — The Lock, Protect, and Free buttons display on the soft panel. Refer to “Using Matrix Panels” 
or “Using MultiBus Panels” for a description of these buttons. 

• Disable — The Lock, Protect, and Free buttons do not display on the soft panel. These protection options 
are not available for the soft panel.

10. Use the Take Operation menu to configure the Take button for the soft panel. Choose from the following:

• Confirm — Displays a Take button on the soft panel. You must select Take to perform a crosspoint switch.
• Direct — The soft panel does not display a Take button. A crosspoint switch occurs automatically after each 

destination/source selection is made by the user on the soft panel.

11. If you selected MultiBus in step 4, use the Selection Operation menu to enable multiple crosspoint/level 
selections and display the Multi Select button. Choose from the following:

• Single — Disables this feature. The Multi Select button does not display on the soft panel.
• Multi — The Multi Select button displays on the soft panel.

12. Use the Machine Control menu to control whether a Take request directed to an Ross NK-M series data router 
automatically makes a reciprocal port switch. Choose from the following:

• Enable — Displays a Machine Control button on the soft panel. You must select Machine Control to 
enable the reciprocal port switch on the NK-M series router.

• Disable — The soft panel does not display a Machine Control button. This is the default setting.

13. If you set the Style to Push Button, proceed to “Configuring a Push Button Soft Panel” on page 245.

14. Click Apply to save your new soft panel.

The new panel displays in the Soft Panels tree. In the example below, there are seven soft panels in the tree 
view. Note that the Priority ID is the value displayed in the [#] brackets.
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15. Continue to the next sections to add levels, destinations, sources, and salvos to your soft panel as required.

Levels for the Soft Panel
You can specify the total number of levels available on the soft panel to the user. For example, if you set the 
Viewable levels to 6 but have assigned 8 levels to the panel, only the first six levels in the Assigned list are 
displayed. You can also specify the order in which the levels are displayed on the soft panel.

To specify the levels for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Levels tab.

3. Use the Viewable levels field to specify the total number of levels for the soft panel.

4. To add a level to the soft panel:

a. From the Available list, select the level(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected level(s).

5. To assign all the available levels in the database to the soft panel, click .

6. To assign multiple levels to the soft panel:

a. From the Available list, select the first level you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other level(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected levels.
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7. Use the provided buttons beside the Assigned list to determine the order in which the levels are displayed on 
the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Destinations for the Soft Panel
You can create a soft panel with a specified number of destinations and determine the order in which they are 
displayed in the crosspoint row of the panel. For example, the router may have 32 destinations but you only want to 
make the first 4 outputs selectable on the crosspoint row of your soft panel. You would then set the Viewable 
destinations to 4. You can also specify the order in which the destinations are displayed on the soft panel.

To specify the destinations for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Destinations tab.

3. Use the Viewable destinations field to specify the total number of destinations for the soft panel.

4. To add a destination to the soft panel:

a. From the Available list, select the destination(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected destination(s).

5. To assign all the available destinations in the database to the soft panel, click .

6. To assign multiple destinations to the soft panel:

a. From the Available list, select the first destination you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other destination(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected destinations.

7. Use the provided buttons beside the Assigned list to determine the order in which the destinations are 
displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.
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Sources for the Soft Panel
You can create a soft panel with a specified number of sources and determine the order in which they are displayed 
in the crosspoint row of the panel. For example, the router may have 64 sources but you only want to make the first 
12 inputs selectable on the crosspoint row of your soft panel. You could set the Viewable sources to 12 or assign 
only those 12 inputs to the soft panel. You can also specify the order in which the sources are displayed on the soft 
panel.

To specify the sources for the soft panel

1. Double-click the panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Sources tab.

3. Use the Viewable sources field to specify the total number of sources for the soft panel.

4. To add a source to the soft panel:

a. From the Available list, select the source(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available sources in the database to the soft panel, click .

6. To assign multiple sources to the soft panel:

a. From the Available list, select the first source you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other source(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected sources.

7. Use the provided buttons beside the Assigned list to determine the order in which the sources are displayed on 
the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Salvos for the Soft Panel
Before you can add salvos to a soft panel, you must configure them as outlined in “Creating Salvos” on page 249. 
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To specify the salvos available on the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Salvos tab.

3. Use the Viewable salvos field to specify the total number of salvos for the soft panel.

4. To add a salvo to the soft panel:

a. From the Available list, select the salvo you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available salvos in the database to the soft panel, click .

6. To assign multiple salvos to the soft panel:

a. From the Available list, select the first salvo you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other salvo(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected salvos.

7. Use the provided buttons beside the Assigned list to determine the order in which the salvos are displayed on 
the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Copying a Soft Panel
 Ensure the soft panel is currently not in use.

To copy a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. From the Panels list in the left toolbar, select the soft panel to copy.

3. Click Edit > Copy.
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4. Click Edit > Paste.

The Panels tab updates to display the settings for the selected soft panel. New soft panels are automatically 
named “New Panel #” where # is an auto-generated value.

5. Select the Info tab.

6. Type a unique identifier in the Panel Name field. This will be used to identify the panel in the tree under the 
Soft Panels node.

7. Click Apply at the bottom of the Panels tab to save the new panel. This also helps to ensure that you do not 
mistakenly edit the original panel that you copied.

Editing a Soft Panel
Once you edit a soft panel, you must re-load the soft panel if it was in use prior to the edit.

 Ensure the soft panel is currently not in use.

To edit a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. From the Panels list in the left toolbar, select the soft panel to edit.

The Panels tab updates to display the settings for the selected soft panel. 

3. Edit the settings for the panel using one of the following procedures:

 You cannot edit the Panel Style of a soft panel.

• “To specify the levels for the soft panel” on page 224
• “To specify the destinations for the soft panel” on page 225
• “To specify the sources for the soft panel” on page 226
• “To specify the salvos available on the soft panel” on page 227

4. Click Apply at the bottom of the Panels tab to save the new settings.

5. If a dialog opens to remind you that the affected soft panel is currently in use:

a.  Click OK to close the dialog.

b.  Perform the procedure “To re-load a soft panel”.

To re-load a soft panel

1. Close the newly edited soft panel as follows:

a. Locate the tab for the soft panel in the DashBoard client window.

b. Click  to close the tab.

2. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

3. Double-click the node for the newly edited soft panel.

The tab for the selected soft panel opens.

Deleting a Soft Panel from the Database
 Ensure the soft panel is currently not in use.

To delete a soft panel from the database

1. Double-click the Panels node located under the Database node.

The Panels tab opens.
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2. Select the soft panel name from the Panels list in the left toolbar.

3. Click Edit > Delete.

4. Click Apply at the bottom of the Panels tab.

Using the Lock and Protect Features
Whether your soft panel includes the Lock and Protect features depends on the panel type. The Matrix and Category 
panels can include the Lock, Protect, and Free buttons. The MultiBus panels can include only the Lock button. 
Matrix and Category soft panels must have their Protection Operation set to Enable to display these buttons.

For More Information on...
• the Protection Operation, refer to Table 30.30 on page 351.

Using a Lock
If your soft panel includes a Lock button, you have the option to protect source/level and destination/level pairs. 
When another control panel or DashBoard client attempts to switch that combination, the request will be denied.

To lock a source/level pair

1. Display the soft panel in the DashBoard window.

2. Select the source/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To lock a destination/level pair

1. Display the soft panel in the DashBoard window.

2. Select the destination/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To clear a lock

• Click the Unlock button.
The label on the button changes to Lock and the button remains lit.

Using a Protect
A soft panel can be locked by clicking the Protect button. The button is lit until pressed again. A protect alarm 
message is displayed in the System Status tab when an output is protected.

This feature protects the currently selected destination/level pair from use by other sources, as well as from other 
linked panels. The Protect button is especially useful in instances where a destination must be held after a switch 
has been made.

To apply a protect

• Click Protect.
The button is lit. Selecting crosspoints will not take effect and the panel does not update when buttons are 
pressed.

To clear a protect

• Click Protect.
The button is no longer lit and crosspoint switches can be initiated.
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Using Matrix Panels
Matrix panels enable you to perform direct take transitions, and local salvo definitions using a grid of sources and 
destinations.

Panel Interface Overview
Each level is represented as a button in the color defined in the current database. Notice that the crosspoints are 
represented in the same color as the applicable level. 

Figure 19.2  Example of a Matrix Panel

1. Crosspoints

The number of Destinations and Sources and their labels in the matrix are specified using the Destinations and 
Sources interfaces. Click within the matrix or click the Destination and Source buttons to select the crosspoints 
for switching the selected levels. In Figure 19.2, crosspoints were selected using the Advanced > Diagonal 
Presets option. 

2. Levels Button

Click a level button to include that level in the next crosspoint switch. A lit button indicates that the 
corresponding level will be included in the next transition. The color and name of the button are specified using 
the Levels interface. Figure 19.2 illustrates a Matrix panel with nine levels selected.

3. Follow Button

Click this button to select all levels in the matrix. Clicking TAKE after pressing Follow will then switch all 
crosspoints at the same time on all available levels.

4. TAKE Button

Click this button to execute the switch between crosspoints. If you are using a soft panel with the Take 
Operation was set to Direct, a TAKE button is not displayed because the transitions will occur automatically 
after a crosspoint switch is selected.

5. Lock Button

Click this button to prevent switching of the selected crosspoints. When creating the soft panel, if the Protection 
Operation was set to Disable, the Lock and Protect buttons are not displayed.

6. Protect Button

Click this button to prevent switching of the selected crosspoints except in the DashBoard client session the 
Protect was initiated in.
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7. Free Button

Click this button to end a lock or protect on the selected crosspoints.

8. Salvo Button

Click this button to display the Salvo menu. Refer to the “Salvo Menus” on page 370 for information on the 
menu options.

9. Advanced Button

Click this button to display the Advanced menu. Refer to the section “Advanced Menus” on page 371 for a list 
of the menu options.

10.Machine Control Button

If you are using a soft panel with the Machine Control set to Enabled, the MACHINE CONTROL button is 
displayed. Refer to the section “Enabling Machine Control” on page 222 for details on this button.

Crosspoint Switches via a Matrix Panel
Crosspoint selections can be made using the cross-hairs or clicking the required Destination and Source buttons on 
the panel. This section provides instructions using the cross-hairs for crosspoint selections.

To make a crosspoint switch using a single level

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select a level from the toolbar.

The button is now lit.

4. Select the source and destination intersection inside the matrix.

The selection is represented as an icon set in the color that matches the level. In the example below, Level 2, 
Src 4, and Dest 2 are selected. The TAKE button is now lit.

5. Click TAKE.

The icon on the matrix is solid in the color that matches the level and the TAKE button is no longer lit.
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To make a crosspoint switch between multiple sources and destinations on a single level

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select a level from the toolbar.

4. Select the first source and destinations inside the matrix.

5. Select the additional crosspoints to switch.

In the example below, Level 2 is selected but seven crosspoint switches are also selected (each is represented 
with a green icon on the matrix).

6. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no longer lit.

To make a crosspoint switch using multiple levels

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select each level from the toolbar or click Follow to include all levels.

4. Select the first source and destination inside the matrix.

5. Select the additional crosspoints to switch.

When multiple levels are selected, the circle on the crosspoint is divided into colored sections with each section 
representing a level. In the example below, Levels 2, 4, and 6 are selected; each with multiple crosspoint 
selections on the matrix.



Ultrix User Guide (v18.0) Soft Panels in DashBoard • 233

6. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no longer lit.

To perform a crosspoint switch on multiple destinations with a single source

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

4. Click Select All located at the top left corner of the interface.

All the Dest buttons on the Matrix panel are now lit and selected.The Select All button is labeled Clear All.

5. From the top toolbar, select the Src button to switch.

The matrix updates to indicate the crosspoint switches that will occur on the next transition to the same source 
and the TAKE button is now lit. In the example below, Levels 2, 4 and 6 are selected; all destinations will 
switch to Src 4.

6. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no longer lit.
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Using a Default Preset
The Advanced menu provides two pre-configured presets: Diagonal and R-Diagonal.

Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top left corner of the matrix (e.g. Src 1 and 
Dest 1), continues in single step intervals (e.g. Src 2 and Dest 2, Src 3 and Dest 3 etc.) and ends with the bottom 
right corner of the matrix (e.g. Src 16 and Dest 16). 

To use the Diagonal Preset

1. Select each level from the toolbar or select Follow to include all levels.

2. Click Advanced > Diagonal Presets.

3. Click TAKE.

R-Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top right corner of the matrix (e.g. Src 16 
and Dest 1), continues in single step intervals (e.g. Src 15 and Dest 2, Src 14 and Dest 3 etc.) and ends with the 
bottom left corner of the matrix (e.g. Src 1 and Dest 16). 

To use the R-Diagonal Preset

1. Select each level from the toolbar or select Follow to include all levels.

2. Click Advanced > R-Diagonal Presets.
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3. Click TAKE.

Creating an Automatic Switching Loop
The Automation feature enables you to set up a crosspoint and create a continuous switch loop using the specified 
crosspoints.

To set up an automated crosspoint selection loop

1. Click Advanced > Setup Automation.

The Automation Setup menu opens.

2. Use the Repeat Interval field to specify the number seconds the crosspoint switch will continuously loop for.

3. Use the Levels menu to specify the levels the crosspoint will include.

4. Use the Destinations menu to select the outputs on the router.

5. Use the Sources menu to select the input signals to route to the output for the switch.

6. Click Start.

The menu closes and the crosspoint switch begins. The loop continues for the length of time specified in step 2.

 To instantly stop the loop, click Advanced > Stop Automation.
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Clearing the Matrix Selections
You can choose to clear all the crosspoint selections, or only the selected Destinations.

To clear all crosspoint selections on the matrix

• Click Advanced > Clear All Presets.

To clear only the Destination selections on the matrix

• Click Advanced > Clear Dest Presets, or
• Click Clear All.

Using MultiBus Panels
Use the MultiBus Panel to send a source to multiple destinations.

Panel Interface Overview
The MultiBus Panel provides breakaway control and status monitoring of several destinations simultaneously. 

Figure 19.3  Example of a MultiBus Panel

1. Destination Bus

Each button in this crosspoint row represents a configured output for the selected router. Selecting a button 
includes the destination in the next crosspoint switch. The number of destinations and label for each button is 
defined by its entry in the Destinations interface. A destination selected to be included in the next crosspoint 
switch will have a lit button. For example, Dest 2 is selected in Figure 19.3.

2. Lock Button

Click this button to prevent switching of the selected crosspoints. If you are using a soft panel with the 
Protection Operation set to Disable, the Lock button is not displayed.

3. Take Button

Click this button to execute the switch between the selected crosspoints. If you are using a soft panel with the 
Take Operation set to Direct, a TAKE button is not displayed because the transitions will occur automatically 
after a crosspoint switch is selected.
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4. Preset Button

When this button is lit, a new crosspoint switch is set up on the soft panel. At least one source, once destination, 
and one level are selected on the interface (the Dest and Src buttons are lit blue to indicate their inclusion in the 
next switch). 

When this button is not lit, the crosspoint switch setup is still valid but is no longer indicated on the soft panel.

If you are using a soft panel with the Take Operation set to Confirm, the crosspoint switch will take effect the 
next time the TAKE button is selected. If you are using a soft panel with the Take Operation set to Direct, a 
TAKE button is not displayed because the transitions occurred automatically (hot-punch operation).

5. Clear Button

Clicking this button clears the selections made for the next crosspoint switch in the soft panel interface.

6. Multi Select Button

Clicking this button enables you to perform a switch on multiple crosspoint combinations. If you are using a soft 
panel with the Selection Operation set to Single, a Multi Select button is not displayed.

7. Level Button(s)

Click a level button to include the level in a crosspoint that you are configuring in the matrix. A lit button 
indicates that the corresponding level will be included in the next transition. The color and name of the button are 
specified using the Levels interface. Figure 19.3 illustrates a MultiBus panel with three levels selected.

8. Follow Button

Click this button to select all levels in the matrix. If you are using a soft panel with the Take Operation set to 
Confirm, pressing TAKE after pressing Follow will then switch all crosspoints at the same time on all available 
levels.

9. Source Bus

Each button in this crosspoint row represents an input in the routing system. Selecting a button includes the 
source in the next crosspoint switch. The label for the button is defined by its entry in the Sources tab of the 
Database. A source selected to be included in the next crosspoint switch will have a lit button. For example, in 
Figure 19.3 the Src 1 is selected for the next transition while the Src 4 is the current source in use. 

10.Machine Control Button (not shown)

If you are using a soft panel with the Machine Control set to Enabled, the MACHINE CONTROL button is 
displayed. Refer to the section “Enabling Machine Control” on page 222 for details on this button.

Crosspoint Switches via a MultiBus Panel
The layout of a MultiBus panel is similar to a production switcher layout where the destinations are arranged into a 
horizontal row of buttons near the top of the panel and the sources are arranged on the row near the bottom. 

To make a crosspoint switch on a single level using a MultiBus panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for your MultiBus Panel.

The MultiBus Panel tab opens.

3. From the left toolbar, select the button for the level you want to perform the crosspoint switch.

4. Select a Src button from the Source bus located at the bottom of the interface.

The button is now lit.

5. Select a Dest button from the Destination bus located at the top of the interface.

The Dest, Preset, and Take buttons are now lit.
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In the example below, Level 2 is selected and Dest 4 will switch with Src 6. The Src 1 button is lit green to 
indicate that Source 1 was used in the last crosspoint switch.

6. Click Take.

To make a crosspoint switch using multiple levels

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

When multiple levels are selected, the center row of the panel reports the level status using a horizontal bar to 
represent the level.

4. Select a Src button from the Source bus located at the bottom of the interface.

The button is now lit.

5. Select the Dest buttons for the outputs to include in the crosspoint switch.

The Dest, Preset, and Take buttons are now lit. In the example below, Follow is selected and Dest 5 will 
switch with Src 4 on all levels.

6. Click Take.
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Using the Multi Select Function
Use the Multi Select button when you want to group multiple destinations to use a single source during the next 
crosspoint switch. 

To use the Multi Select 

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. Select the level(s) from the left toolbar.

4. Click Multi Select.

The Multi Select button is now lit.

5. Select the Dest buttons from the Destination bus located near the top of the interface.

The Dest buttons are now lit.

6. Select a Src button from the Source bus located near the bottom of the interface.

The Src, Preset, and Take buttons are now lit.

In the example below, Levels 2 and 3 are selected, and Dest 2, 3, and 5 will switch with Src 6.

7. Click Take.

Using Category Panels
Category panels organize sources, destinations and levels based on the settings in the Category tab. There are two 
types of category panels: group and classic. This section outlines both types.

For More Information on...
• legacy categories, refer to the RCP-QE User Guide.
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Panel Interface Overview
The soft panel interface for each category type is similar in layout and available buttons. 

Figure 19.4  Example of a Group Category Soft Panel for an Ultrix Router

1. Group Window

This area of the soft panel interface may include the following buttons:

› SOURCES, DESTINATIONS Buttons — Clicking one of these buttons updates the button matrix to display the 
sources or destinations available as per the selected category. The button labels update to display the source or 
destination labels.

› BACK Button — Click this button to return the navigation to the previous category selection (back one level).
› RESET Button — Click this button to clear all selections on the interface. This button is only available on the 

Classic Category soft panels.
› SELECT Button — This button is only available on the Classic Category soft panels.
› TOP Button — This button is only available on the Group Category soft panels.

When using a Group Category soft panel and the Info > Non-group Resources setting is set to Hide, only the 
resources assigned to a group are displayed on the soft panel.

2. Status Window

The bottom right corner of each soft panel includes a status window. For each level in the list of available levels, 
a corresponding status indicator display will indicate the current source for the currently selected destination.

The following buttons are located on the right-side of the soft panel interface:

› Individual Level Buttons — Click a level button to include the level in a crosspoint that you are configuring in 
the matrix. A lit button indicates that the corresponding level will be included in the next transition. The color 
and name of the button are specified using the Levels interface.

› CURRENT button — This button updates the level display area to show the current status for all displayed 
levels.

› FOLLOW Button — Click this button to select all levels in the matrix. Clicking TAKE after clicking Follow 
will then switch all crosspoints at the same time on all available levels.

› PENDING button — This button updates the level display area to show status for the currently pending 
operation (if selected source has not been switched yet. e.g. before TAKE is pressed). The user may clear 
individual source selections by selecting the levels to be cleared, then pressing CLEAR SRC SEL button.

› CLEAR Button — Click this button to clear all selections on the interface.
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› USER button — This button shows current lock/protect status of each levels (and the soft panel name that is 
currently owned it). Since the soft panel does not recognize the names of remote control panels (RCP) to 
retrieve their name, a “owner #” name is used. 

3. TAKE Control Area

The bottom toolbar of the soft panel interface includes the following buttons:

› PROTECT Button — Click this button to prevent switching of the selected destination except by the panel that 
initiated the protect. If you are using a soft panel with the Protection Operation set to Disable, the Protect 
button is not displayed.

› LOCK Button — Click this button to prevent switching of the selected destination by an control device. If you 
are using a soft panel with the Protection Operation set to Disable, the Lock button is not displayed.

› VIEW Button — Click this button to display the VIEW dialog. This dialog lists the current TAKE commands 
in the queue. Individual items may be removed from the queue via the options in the VIEW dialog.

› CLEAR Button — Click this button to clear the current TAKE queue.
› PRESET Button — This button is used to queue up multiple TAKE commands. Select a destination/source 

combination, then click PRESET. Select another destination/source combination then click PRESET. A 
following TAKE command will execute all the PRESET switches. To view the switch commands queued by 
the PRESET, click VIEW.

› TAKE Button — Click this button to execute the switch between the selected crosspoints. If you are using a 
soft panel with the Take Operation set to Direct, a TAKE button is not displayed because the transitions will 
occur automatically after a crosspoint switch is selected.

Crosspoint Switches via a Category Panel
The buttons and options in a Category soft panel are dependent on the categories defined for the current database, 
and how the soft panel was defined in the Panels tab. Instead of having access to all sources, destinations, and 
levels at one time, a Category soft panel provides access based on the categories and the tags you have created.

To make a crosspoint switch using a Group Category Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for the Category Panel.

The Category Panel tab opens.

3. From the status window, highlight the level(s) you wish to include in the crosspoint switch.

• Selected levels highlight in the level defined color.
• Non-selected levels are indicated by a gray button with white text.

Figure 19.5  Status Protected — Destination Figure 19.6  Status Protected — User
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4. To select a destination:

a. Click DEST from the category navigation tools.

b.  Navigate to the desired group using the displayed groups in the main group window. 

 Only groups containing destination assignments will be displayed unless the Non-group Resources option for 
this soft panel is set to Show.

c. Select a DEST button from the available category destinations located in the main group window.

The status title bar (if enabled) reports the currently selected destination. In the example below, the user has 
selected Level A1 and destination EDIT 3 from the EDIT group.

5. To select a source:

a. Click SRC from the category navigation tools.

b. Select a SRC button from the Source bus located in the middle of the interface.

 If your Category soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.

6. Click TAKE.
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Using Push Button Panels
 This soft panel type is not suitable for use on an Ultritouch hard panel. To control the Ultrix via an Ultritouch, 

you must create and load an Ultritouch PB soft panel as outlined in the Ultritouch + Ultrix User Guide.

Panel Interface Overview
The Push Button soft panel is organized into three distinct windows. The order and width of each window can be 
customized using the options in the Panels > Home View interface.

Figure 19.7 is an example of a Push Button soft panel set to portrait.

Figure 19.7  Example of the Default Push Button Soft Panel — Portrait

Figure 19.8 is an example of a Push Button soft panel set to landscape.

Figure 19.8  Example of the Default Push Button Soft Panel — Landscape
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1. Destinations Area

The Destinations area displays the available destinations for router control. Select a Destination button to arm 
that destination for subsequent panel operations. Beneath each destination button is displayed the current source 
for that destination.

This area also includes the Filter field. A filter is available to match destination names against the entered text:   

• Enter text in the Filter field.

• Click  (or press Enter). The destinations area updates to display only those destinations starting with 
the filter text.

• To clear the active filter, click .

2. Sources Area

The Sources area displays the available sources for router control. Select a Source button to control the 
crosspoint for the currently selected destination.

This area also includes a Filter field. A filter is available to match source names against the entered text:

• Enter text in the field provided

• Click  (or press Enter). The sources area updates to display only those sources starting with the filter 
text.

• To clear the active filter, click .

3. Current Destination

The currently selected destination label is displayed here. All subsequent panel operations operate on this 
destination until a new destination is selected.

›  — the current status is not the same for all levels (ie a breakaway switch has occurred).

›  — the current destination is locked. No switches can be made on this destination.

›  — the current destination is protected. Only the panel that initiated the protect may switch this 
destination.

4. Levels Area

The Levels area displays the available router levels as individual buttons. The current source for a given router 
level is displayed each level button. Select a Level button to include this level in the next source selection 
operation. Select the button again to toggle the level selection setting.

› FOLLOW Button — toggles the selection for all displayed levels.
› CLEAR Button — toggles the currently active level buttons.

5. Operation Area

This area provides buttons for soft panel and router control.

› PROTECT Button — protect the current destination. The following occurs:
• The destination button displays a blue border.

• The Current Destination area displays . When a destination is protected, only the panel that initiated 
the protect can change the destination status.

• The PROTECT button is now labeled as UNPROTECT. Toggle the button to disable the protect.

 Only the panel that initiated the protect may change the protect status.
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› LOCK Button — locks the current destination. The following occurs:
• The destination button displays a red border.

• The current destination display area displays . A panel cannot change the destination status of a 
locked destination.

• The LOCK button is now labeled as UNLOCK.

 Only the panel that initiated the lock may change the lock status.

› VIEW Button — displays the current crosspoint switch requests currently in the preset list. Individual 
crosspoints may be removed via the list view.

› CLEAR Button — clear the preset list of all crosspoint selections.
› PRESET Button — adds the current destination/source/level selection to a preset list. A crosspoint is added to 

the list for every level selected. This enables the user to add more switches and execute them all with a single 
take operation. The preset function is only available when the Take Mode is set to Confirm.

› SALVO Button — reveals a list of predefined salvos. A salvo may be executed from the dialog. The salvo 
button is visible only when the panel configuration has one or more salvos assigned.

› TAKE Button — is lit when the current destination/source selection is ready to be requested of the router. The 
Take operation is a configurable and will only be activated if the soft panel Take Mode is set to Confirm.

Configuring a Push Button Soft Panel
The Push Button soft panel provides additional configuration options in addition to those outlined in “Creating a 
Soft Panel” on page 222.

To configure a Push Button soft panel

1. Create a new soft panel as outlined in the procedure “To create a soft panel” on page 222.

2. Select the Home View tab.

3. Use the Display Icons menu to specify whether buttons will display the default icons based on window type 
(Enable) or will only display the label text as determined by the database (Disable).

4. Use the Orientation menu to specify the layout on the monitor. Choose from the following:

• Portrait — a horizontal layout; the panel is taller than it is wide. (Figure 19.7)
• Landscape — a vertical layout; the soft panel is wider than it is tall. (Figure 19.8)

5. Specify the order that the windows will display in the completed soft panel layout as follows:
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 By default, the windows are organized in the following order (left to right): Destinations, Sources, and Status.

a. In the Home Windows table, select the row for the window you want to move to on the soft panel layout.

b. Use the buttons in the toolbar to move the row to the desired position.

In the example, the Status window moved to the top of the table and displays on the far left of the panel.

6. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel area.
• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display

7. Click Apply to save your changes.

Crosspoint Switches via a Push Button Panel
The buttons and options in a Push Button soft panel are dependent on the current database, and how the soft panel 
was defined in the Panels tab. You can also use the Filter fields in the Destinations and Sources area of the panel to 
provide access based on the search criteria entered into each Filter field.

To make a crosspoint switch on a single level using the Push Button Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for the Push Button Panel to open the Push Button Panel tab.

3. Select the Level you want to perform the crosspoint switch.

4. Select a DEST button from the Destinations window.

The Status field reports the selected DEST button. In the example below, the user selected Level 6 and Dest 54.
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5. Select a SRC button from the Sources window.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. Otherwise the 
crosspoint switch automatically occurs.

6. Click TAKE.

To make a crosspoint switch on multiple levels using the Push Button Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix.

2. Double-click the node for a Push Button Panel.

The Push Button Panel tab opens.

3. Select each level from the Levels window or click Follow to include all levels.

The Level buttons are lit in the toolbar.

4. Select a DEST button from the Destination window.

The Status area updates to display report the selected DEST button. In the example below, the user selected 
Levels 2, 6, 8 and 11, then Dest 40.

5. Select a SRC button from the Source window.
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The Status area updates to display only the selected SRC button. In the example below, Src 6 is selected.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. Otherwise the 
crosspoint switch automatically occurs.

6. Click TAKE.

Using an Ultritouch PB Panel
An Ultritouch PB soft panel is organized into a pre-sized layout that can be loaded for use on an Ultritouch hard 
panel. Customize each soft panel by specifying the size of each window, the location of each window on the layout, 
and what operational buttons to include on the panel.

 The Ultritouch PB soft panel can only be loaded and used on an Ultritouch hard panel. 

Figure 19.9  Example of an Ultritouch PB Soft Panel

For More Information on...
• configuring and using an Ultritouch PB soft panel, refer to the Ultritouch + Ultrix User Guide.
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Using Salvos
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later recalled for use.

Creating Salvos
The Salvos tab enables you to create, delete, re-name, and manage your salvos in an interface that is off-line. The 
Salvo tab layout is similar to the Matrix Panel layout where crosspoints are arranged in a grid layout with sources in 
columns and the destinations in rows. 

To create a salvo

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

4. Select the Level(s) button for the level(s) to include in the salvo.

The Level(s) buttons are lit.

5. To create a single crosspoint switch, use the cross-hairs to select the source/destination combination on the 
grid.
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6. To assign multiple destinations to the same source.

a. Click the button(s) in the Destination toolbar for each destination to include in the switch; or click Select 
All to include all the available Destinations.

b. Click the button in the Source toolbar for the source to use for the switch.

The grid updates to indicate the new selections. Notice that each level is represented by a corresponding slice 
of the crosspoint indicator. In the case below, there are seven crosspoint switches selected that will affect two 
levels.

7. Click Follow to enable the levels to automatically follow the switches.

 Click Advanced > Clear Dest Presets to cancel the destination selections or click Advanced > Clear All 
Presets to clear the workspace.

8. Click Apply.

The salvo settings are updated.



Ultrix User Guide (v18.0) Using Salvos • 251

Saving the Current Crosspoint Status as a New Salvo
The Advanced menu in the Salvos tab provides the option to capture the current state of the crosspoint selections 
and save them as a salvo.

To create a salvo based on the current destination status

 This procedure captures the status of all destinations.

1. Verify the current crosspoint state using one of the soft panels in your database. Refer to the chapter “Soft 
Panels in DashBoard” on page 221.

2. In the Basic Tree View, expand the Database node for the Ultrix router.

3. Double-click the Salvos node.

The Salvos tab opens.
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4. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

5. Click Advanced > Capture System Status.

The matrix in the Salvos tab updates to reflect the current crosspoint state as verified in step 1.

6. Click Apply.

The salvo settings are updated.

To create a salvo based on selected destinations

 This procedure captures the status for selected destinations.

1. Verify the current destination crosspoint states using one of the soft panels in your database. Refer to the 
chapter “Soft Panels in DashBoard” on page 221.

2. In the Basic Tree View, expand the Database node for the Ultrix router.

3. Double-click the Salvos node.

The Salvos tab opens.

4. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

5. Click Advanced > Capture Dest Status.

The matrix in the Salvos tab updates to reflect the current Destination states as verified in step 1.
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6. Select the Level(s) button for the level(s) to include in the salvo.

The Level(s) buttons are lit.

7. Select the source(s) to use in the crosspoint switch.

8. Click Apply to update the salvo settings.

Copying and Pasting a Salvo
You can create a copy of a saved salvo and edit its settings or add crosspoint selections separately from the original 
salvo.

To copy and paste a salvo

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo to copy from the Salvos list.

4. Click Edit > Copy.

5. Click Edit > Paste.

A new salvo displays at the bottom of the Salvos list in the Salvos tab. By default, the salvo is named Salvo # 
where # is an automatically assigned value.

6. Give the new salvo a unique identifier as outlined in the procedure “To re-name a salvo” on page 254.

7. Edit the settings of the new salvo as outlined in the procedure “To edit a salvo” on page 253.

Editing a Salvo
Once a salvo is created in the database, you can edit its crosspoint selections, 

To edit a salvo

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.
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The Salvos tab opens.

3. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections currently saved for the salvo.

4. Perform steps 4 to 6 as outlined in the procedure “To create a salvo” on page 249.

5. Click Apply to save your changes.

To re-name a salvo

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections saved for the salvo.

4. Click Edit > Rename.

The Rename Salvo dialog opens.

5. Type a new name for the salvo in the Name field.

6. Click Apply.

The Rename Salvo dialog closes and the salvo displays with the new name in the Salvos list.

Deleting a Salvo
Deleting a salvo removes it from the database. The corresponding button on any soft panels for the deleted salvo are 
also no longer displayed.

To delete a salvo from the database

1. In the Basic Tree View, expand the Database node for the Ultrix router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. From the Salvos list, select the salvo to delete.

4. Click Edit > Delete.

5. Click Apply to close the dialog.

The salvo no longer displays in the Salvos list to the left of the workspace. If the salvo was assigned to a button 
in a soft panel, the button is automatically deleted from the panel.

Recalling a Salvo
Once you have saved a salvo, you can recall it for use on a soft panel in DashBoard.

 You cannot recall salvos from a Category soft panel.

For More Information on...
• adding salvos to customized soft panels, refer to the section “Creating a Soft Panel” on page 222.

To recall a salvo from a Matrix panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix router.

2. Double-click the node for a Matrix Panel.

The Matrix Panel tab opens.



Ultrix User Guide (v18.0) Using Salvos • 255

3. Click Salvo.

4. Click Recall.

The Execute Salvo dialog opens. Notice that the Active column reports whether the salvo is currently in use 
(ON) or not (OFF).

5. Select the salvo to recall.

6. Click Apply to close the dialog.

7. Click Take to apply the salvo.

To recall a salvo from a MultiBus panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix router.

2. Double-click a MultiBus Panel node.

The MultiBus Panel tab opens. The salvo buttons are located at the bottom of the soft panel interface. If a 
salvo button is lit green, the current router status matches the salvo presets. 

3. Click the button for the salvo you wish to recall.

The salvo button and Take buttons are now lit on the soft panel.



256 • Using Salvos Ultrix User Guide (v18.0)

4. Click Take to apply the salvo.

The crosspoint switch is made, and the salvo button is no longer lit.

To recall a salvo from a Category panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultrix router.

2. Double-click a Category Panel node.

The Category Panel tab opens. The salvo buttons are located at the bottom of the soft panel interface. If a 
salvo button is lit green, the current router status matches the salvo presets. 

3. Click the button for the salvo you wish to recall.

The salvo button and Take buttons are now lit on the soft panel.

4. Click Take to apply the salvo.

The crosspoint switch is made, and the salvo button is no longer lit.
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Operation with Ross Devices
Ultrix may also connect to Ross NK series devices to expand functionality for signal types the Ultrix router itself 
does not handle. The Ross NK series devices must be connected to the Ethernet network by virtue of an Ross 
NK-IPS or NK-NET devices to enable the Ultrix router to communicate with them.

Overview
Introducing an Ultrix router to a Ross NK system will require specific configuration to enable the Ultrix routing 
system to manage them.

Using RCP-NKx Remote Control Panels

When adding the Ultrix router to an existing system with one or more RCP-NKx devices, each remote control must:

• have the Virtual routing enabled on their Configuration page
• have the Comms Retry Delay Factor set to 80ms or greater
• ensure that the level numbers correspond to the Ultrix Level ID number

Be aware that the RCP-NKx devices do not:

• support Ultrix salvos
• automatically get source and destination labels from the Ultrix router. They must be entered manually or via a 

global labels file.

Using Ross NK Series Routers

The Ross NK router partitioning not supported. The logical mapping of the Ultricore control system is far more 
capable and should be implemented there if required.

Keep the following in mind:

• The NK-IPS requires version 2.23 or greater to communicate with an Ultrix router.
• The SCP/A is not supported.
• The SCP/K2 is not supported.
• NK-A64 control level is not supported.

Table 21.1 outlines the nomenclature that Ultrix automatically uses for Ross NK devices. 

Using Ross Analog Audio Devices (NK-A16, NK-A32, NK-A64)

The Ross NK Analog Audio devices (NK-A16, NK-A32, NK-A64) will present as two matrices: Left and Right 
respectively. Note that the NK-A64 control level is not supported.

Table 21.1  Default Ultrix Naming for Ross NK Devices

Ross NK Device Matrix Name Port Name
NK-3Gxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Axxx deviceName.An Aud L deviceName.slot1.in/out[socket number].An Aud L.ch1

deviceName.An Aud R deviceName.slot1.in/out[socket number].An Aud R.ch1

NK-Dxxx deviceName.AES deviceName.slot1.in/out[socket number].AES.ch1

NK-Mxx deciceName.Machine Control deviceName.slot1.in/out[socket number].Machine Control.ch1

NK-MDxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Vxxx deviceName.An Vid deviceName.slot1.in/out[socket number].An Vid.ch1
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Connection Diagrams
Figure 21.1 provides an example of a routing system with an Ultrix router, an NK-NET, and several Ross NK 
devices. Communication between the NK-NET and the Ross NK devices is over T-Bus.

 The NK-NET requires any Ross NK router to supply phantom power for operation.

Figure 21.1  Connection Example with an NK-NET

Figure 21.2 provides an example of a system with an Ultrix router, an NK-IPS, and several Ross NK devices. 

Figure 21.2  Connection Example with an NK-IPS
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Adding Ross NK Series Devices to the Ultrix Routing System
To add a Ross NK series device to the Ultrix routing system:

1. Define a connection point between the Ultrix router and each Ross NK series device. Refer to the chapter 
“Device Communication Setup” on page 95 for details.

2. Review the logical matrices for the Ultrix database.

3. Assign outputs to the logical destinations in the database as outlined in the section “To map a physical output 
to a destination” on page 113.

4. Assign inputs to the logical sources in the database as outlined in the section “To map an input to a source” 
on page 117.

Machine-Control (RS-422) Logical Mapping
Connecting an NK-M series router to Ultrix requires some special consideration;

Machine control routing requires two crosspoints for a point to point connection due to the bi-directional nature of 
the signal. Each physical socket contains a transmit/receive pair. This can be thought of as a source-destination 
combination and is known as a port. 

It is necessary to configure the input and output of the machine control port on the same row ID on the logical 
mapping tables.

Figure 21.3  Destination Mapping

Figure 21.4  Source Mapping

It does not matter where the machine control is mapped (either row 3 or 300), but the input and outputs physical 
ports must be mapped to the same row ID.

Conditions for Machine Control
Three conditions must be met before machine control can be switched.

1. The NK machine control router is attached and configured within Ultrix (level, destination. and source maps).

2. Selected breakaway or level must include the machine control level.

3. Machine control reciprocal must be enabled on the controller.

Using Ultricore-CC as a System Controller
Ultricore-CC may control one or more Ultrix routers. Ultricore has the advantage of supporting more external 
connections so is ideal for systems with many external connections (RCPs, DashBoard instances, third-party 
control).

 Ensure a unique device name for each Ultrix within a system.
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Figure 21.5  Example Setup Using an Ultrix and an Ultricore
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Figure 21.6  Workflow Example of an MC1-MK with an Ultrix Router

Communications between an MC1-MK and the Ultrix Router

 The MC1-MK requires software version 5.0 or higher to support the Ultrix router.
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• Set the Protocol to TCP.
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For More Information on...
• the communications setup for the MC1-MK, refer to the MC1-MK Installation Manual.
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External Control
This chapter summarizes the third-party protocols the Ultrix router supports. 

Ultrix Control with Third-Party Systems
Ultrix may be controlled by third-party control or automation systems via the GVG Native Series 7000 or Probel 
SW-P-08 protocols.

Ethernet Communication
The Ethernet interfaces to these protocols are automatically started with Ultrix and no further configuration is 
necessary. However, you must configure your external control systems to match the settings outlined in Table 11.1. 

For More Information on...
• defining an Ethernet connection between Ultrixand an external device, refer to the section “Third-part 

Connection via Ethernet” on page 98.

Serial Communication
If you are using a serial connection, you must first define the serial connection point as outlined in the section 
“Defining a Serial Connection” on page 100 and selecting GVG Native or Probel SW-P-08 from the Protocol 
menu and the settings as outlined in Table 11.3.

Third-Party Matrix Control with Ultrix
The Ultrix control system is able to control third-party matrix devices. Two popular routing protocols are available 
to enhance compatibility: GVG Series 7000 and Probel SW-P-08.

To configure third-party matrix control

1. Create an outgoing connection point from the Ultrix to the third-party matrix device.

2. Define the external matrix.

3. Mapping the external matrix inputs and outputs.

4. Define the Ultrix operating level.

5. Assign external matrix to the Ultrix source and destination levels.

The following sub-sections outline each step required to configure third-party matrix control.

Create an Outgoing Connection Point
You must define an interface for the system to access third-party matrix devices. The connection point must be 
compatible with the settings of the external device you are trying to control.

Before proceeding, ensure that you have the following connection specifics:

• Communication protocol (GVG Native Series 7000 or Probel SW-P-08)

• Communication type (TCP/IP or serial1)

Refer to the section “Connecting to Third-Party Devices” on page 98 details.

1. Only available natively on the Ultrix Central Controller. Serial connections from Ultrix requires an external USB-serial converter.
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Defining the External Matrix
The system does not automatically know the details of any connected third-party matrix. The user must manually 
define the size and operating level within the Ultrix database.

Creating a Logical Matrix for an External Device

Once you establish a valid connection point between the Ultrix router and an external device, you can create logical 
matrices in an Ultrix database using the device inputs and outputs. Creating a logical matrix from the external 
device enables Ultrix to include the inputs and outputs for selection in the Sources and Destination tabs of the Ultrix 
database.

 The input/output range and level you specify in the Ultrix database must match the settings within the external 
matrix. 

To create a logical matrix from an external device

1. Expand the Database node.

2. Double-click the Third Party Matrices node located under the Database node.

The Third Party Matrices tab opens. 

3. Click Edit > Insert to display the Insert Matrix dialog.

4. In the Name field, type a unique identifier for the third-party matrix. This name is used to identify the matrix 
within the Ultrix database.

5. Click Apply to close the Insert Matrix dialog and add a blank row to the Third Party Matrices table.

In the example below, a new matrix named “Matrix 2A” was added.

6. From the Device ID drop-down menu, select the device you want to define the logical matrix for. This is the 
name given to the device when you established a connection point with it on the Connections tab.

 The Device ID menu lists only the third-party devices that have a valid connection point with the Ultrix router.

7. Define the matrix size as follows:

a. Use the First Output and Last Output fields to define the range of destinations from the device within the 
Ultrix database.

b. Use the First Input and Last Input fields to define the range of sources from the device within the Ultrix 
database.
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 These created inputs and outputs will use the nomenclature DeviceID.Slot.Port.Type.Channel where DeviceID 
represents the Name assigned to the external device on the Connections tab.

8. Use the Level field to specify the number of levels for the device within the Ultrix database.

9. Use the Type field to specify the signal type for the matrix. 

10. Click Apply to save the new matrix to the database and add it to the list of available matrices in the Port 
Labels tab.

Mapping the External Matrix Inputs and Outputs
Once the connection point and matrix are defined in the Ultrix database, you can map the external matrix inputs and 
outputs in the same manner as we do with Ross device matrices. However, you will instead select an external matrix 
output from the Outputs list (or an external matrix input from the Inputs list) in the database interfaces. The 
available inputs and outputs will display in the format of DeviceID.slot#.in[x].Type.ch# or 
DeviceID.slot#.out[x].Type.ch#. 

 It may be necessary to create a new level in the Ultrix database for the assignment of inputs and outputs to logical 
labels. Refer to the section “Defining the Levels in a Database” on page 110 for details.

For More Information on...
• assigning destinations, refer to the section “Defining the Destinations in a Database” on page 112.
• assigning sources, refer to the section “Defining the Sources in a Database” on page 115.

Using Index Numbers
Some protocols refer to source and destinations with a numerical index number. This number is listed in the ID 
column of the Source and Destination tabs of the Ultrix database.

For example, the GVG protocol reference to destination ‘00h’ correlates to Ultrix destination ID 1 in the case 
shown below for the Dest 1 entry in the table.

Figure 22.1  Example of ID Numbers Listed in a Destinations Tab

GVG Series 7000 Native Protocol Commands
Ultrix supports the GVG Series 7000 Native protocol and is available over an RS-422 or RS-232 serial connection, 
as well as ethernet connection. 

Table 22.1  Default GVG Native Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400
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To send GVG Native commands to Ultrix

1. Create a network connection to the Ultrix router on TCP/IP Port 12345.

2. A successful connection will be displayed in the listed client devices under the Device Configuration interface.

3. Refer to Table 22.2 for a list of GVG Native Protocol commands that Ultrix supports.

Data Bits 8

Parity None

Stop Bits 1

Ethernet

Port 12345a

a. Port 12345 is the default value but is user configurable.

Table 22.2  GVG Native Protocol Commands

Message
NotesCommand Description

BK[,parameter]

BK,D Force next QD command to return 
status of all destinations

Clears the flags associated with the D,no_parameter 
command. After BK,D is sent, the next QD,no_parameter 
command will result in destination statuses or all destinations 
being returned.

BK,E Request status of level 4 echo 
setting

BK,E,ON Set level 4 echo to on An err=00 response will be returned for successful commands 
that do not generate their own response (eg. Take commands).

This is a per session setting.

BK,E,OFF Set level 4 echo to off (default) No response will be given for commands that do not generate 
their own response.

PR,dest_name,level_bitmap Protects a specific destination 
from having its source changed

ER error-code response is currently not supported.

QC[,dest_name] Query Combined Destination 
status by name

QD[,dest_name] Query Destination status by name No information is returned for unmatched destination levels

Qd[,dest_name] Query Destination status by name Sets response src_name to NO_XPT for unmatched 
destination levels

QI,destIndex,lvlIndex Query Destination status by 
indexa

Qi,destIndex,lvlIndex Query Destination status by 
indexa

The srcIndex returned will be 0xfffe if an error condition 
applies to the crosspoint being reported.

QJ[,destIndex] Query Destination status by 
indexa

No information is returned for unmatched destination levels

Qj Query Destination status by 
indexa

Sets response srcIndex to 0xFFFe for unmatched destination 
levels

QN,parameter

QN,S Query source names/labels As defined inactive database

Table 22.1  Default GVG Native Connection Types

Setting
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For More Information on...
• these commands, refer to the GVG protocol documentation.

RossTalk Commands
The RossTalk protocol is a plain text based protocol that allows control of Ross Video equipment.

 Each command should be terminated by a carriage return and a line feed (CR/LF).

To send RossTalk commands to Ultrix

1. Create a network connection to the Ultrix router on Port 7788.

2. At the prompt, enter the commands you wish to send. Refer to Table 22.3 for a list of supported commands.

QN,D Query destination names/labels As defined inactive database

QN,L Query level names/labels As defined inactive database

QN,IS Query names via source indexa

QN,ID Query names via destination 
indexa

QT Query date and timea

TA,dest_name,nbr_sources,src_name
_entry1[,...src_name_entryn]

Takes sources (on specified 
levels) to specified destination, by 
name rather than index

Src_name_entryn = src_name,level_bitmap

TD,dest_name,src_name_entry Takes same source to all or 
specified levels

Src_name_entryn = src_name[,levelbitmap]

No levelbitmap=all destination levels

TI,destIndex,srcIndex[,levelIndex] Request take by index with level 
indexa

TJ,destIndex,nbr_sources,srcIndex,lev
el_bitmap[,...,srcIndex,level_bitmap]

Takes sources (on specified 
levels) to specified destinations by 
index rather than name; allows 
breakaways

TS,salvo_name Request Take Salvo TS,salvo_name

UP,dest_name,level_bitmap Removes Protect from specified 
destination

ER, error-code response is currently not supported.

a. Zero-based hex logical index numbering.

Table 22.3  RossTalk Protocol Commands

Message
NotesCommand Description

GPI ## Execute the salvo number corresponding to the 
numerical ## extension of the command

For example, GPI 04 triggers the salvo 
<salvo_name>[4] as listed in the Ultrix 
database

TIMER ##:RUN Request Timer ID to start/resume

TIMER ##:STOP Request Timer ID to stop

TIMER ##:PAUSE Request Timer ID to pause

Table 22.2  GVG Native Protocol Commands

Message
NotesCommand Description
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Probel SW-P-08 Protocol Commands
Ultrix supports the Probel SW-P-08 protocol and is available over an RS-422 or RS-232 serial connection, as well 
as ethernet connection. Table 22.4 provides the default values for this protocol. 

Table 22.5 lists the Probel SW-P-08 Serial Protocol commands the Ultrix supports.

TIMER ##:END Request Timer ID to end

XPT D:<dest> S:<source> I:<user_id> [L:<levels>] Crosspoint command for a router TAKE where:
• <dest> is the logical destination ID from the 

active database (1-based)

• <source> is the logical source ID from the 
active database (1-based)

• <user_id> is the numeric user/panel ID that 
will be used to request the switch

• <levels> is an optional parameter specifying 
comma-separated list of 1-based level IDs to 
switch (for breakaway, e.g. L:1,2,4). If no 
levels are specified, a follow switch (all valid 
levels) is requested. 

• <levels> supports ranges specified by two 
numbers separated by dash (e.g. L:1-16)

Range start value must be less than the end 
value

Single levels and ranges can be mixed in the 
list (eg. L:1,3,4-8,12-17)

There are no spaces between numbers or 
ranges

Invalid numbers or improperly specified 
ranges will be ignored 

An argument is separated from its value using 
a single colon (:)

Command arguments are separated single 
spaces

The arguments may be specified in any order, 
(e.g. these are equivalent: XPT D:1 S:4 I:2 and 
XPT S:4 I:2 D:1)

Examples:
• ID 7 requesting to switch Dest 2 to Source 1 

on Levels 1,3,5 and 12-16

• XPT I:7 D:2 S:1 L:1,3,5,12-16

Table 22.4  Default Probel SW-P-08 Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet

Port 8910a

a. Port 8910 is the default value but is user configurable.

Table 22.5  Probel SW-P-08 Native Protocol Commands

Request Message Response Message
NotesCmd ID Description Cmd ID Description

01 Crosspoint Interrogate 03 Crosspoint Tally Get single crosspoint status

02 Crosspoint Connect 04 Crosspoint connected Take single crosspoint

Table 22.3  RossTalk Protocol Commands

Message
NotesCommand Description
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10 Protect Interrogate 11 Protect Tally Get destination protect status

12 Protect Connect 13 Protect connected Set destination protect

14 Protect Disconnect 15 Protect dis-connected Turn off destination protect

17 Protect Device Name Request 18 Protect Device Name Response Get name of device that hold 
protect

19 Protect Tally Dump Request 20 Protect Tally Dump Get all protect status

21 Crosspoint Tally Dump Request 22, 23 Crosspoint Tally Dump Get all crosspoint status

Cmd22: Byte max dest 191

Cmd23: Word max. dest. 
65535 

97 Implementation Request 98 Implementation Status Get list of commands 
supported

100 All Source Names Request 106 Source Name Response Get all source names (8 char. 
max.)

101 Single Source Name Request 106 Source Name Response Get single source names (8 
char. max.)

102 All Destination Association Name 
Request

107 Destination Association Name 
Response

Get destination names (8 
char. max.)

103 Single Destination Association Names 
Request

107 Destination Association Name 
Response

Get single destination name 
(8 char. max.)

104 All UMD Labels Request 108 UMD Label Response Only one set of labels is 
currently supported. UMD 
Labels replicate source 
labels. (16 char. max.)

105 Single UMD Labels Request 108 UMD Label Response Get single source label (16 
char. max.)

120 Crosspoint Connect On Go Group 
Salvo

122 Crosspoint Connect On Go Group 
Salvo Acknowledge

Add crosspoint to preset 
group

121 Crosspoint Go Group Salvo 123 Crosspoint Go Done Group Salvo 
Acknowledge

Switch/clear preset group

124 Crosspoint Salvo Group Interrogate 125 Crosspoint Group Salvo Tally Preset group status

EXTENDED
129 Extended Crosspoint Interrogate 131 Extended Crosspoint Tally Get crosspoint status

130 Extended Crosspoint Connect 132 Extended Crosspoint Connected Take single crosspoint

138 Extended Protect Interrogate 139 Extended Protect Tally Get destination protect status

140 Extended Protect Connect 141 Extended Protect Connected Protect a destination

142 Extended Protect Disconnect 143 Extended Protect Disconnected Turn off protect for a 
destination

147 Extended Protect Tally Dump 148 Extended Protect Tally Dump Message Get all protect status for 
given level

149 Extended Crosspoint Tally Dump 151 Extended Crosspoint Tally Dump Word 
Message

Get destination status for 
given level

228 Extended All Source Names 234 Extended Source Name Response Get source names (8 char 
max.)

229 Extended Single Source Name 234 Extended Source Name Response Get single source name (8 
char max.)

Table 22.5  Probel SW-P-08 Native Protocol Commands

Request Message Response Message
NotesCmd ID Description Cmd ID Description
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NVISION Commands
This section outlines the NVISION protocol commands supported by Ultrix.

 Ensure that the Ultricore-NVISION license is installed for your router. Refer to the section “Installing a License 
Key” on page 34 for details.

NVISION NP16 Ethernet Protocol
Ultrix supports the NVISION NP16 Ethernet protocol. Table 22.6 outlines the default values for the Ultrix when 
using NP16.

NP16 Commands

The NP16 protocol defines the message format: Protocol ID | Sequence Number | byte count | Command

Each field consists of a 32bit number where:

•  Protocol ID — 0x0000000C (Router Control Protocol)
•  Sequence number — controller generated and added to Ultrix response message
•  byte count — total number of bytes in message including header (<8176)
•  Command — refer to Table 22.7

 The protocol is zero based, meaning that destination 0 in the protocol relates to destination ID#1 in Ultrix. This is 
true for sources, destinations, and level values.

Refer to Table 22.7 for a list of supported NP16 commands.

230 Extended All Destination Association 
Names

235 Extended Destination Association 
Names Response

Get all destination names (8 
char. max.)

231 Extended Single Destination 
Association Name

235 Extended Destination Association 
Names Response

Get single destination name 
(8 char. max.)

232 Extended Single UMD Label Request 236 Extended UMD Labels Response Get all source labels (16 char. 
max.)

233 Extended Single UMD Label Request 236 Extended UMD Labels Response Get single source label (16 
char. max.)

248 Extended Crosspoint Connect On Go 
Group Salvo

250 Extended Crosspoint Connect On Go 
Group Salvo Acknowledge

Preset group acknowledge

124 Crosspoint Group Salvo Interrogate 253 Extended Crosspoint Group Salvo Tally Preset group status

Table 22.6  Default Connection Types — NVISION NP16

Setting
TCP Port 5194

Table 22.7  NP16 Protocol Commands

Message
NotesCommand Description

0x0000 0050 Performs a TAKE

0x0000 0051 Set Output LPR Sets or releases a lock or protect on a 
destination

Table 22.5  Probel SW-P-08 Native Protocol Commands

Request Message Response Message
NotesCmd ID Description Cmd ID Description
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NVISION NP0010 Serial Protocol
Ultrix supports a limited sub-set of the NVISION serial NP0010 protocol.

Table 22.8 outlines the default values for the Ultrix for an NP0010 serial connection.

Refer to Table 22.9 for a list of supported NP0010 commands.

0x0000 0052 Get Status of Outputs Retrieves the crosspoint status

0x0000 0059 Router Partition Information

0x0000 005E Crosspoint Tally Retrieves the crosspoint status

0x0000 0070 Machine Control Take Format 1 only

Table 22.8  Default Connection Types — NVISION NP0010

Setting
Connection Type RS232, RS422

Baud 9600, 19200, 38400, 56700, 115200

Data Bits 8

Parity No

Stop Bits 1

Table 22.9  NP0010 Protocol Commands

Message
NotesCommand Description

0x50 Take Non-timestamped version only

0x51 Destination status Get destination status

0x55 Lock destination Assert a destination lock

0x56 Protect destination Assert a destination protect

0x58 Release destination lock/protect Releases the destination lock and protect

0x66 Destination LPR state Get destination locked/protect/released status

Table 22.7  NP16 Protocol Commands

Message
NotesCommand Description
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TSL UMD Protocol v3.1 Commands
Table 22.10 outlines the default values for the Ultrix when using TSL UMD v3.1.

Protocol Implementation
Ultrix implements the protocol with the following structure: DisplayID|Control|DisplayData.

Table 22.11 lists the TSL UMD Protocol v3.1 commands the Ultrix supports.

Table 22.10  Default Connection Types — TSL UMD v3.1

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5727

UDP Port 4490

Table 22.11  TSL UMD Protocol v3.1 Commands

Protocol 
Breakdown Description UltriScape System Use

Display Address 0 - 126 display identification enumeration DisplayID associated with source or 
destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Tally 1 (Red)a

a. Green/Red may be swapped by configuring the Global Tally Settings in the UltriScape Head interface.

Bit 1 Tally 2 status Tally 2 (Green)a

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bits 4-5 Brightness value Not used

Bit 6 Reserved Not used

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h-3Eh) UMD display text



Ultrix User Guide (v18.0) External Control • 273

Refer to Table 22.12 when using TSL UMD v3.1 and configuring PiP Tallies in an UltriScape Head.

TSL UMD Protocol v4.0 Commands
 Table 22.13 outlines the default values for the Ultrix when using TSL UMD v4.0.

Protocol Implementation
Ultrix implements the protocol with the following structure: Header | Control | DisplayData | VBC | XData.

Table 22.14 lists the TSL UMD Protocol v4.0 commands the Ultrix supports.

Table 22.12  UltriScape Tally Display — TSL UMD v3.1

Red Tally Green Tally Display
ON ON RED IS ON

ON OFF RED IS ON

OFF ON GREEN IS ON

OFF OFF OFF (no tallies are lit)

Table 22.13  Default Connection Types — TSL UMD v4.0 

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5728

UDP Port 4491

Table 22.14  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description UltriScape System Use

Header 0x80 + 0 - 126 display address DisplayID associated with source or 
destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Not used

Bit 1 Tally 2 status Not used

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bit 4-5 Brightness value Not used

Bit 6 0=display data, 1=command data Display data only (0)

Bit 7 0 Not used
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TSL UMD Protocol v5.0 Commands
Table 22.15 outlines the default values for the Ultrix when using TSL UMD v5.0.

Protocol Implementation
Ultrix implements the protocol with the following structure: PBC | Ver. | Flags | Screen | DMSG (Index, Control, 
Length, Text).

Display Data 16 ASCII display characters (20h - 7Eh) UMD display text

VBC

Bits 3-0 Byte count of XData

Bits 6-4 Minor protocol version (v4.0=0)

Bit 7 0

XData1

Bits 0-1 Right Hand tally valuea Not implemented

Bits 2-3 Text display valuea Sets text background color

Bits 4-5 Left hand tally valuea Displayed in either border or text 
background; can be either or both

Bit 6 Reserved

Bit 7 0

XData2

Bits 0-1 Right Hand tally value Not implemented

Bits 2-3 Text display value Not implemented

Bits 4-5 Left hand tally value Not implemented

a. Where 0=off, 1=Red, 2=Green, 3=Amber

Table 22.15  Default Connection Types — TSL UMD v5.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5729

UDP Port 4492

Table 22.14  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description UltriScape System Use
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Table 22.16 lists the TSL UMD Protocol v5.0 commands the Ultrix supports. 

Enabling SNMP Support
Ultrix routers running software version 3v4 or higher provide optional support for remote monitoring and control of 
your router using SNMP (Simple Network Management Protocol). This protocol is compatible with many 
third-party monitoring and control tools. 

 The MIB file provides SNMP traps for the configurable alarms on Ultrix as well as on the power supplies and 
fans.

Enabling SNMP Support
The SNMP Agent on the Ultrix router uses SNMP version 2 to allow queries of the configured system alarms, and 
state changes to configured alarms will be sent out as SNMP traps to the specified Trap Destination IP Address(es).

Whenever the options in the SNMP area are edited, the SNMP Agent is restarted on the Ultrix router. It can take 
up to 10 seconds for all monitored states to be updated. This latency only applies once on startup.

The SNMP monitoring and control feature for your Ultrix is a software option that you enable in the System Status 
> Network tab.

Table 22.16  TSL UMD Protocol v5.0 Commands

Protocol 
Breakdown Description UltriScape System Use

PBC Total byte count of packet

Ver. Minor version number (0=v5.00)

 Flags

Bit 0 0=ASCII strings, 1=UTF-16LE

Bit 1 0=display data, 1=screen control Display data only (0)

Bits 2-7 Reserved (0) Not used

Screen 16bit Screen ID ScreenID associated with source or 
destination

DMSG

Index 16bit Display Address DisplayID associated with source or 
destination

Control

Bits 0-1 Right hand tally valuea

a. Where 0=Off, 1=Red, 2=Green, 3=Amber

Sets right-hand tally indicator color

Bits 2-3 Text display valuea Sets text background and border color

Bits 4-5 Left hand tally valuea Sets left-hand tally indicator color

Bits 6-7 Brightness value (0-3) Not implemented

Bits 8-14 Reserved (0)

Bit 15 0=display data, 1=command data Display data only (0)

Length Byte count of text

Text Text as defined by Flag 0 setting UMD display text
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To enable SNMP support on the Ultrix

1. Verify that the Ultricore-SNMP license key is installed for the Ultrix router. Refer to the section “Installing a 
License Key” on page 34 for details.

2. In the Tree View of DashBoard, double-click the System Status node under the Ultrix node.

The System Interfaces display in the DashBoard window.

3. Select the Network tab.

4. Locate the SNMP area of the tab.

5. Select the Enable SNMP box.

6. Ensure that the Alarms you want to monitor via SNMP are also enabled on the Ultrix router. Refer tothe section 
“Monitoring the Hardware” on page 285.

To configure the SNMP Agent using DashBoard

1. In the Tree View of DashBoard, double-click the System Status node under the Ultrix node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. Locate the SNMP area of the tab.

4. Use the SNMP Community Name field to specify the SNMP password for GET requests. For example, 
public.

5. Use the SNMP Trap Destination IP Address field to specify the target address to which traps should be sent.

An example of a valid target is provided in the SNMP area.

 A maximum number of six strings are displayed in the SNMP Trap Destination IP Address field at one time. If 
at the maximum number, you must select a string from the field and delete it before adding a new target entry.

6. Press [Enter] to apply the changes.
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Ember+ Registration and Discovery
This section provides information on the setup and operation for the Ultrix to communicate with a third-party 
control system via the Ember+ media distribution protocol.

Establishing a Connection
To establish a connection between the Ember+ client and the Ultrix

1. Configure your network streams as outlined in “ULTRIX-IP-IO Setup” on page 71.

2. Configure your router database as outlined in “Database Configuration” on page 105.

3. Install the Ultricore-EMBER+ license on the Ultrix. Refer to “Installing a License Key” on page 34. This 
enables the Ultrix to start an Ember+ server and listen to incoming connections.

4. Add the Ultrix in the Ember+ control system interface using the IP Address assigned to the Ultrix.

5. In the Ember+ controls system, set the TCP port to 9000 for the Ultrix.

Specifying the Operation Mode
Ultrix can be controlled via Ember+ in two modes: Virtual Mode (table mapped IO) or Physical Mode (direct socket 
control). 

To specify the Ember+ operation mode on the Ultrix

1. Display the Connections tab for Ultrix as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

2. Click Options in the Protocol Servers area.

The Server Options dialog opens.

3. Use the Ember Plus menu to specify the operation mode required by your Ember+ control system. Choose 
from the following:

• Virtual Mode — each level is represented by a Matrix and the Labels will be the one defined in the 
Destinations and Sources tabs.

• Physical Mode — the whole router is represented as a single Matrix and the physical socket labels are used. 
The external control system using Ember+ commands bypasses the virtual IO mapping and directly controls 
the Ultrix physical socket connections. Therefore the Ultrix should not be switched by any other devices.

4. Click Apply to close the dialog.

5. Click Apply at the bottom of the Connections tab to apply the new setting.
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Supported Commands
We support the Get Directory and Connect commands. The router is represented using the Ember+ Matrix 
object including Labels. This allows the Ember+ control system to see the number of levels, number of sources and 
destinations and their labels, the per destination status, and issue switch commands.

 If you make changes to the router database (such as Levels, Destinations and Sources) after establishing 
communications, you may need to refresh/reload/reconnect the connection.
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ULTRIX-UCCI Redundancy
This chapter outlines the ULTRIX-UCCI Control redundancy feature for the ULTRIX-FR5. This feature is not 
available for the ULTRIX-FR1(-NS) or the ULTRIX-FR2(-NS).

Before You Begin
The following are required for ULTRIX-UCCI Control redundancy:

• Two ULTRIX-UCCI Control cards physically installed and configured in the ULTRIX-FR5
• The ULTRIX-FR5 is installed, fully configured, and running software 4v10 or higher

 Contact Ross Technical Support for installing the second ULTRIX-UCCI Control card in your ULTRIX-FR5.

Overview
The ULTRIX-UCCI Control redundancy feature provides built-in redundancy for your routing system. In the event 
that one ULTRIX-UCCI Control card is affected, the router communications and traffic automatically routes to the 
second card. When the primary ULTRIX-UCCI Control card is back on-line, communications automatically switch 
from the secondary to the primary without user interaction. A DashBoard option also exists that enables a user to 
manually switch from one card to the other.

Monitoring
Communications can be monitored via the LEDs on the ULTRIX-UCCI Control hardware or via the Devices > 
Frame Configuration interface in DashBoard.

Using the Physical LEDs
There are two ULTRIX-UCCI Control Card slots in the top-right corner of the ULTRIX-FR5. Each slot houses an 
Ultricore-CC Internal board which includes a Micro SD Card slot, a USB port, and four status LEDs.

Figure 23.1  Location of ULTRIX-UCCI Control Slots in an ULTRIX-FR5

Table 23.1 describes the Ultrix-UCCI status LEDs. 
Table 23.1  Hardware — Ultrix-UCCI LEDs

LED Status Description
STATUS Green Indicates the ULTRIX-UCCI Control card is powered and the last re-boot 

was successful

Flashing 
Green

Indicates the ULTRIX-UCCI Control card is powered and in the progress 
of a re-boot

Red Indicates the ULTRIX-UCCI Control card is powered but requires a 
re-boot

1 4
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Using DashBoard
The Device Configuration interface in DashBoard enables you to monitor the ULTRIX-FR5 hardware including 
each ULTRIX-UCCI Control slot.

To monitor an ULTRIX-UCCI Control card via DashBoard

1. Display the Device Configuration interface as outlined in the section “To access the Device Configuration 
interfaces in DashBoard” on page 26.

A rear panel map that represents the Ultrix router displays at the top of the interface.

2. Refer to Table 23.2 for the ULTRIX-UCCI Control status LEDs. 

PRIM/SEC Green Indicates the ULTRIX-UCCI Control card is configured and functioning 
as the Primary

Flashing 
Green

Indicates the ULTRIX-UCCI Control card is in standby (Secondary) 
mode 

ALARM Red Indicates the ULTRIX-UCCI Control card is experiencing an error 
condition; verify the message(s) on the router front panel LCD display 
and DashBoard

Off Indicates the ULTRIX-UCCI Control card is operating correctly and is not 
experiencing any errors

AUX This LED is not implemented.

Table 23.2  DashBoard — Ultrix-UCCI LEDs

LED Status Description
STATUS Green Indicates the ULTRIX-UCCI Control card is powered and the last re-boot 

was successful

Red Indicates the ULTRIX-UCCI Control card is powered but is currently 
re-booting

PRIM/SEC Green Indicates the ULTRIX-UCCI Control card is configured and functioning 
as the Primary

Off Indicates the ULTRIX-UCCI Control card is in standby (Secondary) 
mode 

Table 23.1  Hardware — Ultrix-UCCI LEDs

LED Status Description
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Upgrading an ULTRIX-UCCI Control Card
Contact Ross Technical Support for information on upgrading the software on your ULTRIX-UCCI Control card.

ALARM Red Indicates the ULTRIX-UCCI Control card is experiencing an error 
condition; verify the message(s) on the router front panel LCD display 
and DashBoard

Off Indicates the ULTRIX-UCCI Control card is operating correctly and is not 
experiencing any errors

AUX This LED is not implemented.

Table 23.2  DashBoard — Ultrix-UCCI LEDs

LED Status Description
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Managing your Ultrix Settings
The System Status > Transfer interface provides options to import and export archived files (*.ufs) of your Ultrix 
frame settings to another Ultrix. The *.ufs file captures the settings of the Device Configuration interface except 
for:

• database configuration
• UltriScape layouts
• device name
• network settings
• NTP server settings
• installed license keys

 This feature requires DashBoard v8.2 or higher and Ultrix software v2.0 or higher.

For More Information on...
• the settings available in the Device Configuration interface, refer to the section “Device Configuration 

Interfaces” on page 323.

Exporting the Device Configuration Settings
You create an archive of your frame settings using the options in the System Status > Transfer tab.

To export your settings to an archived file

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Select the Ultrix Frame Settings sub-tab.

4. Locate the Export area on the tab.

5. Click Browse... to specify the name and location to save the *.ufs file to.

The Save As read-only field updates with the selected path and file name.

6. Click Apply.

The Downloading Archive dialog opens to report the status of the export.

Importing a Frame Settings File
You must re-boot the Ultrix to apply the settings of the imported *.ufs file. 

To import an Ultrix Frame Settings file

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Select the Ultrix Frame Settings sub-tab.

4. Locate the Import area.

5. Select the *.ufs file you wish to import as follows:
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a. Click Browse... 

The Open dialog opens.

b. Use the Open dialog to specify the *.ufs file to import.

c. Click Open to close the dialog and load the file.

6. Click Apply.

The Uploading Archive dialog opens to report the status of the transfer.
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Monitoring the Hardware
The Frame Configuration interface in DashBoard provides status fields for monitoring the individual Power 
Supplies (PSU), the internal chassis fans, the SD Card, Ethernet ports, and the flash storage space of your Ultrix 
router.

Primary and Redundant Power Alarms
The Primary and Redundant Power alarms in the Frame Configuration interface do not consider what ports the PSU 
are connected on the Ultrix rear panel. The alarms trip only if the required minimum state for main or redundant 
power is not met. Refer to Table 25.1 for the power requirements.

Enabling the Alarms for the Router PSU Ports
You can customize the monitoring of the PSU by selecting which units to monitor and display an alarm message 
when the unit is not detected. The Alarms table fields in the Frame Configuration interface vary in severity from 
green (valid), yellow (caution), to red (alarm). DashBoard reports the most severe alarm for a single field.

For More Information on...
• the messages displayed in the Power Supplies and Fans status fields, refer to Table 25.2.

To monitor the hardware status of an Ultrix router

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Alarms.

The Frame Configuration interface displays the status fields that report on the hardware components.

5. To add a new item to monitor:

 The ULTRIX-FR5 has an option of triggering a GPI contact closure for use with external equipment. Select the 
Alarm Relay box to activate for each alarm type required.

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report “Not 
Configured” with a yellow indicator in the State cell.

b. Select a PSU to monitor from the drop-down menu. Choose from the following:

› PSU # — Monitors the specified PSU port on the Ultrix rear panel.
› Primary Power — Monitors the main power connection (non-PSU port specific) to the Ultrix rear panel 

and determines whether a sufficient number of power supplies are connected and operating for the router 
to run reliably (one PSU for a ULTRIX-FR1(-NS), two PSU for a ULTRIX-FR2(-NS), and one 
Ultripower for the ULTRIX-FR5). Refer to Table 25.1 for details. 

Table 25.1  PSU Requirements based on Frame Size

Frame Size Min. PSU
Min. PSU for 

Redundancy (N+1)
Min. for Fully 

Redundant (2N) Max. Redundancy
ULTRIX-FR1(-NS) 1 2 2 4N

ULTRIX-FR2(-NS) 2 3 4 2N

ULTRIX-FR5 1 x Ultripower
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› Redundant Power — Monitors additional power supplies connected to the Ultrix rear panel. When the 
Primary PSU is unavailable and no other PSU ports are in use, an alarm message will be raised to indicate 
that in the event of a power loss on the primary PSU, the router will lose power. Refer to Table 25.1 for 
details.

6. Refer to Table 25.2 for a summary of the possible messages displayed in the Alarms status fields. 
Table 25.2  Alarms — Status Messages

Item Parameters Description
System 
Error

OK (Green) The last re-boot (power cycle) of the router was successful and no 
errors are detected.

Failed (Red) The last re-boot/power cycle of the router failed. You must 
re-boot/power cycle the router. If the issue still persists, contact 
Ross Technical Support.

None Not Configured 
(Yellow)

The row in the table is not currently monitoring any component of 
the Ultrix router.

Fan # OK (Green) Normal operation; no hardware errors are associated with the 
specified fan

x/y Indicates the fan speed in RPM where:
• x represents the current speed
• y represents the maximum speed

Stalled (Red) Indicates the specified fan is not running

Primary 
Power

OK (Green) Normal operation; no hardware errors associated with the PSU
• ULTRIX-FR5— an Ultripower connection is detected
• ULTRIX-FR2(-NS) — at least 2 connected PSU are detected
• ULTRIX-FR1(-NS) — at least 1 connected PSU is detected

Failed (Red) Indicates the minimum number of PSUa are not detected

a. An ULTRIX-FR2(-NS) requires a minimum of 2 PSU to be connected at all times. For 
ULTRIX-FR1(-NS) routers, a minimum of 1 PSU is required.

Redundant 
Power

OK (Green) Indicates extra PSU are detected/available; normal operation; no 
hardware errors associated with the PSU
• ULTRIX-FR2(-NS) — at least 3 connected PSU are detected
• ULTRIX-FR1(-NS) — at least 2 connected PSU are detected

Failed (Red) Indicates the minimum number of PSUb are not detected

b. An ULTRIX-FR2(-NS) requires a minimum of 2 PSU to be connected at all times. For 
ULTRIX-FR1(-NS) routers, a minimum of 1 PSU is required.

Temperature OK (Green) Indicates that the chassis core components temperature is within the 
normal range

Warning (Yellow) Indicates that at least one chassis core component temperature is 
between 75°C and 80°C (167°F and 176°F)

Failed (Red) Indicates that at least one chassis core component temperature is 
above 80°C (176°F)

Battery OK (Green) The battery installed in the Cooling Fan Module of the chassis is 
operating normally.

Warning (Yellow) The battery power is between 1.5V and 2.7V.

Failed (Red) The battery power is below 1.5V and requires replacement. Refer to 
“Monitoring the Battery” on page 291.
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Setting the PSU Fan Speed
The Ultrix router enables you to control the cooling fan speed of the power supply units for optimum cooling.

To set the fan speed

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Power Supplies and Fans.

5. Use the Minimum Fan Speed slider to specify how fast (rpm) the fans the will run.

Monitoring the Internal Memory
The Device Configuration interface enables you to monitor the flash storage space of your Ultrix router. This is 
useful when managing a large number of databases or during upgrades.

To monitor the flash storage space

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Alarms.

The Frame Configuration interface displays the status fields that report on the hardware components.

5. To enable the Flash Storage alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report “Not 
Configured” with a yellow indicator in the State cell.

b. Select Flash Storage.

6. Refer to Table 25.3 for a summary of the possible messages displayed in the Flash Storage status field.

Monitoring the SD Card
The Device Configuration interface provides two methods for monitoring the SD Card:

• SD Card Free Space — provides an estimate of how much memory is currently allocated on the SD Card.
• SD Card Presence — monitors the physical state of the SD Card within the Ultrix chassis.

Table 25.3  Alarms — Flash Storage

Parameter Description Solution
OK Database and layout storage space is available

WARNING Database and layout storage space is low • Export unused databases and 
layouts as outlined in “Exporting a 
Database” on page 125; or

• Delete unused databases as outlined 
in “Deleting a Database” on 
page 125

CRITICAL Database and layout storage is nearly depleted
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To monitor the SD Card storage space 

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Alarms.

The Frame Configuration interface displays the status fields that report on the hardware components.

5. To enable the SD Card Free Space alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report “Not 
Configured” with a yellow indicator in the State cell.

b. Select SD Card Free Space.

6. Refer to Table 25.4 for a summary of the possible messages displayed in the SD Card Free Space status field.

To monitor the physical state of the SD Card

1. In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Alarms.

The Frame Configuration interface displays the status fields that report on the hardware components.

5. To enable the SD Card Presence alarm:

a. Click the Type cell in a row that is not assigned to an item to monitor. The row will report “Not 
Configured” with a yellow indicator in the State cell.

b. Select SD Card Presence.

Table 25.4  Alarms — SD Card Free Space

Parameter Description Solution
OK Storage space is available

WARNING Less than 20% of the storage space is available Contact Ross Technical Support

CRITICAL Less than 10% of the storage space is available
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6. Refer to Table 25.5 for a summary of the possible messages displayed in the SD Card Presence status field.

Monitoring the Ethernet LEDs via the Rear Panel
Each RJ45 connector on the Ultrix rear panel include two LEDs that report the ethernet communication activity and 
speed. Refer to Figure 25.1 for LED locations on the Ultrix rear panel.

Figure 25.1  ENET Ports on Rear Panel — ULTRIX-FR1(-NS) and ULTRIX-FR2(-NS) LEDs

Figure 25.2  ENET Ports on Rear Panel — ULTRIX-FR5 LEDs

Table 25.5  Alarms — SD Card Presence

Parameters Description
OK (Green) There are no SD Card issues detected

FAIL The SD Card is not properly installed in the router 
chassis. Contact Ross Technical Support.

ENET 2

ENET 1

ENET 1 Port Speed LED
ENET 1 Port Link/Activity LED

ENET 2 Port Speed LED
ENET 2 Port Link/Activity LED

ENET 1

ENET 2
ENET 2 Port Speed LED

ENET 2 Port Link/Activity LED

ENET 1 Port Speed LED

ENET 1 Port Link/Activity LED



290 • Monitoring the Hardware Ultrix User Guide (v18.0)

Table 25.6 provides basic LED descriptions.

Table 25.6  ENET Port LEDs

LED Status Description
ENET # - 
Link/Activity

Green When lit green, this LED indicates a valid link is established on the 
specified ENET port.

Flashing When flashing green, this LED indicates communication activity is 
occurring on the specified ENET port.

Off When unlit, this LED indicates an invalid link is detected on the 
specified ENET port. Verify the cable connection on the rear module 
port and your network connections.

ENET # - Port 
Speed

Green When lit green, this LED indicates the ENET Port communication 
speed is at 1Gbps.

Yellow When lit orange, this LED indicates the ENET Port communication 
speed is at 100Mbps.

Off When unlit, this LED indicates the ENET Port communication 
speed is at 10Mbps.
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Monitoring the Battery
The Ultrix router uses a Panasonic® CR2032 battery to serve as an emergency backup power source for the 
essential memory of the router. This enables the router to power up with the same crosspoint selection as when it 
was powered off. This battery is located on the Cooling Fan Module installed inside the Ultrix router chassis.

 A spare battery was included in the Ultrix Shipping Kit (Ross P/N 2101KR-084) when your router was shipped 
from the factory.

Enabling the Battery Status Monitoring Feature in DashBoard
You can monitor the battery status via the Alarms table in the Frame Configuration interface. 

To configure an alarm for battery status monitoring

1. To In the Tree View of DashBoard, expand the node for the Ultrix router you want to monitor.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Alarms.

The Frame Configuration interface displays the status fields that report on the hardware components.

5. Click the Type cell in a row that is not assigned to an item to monitor. The row will report “Not Configured” 
with a yellow indicator in the State cell.

The Type menu opens.

6. Select Battery from the Type menu.

Replacing a Failed Battery in an ULTRIX-FR5
This section describes how to replace a failed battery within the ULTRIX-FR5 chassis.

Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration interface, you will need 
to replace the battery installed inside the Cooling Fan Module of the chassis. This module is accessed via the front 
of the router chassis and requires that you remove the door first. The door is secured to the front of the router 
chassis with a rare earth magnet on each side. 

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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To remove the door from the ULTRIX-FR5

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the middle of the door on the right side.

Figure 26.1  ULTRIX-FR5 Front Panel — Where to Grasp the Door

 If you have trouble removing the door from the chassis, use your right-hand fingers in the space between the door 
and the chassis for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Figure 26.2  ULTRIX-FR5 — Front Panel — Removing the Door

Caution — The door of the ULTRIX-FR5 is heavy. Ensure that you have a firm grip on the door, or that 
the door is otherwise supported, before removing it from the chassis.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 

1
2

3
4

IP: ###.###.##.###

Space between door and chassis

1
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Removing a Battery from the ULTRIX-FR5
The battery is located on the Main Board inside the ULTRIX-FR5 chassis. You do not need to remove the Cooling 
Fan Module to replace the battery in an ULTRIX-FR5.

To remove the battery from an ULTRIX-FR5

1. Locate and note the orientation of the failed battery on the Main Board. Refer to Figure 26.16 for battery 
location.

Figure 26.3  ULTRIX-FR5 — Battery Location inside the Chassis

2. Gently move the latch to the left and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Main Board.

Installing a New Battery in the ULTRIX-FR5
Installing a new battery requires you to orient the battery on the Main Board, and secure the battery to the board.

To install a new battery in the ULTRIX-FR5

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you.

2. Pull the latch slightly away to make room for the new battery installation.

3. Slide the battery into the empty slot the failed battery was in.

4. Secure the battery to the Main Board using the latch.

To re-install the door on the ULTRIX-FR5

1. Align the door to the front of the router, ensuring that:

• the door is oriented upright
• the corner with the Ultrix logo is in your left hand, and
• the corner with the Ross logo is in your right hand. (Figure 26.4)

Battery
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Figure 26.4  ULTRIX-FR5 — Aligning the Door to the Chassis 

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Replacing a Failed Battery in an ULTRIX-FR2(-NS)
This section describes how to replace a failed battery within the ULTRIX-FR2 or ULTRIX-FR2-NS chassis. Note 
that the battery location differs depending on the model.

Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration interface, you will need 
to replace the battery installed inside the Cooling Fan Module of the chassis. This module is accessed via the front 
of the router chassis and requires that you remove the door first. The door is secured to the front of the router 
chassis with a rare earth magnet on each side. 

To remove the door from the ULTRIX-FR2(-NS)

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the top and bottom of the door at the right side.

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

IP: ###.###.##.###
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3
4



Ultrix User Guide (v18.0) Monitoring the Battery • 295

Figure 26.5  ULTRIX-FR2-NS Front Panel — Where to Grasp the Door 

 If you have trouble removing the door from the chassis, you can insert a flathead screwdriver into the notch on 
either side of the door for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Figure 26.6  ULTRIX-FR2-NS Front Panel — Removing the Door

Removing the Cooling Fan Module from the ULTRIX-FR2(-NS)
This section only applies if you are replacing a battery in the ULTRIX-FR2(-NS).

To remove the Cooling Fan Module from the ULTRIX-FR2(-NS)

1. With the door removed, use a #1 Phillips screwdriver to loosen the screw that affixes the Cooling Fan Module 
to the Main Board.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 
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Figure 26.7  ULTRIX-FR2(-NS) — Location of Screw for Cooling Fan Module

2. Gently pull the Cooling Fan Module towards you to unseat it from the backplane and to disengage the module 
from the chassis.

Figure 26.8  ULTRIX-FR2(-NS) — Removing the Cooling Fan Module from the Chassis

3. Pull the Cooling Fan Module free from the chassis and set it on a static-free surface.

Removing a Battery from the ULTRIX-FR2(-NS)
The battery is installed in a slot on the side of the Cooling Fan Module and secured in place with a small latch.

To remove a failed battery from the ULTRIX-FR2(-NS) Cooling Fan Module

1. Locate and note the orientation of the failed battery inside the Cooling Fan Module. (Figure 26.9)

Main Board

Screw



Ultrix User Guide (v18.0) Monitoring the Battery • 297

Figure 26.9  Battery Location inside the Cooling Fan Module — ULTRIX-FR2 and ULTRIX-FR2-NS

2. Gently move the latch to the right and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Cooling Fan Module.

Installing a New Battery in the ULTRIX-FR2(-NS)
Installing a new battery requires you to orient the battery on the module, secure the battery to the module, and then 
re-install the front door on the chassis.

Battery
Latch

ULTRIX-FR2-NS
Battery
Latch

ULTRIX-FR2
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To install a new battery in the Cooling Fan Module

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you. (Figure 26.17)

Figure 26.10  New Battery Orientation —ULTRIX-FR2 and ULTRIX-FR2-NS

2. Slide the battery into the empty slot the failed battery was in.

3. Secure the battery to the module using the latch.

Re-installing the Cooling Fan Module
Once you have installed the new battery into the new Cooling Fan Module, you can re-install the Cooling Fan 
Module into the Ultrix chassis and replace the door on the front panel.

To install the Cooling Fan Module into the chassis

1. Align the new Cooling Fan Module in its slot inside the chassis.

2. Gently push the Cooling Fan Module into the slot until the module is fully seated. You will feel the back 
connector of the module engaged with its connector inside the chassis.

ULTRIX-FR2-NS

ULTRIX-FR2
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3. Use the screw from step 1 in the procedure “To remove the Cooling Fan Module from the 
ULTRIX-FR2(-NS)” on page 295 to affix the Cooling Fan Module to the frame. 

Re-installing the Door on the Chassis  

To re-install the door on the ULTRIX-FR2(-NS)

1. Align the door to the front of the router, ensuring that the door is oriented upright, the corner with the Ultrix 
logo is in your left hand, and the corner with the Ross logo is in your right hand. (Figure 26.18)

Figure 26.11  ULTRIX-FR2(-NS) — Aligning the Door to the Chassis

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Caution — The Cooling Fan Module includes a connector that must be fully seated. Reinstalling the 
Cooling Fan Module retention screw is required to ensure proper contact.

Caution — Re-installing the door incorrectly or misaligned can damage the door or internal 
components.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

IP: ###.###.##.###
IP: ###.###.##.###
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Replacing a Failed Battery in an ULTRIX-FR1(-NS)
This section describes how to replace a failed battery within the ULTRIX-FR1 or ULTRIX-FR1-NS chassis. Note 
that the battery location differs depending on the model.

Removing the Door from the Chassis

If the Battery alarm displays a red indicator in the Alarms table of the Frame Configuration interface, you will need 
to replace the battery installed inside the Cooling Fan Module of the chassis. This module is accessed via the front 
of the router chassis and requires that you remove the door first. The door is secured to the front of the router 
chassis with a rare earth magnet on each side.

To remove the door from the ULTRIX-FR1(-NS)

1. With your left hand, grasp the top and bottom of the door at the left sides.

2. With your right hand, grasp the top and bottom of the door at the right side.

Figure 26.12  ULTRIX-FR1 Front Panel — Where to Grasp the Door 

 If you are having trouble removing the door from the chassis, you can insert a flathead screwdriver into the notch 
on either side of the door for added leverage.

3. Pull the right side of the door towards you to disengage it approximately 1.0” from the chassis.

4. Pull the left side of the door towards you to fully disengage the door from the chassis.

Caution — For reliable performance, the Ultrix router should not run without the Cooling Fan Module 
for more than 5 minutes.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

Caution — Pull the door off without twisting or rotating it at too steep of an angle. 
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Figure 26.13  ULTRIX-FR1-NS Front Panel — Removing the Door

Removing the Cooling Fan Module from the ULTRIX-FR1(-NS)
This section only applies if you are replacing a battery in the ULTRIX-FR1(-NS).

To remove the Cooling Fan Module from the ULTRIX-FR1(-NS)

1. With the door removed, use a #1 Phillips screwdriver to loosen the screw that affixes the Cooling Fan Module 
to the Main Board.

Figure 26.14  ULTRIX-FR1(-NS) — Location of Screw for Cooling Fan Module

2. Gently pull the Cooling Fan Module towards you to unseat it from the backplane and to disengage the module 
from the chassis.

Figure 26.15  ULTRIX-FR1(-NS) — Removing the Cooling Fan Module from the Chassis

3. Pull the Cooling Fan Module free from the chassis and set it on a static-free surface.

IP: ###.###.##.###
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Removing a Battery from the ULTRIX-FR1(-NS)
The battery is installed in a slot on the side of the Cooling Fan Module and secured in place with a small latch.

To remove a failed battery from the ULTRIX-FR1(-NS) Cooling Fan Module 

1. Locate and note the orientation of the failed battery inside the Cooling Fan Module. (Figure 26.16)

Figure 26.16  Battery Location inside the Cooling Fan Module — ULTRIX-FR1 and ULTRIX-FR1-NS

2. Gently move the latch to the right and away from the failed battery.

3. Remove the battery from its slot by pulling it away from the Cooling Fan Module.

Installing a New Battery in the ULTRIX-FR1(-NS)
Installing a new battery requires you to orient the battery on the module, and secure the battery to the module.

To install a new battery in the Cooling Fan Module

1. Hold the battery in one hand and orient it so that the Positive side (+) faces away from you. (Figure 26.17)

2. Pull the latch slightly away to make room for the new battery installation.

3. Slide the battery into the empty slot the failed battery was in.

Battery
Latch

ULTRIX-FR1-NS Battery
Latch

ULTRIX-FR1
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Figure 26.17  New Battery Orientation —ULTRIX-FR1 and ULTRIX-FR1-NS

4. Secure the battery to the module using the latch.

5. Proceed to the section “Re-installing the Cooling Fan Module” on page 303.

Re-installing the Cooling Fan Module
Once you have installed the new battery into the new Cooling Fan Module, you can re-install the Cooling Fan 
Module into the Ultrix chassis and replace the door on the front panel.

To install the Cooling Fan Module into the chassis

1. Align the new Cooling Fan Module in its slot inside the chassis.

2. Gently push the Cooling Fan Module into the slot until the module is fully seated. You will feel the back 
connector of the module engaged with its connector inside the chassis.

3. Use the screw from step 1 in the procedure “To remove the Cooling Fan Module from the 
ULTRIX-FR1(-NS)” on page 301 to affix the Cooling Fan Module to the frame. 

Caution — The Cooling Fan Module includes a connector that must be fully seated. Reinstalling the 
Cooling Fan Module retention screw is required to ensure proper contact.

ULTRIX-FR1-NS

ULTRIX-FR1
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Re-installing the Door on the Chassis  

To re-install the door on the ULTRIX-FR1(-NS)

1. Align the door to the front of the router, ensuring that the door is oriented upright, the corner with the Ultrix 
logo is in your left hand, and the corner with the Ross logo is in your right hand. (Figure 26.18)

Figure 26.18  ULTRIX-FR1-NS — Aligning the Door to the Chassis

2. Align the left-side of the door against the chassis.

3. Align the right-side of the door, gently rotating the door into position.

4. Verify that the door is fully seated in place with the magnets securing it to the chassis.

Caution — Re-installing the door incorrectly or misaligned can damage the door or internal 
components.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semi-conductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

IP: ###.###.##.###

1
2

3
4
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Monitoring the Communications
This chapter summarizes how to verify communications on an Ethernet port, an Ultricore connection, and the 
overall communication status of the Ultrix router.

Monitoring the Network Status
The Ethernet ports on the Ultrix rear panel are used to connect to an Ethernet network for communications. An 
ENET port is set to active when Ultrix automatically detects a valid network link on the port. When a valid link is 
detected on both ports, the ENET 1 port is set to active and is the primary connection. 

 There are two ENET ports on the Ultrix rear panel. A fail-over feature enables the Ultrix router to automatically 
use the second ENET port when the primary ENET connection is lost or unavailable.

To verify the communication status of an Ethernet Port via the Device Configuration interface

1. Expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Communication Settings.

The Ethernet Configuration area reports which Ethernet port is currently active.

5. Refer to Table 27.1 for a summary of the possible messages displayed in the Status field for the port.

Monitoring the Ultricore Mode Status
The primary Ultrix router passes all commands to each client Ultrix router in the system. Each client Ultrix router 
responds back to the primary in minute intervals.

Primary Status
If the Ultrix router is configured as a primary, the Ultricore Clients table in the Communication Settings interface 
reports on the status between it and each client router connected to it. Each client is listed in the table, with the most 
recently connected router displayed at the bottom of the list. 

Table 27.1  Frame Configuration — Ethernet Configuration

Item Parameters Description
Status ENET # is Active 

(Green)
Ethernet communications for the specified port are 
valid. The specified ENET port on the Ultrix rear 
panel is the currently active (in use).

Inactive (Red) Ethernet communications for the router are 
invalid. The following conditions may be 
occurring:
• The ethernet cables are disconnected from the 

rear panel.
• A valid network connection may be unavailable.
• The IP Address is for the router is no longer 

valid. 
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Client Status
If the Ultrix router is configured as a client, the Communication Settings interface reports on the communications 
between it and the primary.

Troubleshooting
If you have lost communication between the primary Ultrix router and its clients:

1. Verify that each router is installed correctly.

2. Verify that each router is installed with a network connection to your facility.

3. Verify the ethernet settings for each router are valid.

4. Verify that the primary Ultrix router reports a list of valid connections to clients in its Ultricore Clients table. 

5. Verify that each client Ultrix router is running software compatible to the primary Ultrix router.

Monitoring the Ultrix System Status
The System Status node displays an indicator that varies in severity from green (valid) to red (alarm). This indicator 
reports the most severe alarm the Ultrix is experiencing. The types of alarms the Ultrix reports is configured via the 
Frame Configuration > Alarms interface.

When you hover your mouse cursor over a red System Status node in the Tree View of DashBoard, as seen below, a 
tool tip displays with a brief error message. The message and indicator continue to report an error until the 
condition is addressed or the alarm is disabled in the Alarms interface.

Figure 27.1  Example of a Master Alarm Message

For More Information on...
• the options available in the Alarms interface, refer to the section “Alarms” on page 324.

Using the System Logs in DashBoard
An entry in each log includes a timestamp, a code number, and a description. Messages are written to the log when 
significant changes occur in the operation of the Ultrix router. These could include: changes to video, reference, 
audio or time inputs; power-on or reboot cycles; configuration changes that can have an effect on the routing path; 
alarm conditions.
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To access the system logs in DashBoard

1. In the Tree View of DashBoard, double-click the System Status node under the Ultrix node.

The System Interfaces display in the DashBoard window.

2. Select the Logs tab.

The Logs tab opens.

3. To view the communication log for Ultrix only, select the System Log option.

4. To view the log for communications between Ultrix and other devices, select Controller Communications 
Log.

5. To view the log for executed tasks in DashBoard for the router, select DashBoard Communications Log.

6. Click Refresh to update the entries for the currently selected log.
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Monitoring the Signals
This section outlines how to monitor the reference signal, the inputs and outputs signals via the options in the Frame 
Configuration interface.

Monitoring the Reference Signal
The Sync area of the Frame Configuration interface reports on the signals connected to the REF ports on the Ultrix 
rear panel.

For More Information on...
• setting the default reference, refer to the section “Specifying a Default Reference Format” on page 28.

To monitor the Ultrix reference signal

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Sync.

The Frame Configuration interface now displays the References table for the router.

5. Refer to Table 28.1 to troubleshoot the messages displayed in the status fields.

Triggers Status
The Sync area of the Frame Configuration interface reports on the signals connected to the reference ports on the 
Ultrix rear panel.

To monitor the Ultrix reference signal

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

Table 28.1  Frame Configuration — References Status

Item Parameters Description
Status Active (Green) A valid reference signal is connected to the REF 

port on the Ultrix rear panel

No Sync (Yellow) No signal detected on the REF port on the Ultrix 
rear panel

Format Unknown A reference signal is detected but the format is not 
supported by the router

# Indicates the video format of the reference signal
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The Device Configuration interface opens with the Frame Configuration interface selected.

4. Click Sync.

The Frame Configuration interface now displays the Triggers table for the router.

5. Refer to Table 28.2 to troubleshoot the messages displayed in the Detected and Format status fields for each 
sync trigger.

Monitoring the SDI Outputs
The Port Configuration interface enables you to monitor the signal status of the SDI outputs of the Ultrix.

To monitor the status of all the SDI outputs of the Ultrix router

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Click Port Configuration.

The Port Configuration interface opens.

5. Click one of the Outputs banners in the Ultrix rear panel map.

The Outputs Summary table displays and all the Outputs banners are lit blue on the Ultrix rear panel map.

6. Refer to Table 28.3 to troubleshoot the messages displayed in the status fields for each physical output socket.

Table 28.2  Frame Configuration — Triggers Status

Item Parameters Description
Detected Unknown The format of the reference signal is not supported 

by the router

# Indicates the video format of the reference signal 
that is used when the specified Trigger ID is used 
by an output

Format Custom The switching line is specified by the user via the 
Custom menu

# Indicates the video format of the reference signal 
that the specified Trigger will use
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Monitoring the SDI Inputs
The Port Configuration interface enables you to monitor the signal status of the SDI inputs of the Ultrix router.

To monitor the status of all the inputs of the Ultrix router

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Click Port Configuration.

The Port Configuration interface opens. 

5. Click one of the Inputs banners in the Ultrix rear panel map.

The Inputs Summary table displays and all the Inputs banners are lit blue on the Ultrix rear panel map.

6. Refer to Table 28.4 to troubleshoot the messages displayed in the status fields for each physical input socket.

Table 28.3  Port Configuration — Output Summary

Item Parameters Description
Physical Address slot#.out[#] Indicates the physical socket on the Ultrix rear 

panel

Error Status OK (Green) Indicates a valid output signal is detected on the 
specified socket

No Signal (Red) Indicates that a valid output signal is not detected 
on the specified socket 

Video # Indicates the SDI signal type detected on the 
specified socket

Audio # Indicates the audio signal type detected on the 
specified socket

Table 28.4  Port Configuration — Input Summary

Item Parameters Description
Physical Address slot#.in[#] Indicates the physical socket on the Ultrix rear 

panel

Error Status OK (Green) Indicates a valid input signal is detected on the 
specified socket

No Signal (Red) Indicates that a valid input signal is not detected on 
the specified socket 

Video # Indicates the SDI signal type detected on the 
specified socket

Audio # Indicates the audio signal type detected on the 
specified socket
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Monitoring a Specific BNC
The Port Configuration interface enables you to monitor the video and/or audio signal status of a specific port on 
the Ultrix rear panel.

To monitor the status of a specific port for the Ultrix router

1. In the Tree View of DashBoard, expand the Devices node.

2. Expand the Controllers + Matrices node.

3. Double-click the node for your Ultrix router.

The Device Configuration interface opens.

4. Click Port Configuration.

The Port Configuration interface opens.

5. From the Ultrix rear panel map, select the port you wish to monitor.

The icon in the map is lit blue and the Port Configuration interface updates to display information on the 
selected socket. In the example below, OUT 2 in slot 2 was selected on an ULTRIX-FR2 and the user clicked 
Audio to display the audio monitoring features.

6. Click Video to monitor the status of the video signal on the selected port. 

7. Click Audio to monitor the status of the audio channels on the selected port.
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Software Upgrades
The Ultrix router is upgraded through the DashBoard client. To obtain the most recent upgrade package, contact 
Ross Technical Support.

 Ensure that you are running DashBoard software version 8.7.1 or higher and that the computer running the 
DashBoard client is located on the same network as the Ultrix router.

To upgrade the Ultrix software

1. Contact Ross Technical Support for the latest software version file.

2. Ensure the router has a valid Ethernet connection.

3. Launch DashBoard by double-clicking its icon on your computer desktop.

4. Locate the Ultrix in the Tree View of DashBoard.

5. Expand the Ultrix node to display a list of sub-nodes in the Tree View.

6. Expand the Ultrix sub-node.

7. Double-click the System Status node.

The System Status interface displays in the DashBoard window.

8. Click Upload, located near the bottom of the tab.

The Select File to Upload dialog opens.
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9. Navigate to the *.bin file you want to upload.

10. Click Open.

11. Click Finish to start the upgrade.

12. Monitor the upgrade.

An Upload Status dialog enables you to monitor the upgrade process.

 Avoid clicking Reboot until the Ultrix has successfully completed the file upload process and the OK button, 
located in the bottom right corner of the dialog, is enabled.

13. Click OK to reboot the Ultrix. 

The Reboot Confirm dialog opens, indicating the Ultrix will reboot.

14. Click Yes to continue the upgrade process. 

 The router is temporarily taken off-line during the reboot process. The process is complete once the status 
indicators for the router return to their previous status.
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DashBoard Interface Overview
The DashBoard client software enables you to monitor and configure your Ultrix routers. Using the interfaces 
provided via the DashBoard client software, you can:

• Configure the network connection for your router
• Configure router levels and assign level names
• Assign physical router inputs and outputs to logical sources and destinations
• Configure source and destination labels
• Perform crosspoint preset/takes
• Monitor the status of multiple levels
• Create and use salvos

For More Information on...
• the DashBoard client software, refer to the DashBoard User Manual.
• navigating the interfaces in DashBoard, refer to the section “Accessing the Ultrix Interfaces in DashBoard” on 

page 25.

Ultrix in DashBoard
Ultrix groups the configuration, monitoring, and operating features in a Tree View in the DashBoard client window. 
Each node of the tree opens to reveal one or more sub-nodes, giving access to the features for your router.

Figure 30.1  Example of the Ultrix Nodes in a DashBoard Window

Ultrix includes the following interfaces, as separate nodes, in the DashBoard Tree View.

UltriScape

The first node provides access to the UltriScape Layout Editor, and UltriScape Head interfaces. UltriScape is the 
integrated Multiviewer for Ultrix routers. Use the UltriScape Layout Editor to manage the layouts and the 
UltriScape Head to assign sources to the UltriScape Head outputs. You must have at least one UltriScape license 
key installed to access the UltriScape interfaces.
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System Status

Double-clicking the System Status node displays two types of tabs within the same DashBoard window: Status 
(read-only) tabs located on the left, and a series of Configuration tabs located on the right. This interface is similar 
to an openGear® card tab system.

Database

Expanding the Database node enables you to configure the connection points, matrices, destinations, sources, 
group, levels, soft panels, and salvos for the router. The settings are saved locally on the router.

Devices

The sub-nodes under Devices provide a list of devices in the routing system currently communicating with the 
Ultrix router.

Soft Panels

The Soft Panels tree provides access to the Matrix, MultiBus, and Category soft panels for the Ultrix router. From 
these panels you can perform crosspoint switches, and manage salvos.

Terminology
Throughout the Dashboard interface, actual sockets (inputs and outputs) of a router (or matrix) are referred to by 
hierarchical dotted notation: Frame.Slot.Port.Type.Channel where:

• Frame identifies the physical router chassis housing the matrix/matrices.
• Slot identifies which slot in the matrix the socket is located in.
• Port identifies the physical input or output socket.
• Type identifies the generic signal type (e.g. SDI, audio).
• Channel identifies the audio channel within an SDI stream.

These designators may be assigned more user friendly names if required by editing the Port Labels interface.
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System Status Interface
The System Status interface provides hardware information, IP Address settings, and general database management 
for your router. The interface is organized into two distinct areas in the DashBoard window: Status tabs (located on 
the left), and Configuration tabs (located on the right). 

Figure 30.2  Example of a System Status Interface

Status Tabs
The Status tabs display read-only information about the Ultrix hardware and software.

Product Tab

Table 30.1 summarizes the read-only information displayed in the Product tab.

Table 30.1  Product Tab

Item Parameters Description
Product Indicates the Ultrix product name

Vendor Indicates the supplier/manufacturer of the router

System Version Indicates the build version of the Ultrix router

Serial Number Indicates the serial number of the Ultrix router

Uptime #h #m #s Indicates the number of hours since the last reboot of the 
Ultrix router

System Time DD mm dd yyyy 
hh:mm:ss

Indicates the current date based on the Ultrix internal clock 
(if no connection to an NTP Server is available) where:
• DD represents the calendar day
• mm represents the month
• dd represents the day
• yyyy represents the year
• hh:mm:ss represents the current local time
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Other Tab

Table 30.2 summarizes the read-only information displayed in the Other tab.

Configuration Tabs
The Configuration tabs are located on the right side of the DashBoard window. This series of tabs provide network 
setup options for the Ultrix router and managing the databases for your router.

Network Tab

Table 30.3 summarizes the fields and menus displayed in the Network tab.

Table 30.2  Other Tab

Item Parameters Description
Frontend Software Date <number>

Read-only information used by Ross Technical Support.Backend Software Date <number>

Device FW Rev <number>

Table 30.3  Network Tab

Item Parameters Description
Information (Read-only)

Active ENET ENET # Indicates which Ethernet port on the router is the 
primary Ultrix network connection

ENET # LINK Connected (x, y) Indicates that a valid network link is configured on the 
specified Ethernet port of the Ultrix router where:
• x represents the connection speed in number of Mbps
• y represents the link type (e.g. full duplex)

Not Connected Ethernet communications for the Ultrix router are 
invalid. The Ethernet cable may be disconnected on the 
rear panel or the Ethernet network may be down or 
experiencing problems.

ENET MAC <number> Indicates the MAC Address for the Ultrix router 

Settings

Address ###.###.###.### Specifies the IP address for the Ultrix router

Subnet Mask ###.###.###.### Specifies the subnet mask for the Ultrix router

Gateway ###.###.###.### Specifies the gateway for communication outside of the 
local area network (LAN)

Cancel Ignores any unsaved changes made to the Address, 
Subnet Mask, and Gateway settings and reverts back to 
the current running values.

Apply Updates the Address, Subnet Mask, and Gateway 
settings

SNMP

Enable SNMP Selected Enables the SNMP Agent on the Ultrix

Cleared Disables the SNMP Agent on the Ultrix

SNMP Community 
Name

# Specifies the SNMP Agent identifier for 
communications
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Database Tab

Table 30.4 summarizes the fields and menus displayed in the Database tab. The options in the Database tab are 
organized into two sections: Current Database, and Database Management.

SNMP Trap 
Destination IP Address

###.###.###.### Specifies the target address the Ultrix sends SNMP 
traps to

Permitted Clients

DashBoards: ###.###.###.### Lists the IP Address of each DashBoard client that is 
allowed to communicate with this Ultrix router

Add Enables you to add a new DashBoard client to the 
Permitted Clients list

Delete Deletes the selected DashBoard client from the 
Permitted Clients list

Delete All Clears all entries in the Permitted Clients list

Edit Enables you to modify the selected entry in the 
Permitted Clients list

Cancel Ignores any unsaved changes made to the Permitted 
Clients list and reverts back to the current running 
values. 

Apply Updates the Permitted Clients list settings

Table 30.4  Database Tab

Item Parameters Description
Current Databasea

Remote Controller 
Mode

Selected This Ultrix router will be controlled by a remote (primary) 
Ultrix router or Ultricore device. You must reboot this 
router before the change can take effect.

Cleared This Ultrix router is a standalone router or is the primary 
router (system controller) for the routing system.

Name (read-only) <name> Indicates the database currently loaded in the Ultrix router

Levels (read-only) # Indicates the number of levels the database is configured for

Sources (read-only) # Indicates the number of inputs the database is configured 
for

Destinations 
(read-only)

# Indicates the number of outputs the database is configured 
for

Enable Tally Selected Select this box to enable Ultrix to read tally identifiers from 
the input signals. This information is used by the database 
for displaying in the PiPs of the UltriScape head(s), and 
passed through to any assigned outputs.
Selecting this box also updates the Sources and Destinations 
tabs with a new column “Tally” that is used to assign Tally 
IDs to sources and/or destinations.

Table 30.3  Network Tab

Item Parameters Description
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Enable Tally Cleared Tally information from the input signals is not read into the 
Ultrix database

I/O Ports Refresh Updates the Matrix Inputs and Outputs lists in the Sources 
and Destinations tabs respectively

Crosspoint Status Refresh Updates the Status field located directly below this button

Status (read-only) Loaded The active database was successfully loaded. 

Errorb One of the following has occurred:
• the selected database is no longer available
• an attempt was made to delete a non-existent database
• an attempt was made to save a database with an existing 

name

Database Management - Load Database

Name <name> Selects the database to load for the Ultrix router

Database Load Loads the specified database to the Ultrix router

Database to RCPs Send Forces the currently loaded database to refresh/update all 
connected devices (i.e. RCPs, etc.)

Database Management - Add Database

Name <name> Provides a unique identifier for the new database (up to 32 
characters)

Include I/O Maps Creates a database to match the quantity of BNC I/O fitted 
in the Ultrix router. Each input / output SDI port will be 
mapped to default labels of SRC xx and DST xx 
respectively.
• I/O mapping occurs for Level 1 only (SDI)
• the Sources field is ignored
• the Destination field is ignored
• the Level field is applied

Levels # Specifies the total number of levels the database will make 
available

Sources # Specifies the total number of sources the database will make 
available

Destinations # Specifies the number of destinations the database will make 
available

Database Add Uses the settings in the Database Management fields to 
create a new database

Database Management - Delete Database

Name <name> Specifies the database to delete

Database Delete Deletes the currently selected database

a. The Levels, Sources, and Destinations fields indicate the initial values when the database was created. Levels, Sources, 
and Destinations can be removed from or added to the database on their respective configuration tabs. Doing so will not 
alter the fields in the Database tab.

b. This message displays for a maximum of 10 seconds only.

Table 30.4  Database Tab

Item Parameters Description
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Transfer Tab

Table 30.5 summarizes the sub-tabs displayed on the Transfer tab. 

Table 30.5  Transfer Tab

Section Item Parameters Description
Ultricore Database Tab

Export Database <database name> Selects the database to be exported

Save As: 
(read-only)

*.uda Automatically updates with the name of the 
database archive

Export Browse... Enables you to save or re-name the database to a 
specific location

Apply Click to begin exporting the file to specified 
location

Import Archive File: 
(read-only)

*.uda Indicates the last file that was selected for restore

Browse... Enables you to specify the database to import

Retrieve 
Database As:

<database name> Indicates the file currently selected for importing

Apply Click to begin the import

Ultriscape Layout Tab

Export Layout <layout name> Selects the layout to be exported

Save As... 
(read-only)

*.lay Automatically updates with the name of the layout 
archive

Browse... Enables you to save or re-name the layout to a 
specific location

Apply Click to begin exporting the file to the specified 
location

Import Layout File 
(read-only)

*.lay Indicates the last layout file that was imported

Browse... Enables you to specify the layout to import

Retrieve 
Layout As:

<layout name> Indicates the file currently selected for importing

Apply Click to send the file to the device

Ultrix Frame Settings Tab

Export Save As: 
(read-only)

*.ufs Automatically updates with the name of the frame 
settings archive

Browse... Enables you to save or re-name the frame file to a 
specific location

Apply Click to begin exporting the file to the specified 
location

Import Settings File: *.ufs Indicates the last frame file that was imported

Browse... Enables you to specify the frame file to import

Apply Click to send the file to the device
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Setup Tab

Table 30.6 summarizes the options displayed in the Setup tab. 

Storage Tab

Table 30.7 summarizes the read-only displayed in the Storage tab.

Table 30.6  Setup Tab

Item Parameters Description
Device Identification

Device Name <name> Provides a unique identifier for the router in the Tree View 
of DashBoard 

System Name <name> Provides a unique identifier for the routing system

Log Settings

Logging Selected Enables the router to update the entries in the Logs tab

Cleared Disables this feature

Output Debug 
Messages

Selected Only use this feature under the guidance of Ross Technical 
Support.Cleared

DashBoard Interface

DashBoard Timeout 10-300s Sets the maximum number of seconds that DashBoard waits 
until it queries Ultrix.
The default is 10 seconds. This value is re-set after a 
power-cycle.

Update Applies the new value in the DashBoard Timeout menu.

Password Protected Settings

Protect all licensed 
features with a 
password

Selected Enables the password-protected feature that prevents 
unauthorized changes to license keys. When the Port 
License tab is locked, users require a password to 
access/edit the license key information. 

Cleared Disables this feature (the Port License tab is editable). T his 
is the default.

Change Password... Enables you to specify a password at least 8 characters long.
It is recommended to change the password from the default value that is assigned 
at the factory.

Status

Status (read-only) mm/dd/yy 
ERROR: 
Duplicate device 
name [abc] for ID 
[#]

Reports when multiple devices, with the same name, are 
communicating with the Ultrix router where:
• mm/dd/yy represents the date of the error
• [abc] represents the device name
• [#] represents the ID number assigned to the device

Clear Clears the Status field entry
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Logs Tab

There are three logs that can be viewed from the Logs tab: System Log, Controller Communications Log, and 
DashBoard Communications Log. The read-only information displayed in the logs is used by Ross Technical 
Support for diagnostic and troubleshooting purposes.

Device Configuration Interfaces
The Device Configuration interfaces enable you to define the physical outputs, inputs, and communication ports of 
the Ultrix router. You can also monitor the overall status of the Ultrix router, or just the status of a specific signal 
path or port on the rear panel. A rear panel map that represents the Ultrix router displays at the top of the interface, 
enabling you to quickly select physical ports to configure and monitor. The Device Configuration options are 
organized into four interfaces: Frame Configuration, SFP Configuration, Port Licenses, and Port Configuration.

For More Information on...
• displaying the Device Configuration interfaces, refer to the section “To access the Device Configuration 

interfaces in DashBoard” on page 26.

Frame Configuration Interface
The Frame Configuration interface is organized into distinct areas, each accessed by clicking the corresponding 
button on the left toolbar of the interface.

Figure 30.3  Example of Frame Configuration Interface — 2RU Router

Table 30.7  Storage Tab

Item Parameters Description
Internal OK There are no storage space issues detected

WARNING Less than 20% of the storage space is available

CRITICAL Less than 10% of the storage space is available

SD Card OK There are no storage space issues detected
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Frame Information

The read-only fields in the Frame Information area report on the overall hardware status of the Ultrix router. The 
information is organized in the Frame Inventory table with each slot in the router chassis as a separate row. For 
each slot, the cells indicate the I/O Board version, firmware running on the I/O Board, what licenses are enabled for 
the slot, and which AUX ports are populated with SFP modules.

Below the Frame Inventory table are the fields that report status information on the Ultrix hardware such as the 
version of the front panel and the system firmware. From this area you can also specify the NTP Server to be used 
as the time source for the router.

Licenses

Use the options in the Licenses area to manage the licensed features for your Ultrix router. From here you can view 
which licensed features on which slots are enabled, and enter license keys for new features. Refer to the section 
“Software License Keys” on page 33 for details.

Power Supplies and Fans

The Power Supplies and Fans area displays read-only fields that report on the four PSU connections of the Ultrix 
router. Some fields in this interface include color indicators which vary in severity from green (valid), yellow 
(caution), to red (alarm). In the case of multiple messages, the most severe alarm is reported for a single row in the 
table. You can choose to enable the Ultrix router to monitor the presence of each power supply or ignore when a 
PSU is not in use or missing. You can also set the speed of the interior chassis fans.

Alarms

From the Alarms table you can specify what components the Ultrix router monitors such as the power supplies, 
fans, network status, the SD Card, the chassis battery, and the interior chassis temperature. 

By default, the Ultrix monitors the following components (these options in the Alarms table are enabled):

• System Error
• Temperature
• Primary Power
• Redundant Power
• SD Card Presence
• Battery
• Storage Space
• Fan 1
• Fan 2
• Fan 3 (applicable only to the ULTRIX-FR1-NS, ULTRIX-FR2-NS, and ULTRIX-FR5)
• Fan 4 (applicable only to the ULTRIX-FR2-NS, and ULTRIX-FR5)
• Fan 5 (applicable only to the ULTRIX-FR5)

The Alarms table also displays read-only State column that reports the status of each enabled alarm using color 
indicators which vary in severity from green (valid), yellow (caution), to red (alarm). For example, if the SD Card 
status is set to red in the Alarms table, an SD Card is not detected or the SD Card not mounted correctly inside the 
chassis.

Communication Settings

The Frame Communications area enables you to monitor the status of the Ethernet connection of the Ultrix router. 
From here you can verify the network settings of the active Ethernet port on the router, and view the mode of the 
control system (primary/client).
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Sync

The Sync area is organized into two tables: References and Triggers. The References table displays read-only fields 
that report the status on the reference signal. The Triggers table provides options for configuring the reference 
signal for the routing system. From this table you can configure up to four reference triggers which then can be 
assigned to the inputs and outputs of the router. Refer to the sections “Specifying a Default Reference Format” on 
page 28 and “Configuring a Reference Trigger for the Ultrix Router” on page 40 for details.

ULTRIX-IP Settings

 The ULTRIX-IP settings are only available when using an ULTRIX-FR1-NS, ULTRIX-FR2-NS, or an 
ULTRIX-FR5 with an ULTRIX-IP-IO blade installed in at least one of the rear panel slots.

The ULTRIX-IP area provides options for configuring the individual SFP+ ports, the transport protocol, and PTP 
settings that are required for the streaming of video and/or audio. Refer to the chapter “ULTRIX-IP-IO Setup” on 
page 71 for details.

Table 30.7 summarizes the fields and menus displayed in the ULTRIX-IP area.

Table 30.8  ULTRIX-IP Area

Item Parameters Description
NMOS Device Name <text> Specifies the name that the Ultrix router uses to advertise 

itself to the NMOS server

Default Applies the system device identifier to the Ultrix router as 
provided by the master NMOS device

NMOS Node Name <text> Name of the NMOS node being advertised. The default 
name is Ross Ultrix.

Default Applies the system device identifier to the NMOS mode as 
provided by the master NMOS device

Ember+ Port # Specifies the TCP port the Ultrix router uses for Ember+ 
protocol communications. The default is 9095.

Port Network

Port slotx.porty Specifies the port on the ULTRIX-IP blade you are 
configuring where:
• x represents the physical slot the ULTRIX-IP blade is 

installed in
• y represents the physical port on the ULTRIX-IP blade

Name <text> Assigns a unique identifier to the port. This name is 
displayed in the router database tables

MAC Address #:#:#:#:#:# Indicates the MAC Address currently assigned to the Ultrix 
router for the specified ULTRIX-IP port

IP Mode Static The user manually supplies the network settings for the 
specified ULTRIX-IP port

DHCP Automates the assignment of the network settings for the 
specified ULTRIX-IP port. This is the default.

IP Address #.#.#.# Indicates the IP Address currently assigned to the selected 
ULTRIX-IP port. The default is 128.0.0.0 <port #>

Subnet Mask #.#.#.# Indicates the subnet mask for the specified ULTRIX-IP 
port. The default is 255.255.255.0.
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ULTRIX-UCCI Control Card

 The ULTRIX-UCCI Control Cards area is only available when using an ULTRIX-FR5 with at least one 
ULTRIX-UCCI Control Card in the top slot of the rear panel.

SFP Configuration Interface
The SFP Configuration interface is applicable when:

• at least one ULTRIX-SFP-IO blade is in an ULTRIX-FR1-NS, ULTRIX-FR2-NS, or an ULTRIX-FR5; or, 
• at least one AUX port is populated in a router chassis.

From this interface you can configure each populated AUX and/or SFP port on the blade. This interface is 
organized into two sub-tabs: AUX Settings and SFP Settings.

For More Information on...
• the physical SFP ports of your router, refer to the Ultrix Installation Guide.

Gateway #.#.#.# Indicates the gateway for communications outside of the 
local area network (LAN).

ULTRIX-IP PTP

Custom PTP Profile Selected Enables the user to create and assign a custom PTP profile 
for the ULTRIX-IP ports. The Domain, Priority1, Priority2, 
Sync Interval, Announce Interval, and Announce Receipt 
Timeout fields can be edited to create a custom PTP profile.

Cleared The Domain, Priority1, Priority2, Sync Interval, Announce 
Interval, and Announce Receipt Timeout fields do not 
display and cannot be edited. This is the default.

Profile IEEE 1588 Default The ULTRIX-IP timing uses the IEE1588 standard

AES67 Media The ULTRIX-IP timing uses the AES67 Media standard

SMPTE ST 2059-2 The ULTRIX-IP timing uses the SMPTE ST 2059-2 
standard. This is the default.

Custom PTP Options

Domain # Specifies that the ULTRIX-IP is within the specified group 
of clocks in your network

Sync Interval # Specifies often the ULTRIX-IP port sends Sync messages

Announce Interval # Specifies how often the ULTRIX-IP sends Announce 
messages

Announce Receipt 
Timeout

# Controls how long the ULTRIX-IP port will wait before 
declaring the Grandmaster absent and initiating a new 
election

Table 30.8  ULTRIX-IP Area

Item Parameters Description
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Figure 30.4  Example of the SFP Configuration Interface

AUX Settings Tab

The information in the AUX Settings tab is organized into two areas: a table on the left that lists the slots with 
available AUX ports, and a table on the right that provides details on each SFP port of a selected slot. Each row of 
the table reports the port name, type of SFP module installed, and the number of MADI channels that are available 
from SFP module. Refer to the section “Configuring an SFP Port” on page 40 for details.

SFP Settings Tab

The information in the AUX Settings tab is organized into two areas: a table on the left that lists the slots with 
available AUX ports, and a table on the right that provides details on each SFP port of a selected slot. Each row of 
the table reports the port name, type of SFP module installed, and the number of MADI channels that are available 
from SFP module. Refer to the section “Configuring an SFP Port” on page 40 for details.

Port License Interface
The Port License interface displays the following sub-tabs: UltriScape, UltriSync, and UltriSRC.

Figure 30.5  Example of the Port License Interface

 The Port License interface takes up to 35 seconds to register any changes to the table entries.
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UltriScape

The UltriScape table reports on the number of UltriScape licenses installed, and the number of UltriScape Heads 
enabled on the Ultrix router. From this interface, you can assign an UltriScape Head to a physical OUT socket on 
the router. Refer to the chapter “UltriScape Configuration” on page 151 for details.

 At least one UltriScape license must be installed for a slot before you can assign an UltriScape Head to a router 
output in that slot.

The UltriScape table is organized into three columns:

• Head — read-only fields that report the physical address name of an UltriScape output.
• Port — used to enable/assign an UltriScape Head.
• Format — used to select the an UltriScape output format.

UltriSync

The UltriSync table reports on the number of UltriSync-3G and Ultrisync-UHD licenses installed, and the number 
of slots with the licensed enabled on the Ultrix router. The UltriSync table is organized into two columns:

• Port — read-only fields that report the physical address name of an Ultrix router output.
• 3G License — used to enable the UltriSync-3G on the specified port.
• UHD License — used to enable the UltriSync-UHD on the specified port.

 The UltriSync-UHD is only available for the following ports of a slot: AUXB-in[1] or in[1], in[5] or in[6], and 
in[1] or in[12].

UltriSRC

The UltriSRC table reports on the number of UltriSRC licenses installed, and the number of AUX ports with the 
licensed enabled on the Ultrix router. The UltriSRC table is organized into two columns:

• Port — read-only fields that report the physical address name of the Ultrix AUX port.
• License — used to enable the UltriSRC on the specified port.

Port Configuration Interface
Use the Port Configuration interface to assign each physical port on the Ultrix router to the type of signal (video, 
audio, etc.), then further define its purpose using the options based on the type. Use the router rear panel map at the 
top of the interface to select individual ports to configure. 

Figure 30.6  Example of the Port Configuration Interface — Input Summary
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Input and Output Summaries

Select the Input banner under any row of input sockets to display the Input Summary table for the router as seen in 
Figure 30.6. Select the Output banner under any row of output sockets to display the Output Summary table for the 
router. 

Table 30.9 summarizes the read-only information displayed in the Input and Output Summary tables. 

Table 30.9  Input and Output Summary Tables

Item Parameters Description
Input and Output Summary Tables

Physical Address Frame.Slot.Port
.Type.Channel

Lists the physical sockets, in ascending order, of the Ultrix router. 
Each row represents a socket.

Video # If a port is used for video signals, this field indicates the type of 
video (e.g. HD, 3G, UHD, etc.).

Audio # If a port is used for audio signals, this field indicates the type of 
audio detected (e.g. PCM, AES etc.).

2-SI Group Enable Gearbox is available on the indicated I/O Group in groups of 4 
consecutive I/O. For example, selecting Enable in the row for 
slot1.in[1] creates a Gearbox group from slot1.in[1] to slot1.in[4].
Note that I/O Groups for Gearbox are defined in the table using 
colored backgrounds. In Figure 30.6, the first Gearbox group is 
set in dark red, the second group is set in dark green.

Disable The indicated I/O is not included in a Gearbox configuration

Input Summary Table only

Timing Lines 
(read-only)

# Reports the value of timing difference between input and frame 
reference in number of lines.

Detecting The timing difference is being detected; updates the field 
approximately every 33 seconds.

Timing Lines 
(read-only)

Async There is no timing relationship between the input signal and the 
frame reference.

Timing Pixels 
(read-only)

# Reports the value of timing difference between input and frame 
reference in number of pixels. 

Detecting The timing difference is being detected; updates the field 
approximately every 33 seconds.

Async There is no timing relationship between the input signal and the 
frame reference

Frame Sync Delay # frame(s) Specifies the frame buffer size for the selected input port

LoS Statea Black Sets the input to black during the loss of signal

Freeze Sets the input to the last valid frame of video before the loss of 
signal

Signal Medic 
(read-only)b

Not available This port does not support the Gearbox feature.

Good This port is included in a Gearbox setup.

Replaced This port can be included in a Gearbox setup but is currently not 
included in the 12G link.

Output Summary Table only
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Individual HD-BNC I/O Port Interfaces

Selecting a specific socket on the Ultrix rear panel map updates the Port Configuration interface to display the 
read-only information and configurable options for that port. The location of the port is reported at the top of the 
interface. Click the video or audio buttons, located on the left toolbar of the interface, to display the corresponding 
options for configuring the signals on the socket.

Figure 30.7  Example of Port Configuration Interface — slot1.out[2] Selected 

Sub-Image ID 3G Some legacy equipment does not accept a 2SI SMPTE-352 
payload identifier for quad-link SDI. You may need to select this if 
you are connecting legacy equipment to the specified output on 
the Ultrix.

2SI Set the SMPTE-352 payload identifier to 2SI for quad-link.

Clean Switch Status 
(read-only)

Locked The specified output is locked to its input.

Not Locked The specified output is not locked to its input.

Clean Switch Selected Clean Switch is applied to the specified output. The Clean Switch 
Delay value is applied.

Cleared Clean Switch is not applied to the specified output.

Clean Switch Mode Reference Clean Switch is based on the reference signal available on the REF 
port of the router

Input Clean Switch is based on the input signal available on the 
specified port of the router

Clean Switch Delay # Specifies the Clean Switch buffer depth. Select between 1/16 to 
full line to clean switch between signals with slight timing offsets.

Loss Signal None A loss of input is ignored.

Black Sets the output to black when there is a loss of input.

a. This affects UltriScape and routed destinations.
b. Use this field to replace a missing 3G signal when one or more of the four 3G signals for a Gearbox configuration are 

unavailable.

Table 30.9  Input and Output Summary Tables

Item Parameters Description
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ULTRIX-IP Interface

When an ULTRIX-IP-IO blade is installed in a router slot, selecting a specific port on the rear panel map displays 
configurable options for that port. From this interface, you can configure the sender, and receiver streams the port 
will manage. Refer to the chapter “ULTRIX-IP-IO Setup” on page 71 for details on using this interface.

Figure 30.8  Example of Port Configuration Interface — ULTRIX-IP Port Selected

Table 30.12 summarizes the fields displayed in the options in the Port Configuration page for the ULTRIX-IP-IO 
blade.

 
Table 30.10  Port Configuration — ULTRIX-IP

Item Parameters Description
Port Status (read-only) OK (Green) The selected port is ready to accept stream setting changes

NOT READY 
(Red)

Failure to communicate with the port. The router will 
continue to re-establish connection with the port until it is 
successful.

Sender Bandwidth 
(read-only)

# of 25Gb used Reports the amount of data the router is currently 
transmitting on the specified port

Receiver Bandwidth 
(read-only)

FREE Reports the amount of data the router is currently receiving 
on the specified port

Senders

Port slot.port.type.ch Specifies the ULTRIX-IP-IO port when subscribing to 
streams

Name <text> Specifies a unique identifier for the sender stream

Type Indicates whether the stream includes video or audio data

Signal Format # Indicates the video format detected on the stream

Codec # Specifies the AES67 standard that the ULTRIX-IP-IO will 
default to for all IP-based audio sender streams

Channels # Specifies the maximum number of audio channels available 
for configuration within the specified stream

Transport IP # Specifies the IP address for the stream

UDP Port # Indicates the port associated with the IP address and the 
communication protocol for the stream

Redundancy Indicates if Redundancy Mode (protection switching) is 
enabled for the specified ULTRIX-IP-IO port

Session ID # Indicates the ID number assigned to the ULTRIX-IP-IO 
within the system



332 • DashBoard Interface Overview Ultrix User Guide (v18.0)

Database Interfaces
The Database interfaces enable you to configure control aspects of your router. Note that the currently active 
database name is displayed in parentheses beside the Database node in the tree view. For example, Figure 30.9 
illustrates a router with the 100pip database loaded. Unicode names are supported so that names may be defined in 
other languages or writing systems.

Figure 30.9  Expanded Database Node in the Tree View

Stream ID # Indicates the ID number assigned to the specific stream 
within the system

Alarm Severity Indicates any detected errors for the specific stream

Alarm Description

Receivers

Port slot.port.type.ch Specifies the ULTRIX-IP-IO port for the receiver stream

Name <text> Specifies a unique identifier for the receiver stream

Type Indicates whether the stream includes video or audio data

Signal Format # Indicates the video format detected on the stream

Codec Specifies the AES67 standard that the ULTRIX-IP-IO will 
default to for all IP-based audio receiver streams

Channels # Specifies the maximum number of audio channels available 
for configuration within the specified stream

Transport IP # Specifies the IP address for the stream

UDP Port Indicates the port associated with the IP address and the 
communication protocol for the stream

Redundancy # Indicates if Redundancy Mode (protection switching) is 
enabled for the specified ULTRIX-IP-IO port

Session ID # Indicates the ID number assigned to the ULTRIX-IP-IO 
within the system

Stream ID # Indicates the ID number assigned to the specific stream 
within the system

Alarm Severity Indicates any detected errors for the specific stream

Alarm Description

Table 30.10  Port Configuration — ULTRIX-IP

Item Parameters Description
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Most of the interfaces are organized into a table format with a row of buttons at the bottom of the interface. You can 
select individual cells, columns, or rows of entries to define.

Figure 30.10  Example of Filling a Column of Entries

Figure 30.11  Example of Filling a Row of Entries

 A summary of each interface is provided in the following sub-sections.

Database Builder
The Database Builder interface helps you to quickly create a database by grouping basic controls on four pages: 
Quick Start, Levels, Destinations, and Sources. The same controls are available as sub-nodes of the Database 
interface.
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Quick Start

The Quick Start options display by default when the Database Builder displays in DashBoard. From this page you 
can define the database properties including: type of signals (video, audio) the number of Ultrix routers that the 
database includes, the audio elements of the database, and basic UltriScape parameters.

Figure 30.12  Example of the Database Builder — Quick Start Page

Table 30.12 summarizes the fields displayed in the options in the Quick Start page. 
Table 30.11  Database Builder — Quick Start

Item Parameters Description
Database name <name> Assigns a unique identifier for the device in the routing 

system. This name is also used when matrices are defined in 
the Ultrix system.

Frame select table Displays a list of detected routers in your network. Select a 
box to apply the database to the specified router.

Include AUX ports None Do not create entries for AUX ports in the database

Insert at slot Create AUX port entries as they are physically located 
within the Ultrix chassis (e.g. ports 17 and 18).

At the end Create AUX ports after BNC entries

Video support Yes Creates a database that includes video and audio signals

No Creates an audio-only database

Audio channels # Specifies the quantity of audio channels (levels) required

Breakaway source 
support

Yes Create sources for audio breakaways/shuffles

No Audio breakaways are not included in this database

SDI audio per channel Creates audio breakaway sources using the selected audio 
channel grouping size

MADI channels per 
source

Creates MADI sources using the selected audio channel 
grouping size
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Levels

Once you defined the options on the Quick Start interface, you can proceed to preview and customize the levels, 
destinations, and sources this database will include. Clicking Next on the Quick Start page displays the Levels 
page. (Figure 30.13)

The options in the Levels page are organized into a table where each row represents a level and the columns provide 
the options for configuring that level. From this page you assign a unique name to each level, a color that represents 
the level to make it easier to identify the level in a soft panel. 

Figure 30.13  Example of the Database Builder — Levels Page

Destinations

Clicking Next on the Levels page displays the Destinations page. (Figure 30.14)

Disconnect source? Yes Creates a source that will disconnect (mute) SDI and audio 
channels

No This option is not included in the database

Passthrough source? Yes Sources are routed without changes/edits

No This option is not included in the database

UltriScape support? Yes Enables UltriScape heads and PiPs to be included in the 
database

No UltriScape heads and PiPs are not included in the database

Number of Multiviewer 
heads

# Specifies the number of UltriScape heads the database will 
support

Number of Multiviewer 
pips per head

# Specifies the maximum number of PiPs available per layout

Include detected 
Multiviewer layout

Creates sources for detected UltriScape layouts to enable 
layout changing from control panels

Table 30.11  Database Builder — Quick Start

Item Parameters Description
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The Destinations page enables the assignment of logical labels (used by remote control panels and soft panels) to 
physical outputs of the attached matrices or routers. The options in the Destination page are organized into a table 
where each row associates a name of the destination with one or more logical matrix output sockets. 

Figure 30.14  Example of the Database Builder — Destinations Page

Sources

Clicking Next on the Destinations page displays the Sources page. (Figure 30.15)

The Sources page enables the assignment of labels (used by remote control panels and soft panels) to inputs of the 
attached matrices or routers. The options in the Sources page are organized into a table where each row associates a 
name of the source with one or more logical matrix input sockets.

Figure 30.15  Example of the Database Builder — Sources Page

Connections Tab
The Connections tab lists and configures the Ultrix communications systems. The first two tables, Protocol Servers 
and Incoming Connections, configure and list server connections from an external client. The third table, Outgoing 
Connections, lists and configures client connections to an external server.
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Figure 30.16  Example of Entries in a Connections Tab

Protocol Servers Table

The protocol servers table lists the currently active servers running on the Ultricore control system. 

Server Options Dialog

Click Options to display a dialog that provides settings for the supported protocol servers. 

For More Information on...
• configuring the protocol settings, refer to the chapter “External Control” on page 263.

Incoming Connections Table

The Clients table lists the connection details of remote client devices (e.g. devices that are under the supervision of 
this Ultrix router control system) currently communicating with the Ultrix router. 

Table 30.12 summarizes the fields displayed in the Clients table in the Connections tab. 
Table 30.12  Connections Tab — Incoming Connections

Item Parameters Description
Device ID <name> Specifies the external device for the connection point

Name <name> Assigns a unique identifier for the device in the routing 
system. This name is also used when matrices are defined in 
the Ultrix system.

Protocol (read-only) GVG Native The device uses the third-party GVG protocol to 
communicate. Refer to “GVG Series 7000 Native Protocol 
Commands” on page 265.

NVISION This device communicates via the third-party NVISION 
protocol. Refer to “NVISION Commands” on page 270.

OGP This device uses the openGear Protocol to communicate

Probel SW-P-08 The device communicates via the Probel SW-P-08 protocol

Ross NK The device uses the Ross NK protocol to communicate 
(T-Bus or TCP only). Refer to “Connecting to Ross NK 
Series Devices” on page 96.
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Outgoing Connections Table

The Servers table lists the connection details of remote server devices (e.g. devices that are controlling this Ultrix 
router control system) currently communicating with the Ultrix router. 

Table 30.12 summarizes the fields displayed in the Outgoing Connections table. 

Protocol (read-only) TSL UMD v3.1 The device uses TSL UMD protocol version 3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0

Ultrix The device uses the Ross Ultrix protocol to communicate 
(TCP only). Refer to “Adding an Ultrix Connection 
Point” on page 103.

Communication type: tcp   The device is communicating over a network connection. 
Note that the DashBoard client computer, the Ultrix router, 
and the external device must be on the same network.   

ip: 
###.###.###.###

Specifies the IP Address of the device on the network.

ip: localhost Specifies that the device is the router you are currently 
configuring

port:##### Specifies the ethernet port the devices is associated with on 
the network.

TBUS | port: The device is communicating via the specified T-Bus port.

... This button opens a dialog allowing further connection 
point setting adjustments such as specifying an IP address, 
IP port, etc.

Details Provides additional information on the device such as 
device type, and firmware version

Table 30.13  Connections Tab — Outgoing Connections

Item Parameters Description
ID # Auto-numbered field (read-only).

Device ID <name> Specifies the external device for the connection point

Name <name> Assigns a unique identifier for the device in the routing 
system. This name is also used when matrices are defined in 
the Ultrix system.

Enabled Enable Direct communication is established between Ultrix and the 
device.

Disable Communication between the router and the device is 
unavailable.

Connected (read-only) Connect A valid connection is established between the device and 
the Ultrix on your network. This box is automatically 
selected when communication is established.

Disconnect The connection is invalid or absent between the device and 
the Ultrix on your network.

Table 30.12  Connections Tab — Incoming Connections

Item Parameters Description
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Third Party Matrices Tab
Once connection points are established with the devices in your routing system, use the Third Party Matrices tab 
to define the size and type of the external device for use in assignment within the Ultricore control system database.

Protocol (read-only) GVG Native The device uses the third-party GVG protocol to 
communicate. Refer to “GVG Series 7000 Native Protocol 
Commands” on page 265.

NVISION This device communicates via the third-party NVISION 
protocol. Refer to “NVISION Commands” on page 270.

Probel SW-P-08 The devices uses the third-party protocol known as Probel 
SW-P-08.

Ross NK The device uses the Ross NK protocol to communicate 
(T-Bus or TCP only). Refer to the section “Connecting to 
Ross NK Series Devices” on page 96.

TSL UMD v3.1 The device uses TSL UMD protocol version 3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate.(TCP only). Refer to the section “Adding an 
Ultrix Connection Point” on page 103.

Communication type: tcp   The device is communicating over a network connection. 
Note that the DashBoard client computer, the Ultrix router, 
and the external device must be on the same network.   

ip: 
###.###.###.###

Specifies the IP Address of the device on the network.

ip: localhost Specifies that the device is the router you are currently 
configuring.

port:##### Specifies the Ethernet port the devices is associated with on 
the network.

TBUS | port: The device is communicating via the specified T-Bus port.

... This button opens a dialog allowing further connection 
point setting adjustments such as specifying an IP address, 
IP port, etc.

Table 30.13  Connections Tab — Outgoing Connections

Item Parameters Description
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Figure 30.17  Example of Entries in a Third Party Matrices Tab

Table 30.14 summarizes the options displayed in the Third Party Matrices tab. 

Port Labels Tab
The Port Labels tab lists the matrices automatically discovered (Ultrix and NK Series), and those defined via the 
Third Party Matrices tab. A matrix (or router) socket is identified via the Frame.Slot.Port.Type.Channel 
nomenclature. Custom labels may be applied to the ports if required. These may be also known as actual labels in 
other terminology (the name the cable would be assigned). This re-naming is not necessary for router operation, but 
it may make your assignment of source and destination labels easier to identify when using your internal cable 
naming conventions.

Table 30.14  Third Party Matrices Tab

Item Parameters Description
ID # Auto-numbered field (read-only).

Name <name> Assigns a unique identifier for the imported third party 
matrix to be used by the Ultrix database. 

First Output # Specifies the first destination for the device within the 
Ultrix database

Last Output # Specifies the last destination for the device within the Ultrix 
database

First Input # Specifies the first source for the device within the Ultrix 
database

Last Input # Specifies the last source for the device within the Ultrix 
database

Level # Specifies the number of levels for the device in the Ultrix 
database

Type Specifies the signal type of inputs and outputs this device 
provides within the Ultrix database

Device ID Specifies the external third-party device the imported 
logical matrix applies to
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Figure 30.18  Example of Entries in a Port Labels Tab

Table 30.15 summarizes the options displayed in the main area of the Port Labels tab (from left to right on the 
interface). 

Bottom Toolbar

Refer to Table 30.39 for a summary of the buttons displayed in the Bottom toolbar of the Database interfaces. 

Levels Tab
A level is a specific grouping of signal input and output ports, that may be controlled separately from other groups 
(a breakaway). Typically a level is associated with input/output ports that are used with sets of similar or related 
signals, such as SDI Video, AES Audio, Analog Video, Analog Audio, Timecode, or Machine Control, and often 
include routing matrices that are dedicated to controlling that specific type of signal.

The options in the Levels tab are organized into a table where each row represents a level and the columns provide 
the options for configuring that level. From this tab you assign a unique name to each level, a color that represents 
the level to make it easier to identify the level in a soft panel, and add a description of the level to aid identification. 

For More Information on...
• the buttons located in the bottom toolbar of the Levels tab, refer to Table 30.39 on page 355.
• the Tally Status Level menu, refer to the section “Defining the Status Level for Tally Operation” on page 193.

Table 30.15  Port Labels Tab

Item Description
Matrix: Provides a list of configured label matrices for the currently loaded database. Click an 

item in the list to reveal the physical port names and associated labels for the given 
matrix selection in the right-hand table area.

Port Indicates the physical socket on the Ultrix router that is included in the currently 
selected logical matrix using the nomenclature Frame.Slot.Port.Type.Channel.

Label Provides a text label that identifies the port in other interfaces of the database. This 
virtual label is used instead of the Frame.Slot.Port.Type.Channel format for logical 
label assignment. For example, you might re-name port: 
Ultrix.slot1.in[1].SDI.ch1 to IN 1.
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Figure 30.19  Example of Entries in a Levels Tab

Destinations Tab
The Destinations tab enables the assignment of logical labels (used by remote control panels and soft panels) to 
physical outputs of the attached matrices or routers. The options in the Destination tab are organized into a table 
where each row associates a name of the destination with one or more logical matrix output sockets. 

Figure 30.20  Example of Entries in a Destinations Tab
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Table 30.16 summarizes the options displayed in the main area of the Destinations tab (from left to right on the 
interface). 

Sources Tab
The Sources tab enables the assignment of labels (used by remote control panels and soft panels) to inputs of the 
attached matrices or routers. The options in the Sources tab are organized into a table where each row associates a 
name of the source with one or more logical matrix input sockets.

Table 30.16  Destinations Tab

Item Parameters Description
ID # Auto-numbered field (read-only). This is not used within 

the Ultrix system itself, however, third-party protocols 
that do not support labels will reference this field in their 
communications.

Tally TSL v3.1 <displayID> Displays the TSL protocol Tally ID entry. The Enable 
Tally box is selected in the Database tab. TSL 4.0 <displayID>

TSL v5.0 <screenID>:<displayID>

Tally Redirect Enables/disables the re-direction of connected source 
Tally ID to destination Tally ID as set by the Tally field

Name <name> Assigns a unique identifier (label) for the destination in 
the routing system. This label is used by control 
interfaces/devices.

Description Provides additional information or user entered notes 
about the output

Level # Specifies the physical output port associated with the 
destination and assigns it to the specified level. Unless 
you have given the port a different label via the Port 
Labels tab, the port is labeled as 
Frame.Slot.Port.Type.Channel.

Matrix Outputs # Lists all the physical output ports available that can be 
assigned to a destination in the routing system

Assign Click this button to add the selected physical output 
port(s) to the list of Destinations for the database
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Figure 30.21  Example of Entries in a Sources Tab

Table 30.17 summarizes the options displayed in the main area of the Sources tab (from left to right on the 
interface). 

Table 30.17  Sources Tab

Item Parameters Description
ID # Auto-numbered field (read-only). This is not used within 

the Ultrix system itself, however, third-party protocols that 
do not support labels will reference this field in their 
communications.

Tally <displayID>   or 
<screenID>:<displayID>

Displays the TSL protocol tally ID entry. The Enable Tally 
box is selected in the Database tab. 

Name <name> Assigns a unique identifier (label) for the source in the 
routing system. This label is used by control 
interfaces/devices.

Description Provides additional information or user entered notes about 
the input

Level # Specifies the physical input port associated with the source 
and assigns it to the specified level. Unless you have given 
the port a different label via the Port Labels tab, the port is 
labeled as Frame.Slot.Port.Type.Channel.

Matrix Inputs # Lists all the physical input ports available that can be 
assigned as a source in the routing system

Assign Click this button to add the selected physical input port to 
the Source label in the database
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Cat/Index Categories Tab
The Cat/Index Categories tab enables you to categorize sources, destinations, and levels via a hierarchal system of 
tags. You can use categories to filter sources, destinations or levels into manageable groups for a Category soft 
panel.Refer to the section “Category Panels” on page 373 for more information.

Figure 30.22  Example of Entries in a Cat/Index Categories Tab

Categories Area

Table 30.18 summarizes the options displayed in the Categories area of the Cat/Index Categories tab. 

Assigned Resources Area

Table 30.19 summarizes the options displayed in the Assigned Resources area of the Cat/Index Categories tab. 

Table 30.18  Cat/Index Categories — Categories Area

Item Parameters Description
Categories: Lists the category tags defined for this database

Add Adds a category tag

Delete Deletes the selected tag

Delete All Deletes all tags listed in the Categories: pane

Generate Automatically generates category tags based on the entires 
in your database.
Categories are automatically defined by searching for space 
characters within the database logical source and 
destination names.

Table 30.19  Cat/Index Categories — Assigned Resources Area

Item Parameters Description
Destinations: <text> Lists the destinations that are accessible via the defined 

Category/Index combinations

Find Performs a search for destinations in the database to add to 
the category
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Indices Area

Table 30.20 summarizes the options displayed in the Indices area of the Cat/Index Categories tab. 

Unassigned Resources Area

Table 30.21 summarizes the options displayed in the Inaccessible Resources area of the Cat/Index Categories tab. 

Sources: <text> Lists the sources that are accessible via the defined 
Category/Index combinations

Find Performs a search for sources in the database to add to the 
category

Levels: <text> Lists the levels that are accessible via the defined 
Category/Index combinations

Find Performs a search for level in the database to add to the 
category

Table 30.20  Cat/Index Categories — Indices Area

Item Parameters Description
Indices: Creates search terms to define category tags

Add Adds a new entry to the Indices list

Delete Deletes the selected entry from the Indices list

Delete All Deletes all entries from the Indices list

Default Creates indexes 0-9 and A-F

Table 30.21  Cat/Index Categories — Unassigned Resources Area

Item Parameters Description
Destinations: <text> Lists the destinations in the current database that are not 

included in any Cat/Index categories

Generate Automatically generates category tags based on the 
destinations in your database

Create Enables you to create a new Cat/Index filter for destinations

Sources: <text> Lists the sources in the current database that are not 
included in any classic categories

Generate Automatically generates category tags based on the sources 
in your database

Sources: Create Enables you to create a new Cat/Index filter for sources

Levels: <text> Lists the levels in the current database that are not included 
in any classic categories

Generate Automatically generates category tags based on the levels in 
your database

Create Enables you to create a new Cat/Index filter for levels

Table 30.19  Cat/Index Categories — Assigned Resources Area

Item Parameters Description
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Group Categories Tab
The Categories tab enables you to categorize sources, destinations, and levels via a hierarchal system of tags. You 
can use categories to filter sources, destinations or levels into manageable groups for a Category soft panel.Refer to 
the section “Category Panels” on page 373 for more information.

Figure 30.23  Example of Entries in a Group Categories Tab

The Group Categories tab is organized into three panels and a bottom toolbar.

Table 30.22 summarizes the options displayed in the left panel of the Group Categories tab. This panel displays all 
the created groups and sub-groups, and/or resources in a top-down hierarchy. Note that the nodes are sorted by type 
and then by alphabetical order.

Table 30.23 summarizes the options displayed in the middle panel of the Group Categories tab. This panel shows 
the assigned contents (groups and/or resources) of the currently selected group from the tree view (in the left panel). 

 

Table 30.22  Group Categories Tab — Left Panel

Item Description
Group Categories: Displays the groups as folders arranged in a tree view

Find Displays the Find dialog that enables you to search for a category or resource name

Move Displays the Move dialog that enables you to move a selected group and its 
contents to another group

Rename Renames a selected group; the resource type will be not re-named

Delete Deletes a selected group and all of its contents

Add Adds a new group to the selected group

Table 30.23  Group Categories Tab — Middle Panel

Item Description
Name Indicates the name of a resource

Type Indicates the type of resource

Delete Deletes the selected resource(s) from the currently selected group
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Table 30.24 summarizes the options displayed in the right panel of the Group Categories tab. This panel displays 
the available destinations, sources, and levels that can be arranged into group categories.

 

Table 30.25 summarizes the bottom toolbar.

Legacy Categories Tab
The Legacy Categories tab enables you to categorize sources, destinations, and levels via a hierarchal system of 
tags. You can use legacy categories to filter sources, destinations, or levels into manageable groups for legacy 
RCP-QE panels (identified by 17 LCD buttons and firmware versions prior to 1.55). Refer to the RCP-QE User 
Guide for details.

 It is recommended for new installations to utilize the Cat.Index or Group Category methods.

Table 30.26 summarizes the options displayed in the top toolbar. 

 

Table 30.27 summarizes the options displayed when the Edit button is selected from the bottom toolbar.

Table 30.24  Group Categories Tab — Right Panel

Item Description
Destinations Displays the unassigned destinations

Sources Displays the unassigned sources

Levels Displays the unassigned levels

Database/alphabet Sort Toggles the sorting style of the unassigned labels

Assign Select the resource(s) and click Assign to assign it to the group selected in the left 
table

Table 30.25  Group Categories Tab — Bottom Toolbar

Item Description
Auto Generate Click to auto-generate group categories based on the resource names from the 

current database

Cancel Ignores all unsaved changes and reverts the tab back to the last saved entries

Apply Applies all change made in the Group Categories tab

Table 30.26  Legacy Categories Tab — Top Toolbar

Item Description
Destination Lists the destination category/index assignments

Source Lists the source category/index assignments

Level Lists the level category/index assignments

Table 30.27  Legacy Categories Tab — Bottom Toolbar

Item Description
Copy Copies the selected cells in the tab

Paste Pastes the previously copied items to the current cell selection

Clear Clears the data from the selected cells

Clear All Clears all category/index assignments
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Salvos Tab
A salvo is a set of pre-defined switch events. The Salvos tab provides a list of the global salvos available in the 
currently selected database. From this tab you can create salvos, rename, edit, and delete salvos.

The workspace in the Salvos tab displays a grid pattern with sources at the top and the destinations along the left 
side. A list of currently available (saved) salvos displays on the far left-side of the tab. The toolbar on the far 
right-side displays a button for each level available in the database with each button set in the color specified for the 
level. Click the Follow button, located below the level buttons, to include all the Levels in the salvo. The toolbar in 
the bottom right corner of the interface displays three buttons: Advanced, Cancel, and Apply. 

Figure 30.24  Example of a Salvos Tab

Table 30.28 summarizes the options displayed in the Salvos tab. 

Fill Auto fills a range of cells

Auto Generate Auto fills the cells based on spaces in the source/destination names

Table 30.28  Buttons on the Salvos Interface

Button Description
Salvos: Provides a list of configured salvos for the currently loaded database. Double-click 

an item in the list to update the grid in the Salvos tab.

Edit... Displays the Edit dialog for the soft panel. Refer to “Edit Dialogs” on page 356.

Select All Click this button to select all the Destinations in the matrix of the Salvos tab. This 
will include all the destinations in the matrix in the salvo configuration.
• All the Destination buttons are lit red in the matrix.
• The button now displays the Clear All label. Click the button again to remove all 

the Destinations from the salvo configuration.

Level # A button is assigned to each level available in the currently loaded database. The 
color and label of the button is specified in the Levels tab.

Advanced Displays the Advanced options outlined in Table 30.29.

Table 30.27  Legacy Categories Tab — Bottom Toolbar

Item Description



350 • DashBoard Interface Overview Ultrix User Guide (v18.0)

Advanced Menus

Clicking the Advanced button in the Salvos tab displays the options outlined in Table 30.29. 

Panels Tab
The Panels tab includes a series of sub-tabs that enable you to customize the soft panels (control panels within the 
DashBoard environment). You can choose to assign the levels, sources, and destinations, from an Ultrix database to 
the panel buttons. The soft panels display as sub-nodes in the Soft Panels tree using the name specified in the Info 
tab. When you save a soft panel to the database, a node for the panel automatically displays under the Soft Panels 
node in the Tree View. The soft panels display in the tree according to their assigned Panel ID number (where an ID 
of 1 is the highest, and ID of 2 is the second highest etc.).

Figure 30.25  Example of Entries in a Panels Tab

Panels Area

The Panels area displays on the left side of the interface. This area displays a list soft panels saved in the current 
database. Selecting a soft panel from the list updates the tab entries in the Panels tab with the settings for that soft 
panel.

Cancel Discards any recent changes made in the Salvos tab, and clears the matrix. Note 
that the Destinations are still selected (buttons are lit red) if you clicked Select All.

Apply Applies changes made in the Salvos tab and updates the salvo settings.

Table 30.29  Salvos Tab — Advanced Menu Items

Button Description
Clear All Presets Clears the workspace in the Salvos tab and resets all settings to the default values.

Clear Dest Presets Clears all selections made in the Destinations column of the workspace.

Capture System Status Captures the current routing state of the Ultrix router. 

Capture Dest Status Updates the workspace to reflect only the status of the destinations of the Ultrix router.

Table 30.28  Buttons on the Salvos Interface

Button Description
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Info Tab

Use the options in the Info tab to assign a panel a unique identifier, select the panel style template to use, and how 
the panel will perform tasks such as Take transitions. This is the default tab that the interface opens on. Table 30.30 
summarizes the fields and menus displayed in the Info tab. 

Table 30.30  Info Tab

Item Parameters Description
Panel Style (read-only) <name> Specifies the panel type that was assigned to the soft panel 

when it was created.

Panel ID <integer> Assigns an ID number to the panel. This value determines 
the panel node placement in the hierarchy of the Soft Panel 
tree.

Panel Name <name> Provides a unique identifier for the soft panel. This name 
also displays as a sub-node in the Soft Panels tree.

Description # Provides a textual summary of the soft panel or additional 
information about the panel.

Protection Operation Lock Displays only the Lock button in the panel interface.

Protect Displays only the Protect button in the panel interface.

Both Displays the Lock and Protect buttons in the panel interface

Take Operation Confirm Confirmation dialog displays, prompting the user to confirm 
a Take before the transition occurs.

Direct The Take transition occurs automatically.

Machine Control Enable Displays a Machine Control button on the panel. 
When selected on the panel, this Machine Control button 
sends a Take request directed to a Ross NK-M series data 
router to automatically make the reciprocal port switch. On 
a video router, the connection is all one way from an input 
port to an output port (e.g. such as from IN 1 to OUT 2). 

Disable Does not display a Machine Control button on the panel

Selection Operation Single The Multi Select button does not display on the soft panel

Multi Displays the Multi Select button on the soft panel. Use this 
button to quickly select multiple destinations for a 
crosspoint switch.
This button is only applicable for MultiBus and Category 
panels.

Nongroup Resourcesa

a. This menu is only available when the Panel Style is set to Group Category.

Hide Resources that are not assigned to a specific group are not 
displayed on the soft panel.

Show All resources are displayed on the soft panel.
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Levels Tab

Use the options in the Levels tab to specify the number of levels for the panel, and organize them in a hierarchy for 
the panel. Table 30.31 summarizes the fields and menus displayed in the Levels tab. 

Destinations Tab

Use the options in the Destinations tab to specify which outputs will be available in Destination bus of the soft 
panel. Table 30.32 summarizes the fields and menus displayed in the Destinations tab. 

Sources Tab

Use the options in the Sources tab to specify which router inputs will be available in the Source bus of the soft 
panel, and their hierarchy. Table 30.33 summarizes the fields and menus displayed in the Sources tab.

Salvos Tab

Use the options in the Salvos tab to specify the total number of salvos displayed in the soft panel and their 
hierarchy. Table 30.34 summarizes the fields and menus displayed in the Salvos tab. 

Table 30.31  Levels Tab

Item Parameters Description
Viewable Levels <integer> Specifies the maximum number of levels, as selectable 

buttons, that can display on the panel

Available <integer> Lists all the levels in the current database

Assigned <integer> Specifies which levels will be available in the soft panel

Table 30.32  Destinations Tab

Item Parameters Description
Viewable Destinations <integer> Specifies the maximum number of destinations available, as 

selectable buttons, on the panel. This field is not displayed 
when the Panel Style is set to Group Category or Cat/Index 
Category.

Available <integer> Lists all the destinations in the current database

Assigned <integer> Specifies which destinations will be available in the soft 
panel

Table 30.33  Sources Tab

Item Parameters Description
Viewable Sources <integer> Specifies the maximum number of sources available, as 

selectable buttons, on the panel. This field is not displayed 
when the Panel Style is set to Group Category or Cat/Index 
Category.

Available <integer> Lists all the sources in the current database

Assigned <integer> Specifies which sources will be available in the soft panel.

Table 30.34  Salvos Tab

Item Parameters Description
Viewable salvos <integer> Specifies the maximum number of salvos that will be listed 

on the Recall Salvos dialog for the panel. This field is not 
displayed when the Panel Style is set to Matrix.
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Favorites Tab

 The Favorites tab only displays when the Panel Style is set to Ultritouch PB.

Table 30.34 summarizes the fields and menus displayed in the Favorites tab. 

Home View Tab

 The Home View tab only displays when the Panel Style is set to Ultritouch PB or Push Button.

Table 30.36 summarizes the options displayed in the Home View tab. 

Available <integer> Lists all the salvos in the current database

Assigned <integer> Specifies which salvos will be available in the soft panel.

Table 30.35  Favorites Tab

Item Parameters Description
Name <name> Provides a unique identifier for the type of Favorite for this 

soft panel.

Type Crosspoint Creates a Favorites button on the soft panel that recalls a 
specific crosspoints switch

Group Creates a Favorites button on the soft panel that loads a 
specific Group Category in the database

Salvo Creates a Favorites button on the soft panel that recalls a 
specific salvo in the database

Sources Creates a Favorites button on the soft panel that selects a 
specific source in the database

Destinations Creates a Favorites button on the soft panel that selects a 
specific destination in the database

Field 1 Specifies the first item for the Favorite. For example, if the 
type is set to Crosspoint, Field 1 reports the destination.

Field 2 Specifies the second item for the Favorite. For example, if 
the type is set to Crosspoint, Field 2 reports the source.

Up Moves the selected row higher in the table

Down Moves the selected row lower in the table

Top Moves the selected row to the top of the table

Bottom Moves the selected row to the bottom of the table

Sort Sorts by window type

Table 30.36  Home View Tab

Item Parameters Description
Display Icons Enable The Destination and Source buttons on the soft panel 

display icons

Disabled The Destination and Source buttons do not display icons; 
only the labels are displayed on each button.

Table 30.34  Salvos Tab

Item Parameters Description
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Buttons

Table 30.37 summarizes the buttons displayed in all Panel sub-tabs. 

Orientation Portrait The windows are organized into columns (vertical panes) 
on the soft panel

Landscape windows are organized into rows (horizontal panes) on the 
soft panel

Home Windows

Window (read-only) <text> Specifies the window type

Percent # Specifies the width of the window in a percentage of the 
overall soft panel size

Rows # Specifies the number of button rows in the window

Columns # Specifies the number of button columns in the window

Reset Loads the default window layout and widths

Up Moves the selected row higher in the table

Down Moves the selected row lower in the table

Top Moves the selected row to the top of the table

Bottom Moves the selected row to the bottom of the table

Sort Sorts by window type

Table 30.37  Button on the Panels Interface

Button Description

In the Available area, clicking this button toggles the sorting order between 
alphabetical or database-index (based on the current order listed in the Levels, 
Destinations, or Sources tabs)

Moves the selected items in the Available list to the Assigned list.

 
Moves the selected item(s) from the Assigned list back to the Available list. These 
items will not be available in the soft panel window.

Moves all the available labels to the Assigned list

Removes all the items from the Assigned list back to the Available list. These items 
will not be available in the soft panel window.

Up Moves the selected item in the Assigned list up one position. This changes the 
order of the displayed items on the soft panel.

Down Moves the selected item in the Assigned list down one position. This changes the 
order of the displayed items on the soft panel.

Top Moves the selected item in the Assigned list to the top of the list. This changes the 
order of the displayed items on the soft panel.

Table 30.36  Home View Tab

Item Parameters Description
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Destination Follow Tab
Table 30.38 summarizes the options displayed in the Destination Follow tab. 

Additional Dialogs, Menus, and Toolbars in the Database Interfaces
Each tab displays a toolbar located at the bottom that provides buttons that display additional editing dialogs (e.g. 
insert, cut, paste, search). Also, right-clicking a row in any tab also displays a menu of editing dialogs. This section 
briefly outlines those additional editing dialogs.

Bottom Toolbar

The bottom toolbar of a tab in the Database includes buttons for applying changes made to settings in the interface, 
or adding elements to the table in the interface. Table 30.39 summarizes the buttons displayed in a bottom toolbar. 
Note that not all buttons display in all tabs. 

Bottom Moves the selected item in the Assigned list to the bottom of the list. This changes 
the order of the displayed items on the soft panel.

In the Assigned area, clicking this button arranges the items into alphanumerical 
order.

In the Assigned area, clicking this button arranges the items in the Assigned list 
according to the order established in the Levels, Destinations, or Sources tabs.

Edit... Displays the Edit dialog for the soft panel

Cancel Discards any recent changes made in the soft panel, and reverts to the previously 
saved settings.

Apply Applies changes made in the soft panel and updates the Ultrix database

Table 30.38  Destination Follow Tab

Item Parameters Description
Destination # Specifies the Destination you want to configure

Following # Specifies the router output that the specified Destination 
will follow

Table 30.39  Bottom Toolbar Items

Button Description
Edit Displays the Edit dialog for the tab. Refer to Table 30.40 for details.

Find Displays the Find dialog that enables the entering of criteria for searching of the 
tab contents.

Fill Label Applies a custom label to the selected port

Reset Label Reverts the label content to the previously saved text

Delete Removes the selected port from the list for the matrix

Add Adds the selected port from the list for the matrix

Table 30.37  Button on the Panels Interface

Button Description



356 • DashBoard Interface Overview Ultrix User Guide (v18.0)

Edit Dialogs

Table 30.40 summarizes the buttons displayed in the Edit dialogs. Note that not all options display in all tabs. 

Cancel Discards any recent changes made in the tab, and reverts to the previously saved 
table settings.

Apply Applies changes made in the tab and updates the Ultrix database

Table 30.40  Edit Dialogs Items

Button Description
Add In interfaces with lists on the left toolbar (e.g. Panels, Port Labels, Salvos), 

selecting a list item and then clicking Add creates a copy of the selected item. The 
name to the newly created item includes the name from the copied item with the 
prefix “New”.

Auto Generate Automatically fills the cells in the table with a default value. For example, clicking 
this button in the Destinations tab automatically fills all the cells with the text 
“Dest”.

Clear Removes the data from the selected cell.

Clear All Removes the text or entry in all cells of the interface.

Copy Copies the selected cell data to the clipboard. In some interfaces, such as in the 
Salvo tab, the salvo settings are copied in entirety.

Cut Copies the cell data to the clipboard and then delete it from the table.

Deletea When working in an interface with a table layout, clicking this button removes the 
currently active row from the table.
When working in an interface with lists on the left toolbar, clicking this button 
removes the selected item from the list. You will still need to click Apply to 
completely remove the item from the database.

Fill A range of name cells may be filled with consecutive numerical data. For example, 
VTR1 to VTR4 may be entered quickly by defining a prefix (in this case VTR) and 
a suffix that will numerically increment. 
Selecting Fill from the Insert toolbar, a dialog displays prompting you to enter a 
prefix (alphanumeric) and the start/end numerical values.
This method adds rows to the destination table inserting below the active row. 
Refer to the section “Advanced Fill Tool” on page 357 for details.

Fill & Replace Enables you to overwrite a range of cells in the table. Rows beneath the currently 
active row are overwritten with data from the Fill & Replace dialog.

Insert Above Inserts a new row above the currently active row in the table. Any existing data is 
moved down the table by one row.

Insert Below Inserts a new row below the currently active row in the table. Any existing data is 
moved up one row.

Insert Series Inserts a sequential range of labels below the currently selected row.

Paste Pastes the copied cell data from the clipboard. In some interfaces, such as in the 
Salvo tab, the copied salvo settings are pasted in entirety.

Paste Below Pastes the copied cell data, from the clipboard, to currently selected cell.

Table 30.39  Bottom Toolbar Items

Button Description
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Find Dialogs

Table 30.41 summarizes the buttons displayed in the Find dialogs. 

Advanced Fill Tool
The Advanced Fill tool is provided to create new destination and source labels where physical outputs and inputs 
are automatically assigned depending on options set by the user. The audio routing features provided by Ultrix can 
result in an extensive source and destination definition map requiring some time to manually enter. The Advanced 
Fill tool will speed the assignment of physical sockets greatly.

For More Information on...
• using the tool to set up your database, refer to the section “Using the Advanced Fill Tool” on page 118.

Breakaway Fill Dialog

The Breakaway Fill dialog is the Advanced Fill tool for the Sources tab. This dialog is displayed when you click 
Edit > Fill.

Rename When working in an interface with lists on the left toolbar, clicking this button 
enables you to provide a different name/label to the selected item.

Reset All IDs Resets the source/destination ID numbers based on their current row number.
It is recommended to verify the interfaces that reference IDs (such as Soft Panels, 
Salvos, etc.)

a. Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the tabs. Refer to the Reset All IDs 
row in this table.

Table 30.41  Find Dialogs Items

Item Description
Column A pull-down menu that lists the columns available in the current interface. Select 

the column to perform the search within.

Find What: Specifies the characters, or text, to search the table contents.

Direction Begins the search by searching below the currently selected row (Down), or above 
the selected row (Up).

Match whole word only Select the check box to search only for the characters in the Find What: field as 
they are typed in the field. For example, typing “put” will search for instances of 
the word “put” and not “input” or “output”.

Cancel Cancels the search criteria and closes the Find menu.

Find Performs a search through the table contents based on the specified criteria.

Table 30.40  Edit Dialogs Items

Button Description
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Figure 30.26  Example of a Breakaway Fill Dialog

Table 30.42 summarizes the options displayed in the Breakaway Fill dialog. 
Table 30.42  Breakaway Fill Dialog

Item Parameters Description
Fill Custom Insert labels with assignments for a custom range defined 

by the Range setting

Entire Slot Insert labels with assignments for a single Ultrix slot 
(including the AUX ports)

Entire Device Insert labels with assignments for the entire Ultrix router 
(including the AUX ports)

Name <text> The prefix for the label creation. For example, typing VTR 
results in labels VTR1, VTR2, etc. 
Take care when determining label names. While a long 
name may be nice and descriptive for the Source tab, many 
control devices have limited screen space and labels may be 
truncated.

Starting # The starting numerical extension for the label creation. For 
example, typing 3 results in labels Name3, Name4, etc. 

Count # The quantity of labels for custom fill range

AUX Ports None AUX ports will not be included in the resulting definitions

Insert at Slot AUX ports will be defined immediately following a given 
slot BNC definitions

Add at End AUX port definitions will be defined immediately 
following ALL BNC definitions

AUX only Defines only AUX port settings (useful when adding in one 
AUX port to a system)

Slot # The Ultrix slot number to start the label assignmenta

Port # The Ultrix port to start the label assignment froma

Starting Channel # The Ultrix channel to start the label assignment froma

Level # This column lists the levels defined as per user entries in the 
system Levels setup table

I/O Assignment # This column lists the starting assignment for the given 
Level row
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Destinations Fill Dialog

The Destinations Fill dialog is the Advanced Fill tool for the Destinations tab.

Figure 30.27  Example of a Destinations Fill Dialog

Fixed Select the box to fix the I/O assignment selection even 
though it may be out of order compared to other I/O 
assignments.
For example, Ultrix.slot1.in[1].audio.ch1 and 
Ultrix.slot2.in[1].audio.ch1.

BRK I/O Select the box to insert a label with this I/O assignment on 
all BRK Level selections.
For example, IN 1 ch1  | slot1.in[1].audio.ch1 | 
slot1.in[1].audio.ch1 | slot1.in[1].audio.ch1.

BRK Level Select the box to include this level when creating a 
breakaway label. For example, IN 1 ch1.

BRK Suffix <text> By default, breakaway label naming uses the chx part of the 
Ultrix name. A user defined suffix may be entered here.

Assign Click this button to automatically fill the I/O Assignment 
column based on the Slot, Port, Starting Channel settings 
to the selected row(s).

Apply Click this button to insert labels with assignments based on 
dialog settings into the source assignment table below the 
current selected row.

Cancel Click this button to cancel the settings and close the dialog. 
No changes to the Source table will be made.

a. The Breakaway Fill dialog uses the default naming convention of FrameName.slot n.in/out[p].type.chx.

Table 30.42  Breakaway Fill Dialog

Item Parameters Description
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Table 30.43 summarizes the options displayed in the Destinations Fill dialog. 
Table 30.43  Destinations Fill Dialog

Item Parameters Description
Fill Custom Insert labels with assignments for a custom range defined 

by the Range setting

Entire Slot Insert labels with assignments for a single Ultrix slot 
(including the AUX ports)

Entire Device Insert labels with assignments for the entire Ultrix device 
(including the AUX ports)

Name <text> The prefix for the label creation. e.g. typing VTR results in 
labels VTR 1, VTR 2, etc. 
Take care when determining label names. While a long 
name may be nice and descriptive for the Destination tab, 
many control devices have limited screen space and labels 
may be truncated.

Starting # The starting numerical extension for the label creation. e.g. 
typing 3 results in labels Name3, Name4, etc. 

Count # Specifies the quantity of labels for custom fill range

AUX Ports None AUX ports will not be included in the resulting definitions

AUX Ports Insert at Slot AUX ports will be defined immediately following a given 
slot BNC definitions

Add at End AUX port definitions will be defined immediately 
following all BNC definitions

AUX only Defines only AUX port settings (useful when adding in one 
AUX port to a system)

Slot # The Ultrix slot number to start the label assignment froma

a. The Fill Destination dialog uses the default naming convention of FrameName.slot n.in/out[p].type.chx.

Port # The Ultrix port to start the label assignment froma

Starting Channel # The Ultrix channel to start the label assignment froma

Level # Defines the levels as per the entries in the Levels tab

I/O Assignment # Starting assignment for the given level row

Assign Click to automatically fill the I/O Assignment column based 
on the Slot, Port, and Starting Channel settings to the 
selected row(s)

Apply Click to insert labels with assignments based on dialog 
settings into the source assignment table below the current 
selected row

Cancel Click to cancel the settings and close the dialog
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UltriScape Interfaces
The UltriScape licensed feature provides the following nodes in the tree view: Configuration, Layout Editor, and 
Head Selection. Double-click a node to displays its interface in the DashBoard window.

Configuration Interface
The Configuration interface is the first node listed under the main UltriScape node. This interface provides global 
layout editor settings that apply to all UltriScape layouts and heads in the current database. From this interface you 
can specify the Global PiP settings, tally colors, and tally label behavior.

PiP Layout Tab

Table 30.44 summarizes the options displayed in the Layout Editor Settings > PiP Layout tab.

Table 30.44  Layout Editor Settings — PiP Layout Tab

Item Parameters Description
PiP Size Selection

PiP Size A # Specifies the default dimensions of the PiP Size A template 
for all layouts created with the current database. The default 
is 1/4 (480x270).

PiP Size B # Specifies the default dimensions of the PiP Size B template 
for all layouts created with the current database. The default 
is 1/2 (960x540).

PiP Video Alignment

Video Overlap The PiP border overlaps the video image. The PiP Border 
Width Override fields are set to read-only.

Frame The PiP border frames the video image. The video image is 
modified to fit inside the PiP but not overlap the border.

PiP Border Width Override

Border # Sets the border width (in number of pixels) for all layouts 
created with the current database

PiP SD Aspect Ratio

SD is 4:3 270Mbit SD SDI is 4x3 format

16:9 270Mbit SD SDI is of 16x9 format

Audio Meter

Auto Meter Standard -20dBFS Audio meter green to yellow transition equates to audio 
level of -20dBFS

-18dBFS Audio meter green to yellow transition equates to audio 
level of -18dBFS

Cancel Click this button to cancel the settings. No changes to the 
PiP Layout tab will be made.

Apply Click this button to apply the new tab settings.



362 • DashBoard Interface Overview Ultrix User Guide (v18.0)

Tally Settings Tab

Table 30.45 summarizes the options displayed in the Layout Editor Settings > Tally Settings tab.

Label Settings Tab

Table 30.46 summarizes the options displayed in the Layout Editor Settings > Label Settings tab.

 

Table 30.45  Layout Editor Settings — Tally Settings Tab

Item Parameters Description
Tally Lamp Color

Tally #a

a. The function of Tally 0 and Tally 1 is determined by the TSL UMD protocol version as outlined in the chapter “External 
Control” on page 263.

Red When the tally is active (on), the tally object is set to red in 
the UltriScape layout. By default, Tally 0 is set to Red.

Green When the tally is active (on), the tally object is set to green 
in the UltriScape layout. By default, Tally 1 is set to Green.

Tally Label Text Settings

Source Mode overwrite When a PiP is assigned to Src # in the Head Selection 
interface, and the Label Type is set to Tally, the label text is 
determined by the tally label.

append When a PiP is assigned to Src # and the Label Type is set to 
Tally, the label text is src : tally where:
• src — represents the source label defined in the Ultrix 

database.
• tally — represents the text defined by the tally label.

Follow Dest Mode overwrite When a PiP is assigned to Follow Dest # in the Head 
Selection interface, and the Label Type is set to Tally, the 
label text is determined by the tally label.

append When a PiP is assigned to Follow Dest # and the Label Type 
is set to Tally, the label text is dest : tally where:
• dest — represents the destination label defined in the 

Ultrix database.
• tally — represents the text defined by the tally label.

Tally Behavior Settings

When both tallies are 
on:

Red tally only Only the red tally indicator is lit. The green is off.

Both tallies lit Both the red and green tally indicators are lit.

Table 30.46  Layout Editor Settings — Label Settings Tab

Item Parameters Description
Label Settings

Label Background 
Transparency

0 to 100 Adjusts the background transparency level of all label boxes 
in all PiPs of all UltriScape Heads where:
• 0 — The label background is completely opaque. Only the 

label text is visible.
• 100 — The label background is completely transparent; 

the video in the PiP is visible through the label 
background.
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Layout Editor Interface
The Layout Editor interface is the second node displayed under the main UltriScape node in the Tree View. The 
UltriScape Layout Editor provides a central workspace with menus and options set into toolbars for customizing a 
layout. The interface also includes three tabs at the top: Layout Editor, Shared PiPs, and Clocks.

Layout Editor Tab

The Layout Editor tab includes a toolbar at the top of the interface, the workspace in the middle, rulers along the top 
and left side of the workspace, and a toolbar for selecting and adding objects to the layout. From the UltriScape 
Layout Editor interface you can edit, load and save layouts, add objects to a layout, and modify the tiles within a 
layout.

Figure 30.28  Example of the Layout Editor with a Loaded Layout

Main Toolbar

The Main toolbar is located under the Layout Editor tab. (Figure 30.29) The options are organized into two areas: a 
row of menus at the top, and a row of buttons and fields on the bottom. The buttons and fields will change 
depending on what is selected in the workspace.

Figure 30.29  Layout Editor — Main Toolbar when a PiP is Selected

Table 30.47 outlines the menus and buttons available from the Main toolbar. 
Table 30.47  Main Toolbar Menus and Buttons

Name Description
File Provides options for loading templates, publishing layouts to the UltriScape Head 

interface, opening a previously saved layout, managing PiP templates, and saving 
the changes to the currently loaded layout.

Edit Provides options, such as copy, paste, delete, and select all, for managing the 
objects in the currently loaded layout.

Format Provides global options for distributing the PiPs within a layout.
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UltriScape Layout Editor Keyboard Shortcuts

Table 30.48 outlines the keyboard shortcuts for the UltriScape Layout Editor. 

View Provides options for changing how the loaded layout is currently displayed in the 
UltriScape Layout Editor. The default is 100%.

About Provides information about the UltriScape software.

Toggle Grid Click to toggle to display or hide the workspace grid. The grid is hidden by default.
To change the dimensions of the grid, select Format > Grid and use the 
Configure Grid dialog to specify the grid spacing (in number of pixels). You must 
also select the User Spacing check box to apply the new dimension.

UNDO Reverses the last change made to the layout.

REDO Repeats the last change made to the layout.

Layout Name Displays the filename of the layout currently loaded in the UltriScape Layout 
Editor workspace.

Layout UID Displays the unique identifier of the layout currently loaded in the UltriScape 
Layout Editor workspace. This is an auto-generated number.

LOAD PiP This button only displays when you click a PiP on the loaded layout. Enables you 
to load and apply a previously saved PiP template.

SAVE PiP This button only displays when you click a PiP on the loaded layout. Use it to save 
the current PiP as a template to be recalled and applied to other PiPs.

Border Width This field only displays when you click a PiP on the loaded layout. Use this field to 
specify the border width in number of pixels and lines.

Border Type This field only displays when you click a PiP on the loaded layout. Use this field to 
define the border applied to the selected PiP.

Table 30.48  Keyboard Shortcuts

Task Keyboard Shortcut
File Menu

New Layout Alt+N

Load from Local Ctrl+Shift+O

Save to Local Ctrl+Shift+L

Delete from Local Ctrl+Shift+D

Load from Ultricore Alt+O

Save to Ultricore Alt+S

Delete from Ultricore Alt+D

Load Layout Template from Ultricore Alt+T

Load PiP from Ultricore Shift+O

Save PiP to Ultricore Shift+S

Delete PiP from Ultricore Ctrl+D

Upload Background Image Ctrl+Shift+U

Edit Menu

Table 30.47  Main Toolbar Menus and Buttons

Name Description
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Objects Toolbar

The Objects toolbar is located on the left side of the interface and provides tools for adding and editing the objects 
in a loaded layout. Objects are elements that you can place, re-size, and re-position as required within the layout. 

Table 30.49 outlines the menus available from the Objects toolbar. Refer to the section “Managing the Objects in 
a Layout” on page 163 for more details. 

Bottom Toolbar

The Bottom toolbar of the interface enables you to customize the overall look of the currently loaded layout.

Figure 30.30  Layout Editor — Bottom Toolbar Example

Undo Ctrl+Z

Redo Ctrl+Shift+Z

Copy Ctrl+C

Paste Ctrl+V

Clear All Ctrl+Shift+C

Delete Del

Select All Ctrl+A

Refresh F5

View Menu

Zoom 100% Ctrl+0

Zoom 50% Ctrl+5

Zoom 25% Ctrl+2

Table 30.49  Objects Toolbar Icons

Name Description
SELECT This pointer tool enables you to select objects and PiPs in the loaded layout. When 

selecting a PiP, the overlay settings are displayed in the Main toolbar. Select more 
than one PiP to make global overlay changes to the layout.

PIP A Enables you to add a new pre-defined PiP A to the layout. Specify the settings for 
PiP A in the Layout Editor > Configuration tab.

PIP B Enables you to add a new pre-defined PiP A to the layout. Specify the settings for 
PiP B in the Layout Editor > Configuration tab.

PIP C Enables you to add a new pre-defined PiP C to the layout. Specify the settings for 
PiP C using the PiP Size C menu located in the Bottom toolbar.

UMD Enables you to add a new label box on the loaded layout.

METER Enables you to add a new set of audio meters on the loaded layout.

TALLY Enables you to add tally lamps to the selected PiP. Refer to the section 
“Configuring PiP Tallies in an UltriScape Head” on page 197 for details.

CLOCK Enables you to add a clock to the layout. Specify the settings for the clock in the 
Layout Editor > Clocks tab.

Table 30.48  Keyboard Shortcuts

Task Keyboard Shortcut
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Table 30.50 outlines the menus available from the Bottom toolbar. 

Shared PiPs Tab

The Shared PiPs tab lists the configured PiPs to be shared by various layouts in this database. From this tab you can 
assign the operation mode, the video source, the audio mode, and specify the audio bar numbering scheme.

Figure 30.31  Example of the Shared PiPs Tab

Table 30.50  Bottom Toolbar Menus

Name Description
PiP Size A Specifies the dimensions for Local PiP A. This applies to the current layout using 

PiP A created/edited during this session.

PiP Size B Specifies the dimensions for Local PiP B. This applies to the current layout using 
PiP B created/edited during this session.

PiP Size C Specifies the dimensions for Local PiP C. This applies to the current layout using 
the PiP C applied during this session. Note that each layout can only include a 
maximum of one PiP C tile.

Background Specifies the background the entire layout (solid color or a loaded still image). The 
default is Solid Color.

Background Color Specifies the layout background color when Background is set to Solid Color. The 
default is black.

PiP Fill Specifies the background of the PiPs in the layout. Choose from a Solid Color or 
75% Color Bars.

PiP Fill Color If you set the PiP Simulation to Solid Color, this menu enables you to specify the 
color for the PiP backgrounds in the Layout Editor and UltriScape Head interfaces

Point X Indicates the horizontal position of your cursor on the Layout Editor workspace.

Point Y Indicates the vertical position of your cursor on the Layout Editor workspace.
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Table 30.51 summarizes the options displayed in the Layout Editor Settings > Shared PiPs tab.

Clocks Tab

Table 30.52 summarizes the options displayed in the Layout Editor Settings > Clocks tab.

Head Selection Interface
The Head Selection interface is displayed by selecting the third node listed under the UltriScape node in the Basic 
Tree View of DashBoard. The interface displays a tab for each UltriScape Head. From the Head Selection interface 
you can recall a layout and assign it to an UltriScape Head, assign matrix sources to each PiP of a layout (any router 
source can be assigned to a head), assign a layout to an UltriScape Head and display it in the head output.

Table 30.51  Layout Editor — Shared PiPs Tab

Item Parameters Description
ID (read-only) # The unique identifier for the Shared PiP

Mode Normal The PiP does not monitor a specific resource; the Source is 
automatically set to Normal

Follow The PiP monitors a specific destination (as specified in the 
Source column of this tab)

Source The PiP monitors a specific source (as specified in the 
Source column of this tab)

Source # Specifies the resource the PiP will monitor when Mode is 
set to Follow or Source

Audio Mode Logical The PiP audio signals use the source/destination logical 
mapping.

Physical The PiP audio signals map to the physical IN connection on 
the rear panel. Use the Audio Bars field to specify which 
channels to included in the PiP UltriScape Head output

Audio Bars # Specifies up to 16 audio channel(s) the PiP will monitor; 
separate each channel with a comma (e.g. 1,2,3,4)

Table 30.52  Layout Editor — Clocks Tab

Item Parameters Description
ID (read-only) The numerical identifier for the clock

Name Assigns a unique identifier for the clock

Type timeofday The clock reports the time of day as determined by the NTP 
Server it is using

stopwatch The clock functions as a free running timer that counts up 
from 00:00. The count will reset after a maximum of 
23:59:59.

countdown The clock counts down from a value specified by the user. 

TZ Offset +/-HH:MM Specifies an offset to the reported time zone value

Time Value HH:MM:SS Specifies the value the clock counts down from (when Type 
is set to countdown)



368 • DashBoard Interface Overview Ultrix User Guide (v18.0)

Figure 30.32  Example of the Head Selection Interface

Clock Control Interface
The Clock Control interface is displayed by selecting the fourth node listed under the UltriScape node in the Basic 
Tree View of DashBoard. 

Figure 30.33  Example of the Clock Control Interface

The interface is organized into two distinct areas: a table that lists the configured clocks in the database and a 
toolbar with function buttons.

Configured Clocks Area

The table lists, in numeric order based on the ID automatically assigned to each clock, the clocks that are configured 
for the current database. Refer to the section “Adding a Clock” on page 169.

Clock Buttons

Some buttons are only available on count down timers and stopwatch clock elements.
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Devices Interfaces
The Devices node summarizes the hardware components of the routing system. The nodes represent a hierarchy of 
the devices in the routing system communicating with the Ultrix router.

For More Information on...
• how Ultrix communicates with remote control panels, refer to the chapter “Using Remote Control Panels” on 

page 201.
• how Ultrix communicates with Ross devices, refer to the chapter “Operation with Ross Devices” on page 257
• general control of external devices via third-party protocols, refer to the chapter “External Control” on 

page 263.

Controllers and Matrices
Under the Controllers and Matrices node provides an inventory of remote control devices and routers that make 
up your routing system, and have a defined connection to Ultrix.

• A Matrix is, generally speaking, a simple router consists of a matrix and a limited control system. 
• A Controller is a complex router consisting of many matrices and its own control system.

Expanding the Controllers and Matrices reveals devices defined by rows in the Connections tab. Double-click the 
node for a device to open the setup options for that particular device in DashBoard.

Ross Video devices that previously displayed in the Tree View as a sub-node of their IP connection point (i.e. 
NK-NET or IPS), are now relocated to the Controllers and Matrices node of Ultrix once they are defined in the 
Connections tab. This indicates the device in question is now part of the Ultrix control system.

Soft Panels Interfaces
The Soft Panels interface represents the routing system crosspoint control in the virtual space of the Ultrix router. 
Each available soft panel in the database displays as a sub-node under the Soft Panels main node in a tree layout. 
The soft panels display in a hierarchy based on their Panel ID. Double-click a soft panel node in the tree to display 
its interface in the DashBoard window. There are three types of soft panels: Matrix, MultiBus, and Category.

 You must configure your connections, sources, destinations, and levels, before you can create a soft panel and 
perform crosspoint switches. 

For More Information on...
• creating a database for your routing system, refer to the section “Creating a New Database” on page 106.
• the interface for creating soft panels, refer to the section “Panels Tab” on page 350.
• using soft panels, refer to the chapter “Soft Panels in DashBoard” on page 221.
• creating and using salvos, refer to the chapter “Using Salvos” on page 249.

Matrix Panel
The Matrix Panel provides a visual representation of multi-level crosspoints, in a grid layout, and offers a 
convenient and easy way to select and switch crosspoints. The columns of the grid represent the configured Sources 
and are labeled with the global names specified in the Input Name cells of the Sources tab. The rows of the grid 
represent the configured Destinations and display the virtual labels specified in the Destination tab.
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Figure 30.34  Example of a Matrix Panel

Right-side Toolbar

Table 30.53 summarizes the buttons displayed in the toolbar on the right-side of the interface. 

Salvo Menus

Table 30.54 summarizes the options displayed in the Salvo menu. 

Table 30.53  Matrix Panel Toolbar Items

Button Description
Level # Each configured level in the currently active database is represented with a button. 

A selected button is lit with the color assigned to the level. Crosspoint selections 
on the matrix are also lit this color when the level is included in the next switch.

Follow Automatically selects all the Level buttons listed on the Matrix panel (buttons are 
now lit). All levels are now included in the next crosspoint selection.

TAKE Performs a Take transition to the next crosspoint selection.

Lock Locks the Matrix panel from all switches or function button operation.

Protect Protects the currently selected source/destination level pair from use by other 
sources, as well as from other linked panels.

Free Removes the Lock and Protect from the next crosspoint switch.

Salvo Displays the options for managing the salvos for your soft panel. Refer to the 
section “Salvo Menus” on page 370 for details.

Advanced Displays the options for managing crosspoint switches on your soft panel. Refer to 
the section “Advanced Menus” on page 371 for details.

Table 30.54  Matrix Panel — Salvo Menus

Button Description
Recall Recalls and applies the last saved salvo settings.

Edit Enables you to load a salvo, update its settings, and then save your changes.

Save Saves the current crosspoint selection as a salvo.
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Advanced Menus

Table 30.55 summarizes the options displayed in the Advanced menu. 

MultiBus Panel
The MultiBus Panel provides breakaway control and status monitoring of several destinations simultaneously. The 
MultiBus Panel interface is organized into two buses with a central status row of indicators for the levels. The 
toolbar on the far left of the interface provides options for locking and protecting crosspoints, setting up the 
transition, and selecting the levels. The bottom row of the interface is populated with buttons for the salvos defined 
in the database.

Figure 30.35  Example of a MultiBus Panel

Capture Current Status Automatically creates a salvo based on the currently selected destination and 
source positions.

Capture Dest Status Automatically creates a salvo based on the currently selected destination positions.

Table 30.55  Matrix Panel — Advanced Menus

Button Description
Clear All Presets Removes all selections currently made on the soft panel and returns the panel to its 

default destination and source selections.

Clear Dest Presets Removes only the selections made on the Destinations bus.

Diagonal Presets The destination and source crosspoint selections are automatically made starting at 
the top left corner and progressively moving down the grid in a 1:1 pattern. For 
example, Src1 and Dest1, Src2 and Dest2, Src3 and Dest3 etc.

R-Diagonal Presets The destination and source crosspoint selections are automatically made starting at 
the top right corner and progressively moving down the grid in a 1:1 pattern. For 
example, Src10 and Dest1, Src9 and Dest2, Src8 and Dest3 etc.

Setup Automation Automatically loops the crosspoint switches for the specified length of time.

Stop Automation Stops the automatic loop of crosspoint switches that was initiated using the Setup 
Automation option.

Table 30.54  Matrix Panel — Salvo Menus

Button Description



372 • DashBoard Interface Overview Ultrix User Guide (v18.0)

Left Toolbar

Table 30.56 summarizes the fields and information displayed in the left toolbar of the MultiBus Panel. 

Destinations Bus

Each Destination is represented as a distinct box on the top bus of the MultiBus Panel. Figure 30.36 provides an 
example of a Destination bus. The Destination bus only displays the destinations selected, and their hierarchy, 
specified when the soft panel was configured.

Figure 30.36  Example of a Destination Bus on a MultiBus Panel

Table 30.57 summarizes the information displayed for each Destination in the MultiBus Panel. 

Table 30.56  MultiBus Panel — Left Toolbar Items

Button Description
Lock Locks the MultiBus panel from all switches or function button operation.

Take Performs a Take transition to the next crosspoint selection.

Preset When lit, it indicates both the current crosspoint switch results (buttons are lit 
green) and the newly-selected crosspoints that have not taken effect (buttons are lit 
blue).

Clear Clears the selections in the crosspoint buses. No buttons are lit and the fields in the 
Destination buses are blank.

Multi Select Enables you to assign a single source to multiple destinations for a multi-switch 
configuration.

Level # Each configured level in the currently active database is represented with a button. 
When selected, the button is lit with the color assigned to the level. Crosspoint 
selections on the matrix are also lit this color when the level is included in the next 
switch.

Follow Automatically selects all the Level buttons listed on the Matrix panel (buttons are 
now lit). All levels are now included in next crosspoint selection.

Table 30.57  MultiBus Panel — Destination Items

Button Description
Name The Destination name/label is reported at the top of each area and displays as a 

selectable button. This enables for quick identification on the bus when selecting 
crosspoint switches.
The Destinations available on the bus is dependent on the database currently 
loaded on the router and how many destinations were specified when the soft panel 
was configured.

Level # This field reports the level(s) that the destination was associated with on the last 
crosspoint switch.

Source # This field reports the source(s) currently selected on the Source bus located near 
the bottom of the MultiBus Panel interface.
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Sources Bus

Each Source is represented as a distinct button on the bottom bus of the MultiBus Panel. Figure 30.37 provides an 
example of a Source bus. The Source bus only displays the sources, and in the hierarchy, specified when the soft 
panel was configured.

Figure 30.37  Example of a Sources Bus on a MultiBus Panel

Category Panels
There are two types of Category Panels: Classic and Group. Each Category Panel organizes the sources and 
destinations according to the definitions set in the applicable Category interface for the database. The top toolbar is 
used in conjunction with the central button matrix for selecting sources and destinations. The left side of the 
interface provides access to level selection, and reports on the breakaway status with fields for each level. Some 
functions are category type specific.

For More Information on...
• the items in a Category soft panel, refer to the section “Using Category Panels” on page 239.

Figure 30.38  Example of a Group Category Soft Panel for an Ultrix Router

Ultritouch PB Panels
You can control an Ultrix router via Ultritouch by loading a saved soft panel using the Ultritouch hard panel 
interface. Loading a soft panel to Ultritouch requires a similar method as loading a soft panel in the Ultrix and/or 
Ultricore menu system. You select the device in the Ultritouch > All Connections interface, navigate to the specific 
soft panel you wish to load, and select it from the provided list. 

Lock Locks the Destination from all switches or function button operation.

Protect Protects the currently selected Destination from use by other sources, as well as 
from other linked panels.

Table 30.57  MultiBus Panel — Destination Items

Button Description
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Figure 30.39  Example of an Ultritouch Soft Panel

For More Information on...
• the creating and using Ultritouch soft panels, refer to the Ultritouch + Ultrix User Guide.

Push Button Panels
The Push Button Panel interface is organized into four distinct areas. The top area displays the Destinations, the 
middle row includes the Source buttons, and each area can include an independent method for filtering the buttons. 
A toolbar provides access to the level buttons, and includes a status field. A second toolbar provides options for 
locking and protecting crosspoints, setting up the transition, selecting salvos, and other functions. 

Figure 30.40  Example of a (Landscape) Push Button Soft Panel

For More Information on...
• the creating and using Push Button soft panels, refer to the section “Using Push Button Panels” on page 243.

Using Walkabout in DashBoard
Walkabout is a Ross router utility operating within DashBoard that enables you to configure the network settings 
for Ross routers, remote control panels, and other devices. Once a valid connection is established with Walkabout, 
the router is listed in the Tree View of DashBoard and available for monitoring and configuration using the options 
in DashBoard. 

Ultrix supports a basic configuration mode via the Walkabout system for initial configuration of IP settings. Use 
Walkabout to:

• specify device IP settings and names
• specify a name for your routing system
• specify the system role (e.g. primary, backup, device)
• select a system to join from a list of valid system names assigned to controllers
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• set communications server from a list of valid communication server devices (or IP)

For More Information on...
• the features of Walkabout, refer to the Ross Video document Configuring Devices Using Walkabout.
• using Walkabout and the Ultrix router, refer to the section “Using Walkabout to Assign the Initial IP Address 

to the Ultrix Router” on page 23.
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under one label.

Connection Point — setting to define a communication connection between an Ultrix and a device in the routing 
system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires one 
crosspoint.

Destination — a label applied to a router output (or group of outputs).

Device — a physical, virtual, or software application that may include multiple sources, destinations, senders, or 
receivers.

Flow — the continuous raw media content. It can contain more than one essence (e.g. an audio flow can contain 
multiple channels, and an SDI flow may contain audio and video essences). A flow is independent of the transport 
protocol. For example, 48kHz LPCM audio is a flow; AES67 is one type of stream which can carry the flow. Flows 
cannot generally be passed around natively, and need to be encapsulated in a stream. Flows from the same source 
are considered “editorially equivalent”, but may be encoded differently. For example, a video source may be 
encoded as 4:2:2 YCbCr uncompressed, 4:4:4 RGB uncompressed, and h.265 encoded. Each of these would be a 
separate flow from a common source.

Hard Panel — a physical hardware panel of buttons that is used to control the routing system.

Head — An OUT port on the Ultrix router that is assigned as an UltriScape (Multiviewer) output.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and an audio router 
would be a second level.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a common label 
(name).

Macro — a recorded sequence of Remote Control Panel operations (local to the panel).

Map — a table that defines the allocation of names (labels) to router input and output sockets.

Matrix — the part of the routing system that performs the actual signal switching tasks.

Partition — matrices may be partitioned to behave as smaller independent matrices.

Picture in Picture (PIP) — a sub-picture in an UltriScape (Multiviewer) output.

Receiver — an element within a device that receives exactly one stream, which contains one flow from a network.

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the routing system.

Resource — a source or destination of a router configuration; an external device providing some conversion 
functionality for use within the routing control system.

Salvo — a system wide sequence of matrix control operations and crosspoint actions.

Sender — an element within a device which presents exactly one flow, packaged as a stream onto a network.

Stream — one flow, encapsulated within a transport protocol. Examples include SMPTE ST 2022-6, SMPTE ST 
2110-20 Video, or SMPTE ST 2110-30 Audio (AES67).

Soft Panel — a DashBoard interface that represents a panel of buttons that is used to control the routing system.

Source — a label applied to a router input (or group of inputs).
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T-Bus — the Ross Video proprietary routing communication method via a defined physical interface.

UltriClean — clean switch functionality of the Ultrix routers.

Ultricore — refers to the Ultricore-CC and the Ultricore-BCS unless otherwise stated.

UltriMix — SDI embedded audio manipulation sub-system of the Ultrix routers.

UltriScape — licensed Multiviewer option for Ultrix routers.

UltriSpeed — licensed 12Gbps SDI video option.

UltriSync — a per input licensed frame synchronizer.

ULTRIX-FR1 — refers to all versions of the ULTRIX-FR1 router unless otherwise noted.

ULTRIX-FR2 — refers to all versions of the ULTRIX-FR2 router unless otherwise noted.

ULTRIX-FR1-NS — refers to the next generation of the ULTRIX-FR1 router. This router displays the Ultrix logo 
on the front door with a blue dot in the “i”.

ULTRIX-FR2-NS — refers to the next generation of the ULTRIX-FR2 router. This router displays the Ultrix logo 
on the front door with a blue dot in the “i”. 
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